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Notices

Copyright Notice
© Keysight Technologies 2021, 2022

No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or
translation into a foreign language) without prior agreement and written consent from Keysight Technologies as
governed by United States and international copyright laws.

Manual Part Number
EDU33212-90002

Edition
Edition 3, November 2022

Published by

Keysight Technologies

Bayan Lepas Free Industrial Zone
11900 Bayan Lepas, Penang
Malaysia

Warranty

THE MATERIAL CONTAINED IN THIS DOCUMENT IS PROVIDED “AS IS,” AND IS SUBJECT TO BEING CHANGED,
WITHOUT NOTICE, IN FUTURE EDITIONS. FURTHER, TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE
LAW, KEYSIGHT DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR IMPLIED, WITH REGARD TO THIS MANUAL
AND ANY INFORMATION CONTAINED HEREIN, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. KEYSIGHT SHALL NOT BE LIABLE FOR ERRORS
OR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, USE, OR
PERFORMANCE OF THIS DOCUMENT OR OF ANY INFORMATION CONTAINED HEREIN. SHOULD KEYSIGHT AND
THE USER HAVE A SEPARATE WRITTEN AGREEMENT WITH WARRANTY TERMS COVERING THE MATERIAL IN
THIS DOCUMENT THAT CONFLICT WITH THESE TERMS, THE WARRANTY TERMS IN THE SEPARATE AGREEMENT
SHALL CONTROL.

Technology Licenses

The hardware and/or software described in this document are furnished under a license and may be used or copied
only in accordance with the terms of such license.

Keysight EDU33210 Series User's Guide 7



U.S. Government Rights

The Software is “commercial computer software,” as defined by Federal Acquisition Regulation (“FAR”) 2.101.
Pursuant to FAR 12.212 and 27.405-3 and Department of Defense FAR Supplement (“DFARS”) 227.7202, the U.S.
government acquires commercial computer software under the same terms by which the software is customarily
provided to the public. Accordingly, Keysight provides the Software to U.S. government customers under its
standard commercial license, which is embodied in its End User License Agreement (EULA), a copy of which can be
found at http://www.keysight.com/find/sweula. The license set forth in the EULA represents the exclusive authority
by which the U.S. government may use, modify, distribute, or disclose the Software. The EULA and the license set
forth therein, does not require or permit, among other things, that Keysight: (1) Furnish technical information related
to commercial computer software or commercial computer software documentation that is not customarily provided
to the public; or (2) Relinquish to, or otherwise provide, the government rights in excess of these rights customarily
provided to the public to use, modify, reproduce, release, perform, display, or disclose commercial computer
software or commercial computer software documentation. No additional government requirements beyond those
set forth in the EULA shall apply, except to the extent that those terms, rights, or licenses are explicitly required from
all providers of commercial computer software pursuant to the FAR and the DFARS and are set forth specifically in
writing elsewhere in the EULA. Keysight shall be under no obligation to update, revise or otherwise modify the
Software. With respect to any technical data as defined by FAR 2.107, pursuant to FAR 12.211 and 27.404.2 and
DFARS 227.7102, the U.S. government acquires no greater than Limited Rights as defined in FAR 27.4017 or DFAR
227.7103-5 (c), as applicable in any technical data.

Third Party Licenses

Portions of this software are licensed by third parties including open source terms and conditions. To the extent such
licenses require that Keysight make source code available, we will do so at no cost to you. For more information,
please contact Keysight support at https://www.keysight.com/find/assist.

Waste Electrical and Electronic Equipment (WEEE)

This product complies with the WEEE Directive marking requirement. The affixed product label (see below) indicates
that you must not discard this electrical/electronic product in domestic household waste.

Product category: With reference to the equipment types in the WEEE directive Annex 1, this product is classified as
“Monitoring and Control instrumentation” product. Do not dispose in domestic household waste.

To return unwanted products, contact your local Keysight office, or see

about.keysight.com/en/companyinfo/environment/takeback.shtml for more information.

b
—®
I
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Technical Support

If you have questions about your shipment, or if you need information about warranty, service, or technical support,
contact Keysight Technologies: www.keysight.com/find/assist.

Declarations of Conformity

Declarations of Conformity for this product and for other Keysight products may be downloaded from the Web. Go to

https://regulations.about.keysight.com/DoC/default.htm. You can then search by product number to find the latest
Declaration of Conformity.

Safety Information

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly per-

formed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice
until the indicated conditions are fully understood and met.

A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly per-

formed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated con-
ditions are fully understood and met.

Keysight EDU33210 Series User's Guide 9



Safety and Regulatory Information

Safety Considerations

The following general safety precautions must be observed during all phases of operation, service, and repair of this
instrument. Failure to comply with these precautions or with specific warnings elsewhere in this manual violates
safety standards of design, manufacture, and intended use of the instrument. Keysight Technologies assumes no
liability for the customer's failure to comply with these requirements.
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IEZITINEN GENERAL

Do not use this product in any manner not specified by the manufacturer. The protective features of this product may
be impaired if it is used in a manner not specified in the operation instructions.

BEFORE APPLYING POWER
Verify that all safety precautions are taken. Make all connections to the unit before applying power.

GROUND THE INSTRUMENT

This product is provided with protective earth terminals. To minimize shock hazard, the instrument must be con-
nected to the AC power mains through a grounded power cable, with the ground wire firmly connected to an elec-
trical ground (safety ground) at the power outlet. Any interruption of the protective(grounding) conductor or
disconnection of the protective earth terminal will cause a potential shock hazard that could result in personal injury.

DO NOT OPERATE IN AN EXPLOSIVE ATMOSPHERE OR WET ENVIRONMENTS
Do not operate the instrument around flammable gases or fumes, vapor, or wet environments.

DO NOT OPERATE DAMAGED OR DEFECTIVE INSTRUMENTS
Instruments that appear damaged or defective should be made inoperative and secured against unintended operation
until they can be repaired by qualified service personnel.

DO NOT SUBSTITUTE PARTS OR MODIFY INSTRUMENT

Because of the danger of introducing additional hazards, do not install substitute parts or perform any unauthorized
modification to the instrument. Return the instrument to a Keysight Technologies Sales and Service Office for service
and repair to ensure that safety features are maintained. To contact Keysight for sales and technical support, refer to
the support links on the following Keysight website: www.keysight.com/find/assist (worldwide contact inform-
ation for repair and service).

USE THE POWER CORD PROVIDED
Use the instrument with the power cord provided with the shipment.

DO NOT BLOCK VENTILATION HOLES
Do not block any of the ventilation holes of the instrument.

OBSERVE ALL INSTRUMENT MARKINGS BEFORE CONNECTING TO INSTRUMENT
Observe all markings on the instrument before connecting any wiring to the instrument.

ENSURE COVER IS SECURED IN PLACE
Do not operate the instrument with the cover removed or loosened. Only qualified, service-trained personnel should
remove the cover from the instrument.

ENSURE THE INSTRUMENT IS WELL POSITIONED
Do not position the instrument in an area that will post difficulty during instrument disconnection.

AC POWER CORD

Removal of the AC power cord is the disconnect method to remove power from the instrument. Be sure to allow for
adequate access to the power cord to permit disconnection from AC power. Use only the Keysight specified power
cord for the country of use or one with equivalent ratings.

Keysight EDU33210 Series User's Guide 11



. CLEAN WITH SLIGHTLY DAMPENED CLOTH

Clean the outside of the instrument with a soft, lint-free, slightly dampened cloth. Do not use detergent, volatile
liquids, or chemical solvents.

Safety Symbols

fﬂf Caution, risk of danger (refer to the manual for specific Warning or Caution information)

@ Protective earth (ground) terminal

Earth ground

A~_  Alternating current (AC)

12 Keysight EDU33210 Series User's Guide



Regulatory Markings

Symbol Description

c € ICES/NMB-001]| The CE mark is a registered trademark of the European Community. This CE mark shows that the product
ISM GRP 1-A complies with all the relevant European Legal Directives.

ICES/NMB-001 indicates that this ISM device complies with the Canadian ICES-001.

Cet appareil ISM est conforme a la norme NMB-001 du Canada.

ISM GRP.1 Class A indicates that this is an Industrial Scientific and Medical Group 1 Class A product.

The CSA mark is a registered trademark of the Canadian Standards Association.

The RCM mark is a registered trademark of the Australian Communications and Media Authority.

This symbol indicates the time period during which no hazardous or toxic substance elements are expected to
leak or deteriarate during normal use. Forty years is the expected useful life of the product.

This symbol is a South Korean Class A EMC Declaration. This is a Class A instrument suitable for professional
use and in electromagnetic environment outside of the home.

This instrument complies with the WEEE Directive marking requirement. This affixed product label indicates
that you must not discard this electrical or electronic product in domestic household waste.

iiafolic G,

South Korean Class A EMC declaration:

Information to the user:

This equipment has been conformity assessed for use in business environments. In a residential environment this
equipment may cause radio interference.

- This EMC statement applies to the equipment only for use in business environment.

0] 7|7|= 78 HEUM MEE SHo = HldEI/IE &2 7|7I=2M
M3 E SE0|M ALEStE B Tt o 227t ASLILE
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Safety and EMC Requirements

This power supply is designed to comply with the following safety and EMC (Electromagnetic Compatibility)
requirements:

- Low Voltage Directive 2014/35/EU
- EMC Directive 2014/30/EU

Environmental Conditions

This instrument is designed for indoor use and in an area with low condensation. The table below shows the general
environmental requirements for this instrument.

Environmental Condition Requirement

Temperature Operating condition: 0°Cto 55 °C
Storage condition: -40°Cto 70°C

Humidity Operating/Storage condition: Up to 80% RH at temperatures up to 40 °C (non-
condensing)

Altitude Up to 3000 m

Pollution degree 2

Overvoltage Category I

Power Supply and Line Frequency 100/120V, 100/240 V
50/60 Hz

Power Consumption <4HW

MAINS Supply Voltage Fluctuations Mains supply voltage fluctuations are not to exceed 10% of the nominal supply voltage

14 Keysight EDU33210 Series User's Guide



1 Introduction to the Instrument

Keysight EDU33210 Series User's Guide

Instrument at a Glance

Front Panel at a Glance

Front Panel Display at a Glance
Front Panel Number Entry
Rear Panel at a Glance
Instrument Dimensions

The Keysight EDU33210 Series Trueform Arbitrary Waveform Generator
is a series of synthesized waveform generators with built-in arbitrary
waveform and pulse capabilities.
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Instrument at a Glance

The Keysight EDU33210 Series Trueform Arbitrary Waveform Generator is a series of synthesized waveform
generators with built-in arbitrary waveform and pulse capabilities.

Two models are available:

- EDU33211A: 20 MHz, Single channel Trueform Arbitrary Waveform Generator
- EDU33212A: 20 MHz, Dual-channel Trueform Arbitrary Waveform Generator
Key features:

- Built-in modulation and 17 popular waveforms

- 16-bit arbitrary waveform capability with memory up to 8 Msa/channel

- Two independent channels that can be coupled in amplitude and frequency (EDU33212A)
- Colorful, information-packed 7-inch WVGA display

- Excellent usability

- USB and LAN IO interface

- Web interface

- SCPI (Standard Commands for Programmable Instruments) compatibility

- PathWave BenchVue software included

- 3-year warranty standard

16 Keysight EDU33210 Series User's Guide



Front Panel at a Glance

KEYSIGHT EDU33212A Waveform Generator

SIN,50Q

Frequency 1.000,000,000 kHz y 1.000,000,000 kHz

Amplitude 100.0 mVpp 100.0 mVpp Frequency
Offset +0.000V C +0.000V

Phase 0.0° 0.0°

100.00 % Amplitude

\\/

A0 | —)

= |

<

1 7-inch WVGA display -Channel 1 display

2 Channel 2 display (EDU33212A only)

3 [ON/OFF] switch

4 USB port — allows an external USB flash drive to be connected to the instrument

The EDU33210 Series supports USB flash drives with the following specification:
USB 2.0, 32 GB, FAT32 format. We recommend using a SanDisk Cruzer Blade
flash drive for the front panel USB port.

5 [Back] button
Press and hold [Back] button for more than 3 seconds with an external USB flash
drive connected to automatically capture the instrument screen. The captured
image will be saved to the connected USB flash drive.

6 Menu softkeys

7 CAL connector

8 Ext Trig/Gate/FSK/Burst connector

9 Sync/Trigger Out connector

10 Fixed function buttons

[N Numeric keypad

12 Knob and cursor arrows

13 Channel T and Channel 2 (EDU33212A only) connectors and related buttons

Keysight EDU33210 Series User's Guide 17



Front Panel Display at a Glance

Single Channel View

KEYSIGHT

TECHNOLOGIES

Parameter

Frequency 1.000,000,000 kHz Frequency

Amplitude 1.000 mVpp Amplitude

Offset +1.000V

Phase 0.0°

1 Channel 1 information

Status indicators

Channel T waveform parameters
Sweep, modulation, or burst parameters
Channel 1T waveform display

Function name

Softkey labels

~N| OO o W N
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Dual Channel View (Applicable for EDU33212A Only)

Press [Setup] twice to enter the dual channel view mode. In this mode, pressing [Setup] toggles between single

channel view and dual channel view.

Frequency 1.000,000,000 kHz equency 1.000,000,000 kHz

Amplitude 100.0 mVpp Am 100.0 mVpp

Offset +0.000V ffset +0.000V

Phase 0.0° ‘ 0.0°
' 100.00 %

KEYSIGHT

TECHNOLOGIES
Output

Qutput
~5-

Range
Suto Hold

Polarity
Mormal " Inverted

Voltage Limits
-

Mormal  Gated

—

Channel 1 information

Channel 2 information

Status indicators

Channel 1 waveform parameters
Channel 2 waveform parameters
Channel 1 waveform display
Channel 2 waveform display
Function name

Softkey labels

O | 0| O |lo | &~ w N

Instrument Status Indicators

- Shown when remote mode is enabled

- Shown after SYSTem:RWL command is sent

USB flash drive is connected
@ LAN is connected

Keysight EDU33210 Series User's Guide
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Legend Description
- Instrument error has occurred

Front Panel Number Entry

You can enter numbers from the front panel in two ways:

- Use the knob and cursor keys to modify the number. Rotate the knob to change a digit (clockwise increases). The
arrows below the knob move the cursor.

- Use the keypad to enter numbers and the softkeys to select units. The [+/-] key changes the number's sign.

Rear Panel at a Glance

2.Channel Waveform Generator =
ﬁg EDU33212A w—%
MAC N0 0 00

MADE IN CHINA MAY CONTAIN FOREIGN OR DOMESTIC COMPONENTS

Legend Description

1 Kensington lock

2 Universal Serial Bus (USB-B) interface connector

20 Keysight EDU33210 Series User's Guide



Local Area Network (LAN) interface connector
AC power connector
Ventilation fan

Instrument serial number and MAC address

~N| O |o | &~ W

Instrument safety and regulatory labels

m This is a Protection Class 1 equipment (chassis must be connected to a protective earth ground). The mains plug
shall only be inserted in an outlet provided with a Protective Earth Terminal.

Instrument Dimensions
Height: 164.70 mm x Width: 313.60 mm

| | | =

00
00
00
00

164.70

D000
D000
0000

0(0)

v,

0
0

o| 0

I@_

5

g

o

°| 5885880
©

o) 0

[‘

Keysight EDU33210 Series User's Guide



Length: 124.58 mm

124.58
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2 Getting Started

Keysight EDU33210 Series User's Guide

Prepare the Instrument for Use

Set the Output Frequency

Set the Output Amplitude

Set the DC Offset Voltage

Set High-Level and Low-Level Values
Output a DC Voltage

Set Duty Cycle of a Square Wave
Configure a Pulse Waveform

Select a Stored Arbitrary Waveform
Use the Built-in Help System
Update the Firmware

Remote Interface Connections
Remote Interface Configuration

Remote Control

This section describes basic procedures to help you get started quickly

with the instrument.
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Prepare the Instrument for Use

When you receive your instrument, inspect it for any obvious damage that may have occurred during shipment. If
there is damage, notify the shipping carrier and nearest Keysight Sales and Support Office immediately. Refer to
www.keysight.com/find/assist.

Until you have checked out the instrument, save the shipping carton and packing materials in case the unit has to be
returned. Check the list below and verify that you have received these items with your instrument. If anything is
missing, please contact your nearest Keysight Sales and Support Office.

- Quick Start Guide

- AC power cord (for country of destination)

- Certificate of Calibration and Shelf Life Notice

- Keysight Safety Leaflet (9320-6797)

- RoHS Addendum for Arbitrary Waveform Generators (China) (9320-6667)

Documentation and Firmware Revisions

The documentation listed below can be downloaded for free through our website at
www.keysight.com/find/EDU33211A-manuals.

- Keysight EDU33210 Series Trueform Arbitrary Waveform Generators Quick Start Guide.

- Keysight EDU33210 Series Trueform Arbitrary Waveform Generators User's Guide. This manual.
- Keysight EDU33210 Series Trueform Arbitrary Waveform Generators Programming Guide.

- Keysight EDU33210 Series Trueform Arbitrary Waveform Generators Service Guide.

For the latest firmware revision and firmware update instruction, go to:

- EDU3321TA: www.keysight.com/find/EDU33211A-sw

- EDU33212A: www.keysight.com/find/EDU33212A-sw

Recommended Calibration Interval

Keysight Technologies recommends a one-year calibration cycle for this instrument.

Set Up the Instrument

Place the instrument's feet on a flat, smooth horizontal surface. Attach the power cable to the rear panel, then plug
itinto main power. Connect the LAN or USB cables as desired, and you may also secure the instrument with a
security lock cable. Finally, turn the instrument on using the front panel [On/Off] button.

The instrument runs a power-on self test and then displays a message about how to obtain help, along with the
current IP address.

24 Keysight EDU33210 Series User's Guide



Set the Output Frequency

The default frequency is 1 kHz. You can change the frequency, and you can specify frequency in units of period
instead of Hz.

Press [Parameter] > Frequency.

KEYSIGHT

TECHNOLOGIES

Parameter

Frequency  [J000.000000 Frequency

Amplitude 100.0 mVpp Bmplitude

Offset +0.000V

Dffset
Phase 0.0°

Phase
~-

- Use the knob to change the numeric value and/or use the cursor arrows to move the cursor to the next or previous
digit, or

- Use the numeric keypad to set a numeric value. Select a prefix unit (uHz, mHz, Hz, kHz, or MHz) to confirm your
changes.

Press [Units] > Frequency Periodic to change the units to period instead of frequency.
S

Units

Frequency

Period  100.000 ps | | -

Amplitude 100.0 mVpp »  AmplOffs <
High/Low

Offset +0.000V
Amplitude

Phase 0.0° Y J -

Phase

Degrees

Sweep
StrtStop

Keysight EDU33210 Series User's Guide 25



Set the Output Amplitude

The instrument's default function isa 1 kHz, 100 mVpp sine wave (into a 50 Q termination).
The following steps change the amplitude to 50 mVpp.
. Press [Units] > Amp/Offs High/Low to specify voltage as amplitude and offset.

The displayed amplitude is either the power-on value or the amplitude previously selected. When you change func-
tions, the same amplitude is used if it is valid for the new function. To choose to specify voltage as high and low val-
ues instead, press Amp/Offs High/Low.

In this example, we will highlight Amp/Offs High/Low.

KEYSIGHT

TECHNOLOGIES
[nits

Frequency
Frequency 1.000,000,000 kHz " eriodo
Amplitude 100.0 mVpp > AmplOffs <

High/Low
Offset +0.000V

Amplitude

Phase 0.0° -

Phase
Degrees

Sweep
Stristop

26 Keysight EDU33210 Series User's Guide



2. Enter the magnitude of the desired amplitude.

Press [Parameters] > Amplitude. Using the numeric keypad, enter the number 50.

Frequency 1.000,000,000 kHz

Amplitude 50 _
Offset +0.000V

Phase 0.0°

3. Select the desired units.

Press the softkey that corresponds to the desired units. When you select the units, the instrument outputs the wave-
form with the displayed amplitude (if the output is enabled). For this example, press mVpp.

You can also enter the desired value using the knob and arrows. If you do so, you do not need to use a units softkey.
You can easily convert unit types. Simply press [Units] > Amplitude and select the desired units.

Frequency 1.000,000,000 kHz
Amplitude 50.00 mVpp

Offset +0.000V

Phase 0.0°

Keysight EDU33210 Series User's Guide

KEYSIGHT
TECHNOLOGIES

High/Low

$ Vpp Amplituda

pr

Phase

Degrees

Sweep
StrtStop
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Set the DC Offset Voltage
At power-on, the DC offsetis O V. The following steps change the offset to 1.5 VDC.

1. Press [Parameter] >Offset.

The displayed offset voltage is either the power-on value or the offset previously selected. When you change func-
tions, the same offset is used if the present value is valid for the new function.

KEYSIGHT

TECHNOLOGIES

Parameter
Frequency 1.000,000,000 kHz Frequency

Amplitude 50.00 mVpp Bmplitude

Offset [Joooo v

Dffset
Phase 0.0°

Phase
~-

2. Enter the desired offset.
In this case we will use the numeric keypad to enter 1.5.

S
Frequency 1.000,000,000 kHz

Amplitude 50.00 mVpp

Offset 15

Phase 0.0°
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3. Select the desired units.

Press the softkey for the desired units. When you select the units, the instrument outputs the waveform with the dis-
played offset (if the output is enabled). For this example, press V. The voltage will be set as shown below.

KEYSIGHT

TECHNOLOGIES

Parameter

Frequency 1.000,000,000 kHz Frequency

Amplitude 50.00 mVpp Bmplitude

Offset 5000 v

Phase 0.0°

You can also enter the desired value using the knob and arrows.

Set High-Level and Low-Level Values

You can specify a signal by setting its amplitude and DC offset, described above. You can also specify the signal as
high (maximum) and low (minimum) values. This is typically convenient for digital applications. In the following
example, we will set the high level to 1.0 V and the low level to 0.0 V.

1. Press [Units] > Ampl/Offs High/Low. Toggle to High/Low as shown below.

KEYSIGHT

TECHNOLOGIES

[nits

Frequency 1.000,000,000 kHz

High Level +50.00 mV Amp/0ffs
High/Low 4

Low Level -50.00 mV

Phase 0.0°
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2. Press[Parameter] > High Level. Using the numeric keypad or knob and arrows, select a value of 1.0 V. (If you are
using the keypad, you will need to select the V unit softkey to enter the value.)

KEYSIGHT

TECHNOLOGIES

Frequency 1.000,000,000 kHz

High Level 1.0
Low Level -50.00 mV

Phase 0.0°

3. Pressthe Low Level softkey and set the value. Again, use the numeric keypad or the knob to enter a value of 0.0 V.

S
Frequency 1.000,000,000 kHz

High Level +1.000V

Low Level 0.0

Phase 0.0°

These settings (high-level = 1.0 V and low-level = 0.0 V) are equivalent to setting an amplitude of 1.0 Vpp and an
offset of 500 mV.
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Outputa DC Voltage

You can output a constant DC voltage, from -b Vto +5Vinto 50 Q, or -10 V to +10 V into a high impedance load.
1. Press [Waveform] > MORE 1 /2 > DC > Offset. The Offset value becomes selected.

KEYSIGHT

TECHNOLOGIES
Parameter

Dffset

5000 v

2. Enter the desired voltage offset. Enter 1.0 with the numeric keypad or knob, and press the V softkey if you used the
keypad.

KEYSIGHT

TECHNOLOGIES

Set Duty Cycle of a Square Wave

The power-on default for square wave duty cycle is 50%. The duty cycle is limited by the minimum pulse width
specification of 16 ns. The following procedure changes the duty cycle to 75%.
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1. Select the square wave function.

Press [Waveform] > Square.

Parameter

Frequency 1.000,000,000 kHz Frequency

High Level +1.000V High Level

Low Level -1.000 mV

Low Level
Phase 0.0°

Duty Cycle 50.00 % Phase
~5-

Duty Cycle

2. Press the Duty Cycle softkey.

The displayed duty cycle is either the power-on value or the percentage previously selected. The duty cycle rep-
resents the amount of time per cycle that the square wave is at a high level.

KEYSIGHT
TECHNOLOGIES

Parameter
Frequency 1.000,000,000 kHz Frequency

High Level +1.000V High Level

Low Level -1.000 mV

Low Level
Phase 0.0°

Duty Cycle BJ.OO % Phase
~5-

Duty Cycle
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3. Enter the desired duty cycle.

Using the numeric keypad or the knob and arrows, select a duty cycle value of 75. If you are using the numeric
keypad, press Percent to finish the entry. The instrument adjusts the duty cycle immediately and outputs a square
wave with the specified value (if the output is enabled).

KEYSIGHT

TECHNOLOGIES

Frequency 1.000,000,000 kHz Percent

High Level +1.000V

Low Level -1.000 mV

Phase 0.0°
Duty Cycle 75_

Configure a Pulse Waveform

You can configure the instrument to output a pulse waveform with variable pulse width and edge time. The following
steps configure a 500 ms periodic pulse waveform with a pulse width of 10 ms and edge times of 50 ns.

1. Select the pulse function.
Press [Waveform] > Pulse to select the pulse function.

KEYSIGHT
PULS,500Q e

Parameter
Frequency 1.000,000,000 kHz Frequency

High Level +1.000V High Level
igh Leve

Low Level -1.000 mV

Low Level
Phase 0.0°

Pulse Width 10.000,0 ps Phase
~5-

Lead Edge 4.0ns

Pulse

Trail Edge 4.0ns Width

Edge
~9-
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2. Setthe pulse period.
Press the [Units] key and then press Frequency Periodic. Then press [Parameter] > Period. Set the period to 500 ms.

KEYSIGHT

TECHNOLOGIES

Period 500

High Level +1.000V

Low Level -1.000 mV

Phase 0.0°
Pulse Width 10.000,0 ps
Lead Edge 4.0ns

seconds

Trail Edge 4.0 ns

3. Setthe pulse width.

Press [Parameter] > Pulse Width. Then set the pulse width to 10 ms. The pulse width represents the time from the
50% threshold of the rising edge to the 50% threshold of the next falling edge.

AL
Period 500.000,000 ms
High Level +1.000V

Low Level -1.000 mV

Phase 0.0°

Pulse Width 10_ seconds

Lead Edge 4.0ns

Trail Edge 4.0 ns
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4. Setthe edge time for both edges.
Press the Edge softkey and then Each Both.

KEYSIGHT

TECHNOLOGIES

Parameter

Each
Period  500.000,000 ms S

High Level +1.000V Edge
Time

Low Level -1.000 mV

Phase 0.0°
Pulse Width 10.000,000,0 ms
Edge Time 0.000,000,000 s

Press Edge Time to set the edge time for both the leading and trailing edges to 50 ns. The edge time represents the
time from the 10% threshold to the 90% threshold of each edge.

AL
Period 500.000,000 ms
High Level +1.000V

Low Level -1.000 mV

Phase 0.0°
Pulse Width 10.000,000,0 ms

seconds

Edge Time 50_

Select a Stored Arbitrary Waveform

There are nine built-in arbitrary waveforms stored in non-volatile memory. They are Cardiac, D-Lorentz, Exponential
Fall, Exponential Rise, Gaussian, Haversine, Lorentz, Negative Ramp, and Sinc.

This procedure selects the built-in "exponential rise" waveform from the front panel.
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1. Press [Waveform] > Arb > Arbs.

KEYSIGHT

TECHNOLOGIES

Parameter

Select

samp Rate 0.000,000 Sa/s arb

High Level +1.000V Arbs in Memory
-
Low Level -1.000 mV

Samples 250

Arb Name EXP_RISE.arb Import Data
~»-

Save
Changes

2. Choose Arbs in Memory and use the knob to select EXP_RISE. Press Select Arb.

KEYSIGHT
TECHNOLOGIES

ARB,500
Arb Memory Catalog - Channel 1 Parameter

CEIES 1 INTABUILTIN\EXP_RISE.ARB
High Lev

Low Leve

Samples

Arb Nam

Use the Built-in Help System

The built-in help system provides context-sensitive help on any front panel key or menu softkey. A list of help topics
is also available to assist you with several front panel operations.

View the Help Information for a Button or Softkey

Press and hold any softkey or front panel button, such as [Waveform].
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KEYSIGHT
TECHNOLOGIES

? QUICK HELP
Help
Opens th eform list, with a "MORE" softkey for additional items. Pressing a softkey highlights it,
and the waveform's parameters appear. 0K

Available waveforms include Sine, Square, Triangle, Pulse, Ramp, Noise, Arbitrary (user defined),
PRBS (Pseudo-Random Binary Sequence) and DC. To configure the selected waveform, press
[Parameters).

If the message contains more information than will fit on the display, press the down arrow softkey to view the
remaining information.

Press OK to exit Help.

Local Language Help

All messages, context-sensitive help, and help topics are available in English, French, German, Spanish, Simplified
Chinese, Traditional Chinese, Japanese, Korean, and Russian. Softkey labels and status line messages are not trans-
lated (i.e. always in English). To select the language, press [System] > User Settings > Language. Then select the
desired language.

Update the Firmware

Do not turn off the instrument during the update.

Press [System] > Help > About to determine the version number of the instrument's firmware currently installed.

Go to www.keysight.com/find/EDU33211A-sw to find the latest firmware version. If this matches the version
installed on your instrument, there is no need to continue with this procedure. Otherwise, download the firmware
update utility and a ZIP file of the firmware. Detailed firmware update instructions are located on the download page.

Remote Interface Connections

This section describes how to connect to the various communication interfaces to your instrument. For further
information about configuring the remote interfaces, refer to Remote Interface Configuration.

If you have not already done so, install the Keysight 10 Libraries Suite, which can be found at www.key-
sight.com/find/iolib. For detailed information about interface connections, refer to the Keysight Technologies
USB/LAN/GPIB Interfaces Connectivity Guide included with the Keysight 10 Libraries Suite.
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Connect to the Instrument via USB

The following figure illustrates a typical USB interface system.

USB Cable

\ Connect to USB Connect to
port on PC USB port on
instrument

1. Connect your instrument to the USB port on your computer using a USB cable.

2. With the Connection Expert Utility of the Keysight IO Libraries Suite running, the computer will automatically recog-
nize the instrument. This may take several seconds. When the instrument is recognized, your computer will display
the VISA alias, IDN string, and VISA address. You can also view the instrument’s VISA address from the front panel
menu.

3. You can now use Interactive 10 within the Connection Expert to communicate with your instrument, or you can pro-
gram your instrument using the various programming environments.

The USB cable is not recommended to be longer than 3 meters.

Connect to the Instrument via LAN (Site and Private)

Site LAN

A site LAN is a local area network in which LAN-enabled instruments and computers are connected to the network
through routers, hubs, and/or switches. They are typically large, centrally-managed networks with services such as
DHCP and DNS servers. The following figure illustrates a typical site LAN system.

To Network To LAN Port

Interface

c;d (NIC) 1o Site LAN \
© O

1. Connect the instrument to the site LAN or to your computer using a LAN cable. The as-shipped instrument LAN set-
tings are configured to automatically obtain an IP address from the network using a DHCP server (DHCP is ON by
default). The DHCP server will register the instrument’s hostname with the dynamic DNS server. The hostname as
well as the IP address can then be used to communicate with the instrument. The front panel LAN indicator will
come on when the LAN port has been configured.
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2.

3.

1.

If you need to manually configure any instrument LAN settings, refer to Remote Interface Configuration
for information about configuring the LAN settings from the front panel of the instrument.

Use the Connection Expert utility of the Keysight IO Libraries Suite to add the instrument and verify a connection. To
add the instrument, you can request the Connection Expert to discover the instrument. If the instrument cannot be
found, add the instrument using its hostname or IP address.

If this does not work, refer to “Troubleshooting Guidelines” in the Keysight Technologies
USB/LAN/GPIB Interfaces Connectivity Guide included with the Keysight 10 Libraries Suite.

You can now use Interactive |0 within the Connection Expert to communicate with your instrument, or you can pro-
gram your instrument using the various programming environments.

Private LAN

A private LAN is a network in which LAN-enabled instruments and computers are directly connected, and not
connected to a site LAN. They are typically small, with no centrally-managed resources. The following figure
illustrates a typical private LAN system.

To Network To LAN Port

Interface

Card (NIC) \
= \ CATS5 Crossover Cable

Connect the instrument to the computer using a LAN crossover cable. Alternatively, connect the computer and the
instrument to a standalone hub or switch using regular LAN cables.

Make sure your computer is configured to obtain its address from DHCP and that NetBIOS over TCP/IP
is enabled. Note that if the computer had been connected to a site LAN, it may still retain previous net-
work settings from the site LAN. Wait one minute after disconnecting it from the site LAN before con-
necting it to the private LAN. This allows Windows to sense that it is on a different network and restart
the network configuration.

2. The factory-shipped instrument LAN settings are configured to automatically obtain an IP address from a site net-

work using a DHCP server. You can leave these settings as they are. Most Keysight products and most computers
will automatically choose an IP address using auto-IP if a DHCP server is not present. Each assigns itself an IP
address from the block 169.254.nnn. Note that this may take up to one minute. The front panel LAN indicator will
come on when the LAN port has been configured.
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Turning off DHCP reduces the time required to fully configure a network connection when the power
supply is turned on. To manually configure the instrument LAN settings, refer to Remote Interface Con-
figuration for information about configuring the LAN settings from the front panel of the instrument.

3. Use the Connection Expert utility of the Keysight 10 Libraries Suite to add the power supply and verify a connection.
To add the instrument, you can request the Connection Expert to discover the instrument. If the instrument cannot
be found, add the instrument using its hostname or IP address.

If this does not work, refer to “Troubleshooting Guidelines” in the Keysight Technologies
USB/LAN/GPIB Interfaces Connectivity Guide included with the Keysight 0 Libraries Suite.

4. You can now use Interactive 10 within the Connection Expert to communicate with your instrument, or you can pro-
gram your instrument using the various programming environments.

Remote Interface Configuration

The instrument supports remote interface communication over two interfaces: USB and LAN. Both are "live" at
pOWer up.

- USB Interface: Use the rear panel USB port to communicate with your PC. There is no configuration required for
the USB interface. Simply connect the instrument to your PC with a USB cable.

- LAN Interface: Use the rear panel LAN port to communicate with your PC. By default, DHCP is on, which may
enable communication over LAN. The acronym DHCP stands for Dynamic Host Configuration Protocol, a protocol
for assigning dynamic IP addresses to networked devices. With dynamic addressing, a device can have a different IP
address every time it connects to the network.

It is recommended to remove any unused remote interface connection.

Keysight 10 Libraries Suite

Ensure that the Keysight IO Libraries Suite is installed before you proceed for the remote interface configuration.

Keysight 10 Libraries Suite is a collection of free instrument control software that automatically discovers
instruments and allows you to control instruments over LAN, USB, GPIB, RS-232, and other interfaces. For more
information, or to download 10 Libraries, go to www.keysight.com/find/iosuite.

LAN Configuration

The following sections describe the LAN configuration functions on the front panel menu.
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When shipped, DHCP is on, which may enable communication over LAN. The acronym DHCP stands for Dynamic
Host Configuration Protocol, a protocol for assigning dynamic IP addresses to devices on a network. With dynamic
addressing, a device can have a different IP address every time it connects to the network.

Some LAN settings require you to cycle instrument power to activate them. The instrument briefly displays a
message when this is the case, so watch the screen closely as you change LAN settings.

After changing the LAN settings, you must save the changes. Press Apply to save the setting. If you do not save the
setting, exiting the I/0 Config menu will also prompt you to press Yes to save the LAN setting or No to exit without
saving. Selecting Yes cycles power to the instrument and activates the settings. LAN settings are non-volatile; they
will not be changed by power cycling or *RST. If you do not want to save your changes, press No to cancel all
changes.

View the LAN Settings

Press [System] > 1/0 Config to view the LAN Settings.

The LAN status may be different from the front panel configuration menu settings - depending on the configuration
of the network. If the settings are different, it is because the network has automatically assigned its own settings.

KEYSIGHT
TECHNOLOGIES

SN &AN

170 Config

1/0 Overview LAN Settings

Frequ Control Ports: USB, LAN ~5-

Ampli  USB

LAN Reset
VISA Address: USBO0:10893:918:CN59217262::INSTR

Offsel
LAN
Status:
IP:
Host name: Resolving

Phase

Domain name: Resolving

VISA address: TCPIP:K-33212A-00032:inst0:INSTR .
TCPIP:K-33212A-00032::5025::SOCKET /

mDNS hostname:
mDNS service:

Press LAN Settings to access the LAN Settings Menu. See Modify the LAN Settings for more details.

Press LAN Reset restore the LAN settings to default values.
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KEYSIGHT

TECHNO S

SIM NN
170 Config

1/0 Overview
Frequ Control Ports: USB, LAN

Ampli  USB
VISA Address: USBO0:10893:918:CN59217262::INSTR

Offsel

Are you sure you want to reset LAN settings and then restart LAN?

Phase
IP: 10.66.40.108

Host name: Resolving

Domain name: Resolving

VISA address: TCPIP:K-33212A-00032:inst0:INSTR
TCPIP:K-33212A-00032::5025::SOCKET

mDNS hostname:
mDNS service: Keysight EDU33211A Function Generator - MYO0000006

Modify the LAN Settings

As shipped from the factory, the instrument pre-configured settings should work in most LAN environments. Refer to
the "Non-Volatile Settings" in the Programming Guide for information on the factory-shipped LAN settings.
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1. Access the LAN Settings menu.
Press the LAN Settings softkey.

KEYSIGHT

TECHNOLOGIE

SN &AN

LAN Settings Lan

MAC Address: 80-09-02-09-b9-e0 Services

Frequ Config Mode: Manual -
. DHCP: ON
Ampli Auto DNS: ON
mDNS:

Offsel P

Subnet mask: 255.255.0. Host Mame
Phase Gateway:

DNS1:

DNS2:

Host name:
Domain name:
mDNS service:

Select Services to turn the various LAN services on or off.

SN &AN

LAN Settings

MAC Address: 80-09-02-09-b3-e0

Config Mode: Manual

DHCP: ON

Auto DNS: Auto DNS
mDNS: ON""OFF

IP:
mDNS

ON""OFF

Subnet mask:
Gateway:
DNS1:

DNS2:

mDNS Service
Host name:
Domain name: G t
mDNS service: - A tion Generator - MY00000006 / M

With DHCP on, an IP address will automatically be set by the DHCP (Dynamic Host Configuration Protocol) when
you connect the instrument to the network, provided the DHCP server is found and is able to do so. DHCP also auto-
matically deals with the subnet mask and gateway address, if required. This is typically the easiest way to establish
LAN communication for your instrument. All you need to do is leave DHCP on. Contact your LAN administrator for
details.

Keysight EDU33210 Series User's Guide 43



2. Establish an"IP Setup."

If you are not using DHCP (use the Services softkey to set DHCP to OFF), you must establish an IP setup, including
an IP address, and possibly a subnet mask and gateway address.

KEYSIGHT

TECHNOLOGIES

SN &AN

LAN Settings Lan

MAC Address: 80-09-02-09-b3-e0 DHCP

Config Mode: Manual 0N OFF

DHCP:
Auto DNS: Auto DNS
mDNS: ON""OFF

IP:

Subnet mask:
Gateway:
DNS1:

DNS2:

mDNS
ON""OFF

mDNS Service
Host name:
Domain name:
mDNS service: eysight A Function Generator - MY00000006 / -

Press [Back] > Addresses > Modify to configure the IP address, subnet mask, and gateway address.

8 KEYSIGHT

SN &AN

1/0 Conﬁg Lan Adc
— 1
1/0 Overview » IP Address Modify

Control Ports: USB, LAN [P &ddre:

Frequ

Ampli  USB
Previous
VISA Address: USBO0:10893:918:CN59217262::INSTR
Offsel
LAN
Phase Status:
10.66.40.108

Host name: Resolving

Domain name: Resolving

VISA address: TCPIP:K-33212A-00032:inst0:INSTR
TCPIP:K-33212A-00032::5025::SOCKET

mDNS hostname:
mDNS service: no -(66 1140 o 108 stor - MYOD000006

Contact your network administrator for the IP address, subnet mask, and gateway to use.

IP Address: All IP addresses take the dot-notation form "nnn.nnn.nnn.nnn" where "nnn" in each case is a byte value
in the range O through 255. You can enter a new IP address using the numeric keypad (not the knob). Type in the
numbers using the keypad and the cursor keys. Press Previous or Next to move the cursor to the next field or pre-
vious field. Do not enter leading zeros.
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Subnet Mask: Subnetting allows the LAN administrator to subdivide a network to simplify administration and min-
imize network traffic. The subnet mask indicates the portion of the host address used to indicate the subnet. Type in
the numbers using the keypad and the cursor keys. Press Previous or Next to move the cursor to the next field or pre-

vious field.
Gateway: A gateway is a network device that connects networks. The default gateway setting is the IP address of
such a device. Type in the numbers using the keypad and the cursor keys. Press Previous or Next to move the cursor

to the next field or previous field.

Press Apply to save your changes.
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3. Configure the "DNS Setup" (optional)

DNS (Domain Name Service) is an Internet service that translates domain names into IP addresses. Ask your network
administrator whether DNS is in use, and if it is, for the host name, domain name, and DNS server address to use.

Normally, DHCP discovers DNS address information; you only need to change this if DHCP is unused or not func-
tional. To manually configure the addressing of the instrument, use the Services softkey to set Auto DNS to OFF.

SN &AN

170 Config

1/0 Overview

Frequ Control Ports:

Ampli  USB
VISA Address:

Offsel
LAN

Status:
IP:
Host name:

Phase

Domain name:
VISA address:

mDNS hostname:
mDNS service:

KEYSIGHT

TECHNOLOGIES

OFF

USB, LAN O

Auto DNS
USB0:10893:918:CN59217262:INSTR ON " OFF

mDNS
ON""OFF
10.66.40.108
Resolving mDNS Service
Resolving

TCPIP:K-33212A-00032:inst0:INSTR
TCPIP:K-33212A-00032::5025::SOCKET

%

Keysight EDU33211A Function Generator - MYO0000006

a. Set the "hostname." Press [Back] >Host Name and enter the hostname. A hostname is the host portion of the
domain name, which is translated into an IP address. The hostname is entered as a string using the softkeys
provided. The hostname may include letters, numbers, and dashes ("-").

SN &AN

170 Config

1/0 Overview

Frequ Control Ports:

sl Host Name

offs | [-33212A-00032

Phas

Host name:
Domain name:
VISA address:

mDNS hostname:
mDNS service:

KEYSIGHT

TECHNOLOGIES

USB, LAN

Mext Char

Prev Char

ABCDEFGHlJnLMNOPORSTUVWXVZ

Resolving Delete

Resolving
TCPIP:K-33212A-00032:inst0:INSTR

TCPIP:K-33212A-00032::5025::SOCKET Clear All

%

Keysight EDU33211A Function Generator - MYO0000006
Apply

The instrument is shipped with a default hostname with the following format: K-{modelnumber}-{serialnumber},

46
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where {modelnumber} is the instrument’s 6-character model number (e.g. 33212A) and {serialnumber} is the last
five characters of the instrument's serial number (e.g. 45678 if the serial number is MY12345678).

b. Set the "DNS Server" addresses. Press [Back]. Press Addresses > Modify to configure the DNS server addresses.
Enter the Primary DNS (DNST) and Second DNS (DNS2). Type in the numbers using the keypad and the cursor keys.

Press Previous or Next to move the cursor to the next field or previous field. See your network administrator for
details.

KEYSIGHT
S|N qnn TECHNOLOGIES

I/0 Config Lan &

1/0 Overview Modify

Frequ Control Ports: USB, LAN DNS1

Ampli  USB

Previous
VISA Address: USB0:10893:918:CN59217262:INSTR

Offsef
LAN
Phase Status:
23.66.40.108
Host name: Resolving
Domain name: Resolving

VISA address: TCPIP::K-33212A-00032:inst0:INSTR
TCPIP:K-33212A-00032::5025:S0CKET

mDNS hostname:
mDNS service: 61 1183 1140 0100 stor - MYO0000006
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4. Configure the mDNS Service (optional).

Your instrument receives a uniqgue mDNS service name at the factory, but you may change it. The mDNS service
name must be unique on the LAN.

To manually configure the service name of the instrument, use the Services softkey to set mDNS to ON.

KEYSIGHT
TECHNOLOGIES

SN &AN

170 Config

1/0 Overview \
Control Ports: USB, LAN ON""OFF

Frequ

Ampli  USB Auto DNS
VISA Address: USB0:10893:918:CN59217262:INSTR ON™"0FF
Offsel
LAN mDNS
Status: 0K OFF
10.66.40.108
Host name: Resolving mDNSService

Phase

Domain name: Resolving

VISA address: TCPIP:K-33212A-00032:inst0:INSTR
TCPIP:K-33212A-00032::5025::SOCKET

mDNS hostname:
mDNS service: Keysight EDU33211A Function Generator - MYO0000006

Press mDNS Service.

SN &AN

170 Config

1/0 Overview

Frequ Control Ports: USB, LAN

sl mDns Service Name Mext Char

Offs meysight EDU33211A Function Generator - MY00000006

Prev Char

Phas ABCDEFGH I JLMNOPORS TUVWX YZ

Host name: Resolving Delete

Domain name: Resolving

VISA address: TCPIP:K-33212A-00032:inst0:INSTR .
TCPIP:K-33212A-00032::5025::SOCKET / Clear All

mDNS hostname:

mDNS service: Keysight EDU33211A Function Generator - MYO0000006
Apply

Use the softkeys provided to set a desired service name. The name must start with letter; other characters can be an
upper or lower case letters, numeric digits, or dashes ("-"). Press Apply to save your changes.
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SCPI Socket Services

This instrument allow any combination of up to two simultaneous data socket, control socket, and telnet
connections to be made.

Keysight instruments have standardized on using port 5025 for SCPI socket services. A data socket on this port can
be used to send and receive ASCII/SCPI commands, queries, and query responses. All commands must be
terminated with a newline for the message to be parsed. All query responses will also be terminated with a newline.

The socket programming interface also allows a control socket connection. The control socket can be used by a
client to send device clear and to receive service requests. Unlike the data socket, which uses a fixed port number,
the port number for a control socket varies and must be obtained by sending the following SCPI query to the data
socket: SYSTem:COMMunicate: TCPip:CONTrol?

After the port number is obtained, a control socket connection can be opened. As with the data socket, all
commands to the control socket must be terminated with a newline, and all query responses returned on the control
socket will be terminated with a newline.

To send a device clear, send the string "DCL" to the control socket. When the power system has finished performing
the device clear it echoes the string "DCL" back to the control socket.

Service requests are enabled for control sockets using the Service Request Enable register. Once service requests
have been enabled, the client program listens on the control connection. When SRQ goes true the instrument will
send the string "SRQ +nn" to the client. The "nn" is the status byte value, which the client can use to determine the
source of the service request.

More About IP Addresses and Dot Notation

Dot-notation addresses ("nnn.nnn.nnn.nnn" where "nnn" is a byte value from 0 to 255) must be expressed with care,
as most PC web software interprets byte values with leading zeros as octal (base 8) numbers. For example,
"192.168.020.011" is actually equivalent to decimal "192.168.16.9" because ".020" is interpreted as "16" expressed
in octal, and ".011" as "9". To avoid confusion, use only decimal values from O to 255, with no leading zeros.
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Remote Control

You can control the instrument via SCPI with Keysight IO Libraries or via a simulated front panel with the
instrument's Web interface.

Web Interface

You can monitor and control the instrument from a Web browser by using the instrument's Web interface. To
connect, simply enter the instrument's IP address or hostname in your browser's address bar and press Enter.

If you see an error indicating 400: Bad Request, this is related to an issue with "cookies" in your Web browser. To

avoid this issue, either start the Web interface by using the IP address (not hostname) in the address bar, or clear
cookies from your browser immediately before starting the Web interface.

KEYSIGHT EDU33212A Arbitrary Waveform Generator

Login £
TECHNOLOGIES  serial number: CN60350047

Home Control Instrument Configure LAN (-]

Connected to EDU33212A Arbitrary Waveform Generator
at IP address 192.168.1.2

Description
Model number EDU33212A
Manufacturer
Serial number CN60350047

Firmware revision K-01.03.94-01.00-01.04-01.00-01.00-2020010101

Description

VISA instrument addresses

VXI-11 LAN protocol TCPIP::1192.168.1.2:inst0:INSTR

TCP/IP SOCKET protocol TCPIP::192.168.1.2::5025::SOCKET

USB (USBTMC/488) USB::0x2A8D::0x8D01::CN60350047::0::INSTR

GPIB N/A

v More Information

© Keysight Technologies 2021 = Support = Product = Keysight

The Configure LAN tab on the top allows you to change the instrument's LAN parameters; exercise caution when
doing so, as you may interrupt your ability to communicate with the instrument.

When you click the Control Instrument tab, the instrument will ask you for a password (default is keysight), and then
it will open a new page, shown below.

50 Keysight EDU33210 Series User's Guide



M, KEYSIGHT EDU33212A Arbitrary Waveform Generator

Log out £
Serial number: CN60350047

Home Control Instrument Configure LAN o

Control Instrument > Soft Front Panel

Warning: Should network communication issues occur, the reported readings and instrument c
A the Soft Front Panel may not represent the actual readings or instrument state. Do not rely on

uration settings shown in
eported readings from the

Frequency 1.000,000,000 kHz Sine
Amplitude  100.0 mVpp -
Offset +0.000 V

Ramp

Phase 0.000°

Pulse

Arb

annel 1 nnel 2

Ch Chai
P]IHFE E\  onvor | E‘ onor |

© Keysight Technologies 2021 Support  Product  Keysight

This interface allows you to use the instrument just as you would from the front panel. Note the curved arrow keys
that allow you to "rotate" the knob. You can press the arrow keys to rotate the knob clockwise and counterclockwise,
just as you would press any of the other keys on the front panel.

IEZXIICEN READ WARNING

Be sure to read and understand the warning at the top of the Control Instrument page.

Technical Connection Details

In most cases, you can easily connect to the instrument with the |0 Libraries Suite or Web interface. In certain
circumstances, it may be helpful to know the following information.

VXI-117 LAN VISA String: TCPIPQ::<IP Address>::instO:INSTR
Example: TCPIP0::192.168.10.2::inst0:INSTR

Web Ul Port number 80, URL http://<IP address>/

USB USBO::0x2A8D::<Prod ID>::<Serial Number>::0::INSTR

Example: USBO::0x2A8D::0x8D01::CN12340005::0::INSTR

The vendor ID: 0x2A8D, the product ID is 0x8D01, and the instrument serial number is
CN12340005.

The product ID varies by model: 0x08C01 (EDU33211A) / 0x8D01 (EDU33212A).
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3 Front Panel Menu Operations

Select an Output Termination

Reset the Instrument

Output a Modulated Waveform
Output an FSK Waveform

Output a PWM Waveform

Output a Frequency Sweep

Output a Burst Waveform

Trigger a Sweep or Burst

Store or Retrieve the Instrument State
Front Panel Menu Reference

This section introduces front panel keys and menus. See Features and
Functions for additional front panel operation information.

Select an Output Termination

The instrument has a fixed series output impedance of 50 Q to the front panel channel connectors. If the actual load
impedance differs from the value specified, the displayed amplitude and offset levels will be incorrect. The load
impedance setting is simply a convenience to ensure that the displayed voltage matches the expected load.
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1. Press a channel [Setup] key to open the channel configuration screen. Note that the current output termination val-

ues (both 50 Q in this case) appear on the tabs at the top of the screen.

Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

2. Begin specifying the output termination by pressing Output.

Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpr

CH 1 Output Load
Offset +0.000V

50Q

Phase 0.0°

Keysight EDU33210 Series User's Guide

KEYSIGHT

TECHNOLOGIES

Output
~-

Range
Suto Hold

Polarity
Mormal  Inverted

Voltage Limits
~5-

Mode
Mormal  Gated

KEYSIGHT
TECHNOLOGIES

Set To
50 Ohm

Set To
High Z

Load
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. Select the desired output termination either by using the knob or numeric keypad to select the desired load imped-
ance or by pressing Set to 50 Q or Set to High Z. You can also set a specific value by pressing Load.

KEYSIGHT

TECHNOLOGIES

Set T
Frequency 1.000,000,000 kHz Egt(]h?n

Amplitude 100.0 mVpn Set To

CH 1 Output Load High Z
Offset +0.000V
Load

Phase 0.0° High-Z

Reset the Instrument

To reset the instrument to its factory default state, press [System] > Store/Recall > Set to Defaults > Yes. See
"Factory Reset State" in the EDU33210 Series Programming Guide for more details.

S
Frequency 1.000,000,000 kHz
Amplitude 100.0 mVpp

Offset Y i

Return the instrument to its 'Factory Default’ state?
Phase 0.0

Output a Modulated Waveform

A modulated waveform consists of a carrier waveform and a modulating waveform. In AM (amplitude modulation),
the carrier amplitude is varied by the modulating waveform. For this example, you will output an AM waveform with
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80% modulation depth. The carrier will be a 5 kHz sinewave and the modulating waveform will be a 200 Hz sine

wave.

1. Select the function, frequency, and carrier amplitude.

Press [Waveform] > Sine. Press the Frequency, Amplitude, and Offset softkeys to configure the carrier waveform. For
this example, select a b kHz sine wave with an amplitude of 5 Vpp, with O V offset. Note that you may specify amp-

litude in Vpp, Vrms, or dBm.

Frequency 5.000,000,000 kHz

Amplitude  5.000 Vpp

Offset +0.000V

Phase 0.0°

2. Select AM.

KEYSIGHT
TECHNOLOGIES

Parameter

Frequency

Amplitude

Dffset

Phase
~-

Press [Modulate] and then select AM using the Type softkey. Then press the Modulate soft key to turn modulation

ON.

SIN,HiZ
AM Modulated by Sine

Frequency 5.000,000,000 kHz
Amplitude  5.000 Vpp

Offset +0.000V

Phase 0.0°

AM Freq 100.000,000 Hz

KEYSIGHT

TECHNOLOGIES

— Oy Modulate

AM Depth  100.00 % ON " OFF

Type
A

AM
Depth

AM
Freq

Shape

Sine

WMORE
142
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3. Setthe modulation depth. Press the AM Depth softkey and then set the value to 80% using the numeric keypad or
the knob and arrows.

KEYSIGHT
TECHNOLOGIES

SIN,HiZ
AM Modulated by Sine

Frequency 5.000,000,000 kHz amDepth [ Percent

Amplitude 5,000 Vpp AM Freq 100.000,000 Hz
Offset +0.000V

Phase 0.0°

4. Select the modulating waveform shape. Press Shape to select the modulating waveform's shape. For this example,
select a Sine wave.

5. Press AM Freq. Set the value to 200 Hz using the numeric keypad or the knob and arrows. Press Hz to finish entering
the number if you are using the numeric keypad.

KEYSIGHT
TECHNOLOGIES

SIN,HiZ
AM Modulated by Sine

Frequency 5.000,000,000 kHz AM Depth  80.00 % ‘

Amplitude 5.000 Vpp AM Freq 200_

Offset +0.000V

Phase 0.0°

Output an FSK Waveform

You can configure the instrument to "shift" its output frequency between two preset values (called the "carrier
frequency" and the "hop frequency") using FSK modulation. The rate at which the output shifts between these two
frequencies is determined by the internal rate generator or the signal level on the front panel Ext Trig connector. For
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this example, you will set the "carrier" frequency to b kHz and the "hop" frequency to 500 Hz, with an FSK rate of 100
Hz.

1. Select the function, frequency, and carrier amplitude.

Press [Waveform] > Sine. Press the Frequency, Amplitude, and Offset softkeys to configure the carrier waveform. For
this example, select a b kHz sine wave with an amplitude of 5 Vpp, with 0 V offset.

Frequency 5.000,000,000 kHz Frequency

Amplitude 5.000 Vpp Amplitude

Offset +0.000V

Phase 0.0°

2. Select FSK.

Press [Modulate] and then select FSK using the Type softkey. Then press the Modulate softkey to turn modulation
ON.

KEYSIGHT
SIN.500 VY Temowses.

FSK Modulated Modulation

— Oy Modulate
Hop Freq  100.000,000 Hz ‘ ON' " OFF

Amplitude 5.000 Vpp FSK Rate  0.000,000 Hz

Frequency 5.000,000,000 kHz

Type
FSk
Offset +0.000V

Hop

Freq

Phase 0.0°

Fsk
Rate

Source
Internal
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3. Setthe "hop" frequency.

Press the Hop Freq softkey and then set the value to 500 Hz using the numeric keypad or the knob and arrows. If you
use the numeric keypad, be sure to finish the entry by pressing Hz.

KEYSIGHT
TECHNOLOGIES

SIN,50Q
FSK Modulated

Modulate
Frequency 5000,000,000 kHz Hop Freq @0000000 Hz ON""OFF

Amplitude  5.000 Vpp FSK Rate  0.000,000 Hz ,, -
FSk

Offset +0.000V

Hop

Phase 0.0° Freq

Fsk
Rate

Source

Internal

4. Setthe FSK "shift" rate.
Press the Fsk Rate softkey and then set the value to 100 Hz using the numeric keypad or the knob and arrows.

KEYSIGHT
TECHNOLOGIES

SIN,50Q
FSK Modulated

P Modulale S Modulate
Hop Freq  500.000,000 Hz ORI OFF

Amplitude  5.000 Vpp FSK Rate m0.0UOUOU Hz ,, Tiioe
FSk

Frequency 5.000,000,000 kHz

Offset +0.000V
Hop

Freq

Phase 0.0°
Fsk
Rate

Source

Internal

At this point, the instrument outputs an FSK waveform if the channel output is enabled.

58 Keysight EDU33210 Series User's Guide



Output a PWM Waveform

You can configure the instrument to output a pulse width modulated (PWM) waveform. PWM is only available for the
Pulse waveform, and the pulse width varies according to the modulating signal. The amount by which the pulse
width varies is called the width deviation, and it can be specified as a percentage of the waveform period (that is,
duty cycle) or in units of time. For example, if you specify a pulse with 20% duty cycle and then enable PWM with a
5% deviation, the duty cycle varies from 15% to 25% under control of the modulating signal.

To change from pulse width to pulse duty cycle, press [Units].

For this example, you will specify a pulse width and pulse width deviation for a 1 kHz pulse waveform with a 5-Hz
sine wave modulating waveform.

. Select the carrier waveform parameters.
Press [Waveform] > Pulse. Use the Frequency, Amplitude, Offset, Pulse Width, and Edge Times soft keys to configure

the carrier waveform. For this example, select a 1 kHz pulse waveform with an amplitude of 1 Vpp, zero offset, a
pulse width of 100 ms, and an edge time of 50 ns (both leading and trailing).

Frequency 1.000,000,000 kHz Frequency

Amplitude 1.000 Vpp Amplitude

Offset +0.000V

Dffset
Phase 0.0°
Pulse Width 100.000,000,0 ms Phase

~5-
Edge Time 50.0ns

Pulse
Width

Edge
~5-
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2. Select PWM.

Press [Modulate] > Type PWM. Then press the Modulate softkey to turn modulation ON.

PULS,50Q
PWM Modulated by Sine

Modulate

Frequency 1.000,000,000 kHz (PwMDer 00000000005 | e

Amplitude 1.000 Vpp ., PWM Freq 10.000,000 Hz

Offset +0.000V

Phase 0.0°
Pulse Width 100.000,000,0 ms
Edge Time 50.0ns

Source

Internal

3. Set the width deviation.

Press the PWM Dev softkey and set the value to 20 ps using the numeric keypad or the knob and arrows.

4. Setthe modulating frequency.

Press the PWM Freq softkey and then set the value to 5 Hz using the numeric keypad or the knob and arrows.
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. Select the modulating waveform shape.

Press Shape to select the modulating waveform's shape. For this example, select a sinewave.

PULS,50Q
PWM Modulated by Sine

) Modulate
PWM Dev  20.000,0 ps ORTOFF

Amplitude 1.000 Vpp | PwM Freq 000000 Hz

Frequency 1.000,000,000 kHz

Offset +0.000V

Phase 0.0°
Pulse Width 100.000,000,0 ms
Edge Time 50.0ns

Source

Internal

To view the actual PWM waveform, you would need to output it to an oscilloscope. If you do this, you will see how

the pulse width varies, in this case, from 80 to 120 ps. At a modulation frequency of 5 Hz, the deviation is easily vis-

ible.
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Output a Frequency Sweep

In the frequency sweep mode, the instrument moves from the start frequency to the stop frequency at a sweep rate,
which you specify. You can sweep up or down in frequency, and with either linear or logarithmic spacing, or using a
list of frequencies. For this example, you will output a swept sinewave from b0 Hz to 5 kHz.

. Select the function and amplitude for the sweep.

For sweeps, you can select sine, square, ramp, pulse, triangle, PRBS waveforms, or arbitrary waveforms (noise and
DC are not allowed). For this example, select a sine wave with an amplitude of 5 Vpp.

KEYSIGHT

TECHNOLOGIES

Parameter

Frequency 1.000,000,000 kHz Frequency

Amplitude 5.000 Vpp Amplitude

Offset +0.000V

Phase 0.0°
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2. Select the sweep mode.

Press [Sweep] and verify that the Linear sweep mode is currently selected on the second softkey. Press the Sweep

softkey to turn sweep ON. Notice the Linear Sweep status message at the top of the tab for the current channel. The
button is also illuminated.

SIN,50Q

Linear Sweep, Trig Imm

Start Freq  100.000,000 Hz ON""OFF

Amplitude  5.000 Vpp Stop Freq  1.000,000,000 kHz o
Sweep Time 1.000 s Linear
Hold Time 0.000s

Frequency Sweeping...

Offset +0.000V

Sweep

Phase 0.0° Return Time 0.000 s Time

Start
Freq

Stop
Freq

Hold Return
~-

3. Setthe start frequency.

Press Start Freq and then set the value to 50 Hz using the numeric keypad or the knob and arrows.
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4. Setthe stop frequency.

Press Stop Freq and set the value to 5 kHz using the numeric keypad or the knob and arrows.

SIN,500Q

Linear Sweep, Trig Imm

Frequency Sweeping...

Amplitude  5.000 Vpp

Offset +0.000V

Phase 0.0°

Start Freq

50.000,000 Hz
(000.000000 Hz
Sweep Time 1.000 s
Hold Time 0.000s
| Return Time 0.000 s

Stop Freq

KEYSIGHT
TECHNOLOGIES

0N " OFF

Type

Linear

Sweep
Time

Start
Freq

Stop
Freq

Hold Return
~-

At this point, the instrument outputs a continuous sweep from 50 Hz to 5 kHz if output is enabled.

You can also set the sweep frequency boundaries of the sweep using a center frequency and frequency span. These
parameters are similar to the start frequency and stop frequency (above) and they provide added flexibility. To
achieve the same results, set the center frequency to 2.525 kHz and the frequency span to 4.950 kHz.

To generate a frequency sweep, press [Trigger] > Source Manual to put the trigger in manual mode. Press [Trigger]

to send a trigger. For more information, see Trigger a Sweep or Burst.

SIN,500Q

Linear Sweep, Trig Man

Frequency Sweeping...

Amplitude  5.000 Vpp

Offset +0.000V

Phase 0.0°

64

Start Freq  50.000,000 Hz
5.000,000,000 kHz
Sweep Time 1.000 s

e 0.000s

me 0.000s

Stop Freq

Manual Trigger for CH1

i

KEYSIGHT

TECHNOLOGIES
Trigger

Source
Manual

Trigger Setup
~5-

Trig Out Setup
~9-

Sync
ON"" OFF
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Output a Burst Waveform

You can configure the instrument to output a waveform with for a specified number of cycles, called a burst. You can
control the amount of time that elapses between bursts with the internal timer or the signal level on the front panel
Ext Trig connector. For this example, you will output a three-cycle sine wave with a 20 ms burst period.

. Select the function and amplitude for the burst.
For burst waveforms, you can select sine, square, ramp, pulse, arbitrary waveforms, triangle, or PRBS. Noise is

allowed only in the "gated" burst mode and DC is not allowed. For this example, select a sine wave with an amplitude
of 5 Vpp.

Frequency 1.000,000,000 kHz Frequency

amplitude 000000 Vpp

Amplitude

Offset +0.000V

Dffset
Phase 0.0°

Phase
~-
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2. Select the burst mode.

Press [Burst] > Burst ON | OFF.

KEYSIGHT
ECHNOLOGIES
SIN,500 -

N-Cycle Burst, Trig Imm Burst
— Burst

Frequency 1.000,000,000 kHz Start Phase 0.0° 0K OFF

Amplitude 5.000 Vpp # of Cycles 1
Burst Period 10 ms

Offset +0.000V
Infinite
Phase 0.0°

Start Phase

i of Cycles

Burst Period

3. Setthe burst count.

Press # of Cycles and set the count to "3" using the numeric keypad or knob. Press Enter to finish data entry if you
are using the numeric keypad.

!(E‘YS!GHrT
ECHNOLOGIES
SIN,500Q

N-Cycle Burst, Trig Imm

Frequency 1.000,000,000 kHz Start Phase 0.0°

Amplitude 5.000 Vpp # of Cycles 3_

Burst Period 10 ms
Offset +0.000V

Phase 0.0°
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4. Setthe burst period.

Press Burst Period and set the period to 20 ms using the numeric keypad or the knob and arrows. The burst period
sets the time from the start of one burst to the start of the next burst. At this point, the instrument outputs a
continuous three-cycle burst at 20 ms intervals.

KEYSIGHT
TECHNOLOGIES
SIN,50Q
N-Cycle Burst, Trig Imm

Start Phase 0.0°

Amplitude 5.000 Vpp # of Cycles 3
Burst Period 20_

Frequency 1.000,000,000 kHz

Offset +0.000V

Phase 0.0°

seconds

You can generate a single burst (with the specified count) by pressing the [Trigger] key. For more information, see
Trigger a Sweep or Burst.

KEYSIGHT
SIN.500 A

N-Cycle Burst, Trig Man Trigger

Source

Frequency 1.000,000,000 kHz Start Phase 0.0° Manual

Amplitude 5.000 Vpp #of Cycles 3 Trigger Setup

Burst Period 20 ms -
Offset +0.000V : -

Manual Trigger for CH1 Trig Out Setup

Phase 0.0° -

Sync
ON"" OFF

You can also use the external gate signal to create gated bursts, where a burst is produced while a gate signal is
present on the input.
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Trigger a Sweep or Burst

You can select one of four different types of triggers from the front panel for sweeps and bursts:

— Immediate or "automatic" (default): Instrument outputs continuously when sweep or burst mode is selected.
- External: Triggering controlled by front panel Ext Trig connector.

- Manual: Initiates one sweep or burst each time you press [Trigger]. Continue pressing [Trigger] to re-trigger
instrument.

- Timer: Issues one or more triggers a fixed time amount apart.

SIN,50Q
N-Cycle Burst, Trig Man

—EIEE)———  Immediate Source
Start Phase 0.0° External -

Ampitude. 1000 mVpp pof cls 1 DX (i
Burst Period 10 ms Timer -

Frequency 1.000,000,000 kHz

Offset +0.000V
Trig Out Setup
Phase 0.0° i
Sync
ON"" OFF

If sweep or burst is on, pressing [Trigger] displays the trigger menu. An illuminated [Trigger] key (solid or blinking)
indicates that one or both channels are awaiting a manual trigger. Solid illumination occurs when the trigger menu
is selected, and flashing illumination occurs when the trigger menu is not selected. The [Trigger] key is disabled
when the instrument is in remote.

Pressing [Trigger] when it is solidly illuminated causes a manual trigger. Pressing [Trigger] when it is flashing selects
the trigger menu; a second press causes a manual trigger.
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Store or Retrieve the Instrument State

You can store instrument states in any number of state files, (extension .sta). You can do this for backup purposes, or
you can save your state to a external USB flash drive and load it on another instrument to have instruments with
matching configurations. A stored state contains the selected function, frequency, amplitude, DC offset, duty cycle,
symmetry, and any modulation or burst parameters in use. The instrument does not store volatile arbitrary
waveforms.

Store Settings

Store Settings allows you to browse to a directory and specify a file name, and to choose whether you want to store a
state file internally or to an external USB flash drive.

KEYSIGHT
TECHNOLOGIES

Destination
Frequency 1.0NN.NNN NANN LU, It " Bt
Store Settings
Amplitude 10 Store In
Store Destination: Internal State [
Offset +0

Storein: State 0
Phase 0.C

To store (save) the current instrument state:
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1.

Select the desired storage destination.

Press [System] > Store/Recall > Store Settings > Destination.

SIN,50Q
N-Cycle Burst, Trig Imm

Frequency 1.0NN NNN NNN LLI-

Store Settings
Amplitude 5.(

Store Destination:

Offset +0

Store in:

Phase 0.C

KEYSIGHT

TECHNOLOGIES

Destination
[nt " Ext

Store In
Internal State'l

State 0

If choose to store the instrument state in the instrument’s non-volatile internal memory, select Int. Proceed to step

2.

If you choose to store the state file (.sta) in a connected external USB flash drive, select Ext. Skip to step 3.

Make sure to connect a USB flash drive before proceed. If a USB flash drive is not connected, the
menus under Destination Int | Ext will be grayed out.
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2. Select the desired internal storage location to save the instrument state to.
Press Store In, and select between State O, State 1, State 2, State 3, or State 4. Skip to step 5.

KEYSIGHT

TECHNOLOGIES

SIN,50Q

N-Cycle Burst, Trig Imm St

Destination
Int" Bxt

Frequency 1.0NN NNN NNN LLI-

Store Settings
Amplitude 5.( Store In

Store Destination: Internal ) State 0
Offset +0
Storein: State 0

Phase 0.C

3. Select the desired external storage location to save the state file (.sta) to.
Press Select File | Path > Browse to browse for existing state files (.sta) in the connected external USB flash drive.
Use the front panel knob to highlight an existing state file (.sta). Press Select to select the highlighted file and return
to the previous menu.
You can also press Rename to rename the highlighted file or press Delete to delete the highlighted file.
Press Select File | Path > Browse to browse for folders in the external USB flash drive to store the state file (.sta) to.
Use the front panel knob to highlight a folder. Press Select to browse the highlighted folder. Press Select Folder to

select the highlighted folder and return to the previous menu.

You can also press Rename to rename the highlighted folder or press Delete to delete the highlighted folder.
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4. Optional: If you have not done so in the previous step, you can change the state file name.
Press File Name to specify the name of the state file (.sta). Use the provided softkeys to set a desired file name.

KEYSIGHT

TECHNOLOGIES

Char Set

Uppercase

Frequency 1.0NN NNN NNN LLI-

Store Settinas
Amp

File Name Mext Char
State_20201205173300

Offs

Prev Char
Phas _ABCDEFGHIJKLMNOPORBTUVWXVZ

Clear &ll

Apply

Press Apply when you have finished entering the name.
5. Store the instrument state.

Press Store.

KEYSIGHT
SIN,500 ECHNOLOC

N-Cycle Burst, Trig Imm

Destination
Frequency 1.0nn nnn nnn LU~ Int Ext
Store Settings

Amplitude 5.( Store In

Store Destination: Internal State |
Offset +0
Stor¢

Store applied

Phase 0.C
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Recall Settings

Recall Settings allows you to browse to the state in the internal memory or browse to the instrument state file (.sta
format) in the external USB flash drive to be recalled.

The state file you recall must be from same instrument model.

To restore (retrieve) a stored instrument state:

. Select the desired recall source.

Press [System] > Store/Recall > Recall Settings > Source.

KEYSIGHT

TECHNOLOGIES
System

Source
[nt " Ext

Frequency 1.0NN NNN NNN LLI-

Recall Settings
Amplitude 10 Recall

Recall from: Internal State 0
Offset +0
Recall: State 0

Phase 0.C

Recall

If choose to recall an instrument state file from the instrument’s non-volatile internal memory, select Int. Proceed to
step 2.

If you choose to recall a state file (.sta) from a connected external USB flash drive, select Ext. Skip to step 3.

. Select the internal storage location to recall from.

Press Recall, and select between State O, State 1, State 2, State 3, or State 4. Skip to step 4.

. Select the desired external storage location to recall from.

Press Browse and use the front panel knob and arrow keys to navigate to the desired state file (*sta) that you would
like to recall. Press Select when done.

Recall the selected instrument state.

Press Recall.

Keysight EDU33210 Series User's Guide 73



Front Panel Menu Reference

This section begins with an overview of the front panel menus. The remainder of this section contains examples of

using the front panel menus.

- [Waveform] Button

— [Parameter] Button

— [Units] Button

- [Modulate] Button

- [Sweep] Button

— [Burst] Button

- [Trigger] Button

- [System] Button

— Channel [Setup] and [On/Off] Button

[Waveform] Button

Selects waveform:
- Sine

- Square

- Ramp

- Pulse

- Arbitrary

- Triangle

- Noise

- PRBS

-DC

[Parameter] Button

Parameater

Configures waveform-specific parameters:
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- Period / Frequency
- Amplitude or High and Low Voltage
- Offset

- Phase

- Duty Cycle

- Symmetry

- Pulse Width

- Edge Times

- Arbitrary Waveform
- Sample Rate

- Filter

- Arb Phase

- Bandwidth

- PRBS Data

- Bit Rate

- Lead Edge

- Trail Edge

[Units] Button

Specifies unit and parameter preferences:

- Arb Rate: Sa/s, Freq or Period

- Voltage as Amplitude/Offset or High/Low

- Voltage units as Vpp, Vrms, or dBm

- Pulse Width or Duty Cycle

- Burst Phase as Degrees, Radians, or Seconds

- Arb Phase as Degrees, Radians, Seconds, or Samples

- Frequency sweep as Center/Span or Start/Stop
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[Modulate] Button

| Maodulate

Configures modulation parameters:

- Modulation on or off

- Modulation type: AM, FM, PM, PWM, BPSK, FSK, or Sum

- Modulation source

- Modulation parameters (vary by modulation type)

[Sweep] Button

=

Configures frequency sweep parameters:

- Sweep on or off

- Sweep type: Linear, logarithmic, or frequency list
- Sweep time

- Start/stop frequencies or center/span frequencies

- Dwell, hold, and return times

[Burst] Button

o |

- Burst on or off

- Burst mode: triggered (N Cycle) or externally-gated
- Cycles per burst (1 to 100,000,000 or infinite)

- Starting phase angle of burst (-360° to +360°)

- Burst period

[Trigger] Button
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Configures trigger settings and sync output signal:

- Perform a manual trigger, when illuminated

- Specify the trigger source for sweep, burst or arbitrary waveform advance
- Specify the trigger voltage level, count, and delay

- Specify the slope (rising or falling edge) for an external trigger source

- Specify the slope (rising or falling edge) of the trigger output signal

- Enable / disable the signal output from the "Sync" connector

- Specify the Sync source, polarity, mode, marker point, and so on

[System] Button

Store/Recall Softkey

Stores and recalls instrument states:

- Manage files and folders

- Store instrument states in non-volatile memory.

- Recall stored instrument states.

- Select the instrument’s power-on configuration (last power-down or factory default).

- Return the instrument to its factory default state.
I/0 Config Softkey

Configures instrument /0 interfaces:
— Turn LAN services on and off
- Configure LAN (addresses and host name)

- Reset the LAN
Instr. Setup Softkey

Performs system administration tasks:

- Perform self-test
User Settings Softkey
Configures system-related parameters:

- Select local language for front panel messages and help text
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- Enable or disable error beeper

- Enable disable keypad click

- Turn display on and off

- Adjust display dimming behavior
- Set date and time

Help Softkey

Shows list of Help topics:
- View "about" data - serial number, |P address, firmware version, and so on

- View remote command error queue

Channel [Setup] and [On / Off] Button

Enables and configures channels:

[On / Off] button

Turn channel on and off

[Setup] button

Configure channel-related parameters:

- Specify which channel is the focus of the menus

- Select output termination (50 Q, High Z, or Manual)
- Enable/disable amplitude autoranging

- Select waveform polarity (normal or inverted)

- Specify voltage limits

- Specify whether output is normal or gated

For EDU33212A only
Press [Setup] twice to enter dual channel view mode. In this mode, pressing [Setup] toggles between
single channel view and dual channel view.
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4 Features and Functions

Keysight EDU33210 Series User's Guide

Output Configuration

Pulse Waveforms

Amplitude Modulation (AM) and Frequency Modulation (FM)
Phase Modulation (PM)

Frequency-Shift Keying (FSK) Modulation
Pulse Width Modulation (PWM)

Sum Modulation

Frequency Sweep

Burst Mode

Triggering

System-Related Operations

Dual Channel Operations

This chapter contains details on instrument features, including front

panel and remote interface operation. You may want to read Front Panel
Menu Operation first. See the EDU33270 Series Programming Guide for

details on SCPI commands and queries.
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Output Configuration

This section describes the output channel configuration. Many commands associated with the output configuration
starts with SOURce1: or SOURce2: to indicate a certain channel. If omitted, the default is channel 1. For example,
VOLT 2.5 sets the output on channel 1 to 2.5V, and SOUR2:VOLT2.5 does the same for channel 2.

The instrument's display includes a "tab" for each channel that summarizes various aspects of each channel's output
configuration:

SIN,500
1

Linear Sweep, Trig Imm

ON

On a dual-channel instrument, the tab for channel 1 is in yellow, and the tab for channel 2 is in green.

Frequency 1.000,000,000 kHz Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpp Amplitude 100.0 mVpp

Offset +0.000V )ffset +0.000V

Phase 0.0° Phase 0.0° Range
Suto " Hold

Output
~5-

Polarity
Mormal  Inverted

Voltage Limits
~9-

; Mode
Mormal  Gated

Output Function

The instrument includes eight standard waveforms: sine, square, ramp, pulse, triangle, noise, PRBS (pseudorandom
binary sequence), and DC. There are also nine built-in arbitrary waveforms.

The table below shows which functions are allowed (@) with modulation, sweep, and burst. Selecting a function that
is not allowed with a modulation or mode disables the modulation or mode.

Sine and Square ([ [ ([ [ (] [ ] ] (
Pulse [ { { { L ] J [ [
Triangle and Ramp ([ [ (] ([ ] [ ] (
Gaussian Noise ([ [ °
PRBS [ [ { J [
Arbitrary Waveform ([ [ o’ o’ [ ] ([

1 Gated burst only
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2 Applies to sample clock, not whole waveform

- Frequency Limitations: Changing functions may change the frequency to meet the new function's frequency limits.

- Amplitude Limitations: When the output units are Vrms or dBm, changing functions may lower the amplitude to the
maximum for the new function due to variation in waveform shapes. For example, a 5 Vrms square wave (into 50 Q)
changed to a sine will decrease to 3.536 Vrms (sine’s upper limit).

- Amplitude and offset cannot combine to exceed the instrument’s capability. The one you set last may be changed to
stay within limits.

- You may protect a device-under-test (DUT) by specifying upper and lower output voltage limits.
Front Panel Operations
- Toturn on an output: Press Channel [On/Off] for your desired channel.
- To select another waveform: Press [Waveform].
For example, to specify a DC signal:

Press [Waveform] > MORE 1/ 2 > DC » Offset.

Use the numeric keypad or the knob and arrows to set a desired value. If you use the keypad, select a unit prefix to

finish.

KEYSIGHT

TECHNOLOGIES

Offset

Keysight EDU33210 Series User's Guide
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2. Press Channel [On/Off] to produce the DC output.

KEYSIGHT

TECHNOLOGIES
Parameter

Dffset

Offset A9500 v

SCPI Command
[SOURce[1]|2]:]FUNCtion <function>

The APPLy command configures a waveform with one command.

Output Frequency

The output frequency range depends on the function, model, and output voltage, as shown here. The default
frequency is 1 kHz for all functions, and the minimum frequencies are shown in the table below.

Sine 1 pHz
Square 1 pHz
Ramp/Triangle 1 pHz
Pulse 1 pHz
PRBS 1 mbps
Arbitrary 1 pSa/s

- Frequency limitations: Changing functions may change the frequency to meet the new function's frequency limits.
Arbitrary waveforms retain their last frequency setting.

- Burst limitation: For internally-triggered bursts, the minimum frequency is 126 puHz.

- Duty cycle limitations: For Square and Pulse, the Duty Cycle is limited by the 16-ns minimum pulse width
specification. For example, at T kHz, Duty Cycle may be set as low as 0.01%, because that would result in a pulse
width of 100 ns. At T MHz, the minimum Duty Cycle is 1.6%, and at 10 MHz it is 16%. Changing to a frequency that
cannot produce the current duty cycle will adjust the duty cycle to meet the minimum pulse width specification.

The minimum pulse width is 16 ns.
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Front Panel Operations

Press [Parameter] > Frequency. Use the numeric keypad or the knob and arrows to set a desired value. If you use the
keypad, select a unit prefix to finish.

Frequency 1 _

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

SCPI Command
[SOURce[1]2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

The APPLy command configures a waveform with one command.

Output Amplitude

The default amplitude is 100 mVpp (into 50 Q) for all functions.

- Offset voltage limitations: The relationship between amplitude and offset is shown below. Vmax is £5 V for a 50 Q
load or £10 V for a high-impedance load.

Vpp < 2(Vmax - [Voffset|)

- Limits due to output termination: If the amplitude is 10 Vpp and you change the output termination setting from
50 Q to "high impedance" (OUTPut[1|2]:LOAD INF), the displayed amplitude doubles to 20 Vpp. Changing from "high
impedance" to 50 Q halves the displayed amplitude. The output termination setting does not affect the actual output
voltage; it only changes the values displayed and queried from the remote interface. Actual output voltage depends
on the connected load.

- Limits due to units selection: Amplitude limits are sometimes determined by the output units selected. This may
occur when the units are Vrms or dBm due to the differences in various functions' crest factors. For example, if you
change a 5 Vrms square wave (into 50 Q) to a sine wave, the instrument will adjust the amplitude to 3.536 Vrms (the
upper limit for sine in Vrms). The remote interface will also generate a "Settings conflict" error.

- You can set the output amplitude in Vpp, Vrms, or dBm. You cannot specify output amplitude in dBm if output
termination is set to high impedance. See Output Units for details.
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- Arbitrary waveform limitations: For arbitrary waveforms, amplitude is limited if the waveform data points do not
span the full range of the output DAC (Digital-to-Analog Converter). For example, the built-in "Sinc" waveform does
not use the full range of values, so its maximum amplitude is limited to 6.087 Vpp (into 50 Q).

- Changing amplitude may briefly disrupt output at certain voltages due to output attenuator switching. The
amplitude is controlled, however, so the output voltage will never exceed the current setting while switching ranges.
To prevent this disruption, disable voltage autoranging using VOLTage:RANGe:AUTOOFF. The APPLy command
automatically enables autoranging.

- Setting the high and low levels also sets the waveform amplitude and offset. For example, if you set the high level
to +2 V and the low level to -3V, the resulting amplitude is 5 Vpp, with a -500 mV offset.

- ADC signal's output level is controlled by the offset voltage (DC Offset Voltage). The DC level may be between +5
Vinto a 50 Q load or £10 V with a high-impedance load.

Front Panel Operations

Press [Parameter] > Amplitude. Use the numeric keypad or the knob and arrows to set a desired value. If you use the
keypad, select a unit prefix to finish.

KEYSIGHT

TECHNOLOGIES

Frequency 1.000,000,000 kHz men

Amplitude 100 ”
- Pp

Offset +0.000V

mifrms
Phase 0.0°

To use a high level and low level instead: Press [Units] > Ampl/Offs | High/Low.
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KEYSIGHT
TECHNOLOGIES

Units

Frequency <

Frequency 1.000,000,000 kHz Periodc

High Level +50.00 mV Amp/0ffs
High/Low
Low Level -50.00 mV

Phase 0.0°

SCPI Command

[SOURce[1]2]:]VOLTage {<amplitude>|MINimum|MAXimum|DEFault}
[SOURce[1]2]:]VOLTage:HIGH {<voltage>|MINimum|MAXimum|DEFault}
[SOURce[1]2]:]VOLTage:LOW {<voltage>|MINimum|MAXimum|DEFault}

The APPLy command configures a waveform with one command.

DC Offset Voltage

The default offset is 0 V for all functions.

- Limits Due to Amplitude: The relationship between offset voltage and output amplitude is shown below. The peak
output voltage (DC plus AC) cannot exceed the instrument output rating (+5 V into 50 Q load, or +10 V into an open
circuit).

- The relationship between offset voltage and output amplitude is shown below. Vmax is the maximum peak voltage
for the selected output termination (5 V for a 50 Q load or 10 V for a high-impedance load).

|Voffset| < Vmax - Vpp/ 2

If the specified offset voltage is not valid, the instrument will adjust it to the maximum DC voltage allowed with the
specified amplitude. From the remote interface, a "Data out of range" error will also be generated.

- Limits Due to Output Termination: The offset range depends on the output termination setting. For example, if you
set offset to 100 mVDC and then change output termination from 50 Q to "high impedance," the offset voltage
displayed on the front panel doubles to 200 mVDC (no error is generated). If you change from "high impedance" to
50 Q, the displayed offset voltage will be halved. Changing the output termination setting does not change the
voltage present at the output terminals of the instrument. This only changes the displayed values on the front panel
and the values queried from the remote interface. The voltage present at the instrument's output depends on the
load connected to the instrument. See "OUTPut[1]2]:LOAD" in the EDU332170 Series Programming Guide for details.
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- Arbitrary waveform limitations: For arbitrary waveforms, amplitude is limited if the waveform data points do not
span the full range of the output DAC (Digital-to-Analog Converter). For example, the built-in "Sinc" waveform does
not use the full range of values, so its maximum amplitude is limited to 6.087 Vpp (into 50 Q).

- Setting the high and low levels also sets the waveform amplitude and offset. For example, if you set the high level
to +2 V and the low level to -3 V, the resulting amplitude is 5 Vpp, with a -500 mV offset.

- To output a DC voltage level, select the DC voltage function (FUNCtion DC) and then set the offset voltage
(VOLTage:OFFSet). Valid values are between +5 VDC into 50 Q or +10 VDC into an open circuit. While the
instrument is in DC mode, setting amplitude has no effect.

Front Panel Operations

Press [Waveform] > MORE 1/2 > DC > Offset. Use the numeric keypad or the knob and arrows to set a desired value.
If you use the keypad, select a unit prefix to finish.

KEYSIGHT

TECHNOLOGIES

SCPI Command

[SOURce[1]2]:]VOLTage:0FFSet {<offset>|MINimum|MAXimum|DEFault}
[SOURce[1]2]:]VOLTage:HIGH {<voltage>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]VOLTage:LOW {<voltage>|MINimum|MAXimum|DEFault}

The APPLy command configures a waveform with one command.

Output Units

Applies to output amplitude only.
- Output units: Vpp (default), Vrms, or dBm.
- Setting is volatile.

- Units selection applies to front panel and remote interface operations. For example, if you select "VRMS"
remotely, the units are displayed as "VRMS" on the front panel.
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- Amplitude units cannot be dBm if output termination set to high impedance. Calculating dBm requires finite load
impedance. In this case, units are converted to Vpp.

- You can convert between units. For example, to convert 2 Vpp to Vrms equivalent:
Press [Units] > Amplitude Vpp > Amplitude Vrms.
The converted value is 707.1 mVrms for a sinewave.
Front Panel Operations
Press [Units] > Amplitude.
KEYSIGHT
Units
Frequency 1.000,000,000 kHz 1 | ——
Amplitude 100.0 mVpp »  Amp/Offs <

High/Low
Offset +0.000V

Amplitude

Phase 0.0° -

Phase
Degrees

Sweep
StrtStor

SCPI Command

[SOURce[1]2]:]VOLTage:UNIT {VPP|VRMS |DBM}

Output Termination

The instrument has a fixed series output impedance of 50 Q to the front panel channel connectors. If the actual load
impedance differs from the value specified, the displayed amplitude and offset levels will be incorrect. The load
impedance setting is simply a convenience to ensure that the displayed voltage matches the expected load.

- Output termination: 1 Q to 10 kQ, or infinite. The default is 50 Q.

- If you specify a 50 Q termination but actually terminate into an open circuit, the output will be twice the value
specified. For example, if you set the DC offset to 100 mVDC(and specify a 50 Q load) but terminate into an open
circuit, the actual offset will be 200 mVDC.

- Changing output termination setting, adjusts displayed output amplitude and offset (no error is generated). If the
amplitude is 10 Vpp and you change the output termination setting from 50 Q to "high impedance" (OUTPut
[1]2]:LOAD INF), the displayed amplitude doubles to 20 Vpp. Changing from "high impedance" to 50 Q halves the
displayed amplitude. The output termination setting does not affect the actual output voltage; it only changes the
values displayed and queried from the remote interface. Actual output voltage depends on the connected load.
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The output load can affect signal quality for pulse or other functions with high-speed transitions. High load res-
istance can produce reflections.

- Units are converted to Vpp if output termination is high impedance.

- You cannot change output termination with voltage limits enabled, because instrument cannot know which
termination setting the limits apply to. Instead, disable voltage limits, set the new termination value, adjust voltage
limits, and re-enable voltage limits.

Front Panel Operations

Press Channel [Setup] > Output > Load.

KEYSIGHT

TECHNOLOGIES

Set T
Frequency 1.000,000,000 kHz 50 O

Amplitude 100.0 mVpn Set To

CH 1 Output Load High Z
Offset +0.000V

50 Q Load

Phase 0.0°

SCPI Command

OUTPut [1]2] :LOAD {<ohms>|INFinity|MINimum|MAXimum|DEFault}

Duty Cycle (Square Waves)

A square wave’s duty cycle is the fraction of time per cycle that the waveform is at a high level (assuming the
waveform is not inverted). (See Pulse Waveforms for pulse duty cycle details.)

- Duty Cycle: 0.01% to 99.99% at low frequencies; range reduced at higher frequency. Stored in volatile memory;
default 50%.

- This setting is remembered when you change to another function. A 50% duty cycle is always used for a
modulating square waveform; the duty cycle setting applies only to a square wave carrier.
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20% Duty Cycle 80% Duty Cycle

Front Panel Operations

Press [Waveform] > Square > Duty Cycle. Use the numeric keypad or the knob and arrows to set a desired value. If
you use the keypad, press Percent to confirm your changes.

i
Frequency 1.000,000,000 kHz Fercent
Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Duty Cycle 75_

SCPI Command

[SOURce[1]2]:]FUNCtion:SQUare:DCYCle {<percent>|MINimum|MAXimum}

The APPLy command sets the duty cycle to 50%.

Symmetry (Ramp Waves)

Applies to ramp waves only. Symmetry represents the fraction of each cycle that the ramp wave is rising (assuming
waveform is not inverted).
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0% Symmetry 100% Symmetry

- The symmetry (default ) is stored in volatile memory; and is remembered when you change to and from other
waveforms.

- When ramp is the modulating waveform for AM, FM, PM, or PWM, the symmetry setting does not apply.
Front Panel Operations

Press [Waveform] > Ramp > Symmetry. Use the numeric keypad or the knob and arrows to set a desired value. If you
use the keypad, press Percent to confirm your changes.

KEYSIGHT

TECHNOLOGIES

Frequency 1.000,000,000 kHz -
Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Symmetry 75_

SCPI Command
[SOURce[1]2]:]FUNCtion:RAMP:SYMMetry {<percent>|MINimum|MAXimum|DEFault}

The APPLy command sets the symmetry to 100%.

Voltage Autoranging

Autoranging is enabled by default and the instrument selects optimal attenuator settings. With autoranging
disabled, the instrument uses the current attenuator settings and does not switch attenuator relays.
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- You can disable autoranging to eliminate momentary disruptions caused by attenuator switching while changing
amplitude. However:

- The amplitude and offset accuracy and resolution (and waveform fidelity)may be adversely affected when reducing
the amplitude below a range change that would occur with autoranging on.

- You may not achieve minimum amplitude with autoranging on.
- Some instrument specifications do not apply with autoranging off.

Front Panel Operations

Press Channel [Setup] > Range Auto | Hold or Range Auto | Hold.

KEYSIGHT
TECHNOLOGIES

RAMP,50Q

Frequency 1.000,000,000 kHz :lt.pgt

Amplitude 100.0 mVpp Range
Auto " Hold

Offset +0.000V

Polarity

Phase 0.0° Mormal  Inverted

Symmetry 75.00 % Yoltage Limits
~5-

Mode
Mormal  Gated

SCPI Command
[SOURce[1]2]:]VOLTage:RANGe:AUTO {OFF|0O|ON|1]|ONCE}

The APPLy command always enables autoranging.

Output Control

By default, channel output is disabled at power on to protect other equipment. To enable a channel's output, see
below. When channel output is enabled, the corresponding channel button is lit.

If an external circuit applies excessive voltage to a channel output connector, the instrument generates an error
message and disables the output. To re-enable output, remove the overload and turn the channel on again.

Front Panel Operations

Press Channel [On/Off].
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KEYSIGHT

TECHNOLOGIES

Parameter

Dffset

Offset A9500 v

SCPI Command
OUTPut[1]2] {ON|1|OFF|O0}

The APPLy command always enables the channel output connector.

Waveform Polarity

In normal mode (default), the waveform goes positive at the beginning of the cycle. Inverted mode does the
opposite.

- As shown below, the waveform is inverted relative to the offset voltage. The offset voltage remains unchanged
when the waveform is inverted.

Normal Inverted Normal Inverted
M & . o~
LY |I.I "-.I / "'-. %
' ov . ) - Offset
LY ._..' "._ " ll /
N S N \, 7K y ov

No Offset Voltage With Offset Voltage

- The Sync signal associated with an inverted waveform is not inverted.
Front Panel Operations

Press [Setup] > Polarity Normal | Inverted or Polarity Normal | Inverted.
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KEYSIGHT
TECHNOLOGIES

Frequency 1.000,000,000 kHz -

Amplitude  100.0 mVpp Range
Auto " Hold

Offset +0.000V

Polarity

Mormal  Inverted
Phase 0.0° :

Symmetry 75.00 % Voltage Limits
-

Mode
Mormal  Gated

SCPI Command

OUTPut[1|2]:POLarity {NORMal |INVerted}

Sync Output Signal

A sync output is provided on the front panel Sync connector. All of the standard output functions (except DC and
noise) have an associated Sync signal. For applications where you may not want to output the Sync signal, you can
disable the Sync connector. The Sync signal may be derived from either output channel in a two-channel instrument.

General Behavior

- By default, the Sync signal is derived from channel 1 and is routed to the Sync connector (enabled).
- When the Sync signal is disabled, the output level on the Sync connector is at a logic "low."

— The polarity of the Sync signal is specified by OUTPut:SYNC:POLarity {INVerted]NORMal}.

- Inverting a waveform (see Waveform Polarity), does not invert the associated Sync signal .

- For sine, pulse, ramp, square, and triangle waves, the Sync signal is a square wave that is "high" in the first half of
the cycle and "low" in the last half. The Sync signal’s voltages are TTL-compatible when its load impedance exceeds
1kQ.

- For arbitrary waveforms, the Sync signal rises at the beginning of the waveform and falls at the middle of the
arbitrary waveform. You can override this default behavior by using MARKer:POINt to specify the point within the
arbitrary waveform at which the Sync signal transitions to "low."

Modulation

- For internally-modulated AM, FM, PM, and PWM, the Sync signal is normally referenced to the modulating
waveform (not the carrier) and is a square waveform with a 50% duty cycle. The Sync signal is a TTL "high" during
the first half of the modulating waveform. You can set up the Sync signal to follow the carrier waveform by using the
command OUTPut:SYNC:MODE {CARRier[NORMal|[MARKer} when modulating with internal modulation.
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- You can override normal sync behavior to force Sync to always follow the carrier waveform (OUTPut
[1]2]:SYNC:MODE CARRier).

- For FSK, the Sync signal is referenced to the FSK rate. The Sync signalis a TTL "high" on the transition to the "hop"
frequency.

Sweep

- The Sync signalis a TTL "high" at the beginning of the sweep and goes "low" at the sweep's midpoint. The Sync
signal is synchronized with the sweep, but is not equal to the sweep time because its timing includes the re-arm
time.

- For frequency sweeps with Marker On, the Sync signalis a TTL "high" at the beginning of the sweep and a "low" at
the marker frequency. You can change this with OUTPut[1]2]:SYNC:MODE MARKER.

Burst

- For a triggered burst, the Sync signalis a TTL "high" when the burst begins. The Sync signalisa TTL "low" at the
end of the specified number of cycles (may not be the zero-crossing point if the waveform has an associated start
phase). For an infinite count burst, the Sync signal is the same as for a continuous waveform.

- For an externally-gated burst, the Sync signal follows the external gate signal. However, the signal will not go
"low" until the end of the last cycle (may not be a zero-crossing if the waveform has an associated start phase).

Configuring Sync Output
Front Panel Operations

To toggle Sync off and on: Press [Trigger] > Sync ON | OFF or Sync ON | OFF.
e

Trigger

Source

Frequency 1.000,000,000 kHz el

Amplitude 100.0 mVpp Trigger Setup
-

Offset +0.000V

Trig Out Setup

Phase 0.0° -

Symmetry  75.00 % Sync
ON""OFF

Sync Setup
~9-

To configure Sync: Press [Trigger] > Sync Setup.
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KEYSIGHT
TECHNOLOGIES

Trigger

Sync Src
Frequency 1.000,000,000 kHz CHT ' CH2

Amplitude  100.0 mVpp Polarity

Mormal  Inverted

Offset +0.000V
Mode
Mormal

Phase 0.0°
Symmetry 75.00 %

SCPI Command

OUTPut:SYNC {ON|1|OFF|0}
OUTPut[1]|2] :SYNC:MODE {NORMal |CARRier |MARKer}
OUTPut[1]2]:SYNC:POLarity {NORMal |INVerted}

OUTPut:SYNC:SOURce {CH1|CHZ2}

Pulse Waveforms

As shown below, a pulse or square wave consists of a period, a pulse width, a rising edge, and a falling edge.

Pulse Width

Leading Edge Time Trailing Edge Time
-« Period

Y

Period

- Period: reciprocal of maximum frequency to 1,000,000 s. The default is 1 ms.

- The instrument adjusts the pulse width and edge time as needed to accommodate the specified period.
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Front Panel Operations

. Select Pulse waveform: Press [Waveform] > Pulse.

. Select period instead of frequency: Press [Units] > Frequency Periodic > Frequency Periodic.

. Set the period: Press [Parameter] > Period. Use the numeric keypad or the knob and arrows to set a desired value. If
you use the keypad, select a unit prefix to finish.

KEYSIGHT
TECHNOLOGIES

Period 100_

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°
Pulse Width 10.000,0 ps
Lead Edge 4.0ns

seconds

Trail Edge 4.0 ns

SCPI Command

[SOURce[1]2]:]FUNCtion:PULSe:PERiod {<seconds>|MINimum|MAXimum|DEFault}

Pulse Width

Pulse width is the time from the 50% threshold of a pulse's rising edge to the 50% threshold of the next falling edge.

- Pulse width: up to 1,000,000 s (see restrictions below). The default pulse width is 100 us. The minimum pulse
width is 16 ns.

- The specified pulse width must also be less than the difference between the period and the minimum pulse width.

- The instrument will adjust the pulse width to accommodate the specified period.
Front Panel Operations

Press [Waveform] > Pulse > Pulse Width. Use the numeric keypad or the knob and arrows to set a desired value. If
you use the keypad, select a unit prefix to finish.
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KEYSIGHT
TECHNOLOGIES

Period  100.000,000 ms

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°
Pulse Width 10_ seconds
Lead Edge 4.0ns

Trail Edge 4.0 ns

SCPI Command

[SOURce[1]2]:]FUNCtion:PULSe:WIDTh {<seconds>|MINimum|MAXimum|DEFault}

Pulse Duty Cycle

The pulse duty cycle is defined as follows:

Duty Cycle = 100 (Pulse Width)/Period
Pulse width is the time from the 50% threshold of a pulse's rising edge to the 50% threshold of the next falling edge.
— Pulse duty cycle: 0.01% to 99.99%(see restrictions below). The default is 10%.
- The pulse duty cycle must conform to the following restrictions determined by the minimum pulse width (Wmin).
The instrument will adjust the pulse duty cycle to accommodate the specified period.

Duty Cycle > 100 (Minimum Pulse Width) / Period

and

Duty Cycle < 100 (1 - (Minimum Pulse Width/ Period))
The minimum pulse width is 16 ns.

- The longer the edges, the greater the minimum pulse width. Longer edges will therefore restrict duty cycle more
than shorter edges.

Front Panel Operations

Select Pulse function: Press [Waveform] > Pulse.

2. Toggle to Duty Cycle: Press [Units] > Width Duty Cyc > Width Duty Cyc.
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3. Enterthe Duty Cycle: Press [Parameter] > Duty Cycle. Use the numeric keypad or the knob and arrows to set a
desired value. If you use the keypad, press Percent to finish.

KEYSIGHT

TECHNOLOGIES

Period 100.000,000 ms Percent

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°
Duty Cycle
Lead Edge
Trail Edge

SCPI Command

[SOURce[1]2]:]FUNCtion:PULSe:DCYCle {<percent>|MINimum|MAXimum|DEFault}

Edge Times

The edge times set the transition times for the leading and trailing edges of the pulse, either independently or
together. The edge time represents the time between the 10% and 90% thresholds.

- Edge time: Minimum of 8.4 ns. Maximum of 1 us and default 10 ns.

- The specified edge time must fit within the specified pulse width as shown above. The instrument will adjust the
edge time to accommodate the specified pulse width.

Front Panel Operations

1. To set the transition times for the edges of the pulse independently: Press [Waveform] > Pulse > Edge > Each Both.
2. Press Lead Edge to set the transition time for the leading edge of the pulse. Use the numeric keypad or the knob and
arrows to set a desired value. If you use the keypad, select a unit prefix to finish.
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3. Press Trail Edge to set the transition time for the trailing edge of the pulse. Use the numeric keypad or the knob and
arrows to set a desired value. If you use the keypad, select a unit prefix to finish.

Period
Amplitude

Offset

Phase

Duty Cycle
Lead Edge
Trail Edge

KEYSIGHT

TECHNOLOGIES

100.000,000 ms

100.0 mVpp

+0.000 V

0.0°
50.00 %
4.0 ns
4.0ns

1. To set the transition times for the edges of the pulse together: Press [Waveform] > Pulse > Edge > Each Both.
2. Press Edge Time to set the transition times for both the leading and trailing edge of the pulse. Use the numeric
keypad or the knob and arrows to set a desired value. If you use the keypad, select a unit prefix to finish.

Period
Amplitude

Offset

Phase

100.000,000 ms
100.0 mVpp

+0.000V

0.0°

Duty Cycle 50.00 %

Edge Time 1.0ns

SCPI Command

[SOURce[1]2]:]FUNCtion:PULSe:TRANsition:LEADing{<seconds>|MINimum|MAXimum|DEFault}
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[SOURce[1]2]:]FUNCtion:PULSe:TRANsition:TRAiling
{<seconds>|MINimum|MAXimum|DEFault}

[SOURce[1]|2]:]FUNCtion:PULSe:TRANsition[:BOTH] {<seconds>|MINimum|MAXimum|DEFault}

Amplitude Modulation (AM) and Frequency Modulation (FM)

A modulated waveform consists of a carrier waveform and a modulating waveform. In AM, the carrier amplitude is
varied by the voltage level of the modulating waveform. In FM, the carrier frequency is varied by the voltage level of
the modulating waveform. On a two-channel instrument, one channel can modulate the other.

Select AM or FM before setting up any other modulation parameter. For more information on modulation, see
Modulation.

To Select AM or FM

- The instrument allows only one modulation mode to be enabled on a channel. When you enable AM or FM, all
other modulations are off. On two-channel models, the two channels’ modulations are independent from one
another, and the instrument can add modulated waveforms from two channels. See PHASe:SYNChronize and
COMBIne:FEED in the EDU332170 Series Programming Guide for details.

- The instrument will not allow AM or FM to be enabled with sweep or burst. Enabling AM or FM, turns off sweep and
burst.

- To avoid multiple waveform changes, enable modulation after configuring the other modulation parameters.

Front Panel Operations

Press [Modulate] > Type AM.

or

Press [Modulate] > Type AM > Type FM.

Then turn modulation on: Press [Modulate] > Modulate ON | OFF > Modulate ON | OFF.

KEYSIGHT

SIN,SOQ TECHNOLOGIES
FM Modulated by Sine TV

. S Modu
Frequency 1.000,000,000 kHz EM Dev 100 Hz w(.) ur?;?

Amplitude 100.0 mVpp FM Freq 10.000,000 Hz | Type
- Fi
Offset +0.000V

Phase 0.0°

Internal
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The waveform is output using the present carrier and modulating waveform settings.
SCPI Command
[SOURce[1]2]:]AM:STATe{ON|1|OFF |0}

[SOURce[1]2]:]FM:STATe {ON|1|OFF|0}

Carrier Waveform Shape

- AM or FM carrier shape: Sine (default), Square, Ramp, Pulse, Triangle, Noise (AM only), PRBS, or Arbitrary
waveform. You cannot use DC as the carrier waveform.

- For FM, the carrier frequency must always be greater than or equal to the frequency deviation. Attempting to set a
deviation greater than the carrier frequency will cause the instrument to set the deviation equal to the carrier
frequency.

- The carrier frequency plus the deviation cannot exceed the selected function's maximum frequency plus 100 kHz. If
you attempt to set the deviation to an invalid value, the instrument adjusts it to the maximum value allowed with the
present carrier frequency. The remote interface also generates a "Data out of range" error.

Front Panel Operations
Press [Waveform]. Then select a waveform shape.
SCPI Command

[SOURce[1]2]:]FUNCtion <function>

The APPLy command configures a waveform with one command.

Carrier Frequency

The maximum carrier frequency varies by function, model, and output voltage, as shown here. The default is 1 kHz
for all functions other than arbitrary waveforms. Arbitrary waveform "frequency" is also set using the
FUNCtion:ARBitrary:SRATe command.

Front Panel Operations

Press [Parameter] > Frequency. Use the numeric keypad or the knob and arrows to set a desired value. If you use the
keypad, select a unit prefix to finish.
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KEYSIGHT
SIN,50Q ECHNOLOGIES
FM Modulated by Sine

( pHz
FM Dev 100 Hz

Frequency 1 _

Amplitude  100.0 mVpp .,__FM Freq 10.000,000 Hz

Offset +0.000V

Phase 0.0°

SCPI Command
[SOURce[1]2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

The APPLy command configures a waveform with one command.

Modulating Waveform Shape

On a two-channel instrument you can modulate one channel with the other.
You cannot modulate noise with noise, PRBS with PRBS, or an arbitrary waveform with an arbitrary waveform.
The modulating waveform shape (internal source) may be:

- Sine wave

- Square with 50% duty cycle |_|_|

- Triangle with 50% sym metry/\
- UpRamp with 100% symmetry/]

- DnRamp with 0% symmetry ™~
- Noise: White Gaussian noise
- PRBS: Pseudo Random Bit Sequence (polynomial PN7)

- Arb: Arbitrary waveform
Front Panel Operations

Press [Modulate] > Type AM.

or
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Press [Modulate] > Type AM > Type FM.
Then choose the modulating shape: Press Shape.

KEYSIGHT
SIN,500 ECHNOLOGIES

FM Modulated by Sine Verhikien

— ey | i
Frequency 1.000,000,000 kHz Mber 100 - OFF

Amplitude 100.0 mVpp FM Freq 10.000,000 Hz ,, -
) ; Fi

Offset +0.000V

Phase 0.0°

Source

Internal

SCPI Command
[SOURce[1]|2]:]AM:INTernal :FUNCtion <function>

[SOURce[1]|2]:]FM:INTernal :FUNCtion <function>

Modulating Waveform Frequency

Modulating frequency (internal source): minimum is 1 uHz, and the maximum values vary by function.
Front Panel Operations

Press [Modulate] > Type AM > AM Freq.

or

Press [Modulate] > Type AM > Type FM > FM Freq.

Then enter the AM or FM frequency with the knob and keypad. If you use the keypad, select a unit prefix to finish.
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KEYSIGHT

TECHNOLOGIES
SIN,50Q _—
FM Modulated by Sine

Frequency 1.000,000,000 kHz FMDer 100 He e

Amplitude 100.0 mVpp I.__FM Freq 1

Offset +0.000V

Phase 0.0°

SCPI Command
[SOURce[1]2]:]AM:INTernal :FREQuency {<frequency>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]FM:INTernal:FREQuency {<frequency>|MINimum|MAXimum|DEFault}

Modulation Depth (AM)

The modulation depth is a percentage that represents the amplitude variation. At 0% depth, the amplitude is one
half of the carrier's amplitude setting. At 100% depth, the amplitude varies according to the modulating waveform,
from 0% to 100% of the carrier’'s amplitude.

- Modulation depth: 0% to 120%. The default is 100%.

— Even at greater than 100% depth, the instrument will not exceed +5 Vpeak on the output (into a 50 Q load). To
achieve modulation depth greater than 100%, output carrier amplitude may be reduced.

Front Panel Operations

Press [Modulate] > Type AM > AM Depth. Use the numeric keypad or the knob and arrows to set a desired value. If
you use the keypad, press Percent to finish.

104 Keysight EDU33210 Series User's Guide



SIN,50Q
AM Modulated by Sine

Frequency 1.000,000,000 kHz
Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

SCPI Command

[SOURce[1|2] :]AM[ :DEPTh]

KEYSIGHT

TECHNOLOGIES

] Percent
AM Depth  50_

AM Freq 100.000,000 Hz

{<depth in percent>|MINimum|MAXimum}

Double Sideband Suppressed Carrier AM

The instrument supports two forms of amplitude modulation, "Normal" and Double Sideband Suppressed Carrier
(DSSC). In DSSC, the carrier is not present unless the modulating signal has an amplitude greater than zero.

Front Panel Operations

Press [Modulate] > Type AM > MORE 1 /2 > DSCC ON | OFF > DSCC ON | OFF.

SIN,50Q
AM Modulated by Sine

Frequency 1.000,000,000 kHz
Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

SCPI Command

AM Depth  50.00 % Internal

AM Freq 100.000,000 Hz DSSE

ON""OFF

[SOURce[1]|2]:]AM:DSSC{ON|1|OFF |0}
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Frequency Deviation (FM)

The frequency deviation setting represents the peak variation in frequency of the modulated waveform from the
carrier frequency.

When the carrier is PRBS, frequency deviation causes a change in the bit rate equal to one-half of the set frequency.
For example, a 10 kHz deviation is equivalent to a b KBPS change in bit rate.

- Frequency deviation: 1 puHz to (carrier frequency) / 2, default 100 Hz.

- For FM, the carrier frequency must always be greater than or equal to the frequency deviation. Attempting to set a
deviation greater than the carrier frequency will cause the instrument to set the deviation equal to the carrier
frequency.

- The carrier frequency plus the deviation cannot exceed the selected function's maximum frequency plus 100 kHz.
If you attempt to set the deviation to an invalid value, the instrument adjusts it to the maximum value allowed with
the present carrier frequency. The remote interface also generates a "Data out of range" error.

Front Panel Operations

Press [Modulate] > Type AM > Type FM > Freq Dev. Use the numeric keypad or the knob and arrows to set a desired
value. If you use the keypad, select a prefix unit to finish.

KEYSIGHT
TECHNOLOGIES

SIN,50Q
FM Modulated by Sine

Frequency 1.000,000,000 kHz FM Dev 1

Amplitude 100.0 mvpp -.__FM Freq 1.000,000,000 kHz

Offset +0.000V

Phase 0.0°

SCPI Command

[SOURce[1]2]:]FM[:DEViation] {<peak deviation in Hz>|MINimum|MAXimum|DEFault}

Modulating Source

On a two-channel instrument you can modulate one channel with the other.

- Modulating source: Internal (default) or Channel#.
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- AM example: With modulation depth 100%, when the modulating signal is at +5 V, the output will be at the
maximum amplitude. When the modulating signal at -5 V, the output will be at minimum amplitude.

- FM example: With deviation of 10 kHz, then a +5 V signal level corresponds to a 10 kHz increase in frequency.
Lower external signal levels produce less deviation and negative signal levels reduce the frequency below the carrier
frequency.

Front Panel Operations
After enabling Type AM or Type FM, select the modulating source as shown: Press MORE 1 /2 > Source.

KEYSIGHT
TECHNOLOGIES
SIN,50Q
AM Modulated by Sine

Modulation

AM Depth  50.00 % Channel2 —

Frequency 1.000,000,000 kHz
Amplitude 100.0 mVpp AM Freq  100.000,000 Hz DSSC

ON " OFF
Offset +0.000V

Phase 0.0°

SCPI Command
[SOURce[1]2]:]AM:SOURce {INTernal|CH1|CH2}

[SOURce[1]2]:]FM:S0URce {INTernal|CH1|CH2}

Phase Modulation (PM)

A modulated waveform consists of a carrier waveform and a modulating waveform. PM is very similar to FM, but in
PM the phase of the modulated waveform is varied by the instantaneous voltage of the modulating waveform.

For more information on the fundamentals of Phase Modulation, see Modulation.

To Select Phase Modulation

- Only one modulation mode may be enabled at a time. Enabling PM disables the previous modulation mode.
- Enabling PM turns off sweep and burst.

Front Panel Operation

Press [Modulate] > Type AM > Type PM.

The waveform is output using the present carrier and modulating waveform settings.
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To avoid multiple waveform changes, enable modulation after configuring the other modulation parameters.
SCPI Command

[SOURce[1]2]:]PM:STATe {ON|1|OFF|0}

Carrier Waveform Shape

PM carrier shape: Sine (default), Square, Ramp, Triangle, Pulse, PRBS, or Arbitrary. You cannot use Noise or DC as
the carrier waveform.

Front Panel Operation
Press [Waveform]. Then select any waveform except Noise or DC.

SCPI Command
[SOURce[1]2]:]FUNCtion <function>
- The APPLy command configures a waveform with one command.

- When the carrier is an arbitrary waveform, modulation affects the sample "clock" instead of the full cycle defined
by the arbitrary waveform sample set. Because of this, applying phase modulation to arbitrary waveforms is limited.

Carrier Frequency

The maximum carrier frequency varies by function, model, and output voltage, as shown here. The default is 1 kHz
for all functions other than arbitrary waveforms. Carrier frequency must be greater than 20 times the peak
modulation frequency.

Front Panel Operation

Press AM Freq or FM Freq or any other Frequency key. Use the numeric keypad or the knob and arrows to set a
desired value. If you use the keypad, select a prefix unit to finish.

SCPI Command
[SOURce[1]2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

The APPLy command configures a waveform with one command.

Modulating Waveform Shape

The modulating waveform shape may be:

- Sine wave
- Square with 50% duty cycle |_|_|
- Triangle with 50% sym metry/\

— UpRamp with 100% symmetry/]
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- DnRamp with 0% symmetry I\

- Noise: White Gaussian noise

- PRBS: Pseudo Random Bit Sequence (polynomial PN7)

- Arb: Arbitrary waveform

You can use noise as the modulating wave shape, but you cannot use noise or DC as the carrier waveform.

Front Panel Operation

Press [Modulate] > Type AM > Type PM > Shape Sine.

SIN,50Q
PM Modulated by Sine

— ey | i
Frequency 1.000,000,000 kHz Phase Dev 1800° o OFF

Amplitude 100.0 mVpp .,__PM Freq 1.000,000,000 kHz

Offset +0.000V

Phase 0.0°

Source

Internal

SCPI Command

SCPI: [SOURce[1l]2]:]PM:INTernal:FUNCtion <function>

Modulating Waveform Frequency

Modulating frequency: default 10 Hz, minimum T uHz; maximum varies by model, function, and output voltage, as
shown here.

Front Panel Operation

Press [Modulate] > Type AM > Type PM > PM Freq.

Then set the modulating waveform frequency with the knob and keypad. If you use the keypad, select a prefix unit to
finish.
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KEYSIGHT
TECHNOLOGIES
SIN,50Q
PM Modulated by Sine

Frequency 1.000,000,000 kHz 180.0° e

Phase Dev

Amplitude 100.0 mVpp I.__PM Freq 1

Offset +0.000V

Phase 0.0°

SCPI Command

SCPI: [SOURce[1|2]:]PM:INTernal:FREQuency{<frequency>|MINimum|MAXimum|DEFault}

Phase Deviation

The phase deviation setting represents the peak variation in phase of the modulated waveform from the carrier
waveform. The phase deviation can be set from 0 to 360 degrees (default 180).

Front Panel Operation

Press [Modulate] > Type AM > Type PM > Phase Dev.

Then set the phase deviation with the knob and keypad.

SCPI Command
[SOURce[1]2]:]PM:DEViation {<deviation in degrees>|MINimum|MAXimum|DEFault}

When the carrier is an arbitrary waveform, the deviation applies to the sample clock. Therefore, the effect on the full
arbitrary waveform is much less than that seen with standard waveforms. The extent of the reduction depends on
the number of points in the arbitrary waveform.

Modulating Source

Modulating source: Internal (default) or Channel#.
Front Panel Operation

Press [Modulate] > Type AM > Type PM > Source.
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KEYSIGHT
SIN,500Q ECHNOLOGIES

PM Modulated by Sine Verhikien

— Ty Modulate
Phase Dev 270.0° ON""OFF

Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpp .,__PM Freq 1.000,000,000 kHz
Offset +0.000V

Phase 0.0°

® Internal Source
. - Internal
Channel2

SCPI Command

[SOURce[1]2]:]PM:SOURce {INTernal|CH1|CH2}

Frequency-Shift Keying (FSK) Modulation

You can configure the instrument to "shift" its output frequency between two preset values (called the "carrier
frequency" and the "hop frequency") using FSK modulation. The rate at which the output shifts between these two
frequencies is determined by the internal rate generator or the signal level on the front panel Ext Trig connector.

See Front Panel Menu Operation - Output an FSK Waveform for details on FSK using the front panel.

To Select FSK Modulation

- Only one modulation mode may be enabled at a time. Enabling FSK turns off the previous modulation mode.
- You cannot enable FSK when sweep or burst is enabled. Enabling FSK turns off sweep and burst.

- To avoid multiple waveform changes, enable modulation after configuring the other modulation parameters.
SCPI Command

FSKey:STATe {OFF|ON}

FSK Carrier Frequency

The maximum carrier frequency varies by function, model, and output voltage, as shown here. The default is 1 kHz
for all functions other than arbitrary waveforms.

When a logic low is present, the carrier frequency is output. With a logic high, the hop frequency is output.
SCPI Command

[SOURce[1]2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

Keysight EDU33210 Series User's Guide 111



FSK "Hop" Frequency

The maximum alternate ("hop") frequency depends on the function. The default is 100 Hz for all functions. The
internal modulating waveform is a 50% duty cycle square wave.

Function Minimum Hop Frequency Maximum Hop Frequency
Sine 1 uHz 20 MHz
Square 1 uHz 10 MHz
Ramp/Triangle 1 uHz 200 kHz
Pulse 1 uHz 10 MHz

When the External source is selected, the output frequency is determined by the signal level on the front panel Ext
Trig connector. When a logic low is present, the carrier frequency is output. With a logic high, the hop frequency is
output.

SCPI Command

[SOURce[1]2]:]FSKey:FREQuency {<frequency>|MINimum|MAXimum|DEFault}

FSK Rate

The FSK rate is the rate at which the output frequency "shifts" between the carrier frequency and the hop frequency
using the internal FSK source.

- FSK rate (internal source): 125 uHz up to 1 MHz, default 10 Hz.

- The FSK rate is ignored when the external FSK source is selected.

SCPI Command

[SOURce[1]2]:]FSKey:INTernal :RATE {<rate in Hz>|MINimum|MAXimum}

FSK Source

May be Internal (default) or External.

- When the Internal source is selected, the rate at which the output frequency "shifts" between the carrier frequency
and hop frequency is determined by the FSK rate. The internal modulating waveform is a 50% duty cycle square
wave.

- When the External source is selected, the output frequency is determined by the signal level on the front panel Ext
Trig connector.When a logic low is present, the carrier frequency is output. With a logic high, the hop frequency is
output.

- The connector used for externally-controlled FSK waveforms (Ext Trig) is not the same connector that is used for
externally-modulated AM, FM, PM, and PWM waveforms (Modulation In). When used for FSK, the Ext Trig connector
does not have adjustable edge polarity.

SCPI Command

[SOURce[1]2]:]FSKey:3S0URce {INTernal |EXTernal}
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Pulse Width Modulation (PWM)

This section discusses PWM, which stands for pulse-width modulation. PWM is only available for the Pulse
waveform, and the pulse width varies according to the modulating signal. The amount by which the pulse width
varies is called the width deviation, and it can be specified as a percentage of the waveform period (that is, duty
cycle) or in units of time. For example, if you specify a pulse with 20% duty cycle and then enable PWM with a 5%
deviation, the duty cycle varies from 15% to 25% under control of the modulating signal.

To Select PWM

You cannot enable PWM when sweep or burst is enabled.

To avoid multiple waveform changes, enable modulation after configuring the other modulation parameters.
Front Panel Operations

1. Press [Waveform] > Pulse.
2. Press[Modulate] > Type AM > Type PWM.
3. Press Modulate ON | OFF > Modulate ON | OFF.

KEYSIGHT
PULS,500 TECHNOLOGIES

PWM Modulated by Sine Modulation

PP, . S— Modhlate
PWM Dev  0.000,000,000 s ’ O "OFF

Amplitude 100.0 mVpp .,__PWM Freq 10.000,000 Hz

Frequency 1.000,000,000 kHz

Type
Py ,“1

Offset +0.000V
Phase 0.0°

Pulse Width 10.000,0 ps
Lead Edge 4.0ns

Trail Edge 4.0 ns

Source

Internal

The waveform is output using the present carrier and modulating waveform settings.
SCPI Command

[SOURce[1]2]:]PWM:STATe {ON|1|OFF|0}

Modulating Waveform Shape

The modulating waveform shape (internal source) may be:

- Sine wave

Keysight EDU33210 Series User's Guide 113



- Square with 50% duty cycle |_|_|
- Triangle with 50% sym metry/\
- UpRamp with 100% symmetry/]

- DnRamp with 0% symmetry I\

- Noise: White Gaussian noise

- PRBS: Pseudo Random Bit Sequence (polynomial PN7)
- Arb: Arbitrary waveform

Front Panel Operations

Press [Waveform] > Pulse.
Press [Modulate] > Type PWM > Shape Sine.

!(EYSIGH{T
PULS,500Q ECHNOLOGIES
PWM Modulated by Sine

Modulate
PWM Dev  0.000,000,000 s ORI OFF

Amplitude 100.0 mVpp .,__PWM Freq 10.000,000 Hz

Frequency 1.000,000,000 kHz

Type
Py ,“1

Offset +0.000V
Phase 0.0°

Pulse Width 10.000,0 ps
Lead Edge 4.0ns

Trail Edge 4.0 ns

Source

Internal

SCPI Command

[SOURce[1]2]:]PWM:INTernal:FUNCtion <function>

Modulating Waveform Frequency

Modulating frequency: The default is 10 Hz, and the minimum is 1 tHz. The maximum frequency varies by function,
model, and output voltage, as shown here.
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Front Panel Operations

1. Press [Waveform] > Pulse.
2. Press[Modulate] > Type PWM > PWM Freq.

Use the numeric keypad or the knob and arrows to set a desired value. If you use the keypad, select a prefix unit to
finish.

KEYSIGHT
PULS,50Q ECHNOLOGIES
PWM Modulated by Sine

Frequency 1.000,000,000 kHz PWM Dev  0.000,000,000 s e

Amplitude 100.0 mVpp u

Offset +0.000V

Phase 0.0°

Pulse Width 10.000,0 ps
Lead Edge 4.0ns

Trail Edge 4.0 ns

SCPI Command

[SOURce[1]2]:]PWM: INTernal:FREQuency {<frequency>|MINimum|MAXimum|DEFault}

Width or Duty Cycle Deviation

The PWM deviation setting is the peak variation in width of the modulated pulse waveform. You can set it in units of
time or duty cycle.

Front Panel Operations

1. Press [Waveform] > Pulse.
2. Press[Modulate] > Type PWM > PWM Dev. Use the numeric keypad or the knob and arrows to set a desired value. If
you use the keypad, select a prefix unit to finish.

To set deviation in terms of duty cycle:

1. Press [Units] >Width Duty Cyc > Width Duty Cyc.
2. Press [Modulate] > Duty Cycle. Use the numeric keypad or the knob and arrows to set a desired value. If you use the
keypad, press Percent to finish.

SCPI Command

[SOURce[1]2]:]PWM:DEViation {<deviation>|MINimum|MAXimum|DEFault}
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- The sum of the pulse width and deviation must satisfy the formula:
Pulse Width + Deviation < Period - 16 ns

- If necessary, the instrument will adjust the deviation to accommodate the specified period.

Modulating Source

Modulating source: Internal (default) or Channel#.
Front Panel Operations

1. Press [Waveform] > Pulse.
2. Press[Modulate] > Type PWM > Source.

KEYSIGHT
PULS,50Q ECHNOLOGIES
PWM Modulated by Sine

— Oy Modulate

Frequency 1.000,000,000 kHz WM Dev  1.000,000,0005 e

Amplitude 100.0 mVpp .,__PWM Freq 500.000,000 Hz

Type
Py )\1

Offset +0.000V

Phase 0.0°

Pulse Width 10.000,0 ps
Lead Edge 4.0ns

Trail Edge 4.0 ns

® Internal Source
. - Internal
Channel2

SCPI Command

[SOURce[1]2]:]PWM:SOURce {INTernal|CH1l|CH2}

Pulse Waveform

Pulse is the only waveform shape supported for PWM.
Front Panel Operations

Press [Waveform] > Pulse.
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Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Pulse Width 10.000,0 ps
Lead Edge 4.0ns

Trail Edge 4.0 ns

SCPI Command
FUNCtion PULSe

The APPLy command configures a waveform with one command.

Pulse Period

The range for the pulse period is from the reciprocal of the instrument's maximum frequency up to 1,000,000 s

KEYSIGHT
TECHNOLOGIES
Parameter

Frequency

Amplitude

Dffset

Phase
~-

Pulse
Width

Edge
~5-

(default 100 us). Note that the waveform period limits the maximum deviation.

Front Panel Operations

1. Press [Waveform] > Pulse.
2. Press[Units] > Frequency Periodic > Frequency Periodic.

Period 0.000100 s
Amplitude  (0.700000 Vpp

Offset 0.000000 V
Phase 0.000000
Pulse Width 0.000010 s

Lead Edge 0.000000 s
Trail Edge 0.000000 s
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TECHNOLOGIES

Units
Amp/0ffs <

High/Low

Amplitude
Vor

Phase
Degrees

Sweep
StrtStop

Frequency
Periodic ]
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SCPI Command

[SOURce[1]2]:]FUNCtion:PULSe:PERiod {<seconds>|MINimum|MAXimum|DEFault}

Sum Modulation

Sum modulation adds a modulating signal to any carrier waveform; it is typically used to add Gaussian noise to a
carrier. The modulating signal is added to the carrier as a percentage of carrier waveform amplitude.

Enable Sum

To avoid multiple waveform changes, enable Sum after configuring other modulation parameters.
Front Panel Operations

1. Press [Modulate] > Type AM > Type Sum.
2. Press Modulate ON | OFF > Modulate ON | OFF.

KEYSIGHT
PULS,50Q ECHNOLOGIES
Sum Modulated by Sine

Modulate
Period 100.000 ps sum Ampl  100.0 m% ON'" " OFF

Amplitude 100.0 mVpp l.-—Sum Freq  100.000,000 Hz -
Sum
Offset +0.000V
Sum

Ampl
Phase 0.0° e

Pulse Width 10.000,0 ps Sum
I S

Lead Edge 4.0ns

Trail Edge 4.0 ns

Source

Internal

SCPI Command

[SOURce[1]2]:]SUM:STATe {ON|1|OFF |0}

Modulating Waveform Shape

On a two-channel instrument you can modulate one channel with the other.
The modulating waveform shape may be:

- Sine wave

- Square with 50% duty cycle |_|_|
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- Triangle with 50% sym metry/\
— UpRamp with 100% symmetry/]

- DnRamp with 0% symmetry ™~
- Noise: White Gaussian noise
- PRBS: Pseudo Random Bit Sequence (polynomial PN7)

- Arb: Arbitrary waveform
Front Panel Operations

Press [Modulate] > Type Sum > Shape Sine.

SIN,50Q
Sum Modulated by Sine

Frequency 1.000,000,000 kHz -SwnAmpI 100.0 m%

Amplitude 100.0 mVpp l.-—Sum Freq  100.000,000 Hz

Offset +0.000V

Phase 0.0°

SCPI Command

[SOURce[1]2]:]SUM:INTernal:FUNCtion <function>

Modulating Waveform Frequency

KEYSIGHT
TECHNOLOGIES

Modulation
Modulate
ON""OFF

Type

Sum

Sum
Ampl

Sum
Freq

Source

Internal

On a two-channel instrument you can modulate one channel with the other.

Modulating frequency: The default 100 Hz and the minimum is T uHz.

Front Panel Operations

Press [Modulate] > Type Sum > Sum Freq.

Use the numeric keypad or the knob and arrows to set a desired value. If you use the keypad, select a prefix unit to

finish.
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SIN,50Q
Sum Modulated by Sine

Frequency 1.000,000,000 kHz ] i

Amplitude 100.0 mVpp I.__Sum Freq 1_

Offset +0.000V

Phase 0.0°

SCPI Command

[SOURce[1]2]:]SUM:INTernal:FREQuency {<frequency>|MINimum|MAXimum|DEFault}

Sum Amplitude

The Sum Amplitude represents the amplitude of the signal added to the carrier (in percent of carrier amplitude).
- Amplitude setting: 0 to 100% of carrier amplitude, 0.01% resolution.

- Sum Amplitude remains a constant fraction of carrier amplitude and tracks carrier amplitude changes.
Front Panel Operations

Press [Modulate] > Type Sum > Sum Ampl.

Use the numeric keypad or the knob and arrows to set a desired value. If you use the keypad, press Percent to finish.

120 Keysight EDU33210 Series User's Guide



KEYSIGHT
TECHNOLOGIES

SIN,50Q
Sum Modulated by Sine

Sum Ampl 10_

Frequency 1.000,000,000 kHz Percent
Amplitude 100.0 mVpp . Sum Freq  500.000,000 Hz
Offset +0.000V

Phase 0.0°

SCPI Command

[SOURce[1]2]:]SUM:AMPLitude {<amplitude>|MINimum|MAXimum|DEFault}

Modulating Source

On a two-channel instrument you can modulate one channel with the other.

Modulating source: Internal (default) or Channel#.
Front Panel Operations

Press [Modulate] > Type Sum > Source.

KEYSIGHT
SIN,50Q 0
Sum Modulated by Sine

Modulat
Frequency 1.000,000,000 kHz sum Amal 1000 % N OFF

Type

Sum

Amplitude 100.0 mVpp l.-—Sum Freq  500.000,000 Hz

Offset +0.000V

Sum

Ampl

Phase 0.0°
Sum
Freq

Shape

Sine

# Internal Source

[nterna

Channel2
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SCPI Command

[SOURce[1]|2]:]1SUM:SOURce {INTernal|CH1|CH2}

Frequency Sweep

In frequency sweep mode, the instrument moves from the start frequency to the stop frequency at a specified sweep
rate. You can sweep up or down in frequency, with either linear or logarithmic spacing. You can also configure the
instrument to output one sweep from start frequency to stop frequency by applying an external or manual trigger.
The instrument can sweep sine, square, pulse, ramp, triangle, or arbitrary waveforms (PRBS, noise, and DC are not

allowed).

You can specify a hold time, during which the sweep remains at the stop frequency, and a return time, during which
the frequency changes linearly from the stop frequency to the start frequency.

For more information, see Frequency Sweep.

To Select Sweep

The instrument will not allow sweep or list mode to be enabled at the same time that burst or any modulation mode
is enabled. When you enable sweep, the burst or modulation mode is turned off.

To avoid multiple waveform changes, enable the sweep mode after configuring the other parameters.

Front Panel Operations

Press [Sweep] > Sweep ON | OFF> Sweep ON | OFF.

SIN,50Q

Linear Sweep, Trig Imm

Frequency Sweeping...
Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

SCPI Command

Start Freq  100.000,000 Hz
Stop Freq  1.000,000,000 kHz

Sweep Time 1.000 s
Hold Time 0.000s

Return Time 0.000 s

[SOURce[1]2]:]FREQuency:MODE SWEEP

[SOURce[1]2]:]SWEep:STATe {ON|1|OFF |0}

122
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Sweep

ON""OFF

Type

Linear

Sweep
Time

Start
Freq

Stop
Freq

Hold Return

-
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Start Frequency and Stop Frequency

The start frequency and stop frequency set the sweep’s upper and lower frequency bounds. The sweep begins at the
start frequency, sweeps to the stop frequency, and then resets back to the start frequency.

- Start and Stop frequencies: 1 uHz to maximum frequency for the waveform. The sweep is phase continuous over
the full frequency range. The default start frequency is 100 Hz. The default stop frequency is 1 kHz.

- To sweep up in frequency, set the start frequency less than the stop frequency. To sweep down in frequency, set
the opposite relationship.

- Sync setting Normal: Sync pulse is high throughout the sweep.
- Sync setting Carrier: Sync pulse has a 50% duty cycle for every waveform cycle.

- Sync setting Marker: Sync pulse goes high at the beginning and goes low at the marker frequency. You can change
this with OUTPut[1|2]:SYNC:MODEMARKER.

Front Panel Operations

Press [Sweep] > Start Freq.

Use the numeric keypad or the knob and arrows to set a desired value. If you use the keypad, select a prefix unit to
finish.

KEYSIGHT
SIN,500Q ECHNOLOGIES

Linear Sweep, Trig Imm

Frequency Sweeping... Start Freq 1 uHz

Amplitude 100.0 mVpp Stop Freq  1.000,000,000 kHz
Sweep Time 1.000 s

Offset +0.000 V Hold Time 0.000s

Return Time 0.000 s

Phase 0.0°

Press Stop Freq.

Use the numeric keypad or the knob and arrows to set a desired value. If you use the keypad, select a prefix unit to
finish.
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Linear Sweep, Trig Imm

Frequency Sweeping... Start Freq  1.000,000,000 kHz Vi

Amplitude 100.0 mVpp Stop Freq 2
Sweep Time 1.000 s

Hold Time 0.000s
Return Time 0.000 s

Offset +0.000V

Phase 0.0°

SCPI Command

[SOURce[1]2]:]FREQuency:STARt {<frequency>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]FREQuency:STOP {<frequency>|MINimum|MAXimum|DEFault}

Center Frequency and Frequency Span

You can also set the sweep frequency boundaries of the sweep using a center frequency and frequency span. These
parameters are similar to the start frequency and stop frequency (above) and they provide added flexibility.

- Center frequency: 1 pHz to maximum frequency for the waveform. The default is 550 Hz.

- Frequency span: Any value between +tmaximum frequency for the waveform. The default is 900 Hz.

- To sweep up in frequency, set a positive frequency span; to sweep down, set a negative frequency span.
- Sync setting Normal: Sync pulse is high throughout the sweep.

- Sync setting Carrier: Sync pulse has a 50% duty cycle for every waveform cycle.

- Sync setting Marker: Sync pulse goes high at the beginning and goes low at the marker frequency. You can
change this with OUTPut[1]2]:SYNC:MODEMARKER.
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Front Panel Operations

1. Press [Units] > Sweep StrtStop.

KEYSIGHT

TECHNOLOGIES

Frequency 1000.000000 Hz
Amplitude  (0.700000 Vpp
Offset 0.000000 V High/Low

Phase 0.000000 Amplitude

pr

2. Press [Sweep] > Start Freq or Stop Freq. Use the numeric keypad or the knob and arrows to set a desired value. If
you use the keypad, select a prefix unit to finish.

or

1. Press [Units] > Sweep CntrSpan.

KEYSIGHT

TECHNOLOGIES

Units

Frequency 1000.000000 Hz
Amplitude  0.700000 Vpp AmplOffs 4
Offset 0.000000 V High/Low

Phase 0.000000 Amplitude
Vop

Phase

Degrees

Sweep

CntrSpan

2. Press [Sweep] > Center or Span. Use the numeric keypad or the knob and arrows to set a desired value. If you use

the keypad, select a prefix unit to finish.
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SCPI Command
[SOURce[1]2]:]1FREQuency:CENTer {<frequency>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]FREQuency:SPAN {<frequency>|MINimum|MAXimum|DEFault}

Sweep Mode

You can sweep with linear or logarithmic spacing, or with a list of sweep frequencies. For a linear sweep, the
instrument varies the output frequency linearly during the sweep. A logarithmic sweep varies the output frequency
logarithmically.

The selected mode does not affect the sweep return (from stop to start, if one is set).
Front Panel Operations

Press [Sweep] > Type Linear.

SIN,50Q

Linear Sweep, Trig Imm

Frequency Sweeping... Center 0.000,000 Hz

Amplitude 100.0 mVpp Span 0.000,000 Hz % Linear |
Sweep Time 1.000 s g

Offset +0.000 V Hold Time 0.000's List

Return Time 0.000 s ’

Phase 0.0°

Span

Hold Return
~-

SCPI Command

[SOURce[1]2]:]SWEep:SPACing {LINear|LOGarithmic}

Sweep Time

Sweep time specifies the number of seconds required to sweep from the start frequency to the stop frequency. The
instrument calculates the number of points in the sweep based on the sweep time.

Sweep time: 1 ms to 250,000 seconds, default 1 s. For a linear sweep in immediate trigger mode, the maximum total
sweep time (including hold time and return time) is 8,000 s. The maximum total sweep time for linear sweeps using
other trigger modes is 250,000 s; the maximum total sweep time for logarithmic sweeps is 500 s.
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Front Panel Operations

Press [Sweep] > Sweep Time. Use the numeric keypad or the knob and arrows to set a desired value. If you use the
keypad, select a prefix unit to finish.

SIN,500Q

Linear Sweep, Trig Imm

FrequenCy Sweeping... ‘ Center 0'000,000 Hz

Amplitude 100.0 mVpp Span 0.000,000 Hz
Sweep Time 1_

seconds

Offset +0.000 V Hold Time 0.000s

Phase 0.0° IhReturn Time 0.000 s

SCPI Command

[SOURce[1]2]:]SWEep:TIME {<seconds>|MINimum|MAXimum|DEFault}

Hold/Return Time

Hold time specifies time (in seconds) to remain at the stop frequency, and return time specifies the number of
seconds to return from the stop frequency to the start frequency.

Hold time and return time: 0 to 3600 seconds (default 0).
Front Panel Operations

Press [Sweep] > Hold Return > Hold Time or Return Time. Use the numeric keypad or the knob and arrows to set a
desired value. If you use the keypad, select a prefix unit to finish.
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SIN,500Q

Linear Sweep, Trig Imm

Frequency Sweeplng... Center 0'000’000 Hz

Amplitude 100.0 mVpp Span 0.000,000 Hz
Sweep Time 1 ms
Offset +0.000V Hold Time 1

seconds

Return Time 0.000 s

Phase 0.0°

SCPI Command
[SOURce[1]2]:]SWEep:HTIMe {<hold time>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]SWEep:RTIMe {<return time>|MINimum|MAXimum|DEFault}

Marker Frequency

If desired, you can set the frequency at which the signal on the front panel Sync Out connector goes to a logic low
during the sweep. The Sync signal always goes from low to high at the beginning of the sweep.

- Marker frequency: 1 pHz to maximum frequency for the waveform. The default is 500 Hz.

- When the sweep mode is enabled, the marker frequency must be between the specified start frequency and stop
frequency. If you attempt to set the marker frequency to a frequency not in this range, the instrument will set the
marker frequency equal to the start frequency or stop frequency (whichever is closer).

- You cannot configure the marker frequency with the front panel menus unless the Sync source is the sweeping
channel.

Front Panel Operations

1. Press [Sweep] > Sweep ON | OFF > Sweep ON | OFF.
2. Press[Trigger] > Sync ON | OFF > Sync Setup.
3. Select Mode Marker.
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4. Select Marker Freq. Use the numeric keypad or the knob and arrows to set a desired value. If you use the keypad,

select a prefix unit to finish.

A
SIN,500 kol

Linear Sweep, Trig Imm
Center 550.000,000 Hz
Amplitude 100.0 mVpp Span 900.000,000 Hz
Sweep Time 1 ms
Hold Time 1_
Return Time 0.000 s

Frequency Sweeping...

seconds

Offset +0.000V

Phase 0.0°

SCPI Command

[SOURce[1]2]:]MARKer:FREQuency {<frequency>|MINimum|MAXimum|DEFault}

Sweep Trigger Source

In sweep mode, the instrument outputs a single sweep when a trigger signal is received. After one sweep from the
start frequency to the stop frequency, the instrument waits for the next trigger while outputting the start frequency.

- Sweep trigger source: Immediate (default), External , Time, or Manual.

- With the Immediate (internal) source, the instrument outputs a continuous sweep at a rate determined by the total
of the hold time, sweep time and return time. The sweep time for this source is limited to 8000 seconds.

- With the External source, the instrument accepts a hardware trigger on the front panel Ext Trig connector and
initiates one sweep each time Ext Trig receives a TTL pulse with the specified polarity.

- The trigger period must be greater than or equal to the specified sweep time.
- With the Manual source, the instrument outputs one sweep each time the front panel [Trigger] key is pressed.

Front Panel Operations

Press [Trigger] > Source.
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sIN,SOQ TECHNOLOGIES
Linear Sweep, Trig Timer Trigaer
. —EET————————  Immediate Source
Frequency Sweeplng... Center 0.000,000 Hz| Timer
Amplitude 100.0 mVpp 2 0.000,000 Hz ~ Manual Trigger Setup

Sweep Time 1 ms -
Hold Ti d
old Time 1.000s Trig Out Setup

Return Time 0.000 s -

Offset +0.000V

Phase 0.0°

Sync
0N OFF

Sync Setup
~9-

To specify the slope of the trigger signal edge: Press [Trigger] > Trig Out Setup > Trig Out Off | (Up) | (Down).

KEYSIGHT
SIN,50Q ECHNOLOGIES
Linear Sweep, Trig Timer Triaqor

: — Ty Source
Frequency Sweeping... E— 0,000,000 Hz A

Amplitude  100.0 mVpp Span 0.000,000 Hz Trig Out
Sweep Time 1 ms off Tty

Offset +0.000 V Hold Time 1.000s

Return Time 0.000 s

Phase 0.0°

SCPI Command

TRIGger[1|2] :SOURce {IMMediate|EXTernal|TIMer |BUS}
TRIGger[1|2]:SLOPe {POSitive|NEGative}

See Triggering for more information.

Trigger Out Signal

See Trigger Output Signal for more details.
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Front Panel Operations

To specify whether the instrument triggers on the rising or falling edge on the Sync Out connector, press [Trigger] >
Trig Out Setup. Then select the desired edge by pressing Trig Out.

SIN,500Q

Linear Sweep, Trig Timer

Frequency’ Sweeping... Center  0.000,000 Hz

Amplitude 100.0 mVpp Span 0.000,000 Hz T
Sweep Time 1 ms off "1 e

Offset +0.000 V Hold Time 1.000s

Phase 0.0° Il‘_Return Time 0.000 s

SCPI Command

OUTPut:TRIGger:SLOPe {POSitive|NEGative}

OUTPut:TRIGger {ON|1|OFF |0}

Frequency List

In frequency list mode, the instrument "steps" through a list of frequencies, dwelling on each frequency for a
specified period. You may also control progress through the list with triggering.

- The instrument will not allow sweep or list mode to be enabled at the same time that burst or any modulation
mode is enabled. When you enable sweep, the burst or modulation mode is turned off.

- To avoid multiple waveform changes, enable list mode after configuring its parameters.

Front Panel Operations

Enable list before setting any other list parameter. Press [Sweep] > Type Linear > Type List.
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SIN,500Q

List Sweep, Trig Imm

ep

— Ty Sweep
Dwell Time 1.000s ON""OFF

Frequency Sweeping...
Amplitude 100.0 mVpp » Type

List
Offset +0.000 V

Duvell

Phase 0.0° i

View List
~-

Select
List

Save
List

Select View List to view the list parameters. You can edit (Edit Freq) the frequency value in the sweep list, add (Add
Freq) or delete (Delete Freq) a frequency value, and reorder the sweep list (Reorder List).

KEYSIGHT
TECHNOLOGIES

SIN,500Q Are

List Sweep, X -
Sweep Frequency List Sweep

Frequency S 1 100.000000 Hz Edit Freq
2 1000.000000 Hz

Amplitude 1
3 550.000000 Hz

Offset +

Phase

Add Freq

Delete Freq

Reorder List
~-

If you have a external USB flash drive connected, press Save List to save the sweep list to the external USB flash
drive.

To retrieve a previously saved sweep list from the connected external USB flash drive, press Select List.
SCPI Command

[SOURcd[1]2] :]FREQuency:MODE LIST

[SOURce[1]2]:]LIST:FREQuency <freqgl>[, <freg2>, etc.]

Progress through list is controlled by the trigger system. If trigger source is internal or immediate, the dwell time
setting (LIST:DWELL) determines time spent at each frequency. For any other trigger source, dwell time is
determined by trigger event spacing.
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Burst Mode

The instrument can output a waveform for a specified number of cycles, called a burst. Burst is allowed with sine,
square, triangle, ramp, pulse, PRBS, or arbitrary waveforms (noise is allowed only in gated burst mode; DC is not
allowed).

For details, see Burst.

To Select Burst

Burst cannot be enabled when sweep or modulation is enabled. Enabling burst turns off sweep and modulation.

To avoid multiple waveform changes, enable burst mode after configuring other parameters.
Front Panel Operations

Press [Burst] > Burst ON | OFF > Burst ON | OFF.

SCPI Command

[SOURce[1|2]:]1BURSt:STATe {ON|1|OFF|0}

Burst Mode

Burst has two modes, described below. Selected mode controls allowable trigger source, and which other burst
parameters apply.

- Triggered Burst Mode (default): The instrument outputs a waveform for specified number of cycle (burst count)
each time trigger is received. After outputting specified number of cycles, instrument stops and waits for next
trigger. The instrument can use an internal trigger to initiate burst, or you can provide external trigger by pressing
the front panel [Trigger] key, applying trigger signal to front panel Ext Trig connector, or sending software trigger
command from remote interface.

- External Gated Burst Mode: Output waveform is on or off, based on level of external signal applied to front panel
Ext Trig connector. When the gate signal is true, the instrument outputs a continuous waveform. When the gate
signal goes false, the current waveform cycle is completed and the instrument stops while remaining at the voltage
level corresponding to the starting burst phase of the selected waveform. The noise waveform output stops
immediately when the gate signal goes false.

Parameter Burst Mode Burst Count Burst Period Burst Phase TriggerSource
(BURS:MODE) (BURS:NCYC) (BURS:INT:PER) (BURS:PHAS) (TRIG:SOUR)

Triggered Burst Mode:  TRIGgered Available Available Available IMMediate

Internal Trigger

Triggered Burst Mode: ~ TRIGgered Available Not Used Available EXTernal, BUS

External Trigger

Gated Burst Mode: GATed Not Used Not Used Available Not Used

External Trigger

Timer Burst Mode: TRIGgered Available Not Used Available TIMer

Internal Trigger
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- In gated mode, burst count, burst period, and trigger source are ignored (used for triggered burst only). Manual
triggers ignored; no error generated.

- In gated mode, you can specify polarity of signal on the front panel Ext Trig connector ([SOURce
[1]2]:]BURSt:GATE:POLarity {NORMal|INVerted}). Default is NORMal (true-high).

Front Panel Operations

Press [Burst] > N Cycle Gated or N Cycle Gated.

KEYSIGHT
TECHNOLOGIES

SIN,500Q

Gated Burst, Trig Timer Burst

— Burst

Frequency 1.000,000,000 kHz Start Phase 0.0° 0K OFF

Amplitude 100.0 mVpp # of Cycles 1 N Cycle
Burst Period 10 ms » Gated <

Offset +0.000V
Polarity

Pos  Neg
Phase 0.0° _:

Start Phase

SCPI Command

[SOURce[1]2] :]BURSt:MODE {TRIGgered|GATed}

Waveform Frequency

You can specify the signal frequency during the burst in triggered and external gated modes. In the triggered mode,
the number of cycles specified by the burst count is output at the waveform frequency. In the external gated mode,
the waveform frequency is output when the external gate signal is true. This differs from the "burst period," which
specifies interval between bursts (triggered mode only).

Waveform frequency: 1 uHz to maximum frequency of the waveform. The default value is 1 kHz. (For an internally
triggered burst waveform, the minimum frequency is 126 uHz.)

Front Panel Operations

Press [Parameter] > Frequency. Use the numeric keypad or the knob and arrows to set a desired value. If you use the
keypad, select a prefix unit to finish.
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Frequency 1 _ pHz

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

SCPI Command
[SOURce[1]2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

The APPLy command configures awaveform with one command.

Burst Count

Number of cycles (1 to 100,000,000 or infinite) to be output per burst. Used in the triggered burst mode only
(internal or external source).

- With the Immediate trigger source, the specified number of cycles are output continuously at a rate determined by
the burst period. The burst period is the time between the starts of consecutive bursts. Also, the burst count must be
less than the product of burst period and waveform frequency:

Burst Period > (Burst Count) / (Waveform Frequency) + 1 usec

- The instrument will increase burst period to its maximum value to accommodate specified burst count (but
waveform frequency will not be changed).

- In gated burst mode, burst count is ignored. However, if you change the burst count from the remote interface
while in the gated mode, the instrument remembers the new count and will use it when the triggered mode is
selected.

Front Panel Operations

Press [Burst] > # of Cycles. Use the numeric keypad or the knob and arrows to set a desired value. If you use the
keypad, press Enter to finish.
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Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

SCPI Command

[SOURce[1]2]:]BURSt:NCYCles {<num cycles>|INFinity|MINimum|MAXimum}

Burst Period

Burst period, which is used in internal triggered burst mode only, is the time from the start of one burst to the start of
next burst (1 us to 8000 s, default 10 ms). Burst period differs from "waveform frequency," which specifies the
frequency of the bursted signal.

Burst period is used only when Immediate triggering is enabled. The burst period is ignored when manual or external
triggering is enabled (or when the gated burst mode is selected).

You cannot specify a burst period that is too short for the instrument to output with the specified burst count and
frequency. If the burst period is too short, the instrument will increase it as needed to continuously re-trigger the
burst.

Front Panel Operations

Press [Burst] > Burst Period. Use the numeric keypad or the knob and arrows to set a desired value. If you use the
keypad, select a prefix unit to finish.
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Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

seconds

SCPI Command

[SOURce[1]2]:]1BURSt:INTernal:PERiod {<seconds>|MINimum|MAXimum}

Start Phase

Start phase of the burst, from -360 to +360 degrees (default 0).

- Specify the start phase units with UNIT:ANGLe.

- Always displayed in degrees on front panel (never radians). If set in radians from remote interface, instrument
converts value to degrees on the front panel.

- For sine, square, and ramp, O degrees is the point at which the waveform crosses 0 V(or DC offset) in a positive
going direction. For arbitrary waveforms, O degrees is the first waveform point. Start phase has no effect on noise.

- Start phase also used in gated burst mode. When the gate signal goes false, the current waveform cycle finishes,
and output remains at the voltage level of the starting burst phase.

Front Panel Operations

Press [Burst] > Start Phase. Use the numeric keypad or the knob and arrows to set a desired value. If you use the
keypad, press Degrees to finish.
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Frequency 1.000,000,000 kHz Degrees

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

SCPI Command

[SOURce[1]2]:]BURSt:PHASe {<angle>|MINimum|MAXimum}

Burst Trigger Source

In triggered burst mode:

- The instrument outputs a waveform of the specified number of cycles (burst count) when a trigger is received.
After the specified number of cycles have been output, the instrument stops and waits for next trigger.

- IMMediate (internal): the instrument outputs continuously when burst mode is enabled. The rate at which the burst
is generated is determined by BURSt:INTernal:PERIod.

- EXTernal: the instrument accepts a hardware trigger at the front panel Ext Trig connector. The instrument outputs
one burst of the specified number of cycles each time Ext Trig receives a level transition with the proper polarity
(TRIGger[1|2]:SLOPe). External trigger signals during a burst are ignored.

- BUS (software): the instrument initiates one burst each time a bus trigger (TRG) is received. The front panel
[Trigger] key is illuminated when the instrument is waiting for a bus trigger.

- EXTernal or BUS: burst count and burst phase remain in effect, but burst period is ignored.

- TIMer: trigger events are spaced by a timer, with the first trigger as soon as INIT occurs.
Front Panel Operations

Press [Trigger] > Trigger Setup > Source.
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Frequency 1.000,000.000 kHz [

CH 1 Trigger Setu
Amplitude 100.0r o >

External

Offset +0.000 Source Immediate

Phase 0.0° Delay 0s

KEYSIGHT

TECHNOLOGIES
Trigger
Source

Immediate

Delay

To specify whether the instrument triggers on a rising or falling edge of the signal at the Ext Trig connector, select

the external trigger source before choosing Trigger Setup.

SCPI Command

TRIGger[1|2] :SOURce {IMMediate|EXTernal|TIMer |BUS}

TRIGger[1|2]:SLOPe {POSitive|NEGative}

See Triggering for more information.

If the duty cycle is changed on a triggered bursted square wave with the trigger mode set to Timer, the current burst

will finish and one more burst will be executed before the duty cycle of the burst changes.

Trigger Out Signal

See Trigger Output Signal for more details.
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Front Panel Operations

1. Press [Burst] > Burst ON | OFF > Burst ON | OFF.

SIN,50Q
N-Cycle Burst, Trig Imm

Frequency 1000.000000 Hz
Amplitude  0.700000 Vpp

Offset 0.000000 V
Phase 0.000000

2. Press[Trigger] > Trig Out Setup.

—
Start Phase 0.000000

# of Cycles 1.000000
Burst Period 0.010000 s

—

KEYSIGHT

TECHNOLOGIES
Burst
Burst

0N OFF

MCycle <
Gated

Start Phase

# of Cycles

Burst Period

3. Then use this softkey to choose the desired edge direction: Press Trig Out Off | (Up) | (Down).

SIN,50Q
N-Cycle Burst, Trig Imm

Frequency 1.000,000,000 kHz
Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

SCPI Command

Start Phase 90.0°

# of Cycles 10

Burst Period 1 ms

OUTPut:TRIGger:SLOPe {POSitive|NEGative}

OUTPut:TRIGger {ON|1|OFF |0}
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Triggering

This section describes the instrument's triggering system.

Trigger Overview

This triggering information applies to sweep and burst only. You can issue triggers for sweeps or bursts using
internal triggering, external triggering, timer triggering, or manual triggering.

— Internal or "automatic" (default): Instrument outputs continuously when sweep or burst mode is selected.

- External: Uses front panel Ext Trig connector to control sweep or burst. The instrument initiates one sweep or
outputs one burst each time Ext Trig receives a pulse. You can select whether instrument triggers on rising or falling
edge.

- Manual: Triggering initiates one sweep or outputs one burst each time you press [Trigger] on the front panel.
- When you sweep a list, trigger moves the wave form to the next frequency in the list.

- The [Trigger] key is disabled when in remote and when a function other than burst or sweep is currently selected.

Trigger Sources

This triggering information applies to sweep and burst only. You must specify the source from which the instrument
accepts a trigger.

- Sweep and Burst trigger source: Immediate (default), External, Manual or Timer.

- The instrument will accept a manual trigger, a hardware trigger from the front panel Ext Trig connector, or
continuously output sweeps or bursts using an internal trigger. You can also trigger bursts based on a timer. At
power-on, immediate trigger is selected.

- Trigger source setting is volatile; set to internal trigger (front panel) or immediate (remote interface) by power
cycle or *RST.

Front Panel Operations

Enable sweep or burst. Then:

Press [Trigger] > Source.
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KEYSIGHT
SIN,500Q TECHNOLOGIES
Linear Sweep, Trig Imm Triager
s ——— [ Source
Start Freq 100000,000 Bieic] Immediate

Amplitude 100.0 mVpp Stop Freq  1.000,000,00/ Hanua Trigger Setup
Sweep Time 1.000 s Timer -
Hold Time 0.000s

Return Time 0.000 s

Frequency Sweeping...

Offset +0.000V
Trig Out Setup

Phase 0.0° -

Sync
0N OFF

Sync Setup
~9-

SCPI Command
TRIGger[1|2] :SOURce {IMMediate|EXTernal|TIMer |BUS}

The APPLy command automatically sets the source to Immediate.

Immediate Triggering

Internal trigger mode (default): Instrument continuously outputs sweep or burst (as specified by sweep time or burst
period).

Front Panel Operations
Press [Trigger] > Source Immediate.
SCPI Command

TRIGger:SOURce IMMediate

Manual Triggering

Manual trigger mode (front panel only): You manually trigger the instrument by pressing [Trigger]. The instrument
initiates one sweep or burst for each time you press [Trigger]. The button is lit when you are in the trigger menu and
the instrument is waiting for a manual trigger. The button blinks when the instrument is waiting for a manual trigger,
but you are not in the trigger menu. The key is disabled when the instrument is in remote.

Front Panel Operations

Press [Trigger] > Source Manual.
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External Triggering

In external trigger mode, the instrument accepts a hardware trigger at the front panel Ext Trig connector. The
instrument initiates one sweep or burst each time Ext Trig receives a TTL pulse with the specified edge. The external
trigger mode is like the manual trigger mode except that you apply the trigger to the Ext Trig connector.

See Trigger Input Signal, below.
Front Panel Operations

Press [Trigger] > Source External.

To specify whether the instrument triggers on a rising or falling edge, press Trigger Setup and select the edge
direction by pressing Slope.

SCPI Command

TRIGger:SOURce EXTernal

TRIGger[1|2]:SLOPe {POSitive|NEGative}

Software (Bus) Triggering

Available only from remote interface, this is similar to manual trigger mode from the front panel, but you trigger the
instrument with a bus trigger command. The instrument initiates one sweep or outputs one burst each time a bus
trigger command is received. The key blinks when a bus trigger command is received.

To select the bus trigger source, send TRIGger:SOURce BUS.

To trigger instrument from remote interface (USB, or LAN) when Bus source is selected, send TRIG or *TRG (trigger).
The front panel [Trigger] key is illuminated when the instrument is waiting for a bus trigger.

Front Panel Operations

Press [Trigger] > Source Manual.

Timer Triggering

The timer trigger mode issues triggers a fixed period apart. To select the bus trigger source, send TRIGger:SOURce
TIMer.

Front Panel Operations

Press [Trigger] > Source Timer.

Trigger Input Signal

This front panel connector is used in the following modes:

- Triggered Sweep Mode: Press [Trigger] > Trigger Setup > Source External, or execute TRIG:SOUR EXT (sweep must
be enabled). When a level transition of the correct polarity is received on the Ext Trig connector, instrument outputs
a single sweep.
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- Triggered Burst Mode: Press [Trigger] >Trigger Setup > Source External, or execute TRIG:SOUR EXT (burst must
be enabled). The instrument outputs a waveform with specified number of cycles (burst count) each time a trigger is
received from the specified trigger source.

- External Gated Burst Mode: Press the Gated softkey or execute BURS:MODE GAT with burst enabled. When
external gate signal is true, instrument outputs a continuous waveform. When external gate signal goes false, the
current waveform cycle completes and then instrument stops while remaining at voltage level corresponding to
starting burst phase. For noise, output stops as soon as the gate signal goes false.

Trigger Output Signal

The trigger output signal is chassis referenced. Use appropriate care not to touch the two signals simultaneously as
you are connecting or disconnecting these cables. De-energize connections to the instrument output before con-
necting or disconnecting these cables.

- A "trigger out" signal is provided on the front panel Sync Out connector (used with burst and sweep only). When
enabled, a pulse with either a rising edge (default) or falling edge is output from this connector at the beginning of
the sweep or burst.

OUTPUT

Sync Out +33V

o >TUsS |

OV

Rising edge shown.

- Internal (immediate) or Timer trigger source: Instrument outputs a square wave with a 50% duty cycle from the
Sync Out connector at the beginning of the sweep or burst. Waveform period equals specified sweep time or burst
period.

- External trigger source: Instrument disables "trigger out" signal.

- Bus (software) or manual trigger source: Instrument outputs a pulse (>1 us pulse width) from Sync Out connector
at beginning of each sweep or burst.

Front Panel Operations

. Enable sweep or burst.
. Then press [Trigger] > Trig Out Setup.
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3. Then use this softkey to choose the desired edge direction: Trig Out Off | (Up) | (Down).

KEYSIGHT
TECHNOLOGIES

SIN,500Q

Linear Sweep, Trig Trigger

= Source
Frequency - Sweeping... Start Freq 100.000,000 Hz ————

Amplitude 100.0 mVpp Stop Freq  1.000,000,000 kHz Trig Out
Sweep Time 1.000 s off "1t

Hold Time 0.000s
Return Time 0.000 s

Offset +0.000V

Phase 0.0°

SCPI Command

OUTPut:TRIGger:SLOPe {POSitive|NEGative}

OUTPut:TRIGger {ON|1|OFF |0}

System-Related Operations

This section covers instrument state storage, power-down recall, error conditions, self test, and display control.
Though unrelated to waveform generation, these operations are important for instrument operation.

Instrument State Storage

- There are two ways to store and retrieve instrument states:

- Named state files, using the front panel or MMEMory:STORe:STATe and MMEMory:LOAD:STATe
- Memory locations O through 4, using *SAV and *RCL

- Both state storage methods remember the selected function (including arbitrary waveforms), frequency,
amplitude, DC offset, duty cycle, symmetry, and modulation parameters.

- Stored states are not affected by *RST; a stored state remains until overwritten or specifically deleted.
Front Panel Operations

See Store or Retrieve the Instrument State.
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Instrument Power On State

You can configure instrument to power-down state from location O on power up. The factory default is to recall
factory default state at power-on.

Front Panel Operations
Press [System] > Power On Setting > Power On Factory Default or Power On State 0.
SCPI Command

MEMory:STATe:RECall:AUTO {ON|1|OFF |0}

Error Conditions

Up to 20 command syntax or hardware errors can be stored in the error queue. See "SCPI Error Messages" in the
EDU332170 Series Programming Guide for more information.

Front Panel Operations
Press [System] > Help > Error View.

SCPI Command

SYSTem:ERRor?

Beeper Control

The instrument normally beeps when an error is generated from the front panel or remote interface.
This setting is non-volatile; it will not be changed by power cycling or *RST.

Front Panel Operations

Press [System] > User Settings > Beeper ON | OFF.

SCPI Command

SYSTem:BEEPer:STATe {ON|1|OFF|0}

SYSTem:BEEPer

Key Click

The instrument emits a click when a front panel key or softkey is pressed.
This setting is non-volatile; it will not be changed by power cycling or *RST.
Front Panel Operations

Press [System] > User Settings > Key Click ON | OFF.
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SCPI Command

SYSTem:CLICk:STATe {ON|1|OFF|0}

Turn off the Display

For security reasons, or to speed up the rate at which the instrument executes remote interface commands, you may
want to turn off the display.

Front Panel Operations

Press [System] > User Settings > Display ON | OFF.

Press any key to turn the display back on.
SCPI Command

DISPlay {ON|1|OFF|0}

Display Brightness

You can set the display brightness to auto dim (100% to 10%) after 2 minutes of inactivity. You may set this feature
from the front panel only.

This setting is non-volatile; it will not be changed by power cycling or *RST.
Front Panel Operations

Press [System] > User Settings > Auto Dimming ON | OFF.

Date and Time

You can set the instrument's date and time clock.
Front Panel Operations

Press [System] > User Settings > Date / Time.
SCPI Command

SYSTem:DATE <yyyy>, <mm>, <dd>
SYSTem:TIME <hh>, <mm>, <ss>
Manage Files

You can perform file management tasks, including copying, renaming, deleting, and creating new folders.
Front Panel Operations

Press [System] > Store/Recall > File Manager.
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You can copy, rename, or delete files or folders. Deleting a folder removes all of the files within the folder, so be sure
that you want to delete all of the files within the folder.

The most important softkey is Switch Pane, which allows you to specify the location of the action to perform. Once
you have chosen the location of the action to perform, press Select to select the file to manage. Once you are
completely prepared to execute the task, press Rename, Copy, or Delete.

SCPI Command

See "MEMory" and "MMEMory subsystems" in the EDU33210 Series Programming Guide.

Self-Test

Alimited power-on self-test occurs when you turn on the instrument to assure you that the instrument is
operational. You can also run a more complete self-test. For details, see "Self-Test Procedures" in the EDU33270
Series Service Guide.

Front Panel Operations
Press [System] > Instr. Setup > Self Test.
SCPI Command

*TST

Firmware Revision Query

Send *IDN? to determine which revision of firmware is currently installed. The query returns a string of the form:
Keysight Technologies,[Model Number],[10-char Serial Number],[Firmware Revision Number]

Firmware revision number example: K-01.00.04-01.00-01.00-01.00-01.00
Front Panel Operations
Press [System] > Help > About. Scan the QR code shown to view the documentation related to this instrument.

SCPI Command

*IDN?

SCPI Language Version Query
The instrument complies with the rules and conventions of the present version of SCPI (Standard Commands for
Programmable Instruments). Use SYSTem:VERSion? to determine the SCPI version with which the instrument

complies. The query returns a string in the form "YYYY.V", representing the year and version number for that year (for
example, 1999.0).

170 Config

See Remote Interface Connections and Remote Interface Configuration for more details.
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Dual Channel Operations

This section covers most topics related to dual channel operation.

Entering Dual Channel Operation

You enter dual channel configuration by pressing a channel output button, then Dual Chanrel.
S

Freq Cpl
Frequency 1. oy q pyal Channel Operation ON"TOFF

Amplitude 1l Frequencies Independent Freq Cpl Settings

-
Offset + Offset CH2 - CH1 = +0.000,000 Hz

Amplitudes & Offsets Independent Qr:? K D‘ﬂ

Tracking

Phase 0.
Tracking
OFF

Combine
CH2 " OFF

Frequency Coupling

Frequency coupling allows you to couple frequencies or sample rates between channels, either by a constant ratio or
offset between them. Press Freq Cpl ON | OFF to turn frequency coupling on or off, and press Freq Cpl Settings to
configure frequency coupling.

The Freq Cpl Settings softkey opens the menu shown below. The first softkey allows you to specify whether you want
to couple the frequencies with a ratio or an offset, and the second softkey allows you to specify the ratio or offset.
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TECHNOLOGIES

— | offser <
Frequency 1. oy 1 pyal Channel Operation Riatio

Amplitude 1! Frequencies Independent Freq Couple

Offset
Offset + Offset CH2 - CH1 = +0.000,000 Hz

Amplitudes & Offsets Independent

Phase 0.
Tracking

Amplitude Coupling

Amplitude coupling, enabled by the Ampl Cpl ON | OFF softkey, couples the amplitude and offset voltage between
the channels so that changing the amplitude or offset on one channel affects both channels.

Tracking

Tracking, configured by the Tracking softkey, has three modes: OFF, Identical, and Inverted.
- When tracking is OFF, the two channels operate independently.
- When tracking is Identical, they behave as one channel.

- The third mode, Inverted, makes the channels' outputs inverses of each other, resulting in a differential channel
using both outputs.

Combine

The Combine feature combines two outputs into one connector. If you choose CH2 from the Channel 1 menu, they
are combined on channel 1; choosing CH1 from the Channel 2 menu combines them on chanrel 2.

In the image below, the top waveform is a 100 mVpp, 1 kHz sine wave on channel 1, and the bottom waveform is a
100 mVpp, 5 kHz sine wave on channel 2.
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The image below shows the two outputs combined on channel 1. Note that the X-axis has been compressed
(zoomed out) to show more cycles.

DI B ] 4 Bk S by @ INe

Operating Information

The signals being combined do not have to be of the same type; for example, this image shows the same b kHz
channel on channel 2 combined with a 100 mVpp square wave on channel 1.

TR T T | o L L R

When signals are combined, the DC Offset values are not added together. Only the DC Offset from the receiving
channel is used in the combined output. The figure below shows 50 a mV DC Offset added to Channel 1. The 50 mV
offset added to Channel 2 is ignored.
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You may also use Combine with bursts. For example, consider the image below, which includes a 1 kHz sine wave on
channel T and three-cycle bursts of a 5 kHz sine wave on channel 2.

E e | e § [ ] W Bl BRI Pw f @ IR

When these signals are combined on channel 1, the result is a simple amplitude addition of the two signals, as
shown below.

E e | e § [ ] W Bl RIS w f @ IR

You also can combine the signals on channel 2, as shown below.

L B ] L} 4 G IR Bw 1 W ISe
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o Characteristics and Specifications

For the characteristics and specifications of the EDU33210 Series Trueform Arbitrary Waveform Generators, refer to
the data sheet at: https://www.keysight.com/us/en/assets/3121-1004/data-sheets/EDU33210-Series-20-MHz-
Function-Arbitrary-Waveform-Generators.pdf.
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o Measurement Tutorial

Arbitrary Waveforms
Quasi-Gaussian Noise
PRBS

Modulation

Burst

Frequency Sweep
Attributes of AC Signals
Signal Imperfections

This section describes theory of operation information for several
waveform types and instrument operating modes. The last two topics
include information that may help you improve signal quality.
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Arbitrary Waveforms

Arbitrary waveforms can meet needs not met by the instrument’s standard waveforms. For example, you might need
a unique stimulus, or you might want to simulate signal imperfections such as overshoot, ringing, glitching, or noise.
Arbitrary waveforms can be very complex, making them suitable for simulating signals in modern communications
systems.

You can create arbitrary waveforms from a minimum of 8 points up to 1,000,000 points. The instrument stores these
numeric data points, known as "samples," in memory and then converts them into voltages as the waveform is
generated. The frequency at which points are read is the "sample rate," and the waveform frequency equals the
sample rate divided by the number of points in the waveform. For example, suppose a waveform has 40 points and
the sample rate is 10 MHz. The frequency would be (10 MHz)/40 = 250 kHz and its period would be 4 ps.

The instrument can directly play .ARB files. To load the specified arb file (.arb) in Internal or USB memory, press
[Waveforms] > Arb > Arbs > Select Arb.

You can also import one column data files in .CSV format. To import a file, press [Waveforms] > Arb > Arbs > Import
Data. This opens a menu interface that quickly guides you through the process of importing a file.

Each value in the .CSV file is limited to 7 characters (include the minus sign and decimal point); for example -0.1234.

If the .CSV file has more than 7 characters, the function generator is unable to import the .CSV file.

Waveform Filters

The instrument includes two filters to smooth transitions between points as arbitrary waveforms are generated.
- Normal filter: A wide, flat frequency response, but its step response exhibits overshoot and ringing

- Stepfilter: A nearly ideal step response, but with more roll-off in its frequency response than the Normal filter
- Off: Output changes abruptly between points, with a transition time of approximately 10 ns.

Each filter’s cutoff frequency is a fixed fraction of the waveform’s sample rate. The Normal filter’s response is -3 dB at
27% of the sample rate and the Step filter’s response is -3 dB at 13% of the sample rate. For example, for an
arbitrary waveform at 100 MSa/s, the Normal filter’s -3 dB frequency bandwidth is 27 MHz.

Turning the filter off may change the sample rate to a lower rate if the sample rate was greater than 250 MSa/s
before the filter was turned off.

Quasi-Gaussian Noise

The Noise waveform is optimized for both quantitative and qualitative statistical properties. It does not repeat for
more than 50 years of continuous operation. Unlike a true Gaussian distribution, there is zero probability of getting a
voltage beyond the instrument’s Vpp setting. The crest factor (peak voltage divided by RMS voltage) is
approximately 4.6.

You can vary the Noise bandwidth from 1 mHz to the instrument's maximum bandwidth. The energy in the noise
signal is concentrated in a band from DC to the selected bandwidth, so the signal has greater spectral density in the
band of interest when the bandwidth setting is lower. In audio work, for example, you might set the bandwidth to 30
kHz, to make the audio band signal strength 30 dB higher than if the bandwidth were set to 30 MHz.
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PRBS

A Pseudo-Random Bit Sequence (PRBS) has two levels (high and low), and it switches between them in a manner
that is difficult to predict without knowing the sequence generation algorithm. A PRBS is generated by a linear-
feedback shift register (LFSR), shown below.

HOR

& &

s 1 | 2| 3|4 |5 —— 6|7 ]|8 |9 ——PRBS

An LFSR is specified by the number of stages it contains and which stages ("taps") feed the exclusive-or (XOR) gates
in its feedback network. The PRBS output is taken from the last stage. With properly chosen taps, an L-stage LFSR
produces a repetitive PRBS of length 2- - 1. The clocking frequency of the LFSR determines the "bit rate" of the

PRBS.
YoucansetLto 7,9, 11,1b, 20, or 23, resulting in sequences from 127 to 8,388,607 bits in length.

The default value for Lis 7, resulting in a sequence of 127 bits in length.

Modulation

Amplitude Modulation (AM)

The instrument implements two forms of AM:
- Double-sideband full-carrier (DSB-FC), which has an ITU designation of A3E and is used in AM broadcasting.
The equation for DSB-FC is

y()= [(16)+(%)-d-m(]-Agsin(wg b

where

m(t) is the modulating signal

A is the carrier amplitude

W, is the carrier frequency of the carrier

dis the "modulation depth," or fraction of the amplitude range is used by the modulation

For example, a depth setting of 80% varies the amplitude from 10% to 90% of the amplitude setting (90% - 10% =
80%) with either an internal or a full-scale (+5 V) external modulating signal. You may set depth as high as 120%, as
long as you do not exceed the instrument’s maximum output voltage of (+5 V into 50 Q, +10 V into high impedance).

The top trace below represents the modulating signal; the bottom trace represents the modulated carrier.
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- Double-sideband suppressed-carrier (DSSC). Many modern communications systems employ DSSC on each of
two carriers that have the same frequency but a 90-degree phase difference. This is called quadrature amplitude
modulation (QAM).

The equation for DSSC is
y(t)=d-m(t)-sin(w, t)

In DSB-SC, the carrier signal is inverted whenever m(t) < 0. For QAM, the second carrier signal would be cos(w, 1),
making it 90 degrees out of phase from the first carrier.

Frequency Modulation (FM)

Frequency modulation varies a carrier signal’s frequency according to the modulating signal:
y(©)=Assin[(wy+d-m(t) )-t]

where m(t) is the modulating signal and d is the frequency deviation. FM is called narrowband if the deviation is less
than 1% of the modulating signal’s bandwidth, and wideband otherwise. You can approximate the modulated
signal’s bandwidth with the following equations.

BW ~ 2-(Modulating Signal Bandwidth) for narrowband FM
BW = 2-(Deviation+Modulating Signal Bandwidth) for wideband FM

The top trace below represents the modulating signal; the bottom trace represents the modulated carrier.
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Phase Modulation (PM)

PM is similar to FM, but the phase of the carrier waveform is varied, rather than the frequency:
y(t)=sin[w, t+d-m(t) ]

where m(t) is the modulating signal and d is the phase deviation.

Frequency-Shift Keying (FSK) Modulation

FSK is similar to FM, except the carrier frequency alternates between two preset values, the carrier frequency and
the hop frequency. Sometimes the hop and carrier frequencies are called "Mark" and "Space," respectively. The rate
at which the switching between these values occurs is determined by an internal timer or the signal on the front
panel Ext Trig connector. Frequency changes are instantaneous and phase-continuous.

The internal modulating signal is a square wave with 50% duty cycle.

The top trace below represents the modulating signal; the bottom trace represents the modulated carrier.

[T 11773

Binary Phase Shift Keying (BPSK)

BPSK is similar to FSK, except it is the carrier’s phase, rather than its frequency, that switches between two values.
The rate at which the switching between these values occurs is determined by an internal timer or the signal on the
front panel Ext Trig connector. Phase changes are instantaneous.

The internal modulating signal is a square wave with 50% duty cycle.

Pulse Width Modulation (PWM)

PWM is only available for the Pulse waveform, and the pulse width varies according to the modulating signal. The
amount by which the pulse width varies is called the width deviation, and it can be specified as a percentage of the
waveform period (that is, duty cycle) or in units of time. For example, if you specify a pulse with 20% duty cycle and
then enable PWM with a 5% deviation, the duty cycle varies from 15% to 25% under control of the modulating
signal.
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Additive Modulation (Sum)

The "Sum" feature adds the modulating signal to the carrier. For example, you can add controlled amounts of
variable-bandwidth noise to a signal or create two-tone signals. The instrument's internal modulation generator can
produce the same continuous waveform as the main generator, so the Sum function lets you to create many signals
that would have required two instruments before.

The Sum feature increases the amplitude of the output signal by the amplitude of the modulating signal. This might
cause the instrument to switch to a higher output-voltage range, resulting in a momentary signal loss. If thisis a
problem in your application, turn on the Range Hold function. If the voltage increase could damage your device
under test, apply Voltage Limits.

Burst

You can configure the instrument to output a waveform with for a specified number of cycles, called a burst. You can
use burst in one of two modes: N-Cycle Burst (also called "triggered burst") or Gated Burst.

An N-Cycle burst consists of a specific number of waveform cycles (1 to 1,000,000) and is always initiated by a
trigger event. You can also set the burst count to "Infinite," which results in a continuous waveform once the
instrument is triggered.

In the image below, the top trace is the sync output, and the bottom one is the main output.

Three-Cycle Burst Waveform

For bursts, the trigger source can be an external signal, an internal timer, the key, or a command from the remote
interface. The input for external trigger signals is the front panel Ext Trig connector. This connector is referenced to
chassis ground (not floating ground). When not used as an input, the Ext Trig connector can be configured as an
output to enable the instrument to trigger other instruments at the same time that its internal trigger occurs.

An N-Cycle burst always begins and ends at the same point in the waveform, called the start phase.

In GATed burst mode, the output waveform is on or off, based on the signal at the front panel Ext Trig connector.
Select this signal's polarity using BURSt:GATE:POLarity. When the gate signal is true, the instrument outputs a
continuous waveform. When the gate signal goes false, the current waveform cycle is completed and the instrument
stops and remains at the voltage level corresponding to the waveform's starting burst phase. For a noise waveform,
the output stops immediately when the gate signal goes false.
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Frequency Sweep

Frequency sweeping is similar to FM, but no modulating waveform is used. Instead, the instrument sets the output
frequency based on either a linear or logarithmic function, or a list of up to 128 user-specified frequencies. A linear
sweep changes the output frequency by a constant number of Hz per second, and a logarithmic sweep changes the
frequency by a constant number of decades per second. Logarithmic sweeps let you cover wide frequency ranges
where resolution at low frequencies could be lost with a linear sweep.

Frequency sweeps are characterized by a sweep time (during which the frequency changes smoothly from the start
frequency to the stop frequency), a hold time (during which the frequency stays at the stop frequency), and a return
time (during which the frequency returns smoothly and linearly to the start frequency). Trigger settings determine
when the next sweep begins.

Frequency
A
Frequency
Start |
Frequency
Sweep , Hod ‘_Retu‘n_,i
Time Time Time
(Trigger starts sweep) (Trigger stats next sweep)
Attributes of AC Signals

The most common AC signal is a sine wave. In fact, any periodic signal can be represented as the sum of different
sine waves. The magnitude of a sine wave is usually specified by its peak, peak-to-peak, or root mean-square (RMS)
value. All of these measures assume that the waveform has zero offset voltage.

N VF'B&"C
URMS =0.707 UPEEF:

Vpkpx

{:—T=% >

A waveform's peak voltage is the maximum absolute value of all of its points. The peak-to-peak voltage is the
difference between the maximum and minimum. The RMS voltage equals the standard deviation of all waveform
points; it also represents the one-cycle average power in the signal, minus the power in any DC component of the
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signal. Crest factor is the ratio of a signal’s peak value to its RMS value and varies according to waveshape. The table
below shows several common waveforms with their respective crest factors and RMS values.

Waveform Crest Factor AC+DC
Shape (C.F.) AC RMS RMS
¥—
L' v
° 141 1.414 1.414

::%— 1.732 555 355
v —

||
T Vv oVl o

If an average-reading voltmeter is used to measure the "DC voltage" of a waveform, the reading may not agree with
the DC Offset setting. This is because the waveform may have a non-zero average value that would be added to the
DC Offset.

You may occasionally see AC levels specified in "decibels relative to 1 milliwatt" (dBm). Since dBm represents a
power level, you need to know the signal’s RMS voltage and the load resistance in order to make the calculation.

dBm =10 x logq (P/ 0.001) where P = VRMS? / RL

For a sine wave into a 50 Q load, the following table relates dBm to voltage.

dBm RMS Voltage Peak-to-Peak Voltage
+23.98 dBm 3.54Vrms 10.00 Vpp
+13.01 dBm 1.00 Vrms 2.828 Vpp
+10.00 dBm 707 mVrms 2.000 Vpp
+6.99 dBm 500 mVrms 1.414 Vipp
3.98dBm 354 mVrms 1.000 Vpp
0.00 dBm 224 mVrms 632 mVpp
-6.99 dBm 100 mVrms 283 mVpp
-10.00 dBm 70.7 mVrms 200 mVpp
-16.02 dBm 35.4 mVrms 100 mVpp
-30.00 dBm 7.07 mVrms 20.0mVp
-36.02 dBm 3.54 mVrms 10.0 mVpp
-50.00 dBm 0.707 mVrms 2.00 mVpp
-56.02 dBm 0.354 mVrms 1.00 mVpp

For 75 Q or 600 Q loads, use the following conversions:

dBm (75 Q) =dBm (50 Q) - 1.76
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dBm (600 Q) = dBm (50 Q) - 10.79

Signal Imperfections

For sine waves, common signal imperfections are easiest to describe and observe in the frequency domain, using a
spectrum analyzer. Any output signal component with a frequency different from the fundamental (or "carrier") is
considered to be distortion. Those imperfections can be categorized as harmonic distortion, non-harmonic spurious,
or phase noise, and they are specified in decibels relative to the carrier level, or "dBc."

Harmonic Distortion

Harmonic components occur at integer multiples of the fundamental frequency and are usually created by non-
linear components in the signal path. At low signal amplitudes, another possible source of harmonic distortion is the
Sync signal, which is a square wave with many strong harmonic components that can couple into the main signal.
Although Sync is highly isolated from the instrument's main signal outputs, coupling can occur in external cabling.
For best results, use high-quality coaxial cables with double or triple shields. If Sync is not required, leave it
unconnected or off.

Non-Harmonic Spurious

One source of non-harmonic spurious components (called "spurs") is the digital-to-analog converter (DAC) that
converts the digital waveform values into voltage. Non-linearity in this DAC gives rise to harmonics that can be
higher than the Nyquist frequency and will therefore be aliased to a lower frequency. For example, the fifth harmonic
of 30 MHz (150 MHz) could create a spur at 100 MHz.

Another source of non-harmonic spurs is the coupling of unrelated signal sources (such as the embedded
controller’s clocks) into the output signal. These spurs usually have constant amplitude and are most troublesome at
signal amplitudes below 100 mVpp. For optimal signal purity at low amplitudes, keep the instrument’s output level
relatively high and use an external attenuator.

Phase Noise

Phase noise results from small, instantaneous changes in the output frequency ("jitter"). On a spectrum analyzer, it
appears as a rise in the apparent noise floor near the frequency of the output signal. The phase noise specification
represents the amplitudes of the noise in 1 Hz bands located 1 kHz, 10 kHz, and 100 kHz away from a 30-MHz sine
wave. Be aware that spectrum analyzers also have phase noise, so the levels you read may include analyzer phase
noise.

Quantization Noise

Finite resolution in the waveform DAC causes voltage quantization errors. Assuming the errors are uniformly
distributed over a range of £0.5 least-significant bit, the equivalent noise level for standard waveforms is
approximately -95 dBc. At this level, other sources of noise in the instrument dominate. Quantization noise can be of
concern, though, in arbitrary waveforms that do not use the whole range of DAC codes (-32767 to +32767). Scale
arbitrary waveforms to use the entire range, if possible.
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Licences technologiques

Le matériel et les logiciels décrits dans ce document sont protégés par un accord de licence et leur utilisation ou
reproduction est soumise aux termes et conditions de ladite licence.
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Droits du Gouvernement des Etats-Unis

Le Logiciel est un «logiciel informatiqgue commercial » tel que défini par la Federal Acquisition Regulation

(«FAR ») 2.101. Conformément aux FAR 12.212 et 27.405-3 et a 'addenda FAR du Ministére de la défense

(« DFARS ») 227.7202, le gouvernement des Etats-Unis acquiert des logiciels informatiques commerciaux dans les
mémes conditions que celles dans lesquelles les logiciels sont habituellement fournis au public. De ce fait, Keysight
fournit le Logiciel aux clients du gouvernement des Etats-Unis sous la licence commerciale standard, incluse dans
son contrat de licence d'utilisateur final (EULA). Vous trouverez une copie de ce contrat sur le site
http://www.keysight.com/find/sweula. La licence mentionnée dans 'EULA représente l'autorité exclusive par
laguelle le gouvernement des Etats-Unis est autorisé & utiliser, modifier, distribuer ou divulguer le Logiciel. L'EULA
et la licence mentionnées dans les présentes n'imposent ni n'autorisent, entre autres, que Keysight : (1) fournisse
des informations technigues relatives au logiciel informatique commercial ni a la documentation du logiciel
informatique commercial non habituellement fournies au public ; ou (2) abandonne, ou fournisse, des droits
gouvernementaux dépassant les droits habituellement fournis au public pour utiliser, reproduire, communiquer,
exécuter, afficher ou divulguer le logiciel informatique commercial ou la documentation du logiciel informatique
commercial. Aucune exigence gouvernementale autre que celle établie dans l'EULA ne s'applique, sauf dans la
mesure ou ces conditions, droits ou licences sont explicitement requis de la part de tous les prestataires de logiciels
commerciaux conformément a la FAR et au DFARS et sont spécifiquement établis par écrit ailleurs dans 'EULA.
Keysight n’est en aucun cas tenu de mettre a jour, de réviser ou de modifier de quelque fagon que ce soit le Logiciel.
En ce qui concerne toutes les données techniques telles que définies par la FAR 2.101, conformément aux FAR
12.211 et 27.404.2 et au DFARS 227.7102, le gouvernement des Ftats-Unis acquiert des droits n’excédant pas les
Droits limités tels que définis dans la FAR 27.401 ou le DFAR 227.7103-5 (c), applicables dans toutes les données
techniques.

Licences tierces

Certaines parties de ce logiciel sont concédées sous licence par des tiers, y compris les conditions générales Open
Source. Dans la mesure ou ces licences exigent que Keysight mette le code source a disposition, nous le ferons
gratuitement. Pour plus d'informations, veuillez contacter l'assistance Keysight, a l'adresse
https://www.keysight.com/find/assist.

Déchets d’équipements électriques et électroniques (DEEE)

Ce produit est conforme aux exigences de marquage de la directive DEEE. L’étiquette collée sur le produit (voir ci-
dessous) indique que vous ne devez pas jeter cet appareil électrique/électronique avec les ordures ménageres.

Catégorie du produit : par référence aux types d'équipements décrits dans l'annexe 1 de la directive WEEE, ce
produit est classé comme un produit "d'instrumentation de surveillance et de contréle". Ne le jetez pas avec les
ordures ménageres.

Pour retourner vos produits usagés, contactez votre revendeur Keysight le plus proche ou visitez

about.keysight.com/en/companyinfo/environment/takeback.shtml pour de plus amples informations.
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Assistance technique

Pour toute question concernant votre livraison ou pour obtenir des informations sur la garantie, la maintenance ou
l'assistance technique, contactez Keysight Technologies : www.keysight.com/find/assist.

Certificats de conformité

Il est possible de télécharger la Déclaration de conformité pour ces produits et d'autres produits Keysight sur le
Web. Consultez https://regulations.about.keysight.com/DoC/default.htm. Vous pouvez ensuite effectuer une
recherche par numéro de produit pour trouver la derniere déclaration de conformité.

Informations relatives a la sécurité

La mention ATTENTION signale un danger pour le matériel. Si la manceuvre ou la procédure correspondante n’est pas exécutée cor-
rectement, il peut y avoir un risque d’endommagement de 'appareil ou de perte de données importantes. En présence de la men-

tion ATTENTION, il convient de ne pas poursuivre tant que les conditions indiquées n’ont pas été parfaitement comprises et
remplies.

AVERTISSEMENT

La mention AVERTISSEMENT signale un danger pour la sécurité de l'opérateur. Si la manceuvre ou la procédure correspondante
n’est pas exécutée correctement, il peut y avoir un risque grave, voire mortel pour les personnes. En présence de la mention

AVERTISSEMENT, il convient de ne pas poursuivre tant que les conditions indiquées n'ont pas été parfaitement comprises et res-
pectées.
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Informations relative a la sécurité et a la réglementation

Consignes de sécurité

Les consignes de sécurité présentées dans cette section doivent étre appliquées dans toutes les phases de
l'utilisation, de U'entretien et de la réparation de cet équipement. Le non-respect de ces précautions ou des
avertissements spécifiques mentionnés dans ce manuel constitue une violation des normes de sécurité établies lors
de la conception, de la fabrication et de U'usage normal de linstrument. Keysight Technologies ne saurait étre tenu
responsable du non-respect de ces consignes.
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BT CENERAL

N'utilisez pas ce produit d’'une autre maniere que celle spécifiée par le fabricant. Les caractéristiques de protection de
ce produit peuvent étre affectées s'il est utilisé d'une maniére non indiquée dans les instructions de fonctionnement.

AVANT LA MISE SOUS TENSION
Vérifiez que vous avez bien respecté toutes les consignes de sécurité. Effectuez tous les branchements a 'appareil
avant de le mettre sous tension.

MISE A LA TERRE DE L’INSTRUMENT

Ce produit comporte des bornes de terre de protection. Afin de réduire les risques d’électrocution, l'instrument doit
étre relié a une source de courant alternatif par l'intermédiaire d’un cordon d’alimentation alternative secteur pourvu
d’un fil de terre connecté fermement a une terre électrique (terre de sécurité) au niveau de la prise de courant. Toute
interruption du conducteur de protection (mise a la terre) ou tout débranchement de la borne de terre de protection
entraine un risque d'électrocution pouvant provoquer des accidents graves.

NE L’UTILISEZ PAS DANS UNE ATMOSPHERE EXPLOSIVE OU DES ENVIRONNEMENTS HUMIDES
N'utilisez pas l' instrument dans des environnements avec des gaz ou des fumées inflammables, de la vapeur ou des
environnements humides.

NE FAITES PAS FONCTIONNER DES INSTRUMENTS ENDOMMAGES OU DEFECTUEUX
Les instruments endommagés ou défectueux doivent étre désactivés et protégés contre toute utilisation involontaire
jusqu'a ce qu'ils aient été réparés par une personne qualifiée.

NE REMPLACEZ JAMAIS DE COMPOSANTS ET N'APPORTEZ AUCUNE MODIFICATION A
L'INSTRUMENT.

En raison des risques éventuels supplémentaires, ne remplacez pas de composants et n'apportez aucune modification
non autorisée a l'instrument. Pour tout entretien ou réparation, renvoyez le produit a un bureau de ventes et de ser-
vice apres-vente Keysight Technologies. Ainsi, l'intégrité des fonctions de sécurité sera maintenue. Pour contacter
Keysight afin d'obtenir un support technique et commercial, consultez les liens d'assistance sur le site Web Keysight
suivant : www.keysight.com/find/assist (informations de contact dans le monde entier pour les réparations et le
support).

UTILISER LE CORDON D’ALIMENTATION FOURNI
Utilisez l'instrument avec les cordons d’alimentation fournis avec la livraison.

NE BLOQUEZ PAS LES ORIFICES D’AERATION
Ne bloquez aucun des orifices d’aération de l'instrument.

OBSERVEZ TOUTES LES MARQUES SUR L'INSTRUMENT AVANT DE VOUS CONNECTER A UN
INSTRUMENT
Observez tous les marquages portés par l'instrument avant de le brancher.

VERIFIEZ QUE LE CAPOT EST BIEN EN PLACE
Ne faites pas fonctionner l'instrument avec son capot démonté ou détaché. Il est recommandé de ne faire appel qua
du personnel qualifié, formé a la maintenance pour retirer le capot de l'instrument.

VERIFIEZ LE BON POSITIONNEMENT DE L'INSTRUMENT
Ne positionnez pas l'instrument dans une zone qui posera des difficultés pendant la déconnexion de linstrument.
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CABLE D’ALIMENTATION CA
La dépose du cable d’alimentation est la méthode de déconnexion utilisée pour couper l'alimentation de l'instrument.
Assurez-vous que 'accés au cable d’alimentation est adéquat afin de permettre la déconnexion de 'alimentation sec-

teur. Utilisez uniquement le cable d’alimentation défini par Keysight pour le pays d’utilisation ou un cable de per-
formances équivalentes.

NETTOYEZ AVEC UN CHIFFON LEGEREMENT HUMIDE
Nettoyez les parties externes de l'instrument a l'aide d'un chiffon doux non pelucheux légerement humidifié. N'utilisez
pas de détergent, de liquides volatiles ou de solvants chimiques.

Symboles de sécurité

Symbole Description

i"f Attention, risque de danger (repartez-vous au manuel pour des informations détaillées sur les avertissements et les mises en
garde)

@ Borne de terre de protection (masse)

Mise a la terre

~ Courant alternatif (CA)

12 Guide de I'utilisateur Keysight série EDU33210



Marquages réglementaires

Symbole Description

c € ICES/NMB-001| Le label CE est une marque déposée de la Communauté Européenne. Cette marque CE montre que le produit
ISMGRP 1-A | cst conforme a toutes les Directives juridiques européennes pertinentes.

ICES/NMB-001 indique que cet appareil ISM est conforme a la norme canadienne ICES-001.

Cet appareil ISM est conforme a la norme NMB-001 du Canada.

La classe AISM GRP 1 indique qu'il s’agit d’un produit industriel scientifique et médical de groupe 1 classe A.

La mention CSA est une marque déposée de la Canadian Standards Assaciation.

La marque RCM est une marque déposée de 'Australian Communications and Media Authority.

Ce symbole indique la période pendant laguelle aucune détérioration ou fuite de substances toxiques ou
dangereuses n’est a attendre dans le cadre d’une utilisation normale. La durée de vie prévue du produit est de
quarante ans.

Ce symbole est une déclaration EMC de classe A de Corée du Sud. Il s'agit d'un instrument de classe A adapté a
un usage professionnel dans un environnement électromagnétique en dehors du domicile.

Cetinstrument est conforme aux exigences de marquage de la directive DEEE. L'étiquette apposée sur le pro-
duit indigue que vous ne devez pas jeter ce produit électrique ou électronique avec les ordures ménageres.

It= O ®

Déclaration sud-coréenne de CEM de classe A :
Information a l'utilisateur :

La conformité de cet équipement pour une utilisation dans des environnements professionnels a été évaluée. Dans
un environnement résidentiel, cet équipement peut causer des interférences radio.

- Cette déclaration EMC ne s'applique que pour les équipements utilisés uniguement dans un environnement
professionnel.
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Exigences de sécurité et de CEM

Cette alimentation est congue de maniere a se conformer aux exigences de sécurité et de compatibilité CEM
(Compatibilité électromagnétique) suivantes :

- Directive basse tension 2014/35/EU
- Directive CEM 2014/30/EU

Conditions d’environnement

Cet instrument est concu pour étre utilisé dans des locaux fermés ou la condensation est faible. Le tableau ci-
dessous illustre les conditions d’environnement générales requises pour cet instrument.

Environnement Exigences

Température Conditions de fonctionnement: 0a 55 °C
Conditions de stockage : -40°Ca 70°C

Humidité Conditions de stockage/fonctionnement : Jusqu'a 80 % HR a des températures allant
jusqu’a 40 °C (sans condensation)

Altitude Jusqu'a 3000 m

Degré de pollution 2

Catégorie de surtension I
Alimentation électrique et fréquence de 100/120V, 100/240V

ligne 50/60 Hz

Consommation d’énergie <4HW

Fluctuations de la tension de Les fluctuations de la tension d’alimentation du réseau principal ne doivent pas dépasser
l'alimentation secteur 10 % de la principale tension nominale
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1 Présentation de l'instrument

Présentation succincte de l'instrument
Présentation succincte du panneau avant
Présentation succincte de 'écran du panneau avant
Saisie d’une valeur numérique sur le panneau avant
Présentation succincte du panneau arriere
Dimensions de l'instrument

Le générateur de signaux arbitraires Keysight EDU33210 série Trueform
comprend des générateurs de signaux synthétisés dotés de
fonctionnalités prédéfinies de signaux et impulsions arbitraires.
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Présentation succincte de l'instrument

Le générateur de signaux arbitraires Keysight EDU33210 série Trueform comprend des générateurs de signaux
synthétisés dotés de fonctionnalités prédéfinies de signaux et impulsions arbitraires.

Deux modeles sont disponibles :

- EDU33211A: 20 MHz, générateur de signaux arbitraires Trueform a voie unique

- EDU33212A: 20 MHz, Générateur de signaux arbitraires Trueform a deux voies
Principales fonctions :

- Modulation intégrée et 17 signaux populaires

- Fonctionnalité de signaux arbitraires a 16 bits avec une mémoire de jusqu’a 8 Msa/voie
- Deux voies indépendantes qui peuvent étre couplées en amplitude et fréquence (EDU33212A)
— Ecran WVGA de 7 pouces couleur riche en informations

- Excellente utilisabilité

- Interface d’E/S USB et LAN

- Interface Web

- Compatibilité SCPI (Standard Commands for Programmable Instruments)

- Logiciel PathWave BenchVue inclus

- Garantie de 3 ans standard
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Présentation succincte du panneau avant

KEYSIGHT EDU33212A Waveform Generator

SIN,50Q

Frequency 1.000,000,000 kHz 1.000,000,000 kHz

Amplitude 100.0 mVpp 100.0 mVpp Frequency
Offset +0.000V +0.000V

Phase 0.0° 0.0°

100.00% Amplitude

\\/

A0 | —)

= |

Channel 2

<

1 Ecran WVGA 7 pouces -écran Voie 1

2 Fcran voie 2 (EDU33212A uniquement)

3 Interrupteur [ON/OFF]

4 Port USB — Permet de raccorder un périphérigue de stockage USB a l'instrument

La série EDU33210 prend en charge les clés USB dotées des spécifications
suivantes : USB 2.0, format FAT32, jusqu'a 32 Go. Nous recommandons d’utiliser
un périphérique flash SanDisk Cruzer Blade pour le port USB du panneau avant.

5 Bouton [Back]

Maintenez le bouton [Back] enfoncé pendant plus de 3 secondes avec une clé
USB externe connectée afin de capturer automatiquement 'écran de linstrument.
L'image capturée sera enregistrée sur la clé USB connectée.

6 Touches de fonction du menu

7 Connecteur CAL

8 Connecteur déclenchement externe/Porte/FSK/Rafale

9 Connecteur de déclenchement en sartie/synchronisation

10 Boutons a fonction fixe

[N Clavier numérique

12 Bouton et touches fléchées

13 Connecteurs de voie 1 et voie 2 (EDU33212A uniquement) et boutons associés
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Présentation succincte de 'écran du panneau avant

Affichage d’une seule voie

KEYSIGHT

TECHNOLOGIES

Parameter

Frequency 1.000,000,000 kHz Frequency

Amplitude 1.000 mVpp Amplitude

Offset +1.000V

Phase 0.0°

1 Informations sur la voie 1

Voyants d’état

Parametres du signal de la voie 1

Parametres de balayage, de modulation ou de rafale
Affichage du signal de la voie

Nom de la fonction

~N| OO o W N

Libellés des touches de fonction

18 Guide de I'utilisateur Keysight série EDU33210



Affichage a double voie (applicable au EDU33212A uniguement)

Appuyez deux fois sur [Setup] pour accéder au mode double voie. Dans ce mode, appuyez sur [Setup] pour basculer

entre la vue en voie unique et la vue en voie double.

Frequency 1.000,000,000 kHz equency 1.000,000,000 kHz

Amplitude 100.0 mVpp Am 100.0 mVpp

Offset +0.000V ffset +0.000V

Phase 0.0° ‘ 0.0°
100.00 %

KEYSIGHT

TECHNOLOGIES
Output

Qutput
~5-

Range
Suto Hold

Polarity
Mormal " Inverted

Voltage Limits
-

Mormal  Gated

—

Informations sur la voie 1
Informations sur la voie 2
Voyants d’état

Parametres du signal de la voie 1
Parametres du signal de la voie 2
Affichage du signal de la voie 1
Affichage du signal de la voie 2

Nom de la fonction

O | 0| O |lo | &~ w N

Libellés des touches de fonction

Témoins d’état de l'instrument

- Affiché lorsque le mode distant est activé

- Affiché apres 'envoi de la commande SYSTem RWL

La clé USB est connectée

@ Le LAN est connecté

Guide de I'utilisateur Keysight série EDU33210
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Légende Description
- Une erreur s’est produite sur linstrument

Saisie d’une valeur numérique sur le panneau avant

Vous pouvez saisir des nombres sur le panneau avant en utilisant une de ces deux méthodes :

- Utilisez le bouton et les touches fléchées pour modifier le nombre. Tournez le bouton pour madifier un chiffre
(dans le sens des aiguilles d’'une montre pour l'augmenter). Les fleches sous le bouton déplacent le curseur.

- Utilisez le clavier numérique pour saisir des nombres et les touches de fonction pour sélectionner les unités. La
touche [+/-] change le signe du nombre.

Présentation succincte du panneau arriere

2045
MADE IN CHINA MAY CONTAN FOREIGN OR DOMESTIC COMPONENTS

2-Channel Waveform Generator o
&'E EDU33212A S/N:Cwmmesunes %
MAC: I AT

Légende Description

1 verrou Kensington

2 Connecteur de linterface USB-B (Bus série universel)
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Connecteur de linterface du réseau local (LAN)
Connecteur d’alimentation CA
Ventilateur

Numéro de série de l'instrument et adresse MAC

~N| O |o | &~ W

Etiquettes de sécurité et réglementaires de linstrument

Il s’agit d’'un équipement de classe de protection 1 (le chéssis doit étre connecté a une mise a la terre de protection).
La fiche d’alimentation secteur doit étre branchée dans une prise murale dotée d’'une borne de mise a la terre de pro-
tection.

Dimensions de l'instrument

Hauteur : 164,70 mm x Largeur : 313,60 mm
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Longueur: 124,58 mm

124.58
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2 Mise en route

Préparer linstrument avant utilisation
Définir la fréquence de sortie

Définir 'amplitude de sortie

Définir la tension CC de décalage

Définir des valeurs haut et bas

Envoyer une tension continue

Définir le rapport cyclique d’un signal carré
Configurer un signal d’impulsions
Sélectionner un signal arbitraire prédéfini
Utiliser le systéme d’aide intégré

Mettre a jour le microprogramme
Connexions de l'interface de commande a distance
Configuration de l'interface distante
Commande a distance

Cette rubrique décrit les procédures de base pour vous aider a utiliser
rapidement Uinstrument.
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Préparer l'instrument pour l'utilisation

Lorsque vous recevez votre instrument, inspectez-le pour déceler tout dommage évident qui aurait pu survenir
pendant U'expédition. En cas de dommage, informez immédiatement le transporteur et le bureau de vente et
d’assistance Keysight le plus proche. Rendez-vous sur www.keysight.com/find/assist.

Jusqu'a ce que vous ayez vérifié l'instrument, conservez le carton d'expédition et les matériaux d'emballage au cas
ou l'appareil devrait étre retourné. Vérifiez que vous avez regu avec votre instrument tous les éléments de la liste ci-
dessous. Si un composant est manquant, contactez votre bureau commercial et d'assistance Keysight le plus
proche.

- Guide de démarrage rapide

- Cordon d’alimentation AC (adapté au pays)

- Certificat d’étalonnage et Notice sur la durée de conservation
- Brochure sur la sécurité Keysight (9320-6797)

- Addendum RoHS pour les générateurs de signaux arbitraires (Chine) (9320-6667)

Révisions de la documentation et du micrologiciel

La documentation indiquée ci-dessous peut étre téléchargée gratuitement sur notre site Web a 'adresse
www.keysight.com/find/EDU33211A-manuals.

- Guide de démarrage rapide des générateurs de signaux arbitraires Keysight EDU33210 série Trueform.

- Guide utilisateur des générateurs de signaux arbitraires Keysight EDU33210 série Trueform. Le présent manuel.
- Guide de programmation des générateurs de signaux arbitraires Keysight EDU33210 série Trueform.

- Guide des services des générateurs de signaux arbitraires Keysight EDU33210 série Trueform.

Pour obtenir la derniére révision du micrologiciel et les instructions de mise a jour du micrologiciel, rendez-vous sur
le site.

-EDU33211A: www.keysight.com/find/EDU33211A-sw
-EDU33212A: www.keysight.com/find/EDU33212A-sw

Intervalle d’étalonnage recommandé

Keysight Technologies recommande un cycle d’étalonnage d’un an pour cet instrument.

Paramétrer l'instrument

Placez les pieds de l'instrument sur une surface horizontale plate et lisse. Fixez le cable d’alimentation sur le
panneau arriere, puis branchez-le sur l'alimentation secteur. Connectez les cables LAN ou USB comme vous le
souhaitez et vous pouvez également sécuriser linstrument avec un céble de verrouillage de sécurité. Enfin, allumez
linstrument en utilisant le bouton [On/Off] du panneau avant.
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L'instrument exécute un autotest a la mise sous tension et affiche ensuite un message qui expligue comment obtenir
de l'aide et indique 'adresse IP actuelle.
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Définir la fréquence de sortie

La fréquence par défaut est égale a 1 kHz. Vous pouvez modifier cette fréquence et la spécifier en nombre de
périodes au lieu de Hz.

Appuyez sur [Parameter] > Frequency.

KEYSIGHT

TECHNOLOGIES

Parameter

Frequency  [J000.000000 Frequency

Amplitude 100.0 mVpp Amplitude

Offset +0.000V

Dffset
Phase 0.0°

Phase
~-

- Utilisez le bouton rotatif pour modifier la valeur numérigue et/ou utilisez les touches fléchées pour déplacer le
curseur vers le chiffre suivant ou précédent ou

- Utilisez le clavier numérique pour entrer une valeur. Sélectionnez une unité de préfixe (uHz, mHz, Hz, kHz, ou
MHz) pour confirmer vos modifications.

Appuyez sur [Units] > Frequency Periodic pour modifier les unités en période au lieu de fréquence.

Units

Frequency

Period  100.000 ps | | -

Amplitude 100.0 mVpp »  AmplOffs <
High/Low

Offset +0.000V
Amplitude

Phase 0.0° Y J -

Phase

Degrees

Sweep
StrtStop

26 Guide de I'utilisateur Keysight série EDU33210



Définir lamplitude de sortie
La fonction par défaut de linstrument est un signal sinusoidal 1 kHz / 100 mVpp (dans une terminaison de 50 Q).
Les opérations suivantes modifient 'amplitude avec 50 mVpp.

. Appuyez sur [Units] > Amp/Offs High/Low pour spécifier la tension comme amplitude et décalage.

L'amplitude affichée est la valeur de mise sous tension ou la valeur sélectionnée précédemment. Lorsque vous chan-
gez des fonctions, la méme amplitude est utilisée si la valeur présente est valide pour la nouvelle fonction. Pour choi-
sir de spécifier une tension sous forme de valeurs haute et basse, appuyez sur Amp/Offs High/Low.

Dans cet exemple, nous affichons en surbrillance Amp/Offs High/Low.

KEYSIGHT

TECHNOLOGIES
[nits

» Frequency <

Frequency 1.000,000,000 kHz Periodic

Amplitude 100.0 mVpp »  Amp/Offs <
High/Low

Offset +0.000V

Amplitude

Phase 0.0° -

Phase
Degrees

Sweep
Stristop
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2. Entrezla valeur de 'amplitude désirée.

Appuyez sur [Parameters] > Amplitude. A l'aide du pavé numérique, saisissez la valeur 50.

Frequency 1.000,000,000 kHz

Amplitude 50 _
Offset +0.000V

Phase 0.0°

3. Sélectionnez 'unité voulue.

Pour cela, appuyez sur la touche de fonction correspondant a U'unité désirée. Lorsque vous sélectionnez l'unité,
linstrument envoie le signal avec 'amplitude affichée (si la sortie est activée). Dans cet exemple, appuyez sur mvVpp.

Vous pouvez également entrer la valeur voulue en utilisant le bouton et les fleches. Si vous procédez ainsi, vous
n’avez pas besoin d’utiliser la touche de fonction des unités. Vous pouvez facilement convertir les types d’unité.
Appuyez simplement sur [Units] > Amplitude et sélectionnez les unités voulues.

Frequency 1.000,000,000 kHz
Amplitude 50.00 mVpp

Offset +0.000V

Phase 0.0°

28

KEYSIGHT

TECHNOLOGIES
[nits
» Frequency <

Periodic

»  Amp/Offs <
High/Low
Amplitude

Vop

Phase
Degrees

Sweep
Stristop
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Définir la tension CC de décalage

A la mise sous tension, la tension CC de décalage est nulle (O V). Les opérations suivantes modifient la tension de
décalage avec -1,5 Vcc.

1. Appuyez sur [Parameter] >Offset.
La tension continue de décalage affichée est la valeur de mise sous tension ou la valeur sélectionnée pré-

cédemment. Lorsque vous changez de fonction, la méme tension continue de décalage est utilisée si la valeur pré-
sente est valide pour la nouvelle fonction.

KEYSIGHT

Parameter
Frequency 1.000,000,000 kHz Frequency

Amplitude 50.00 mVpp Amplitude

Offset [Joooo v

Phase 0.0°

2. Entrez la tension de décalage voulue.
Dans ce cas nous utilisons le clavier numérique pour entrer 1,5.

Skl
Frequency 1.000,000,000 kHz

Amplitude 50.00 mVpp

Offset 15

Phase 0.0°
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3. Sélectionnez 'unité voulue.

Appuyez sur la touche de fonction correspondant a U'unité voulue. Lorsque vous sélectionnez Uunité, Uinstrument
envoie le signal avec la tension de décalage affichée (si la sortie est activée). Pour cet exemple, appuyez sur V. La
tension sera définir comme indiqué ci-dessous.

Parameter
Frequency 1.000,000,000 kHz Fraquency

Amplitude 50.00 mVpp Amplitude

Offset 5000 v

Dffset
Phase 0.0°

Phase
-

Vous pouvez également entrer la valeur voulue en utilisant le bouton et les fleches.

Définir des signaux hauts et bas

Vous pouvez spécifier un signal en indiquant son amplitude et sa tension CC de décalage (voir ci-dessus). Vous
pouvez également spécifier le signal avec des valeurs haute (maximum) et basse (minimum). Cela est
particulierement intéressant pour les applications numériques. Dans 'exemple suivant, nous réglons le niveau haut
a1,0Vetleniveaubasa0,0V.
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1. Appuyez sur [Units] > Ampl/Offs High/Low. Basculez sur High/Low comme indiqué ci-dessous.

KEYSIGHT

TECHNOLOGIES

Units

FT'E!V] uency 4

Frequency 1.000,000,000 kHz Periodc

High Level +50.00 mV Amp/0ffs
H\ fh“” O 4

Low Level -50.00 mV

Phase 0.0°

2. Appuyez sur [Parameter] > High Level. Sur le clavier numérique ou avec le bouton et les fleches, sélectionnez 1,0 V.
(Sivous utilisez le clavier, vous devez sélectionner la touche de fonction de 'unité V pour entrer la valeur.)

S
Frequency 1.000,000,000 kHz
High Level 1.0

Low Level -50.00 mV

Phase 0.0°
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3. Appuyez sur la touche de fonction Low Level et indiguez la valeur. Utilisez a nouveau le pavé numérique ou le bou-
ton rotatif pour indiquer 0.0 V.

KEYSIGHT

TECHNOLOGIES

Frequency 1.000,000,000 kHz

High Level +1.000V

Low Level 0.0_

Phase 0.0°

Ces réglages (niveau haut = 1.0 V et niveau bas = 0.0 V) sont équivalents a un réglage d’amplitude de 1.0 Vpp et de
tension de décalage égale a 500 mV.
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1.

Envoyer une tension continue
Vous pouvez envoyer une tension CC constante comprise entre -5 V et +5 V dans une résistance de 50 Q, ou de -10
V a+10V dans une charge de haute impédance.

Appuyez sur [Waveform] > MORE 1 /2 > DC > Offset. La valeur décalage est alors sélectionnée.

KEYSIGHT

TECHNOLOGIES
Parameter

Dffset

5000 v

2. Entrez la tension de décalage voulue. Entrez 1.0 sur le clavier numérique ou avec le bouton et appuyez sur la touche

de fonction V si vous utilisez le clavier.

KEYSIGHT

TECHNOLOGIES

Offset 1.0_
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Définir le rapport cyclique d’un signal carré

A la mise sous tension, le rapport cyclique par défaut d’un signal carré est égal & 50 %. Le rapport cyclique est limité
par la largeur minimale des impulsions spécifiée de 16 ns. La procédure suivante modifie le rapport cyclique avec la
valeur 75 %.

1. Sélectionnez la fonction de signal carré.
Appuyez sur [Waveform] > Square.

KEYSIGHT
TECH OGIES

Frequency 1.000,000,000 kHz Frequency

High Level +1.000V High Level

Low Level -1.000 mV

Low Level
Phase 0.0°

Duty Cycle 50.00 % Phase
~5-

Duty Cycle

2. Appuyez sur la touche de fonction Duty Cycle.

Le rapport cycligue affiché est la valeur de mise sous tension ou le pourcentage sélectionné précédemment. Le rap-
port cycligue représente la durée par cycle pendant laquelle le signal carré est au niveau haut.

KEYSIGHT
TECHNOLOGIES

Parameter
Frequency 1.000,000,000 kHz Fraquency

High Level +1.000V High Level
igh Leve

Low Level -1.000 mV

Low Level
Phase 0.0°

Duty Cycle @.00 % Phase
~-

Duty Cycle
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3. Saisissez le rapport cyclique voulu.

A l'aide du pavé numérique ou du bouton rotatif et des fleches, sélectionnez un rapport cyclique de 75. Si vous uti-
lisez le clavier numérique, appuyez sur Percent pour terminer la saisie. L'instrument regle immédiatement le rapport
cyclique et délivre un signal carré ayant la valeur mentionnée (si la sortie est activée).

KEYSIGHT

TECHNOLOGIES

Frequency 1.000,000,000 kHz Percent

High Level +1.000V

Low Level -1.000 mV

Phase 0.0°
Duty Cycle 75_

Configurer un signal d'impulsions

Vous pouvez configurer Uinstrument pour envoyer un signal d’impulsions avec une largeur d'impulsion et un temps
de front variables. Les opérations suivantes expliquent comment configurer un signal d’impulsions de période
500 ms avec une largeur d'impulsion de 10 ms et des temps de front de 50 ns.
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1. Sélectionnez la fonction d’impulsions.
Appuyez sur [Waveform] > Pulse pour sélectionner la fonction d’impulsions.

KEYSIGHT

TECHNOLOGIES

Parameter

Frequency 1.000,000,000 kHz Frequency

High Level +1.000V High Level

Low Level -1.000 mV

Low Level
Phase 0.0°

Pulse Width 10.000,0 ps Phase
~5-
Lead Edge 4.0ns

Pulse

Trail Edge 4.0 ns Width

Edge
~5-

2. Définissez la période des impulsions.

Appuyez sur la touche [Units] puis sur Frequency Periodic. Appuyez ensuite sur [Parameter] > Period. Définissez la
période a 500 ms.

KEYSIGHT

TECHNOLOGIES

Period 500
High Level +1.000V

Low Level -1.000 mV

Phase 0.0°

Pulse Width 10.000,0 ps seconds

Lead Edge 4.0ns
Trail Edge 4.0 ns
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3. Définissez la largeur des impulsions.

Appuyez sur [Parameter] > Pulse Width. Définissez ensuite la largeur des impulsions a 10 ms. La largeur d’impulsion
représente le temps s’écoulant entre le seuil de 50 % du front ascendant et le seuil de 50 % du front descendant sui-
vant.

Period 500.000,000 ms

High Level +1.000V

Low Level -1.000 mV

Phase 0.0°
Pulse Width 10_ seconds
Lead Edge 4.0ns

Trail Edge 4.0ns
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4. Réglez le temps des deux fronts.

Appuyez sur la touche de fonction Edge puis sur Each Both.

Period  500.000,000 ms

High Level +1.000V

Low Level -1.000 mV

Phase 0.0°
Pulse Width 10.000,000,0 ms
Edge Time 0.000,000,000 s

Appuyez sur Edge Time pour définir les temps des fronts ascendant et descendant a 50 ns. Le temps de front repré-
sente la durée entre 10 % et 90 % de chaque front.

AL
Period 500.000,000 ms
High Level +1.000V

Low Level -1.000 mV

Phase 0.0°
Pulse Width 10.000,000,0 ms

seconds

Edge Time 50_

Sélectionner un signal arbitraire prédéfini

Il existe neuf signaux arbitraires prédéfinis enregistrés en mémoire non volatile : Cardiaque, D-Lorentz, Décroissance
exponentielle, Croissance exponentielle, Gaussien, Demi-sinus inverse (Haversine), Lorentz, Rampe négative et
Sinc.

Cette procédure sélectionne le signal prédéfini « croissance exponentielle » sur le panneau avant.
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1. Appuyez sur [Waveform] > Arb > Arbs.

KEYSIGHT

TECHNOLOGIES

Parameter

Select

samp Rate 0.000,000 Sa/s arb

High Level +1.000V Arbs in Memory
-
Low Level -1.000 mV

Samples 250

Arb Name EXP_RISE.arb Import Data
~»-

Save
Changes

2. Choisissez Arbs in Memory et utilisez le bouton rotatif pour sélectionner EXP_RISE. Appuyez sur Select Arb.

KEYSIGHT
ARB,500 TECHNOLOGIES
Arb Memory Catalog - Channel 1 Parameter
CEIES 1 INT:ABUILTIN\EXP_RISE.ARB
High Lev

Low Leve

Samples

Arb Nam

Utiliser le systeme d’aide intégré

Le systeme d’aide intégré fournit une aide contextuelle sur toutes les touches de la face avant et les touches de
fonction des menus. La liste des rubriques d’aide est également disponible pour vous aider dans les diverses
opérations sur le panneau avant.

Afficher 'aide relative a une touche de fonction ou a un bouton

Maintenez enfoncée une touche de fonction ou un bouton du panneau avant (ex. [Waveform]).
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KEYSIGHT

TECHNOLOGIES

? QUICK HELP o
elp

Opens t veform list, with a "MORE" softkey for additional iterns. Pressing a softkey highlights it,
and the waveform's parameters appear. 0K

Available waveforms include Sine, Square, Triangle, Pulse, Ramp, Noise, Arbitrary (user defined),
PRBS (Pseudo-Random Binary Sequence) and DC. Ta configure the selected waveform, press
[Parameters).

Si le message contient plus d’'informations que ne peut en afficher l'écran, appuyez sur la fleche vers le bas pour
afficher les informations restantes.

Appuyez sur OK pour quitter 'aide.

Aide dans votre langue

Tous les messages, l'aide contextuelle et les rubriques d’aide existent dans les langues suivantes : Anglais, Francais,
Allemand, Espagnol, Chinois simplifié, Chinois traditionnel, Japonais, Coréen et Russe. Les libellés des touches de
fonction et les messages sur la ligne de configuration ne sont pas traduits (ils sont toujours en anglais). Pour sélec-
tionner la langue, appuyez sur [System] > User Settings > Language. Sélectionnez ensuite la langue souhaitée.

Mettre a jour le microprogramme

Ne désactivez pas l'instrument pendant la mise a jour.

Appuyez sur [System] > Help > About pour déterminer le numéro de version actuellement installé du
microprogramme de l'instrument.

Rendez-vous sur le site www.keysight.com/find/EDU33211A-sw pour obtenir la derniere version du
microprogramme. S’il correspond a la version installée sur votre instrument, il n’est pas nécessaire de poursuivre
cette procédure. Sinon, téléchargez U'utilitaire de mise a jour du micrologiciel et un fichier ZIP du micrologiciel. Des
instructions détaillées sur la mise & jour du micrologiciel sont situées sur la page de téléchargement.

Connexions de l'interface de commande a distance

Cette section décrit la procédure a suivre pour connecter les diverses interfaces de communication a votre
instrument. Pour de plus amples informations sur la configuration des interfaces de commande a distance, reportez-
vous a la sectionConfiguration de l'interface de commande a distance.
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Sivous ne 'avez pas encore fait, installez la suite Keysight IO Libraries, disponible a l'adresse www.-
keysight.com/find/iolib. Pour de plus amples informations sur les connexions des interfaces, reportez-vous au Guide
de connectivité des interfaces USB/LAN/GPIB Keysight Technologies fourni avec la suite Keysight |0 Libraries.

Se connecter a Uinstrument par USB

La figure ci-dessous illustre un systeme d'interface USB classique.

Cable USB
\ Connecter au Connecter au
port USB sur port USB sur
I'ordinateur l'instrument

1. Connectez votre instrument au port USB de votre ordinateur a l'aide d'un cable USB.

2. Lorsque lutilitaire Connection Expert de Keysight |O Libraries Suite est en cours d’exécution, Uordinateur reconnait
automatiquement Uinstrument. Cette opération peut durer quelques secondes. Une fois l'instrument reconnu, votre
ordinateur affiche l'alias VISA, la chaine IDN et l'adresse VISA. Vous pouvez également afficher l'adresse VISA de
l'instrument a partir du menu du panneau avant.

3. Vous pouvez désormais utiliser Interactive 10 depuis ['utilitaire Connection Expert pour communiquer avec votre
appareil, ou le programmer a l'aide des divers environnements de programmation.

Il n’est pas recommandé que le cable USB mesure plus de 3 metres.

Se connecter a l'instrument via LAN (de site et privé)
LAN de site

Un LAN de site est un réseau local dans lequel des instruments et des ordinateurs compatibles LAN sont connectés
au réseau via des routeurs, des concentrateurs et/ou des commutateurs. Il s'agit habituellement de grands réseaux
administrés de maniere centralisée, avec des services tels que des serveurs DHCP et DNS. La figure ci-dessous
illustre un systéme LAN de site classique.

Vers la carte Vers le port LAN
d'interface
réseau (NIC)  Versle LAN
'/ de site
© C,

=\
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Branchez l'instrument au LAN de site ou a votre ordinateur a Uaide d’un cable LAN. Les parametres LAN de
linstrument tel gu’expédié sont configurés pour obtenir automatiquement une adresse IP du réseau a 'aide d’un ser-
veur DHCP (le DHCP est activé par défaut). Le serveur DHCP enregistre le nom d’hote de instrument auprés du ser-
veur DNS dynamique. Le nom d'hote ainsi que l'adresse IP permettent alors de communiquer avec l'appareil. Le
voyant LAN du panneau avant s'allume lorsque le port LAN a été configuré.

Si vous devez configurer manuellement les parametres LAN de l'instrument, reportez-vous a la section
Configuration des interfaces de commande a distance pour de plus amples informations concernant
cette configuration depuis le panneau avant de l'instrument.

Utilisez l'utilitaire Connection Expert de Keysight IO Libraries Suite pour ajouter Uinstrument et vérifier une
connexion. Pour ajouter Uinstrument, demandez a Connection Expert de le rechercher. Si 'appareil demeure introu-
vable, ajoutez-le a l'aide de son nom d’hote et de son adresse IP.

Si cela ne fonctionne pas, reportez-vous a la section « Instructions de dépannage » dans le Guide de
connectivité des interfaces USB/LAN/GPIB Keysight Technologies fourni avec la suite Keysight |0 Libra-
ries.

. Vous pouvez désormais utiliser Interactive 10 depuis ['utilitaire Connection Expert pour communiguer avec votre
appareil, ou le programmer a l'aide des divers environnements de programmation.

LAN privé

Un LAN privé est un réseau dans lequel les instruments et ordinateurs compatibles LAN sont directement connectés
et non connectés a un LAN de site. Il s'agit habituellement de petits réseaux, sans ressources administrées de
maniere centralisée. La figure ci-dessous illustre un systeme LAN privé classique.

- Vers la carte Vers le port LAN
d’interface
ﬁ% réseau (NIC) \
wes || ¥
= = Cable croisé CATS
[ — 1

Connectez l'instrument a Uordinateur a Uaide d’'un cable LAN croisé. Vous pouvez également relier Uordinateur et
U'appareil a un concentrateur ou a un commutateur autonome a 'aide de cables LAN normaux.
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Vérifiez que votre ordinateur est configuré pour obtenir son adresse depuis DHCP et que NetBIOS

sur TCP/IP est activé. Notez que si U'ordinateur a été connecté a un LAN de site, il peut en avoir
conservé les parametres réseau. Attendez une minute aprés 'avoir débranché du LAN de site avant de
le brancher au LAN privé. Cela permet a Windows de détecter que l'ordinateur est sur un réseau dif-
férent et de redémarrer la configuration réseau.

2. Les parametres LAN de l'instrument expédié par l'usine sont configurés pour obtenir automatiquement une adresse
IP a partir d'un réseau de site a l'aide d'un serveur DHCP. Vous pouvez laisser ces parameétres tels quels. La plupart
des produits Keysight et des ordinateurs choisissent automatiquement une adresse IP via l'option Auto-IP s'il
n'existe pas de serveur DHCP. Chacun s'auto-attribue une adresse IP a partir du bloc 169.254.nnn. Notez que cela
peut prendre jusqu’a une minute. Le voyant LAN du panneau avant s'allume lorsque le port LAN a été configuré.

L'arrét du DHCP réduit le temps requis pour configurer entiérement une connexion réseau lorsque
l'alimentation est sous tension. Pour configurer manuellement les paramétres LAN de Uinstrument,
reportez-vous a Configuration de linterface a distance pour plus d’informations sur la configuration des
parametres LAN a partir du panneau avant de l'instrument.

3. Lutilitaire Connection Expert de la suite Keysight 10 Libraries permet d’ajouter 'alimentation et de vérifier la
connexion. Pour ajouter Uinstrument, demandez a Connection Expert de le rechercher. Si 'appareil demeure introu-
vable, ajoutez-le a l'aide de son nom d’hoéte et de son adresse IP.

Si cela ne fonctionne pas, reportez-vous a la section « Instructions de dépannage » dans le Guide de
connectivité des interfaces USB/LAN/GPIB Keysight Technologies fourni avec la suite Keysight 10 Libra-
ries.

4. Vous pouvez désormais utiliser Interactive 10 depuis l'utilitaire Connection Expert pour communiquer avec votre
appareil, ou le programmer a l'aide des divers environnements de programmation.

Configuration de linterface de commande a distance

L'instrument prend en charge les communications avec l'interface distante sur deux interfaces : USB et LAN. Ces
deux interfaces sont « actives » a la mise sous tension.

- Interface USB : Utilisez le port USB du panneau arriere pour communiquer avec votre PC. Aucun parametre de
configuration n’est requis pour Uinterface USB. Connectez simplement Uinstrument a votre ordinateur via le cable
USB.

- Interface au réseau local (LAN) : Utilisez le port LAN du panneau arriere pour communiquer avec votre PC. Par
défaut, le protocole DHCP est actif pour permettre les communications sur un réseau local. DHCP est 'abréviation
de Dynamic Host Configuration Protocol ; il s’agit d’un protocole d’affectation d’adresses IP dynamiques IP aux
périphérigues sur un réseau. Avec l'adressage dynamique, un périphérique peut avoir une adresse IP différente
chaque fois qu'il se connecte au réseau.
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Il est recommandé de supprimer toute connexion d'interface distante non utilisée.

Keysight IO Libraries Suite

Assurez-vous que la suite Keysight 10 Libraries est installée avant de procéder a la configuration de l'interface dis-
tante.

La suite Keysight IO Libraries est une série de logiciels de commande d’instruments gratuits qui découvre
automatiquement des instruments et vous permet de commander des instruments sur LAN, USB, GPIB, RS-232 et
d’'autres interfaces. Pour plus d'informations ou pour télécharger 10 Libraries, rendez-vous a l'adresse
www.keysight.com/find/iosuite.

Configuration LAN

Les sections suivantes décrivent les fonctions de base de configuration du réseau local au moyen du menu du
panneau avant.

Par défaut, le protocole DHCP est activé pour permettre les communications sur un réseau local. L'acronyme DHCP
signifie Dynamic Host Configuration Protocol ; il s'agit d'un protocole d'attribution d'adresses IP dynamiques a des
périphérigues sur un réseau. Avec l'adressage dynamique, un périphérique peut avoir une adresse IP différente
chaque fois qu'il se connecte au réseau.

Certains parametres LAN nécessitent de redémarrer l'instrument pour les activer. L'instrument affiche brievement
un message dans ce cas ; examinez donc attentivement l'écran lorsque vous modifiez les paramétres du réseau.

Apres avoir modifié les parametres du LAN, vous devez enregistrer les modifications. Appuyez sur Apply (Appliquer)
pour enregistrer le réglage. Si vous n’enregistrez pas le réglage, en quittant le menu Config. d’E/S, vous serez invité
a cliquer sur Yes pour enregistrer le réglage LAN ou sur No pour quitter sans enregistrer. Sélectionnez Yes pour
remettre linstrument sous tension et activer les paramétres. Les parametres du LAN ne sont pas volatiles. Ils ne
sont pas modifiés apres une remise sous tension ou la commande *RST. Si vous ne souhaitez pas enregistrer vos
modifications, appuyez sur No pour annuler toutes les modifications.

Afficher les paramétres LAN

Appuyez sur [System] > |/0 Config pour afficher les paramétres LAN.

L’état LAN peut étre différent des paramétres du menu de configuration du panneau avant - en fonction de la
configuration du réseau. Les parametres sont différents lorsque le réseau a affecté les siens automatiquement.
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KEYSIGHT

TECHNOLOGIES

SN &AN

170 Config

1/0 Overview LAN Settings

Frequ Control Ports: USB, LAN ~5-

Ampli  USB
VISA Address: USBO0:10893:918:CN59217262::INSTR

LAN Reset

Offsel
LAN

Status:
IP:
Host name: Resolving

Phase

Domain name: Resolving

VISA address: TCPIP:K-33212A-00032:inst0:INSTR
TCPIP:K-33212A-00032::5025::SOCKET

mDNS hostname:
mDNS service:

Appuyez sur LAN Settings pour accéder au menu Parameétres LAN. Voir Modifier les parametres LAN pour plus
d’informations.

Appuyez sur LAN Reset pour restaurer les parametres LAN par défaut.

KEYSIGHT
TECHNOLOGIES

SN &AN

I/0 Config

1/0 Overview

Frequ Control Ports: USB, LAN

Ampli  USB
VISA Address: USB0:10893:918:CN59217262:INSTR
Offsel

Are you sure you want to reset LAN settings and then restart LAN?

Phase
10.66.40.108

Host name: Resolving
Domain name: Resolving

VISA address: TCPIP:K-33212A-00032:inst0:INSTR .
TCPIP:K-33212A-00032::5025:S0CKET /

mDNS hostname:
mDNS service: Keysight EDU33211A Function Generator - MY00000006

Modifier les paramétres LAN

Les parametres pré configurés en usine de l'instrument fonctionnent avec la plupart des environnements de réseau
local. Reportez-vous aux « paramétres non volatiles » dans le Guide de programmation pour obtenir des informations
sur les parametres LAN définis en usine.
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1.

Accédez au menu des parametres LAN.

Appuyez sur la touche de fonction LAN Settings.

SN &AN

LAN Settings

MAC Address:
Frequ )
Config Mode:

_ DHCP:
Ampli Auto DNS:
mDNS:

Offsel P

Subnet mask:
Phase Gateway:

DNS1:

DNS2:

Host name:

Domain name:
mDNS service:

SN &AN

LAN Settings

MAC Address:

Config Mode:
DHCP:

Auto DNS:
mDNS:

IP:

Subnet mask:
Gateway:
DNS1:

DNS2:

Host name:

Domain name:
mDNS service:

80-09-02-09-b3-e0

Manual

80-09-02-09-b3-e0

Manual
ON
ON
ON

KEYSIGHT

TECHNOLOG

la tings

Services

-

Host Mame

OM" " OFF

Auto DNS
ON""OFF

mDNS
ON""OFF

mDNS Service

\ Function Generator - MY0O0000006 / M

Si l'option DHCP est activée, une adresse IP est automatiquement configurée par DHCP (Dynamic Host Con-
figuration Protocol) lorsque vous connectez 'instrument au réseau, si le serveur DHCP existe et peut effectuer cette
opération. Le protocole DHCP se charge également du masque de sous-réseau et de l'adresse de la passerelle si
nécessaire. Il s’agit de la maniére la plus facile d’établir les communications avec le réseau local pour votre ins-
trument. Il vous suffit de laisser activée Uoption DHCP. Contactez votre administrateur réseau pour plus

d'informations.
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2. Spécifiez une « Configuration IP ».

.Sivous n’utilisez pas 'option DHCP (utilisez la touche de fonction Services pour placer DHCP sur OFF), vous devez
spécifier une configuration IP, y compris une adresse IP, et éventuellement un masque de sous-réseau et 'adresse
d’une passerelle.

KEYSIGHT
SIN ENN TECHNOLOGIES

LAN Settings Lan

MAC Address: 80-09-02-09-b9-e0 DHCP

Frequ \
- Config Mode: Manual -

, DHCP: FF
Ampli Auto DNS: N Auto DNS
mDNS: N ON" " OFF

Offsel

IP:
Subnet mask: 255.255.0. mDNS

. ON™"0FF
Phase Gateway:
DNS1:

DNS2: mDNS Service

Host name:
Domain name:
mDNS service:

Appuyez sur [Back] > Addresses > Modify pour configurer 'adresse IP, le masque de sous-réseau et 'adresse de pas-
serelle.

a KEYSIC
SN &AN TECHNOLC

1/0 Conﬂg ﬁ Lan Ad
1/0 Overview » IP Address Modify
Frequ Control Ports: USB, LAN Subnet Mz IP"Addre:
Ampli  USB
Previous
VISA Address: USBO0:10893:918:CN59217262::INSTR
Offsel
LAN
Status:
IP: 10.66.40.108

Host name: Resolving

Phase

Domain name: Resolving

VISA address: TCPIP:K-33212A-00032:inst0:INSTR
TCPIP:K-33212A-00032::5025::SOCKET

mDNS hostname:
mDNS service: no -£66 1140 o 108 stor - MYOD000006

Contactez votre administrateur réseau pour connaitre U'adresse IP, le masque de sous-réseau et la passerelle a uti-
liser.

Adresse IP : Toutes les adresses IP sont exprimées sous la forme de notation par points « nnn.nnn.nnn.nnn » ou
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«nnn» est la valeur d’un octet de 0 a 255. Vous pouvez entrer une nouvelle adresse IP a l'aide du clavier numérique
(pas avec le bouton rotatif). Saisissez les chiffres en utilisant le clavier et les touches de curseur. Appuyez sur Pre-
vious ou Next pour passer le curseur au champ suivant ou précédent. Ne saisissez pas de zéro au début des
nombres.

Masque de sous-réseau : Le masque de sous-réseau permet a l'administrateur réseau de sous-diviser un réseau
pour simplifier sa gestion et minimiser le trafic sur le réseau. Le masque de sous-réseau indique la partie de
l'adresse de 'hOte utilisée pour désigner le sous-réseau. Saisissez les chiffres en utilisant le clavier et les touches de
curseur. Appuyez sur Previous ou Next pour passer le curseur au champ suivant ou précédent.

Passerelle : Une passerelle est un périphérique de connexion au réseau. La passerelle par défaut est l'adresse IP de
ce périphérique. Saisissez les chiffres en utilisant le clavier et les touches de curseur. Appuyez sur Previous ou Next

pour passer le curseur au champ suivant ou précédent.

Appuyez sur Apply pour enregistrer vos modifications.
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3. Configurer le « Paramétrage DNS » (facultatif)

DNS (Domain Name Service) est un service Internet qui traduit les noms de domaine en adresses IP. Demandez a
votre administrateur réseau si ce service est utilisé ; si c’est le cas, demandez le nom de 'héte, le nom du domaine et
'adresse du serveur a utiliser.

Normalement, DHCP recherche l'adresse DNS ; il vous suffit d’'indiquer si le protocole DHCP est inutilisé ou non fonc-
tionnel. Pour configurer manuellement l'adressage de Uinstrument, utilisez la touche de fonction Services pour pas-
ser Auto DNS sur OFF.

SN &AN

170 Config

Frequ

Ampli

Offsel

Phase

1/0 Overview
Control Ports:

USB
VISA Address:

LAN
Status:
IP:
Host name:
Domain name:
VISA address:

mDNS hostname:
mDNS service:

USB, LAN

USB0:10893:918:CN59217262:INSTR

10.66.40.108
Resolving
Resolving

TCPIP:K-33212A-00032:inst0:zINSTR .
TCPIP:K-33212A-00032:5025:50CKET /

Keysight EDU33211A Function Generator - MYO0000006

Auto DNS
ON""OFF

mDNS
ON""OFF

mDNS Service

a. Configurez le nom de 'h6te (« hostname »). Appuyez sur [Back] >Host Name et entrez le nom d’héte. Un nom
d'hoéte est la partie hdte du nom du domaine qui est convertie en adresse IP. Le nom d’hdte est saisi sous forme de
chaine a l'aide des touches de fonction fournies. Le nom de 'h6te peut contenir des lettres, des chiffres et des tirets

(« - »).
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KEYSIGHT

SN &AN

170 Config

1/0 Overview

Frequ Control Ports: USB, LAN

Amp

Host Name Mext Char
[3-33212A-00032

Offs

Prev Char
Phas ABCDEFGHlJnLMNOPORSTUVWXYZ

Host name: Resolving Delete
Domain name: Resolving

VISA address: TCPIP:K-33212A-00032:inst0:INSTR .
TCPIP:K-33212A-00032::5025::SOCKET / Clear All
mDNS hostname:

mDNS service: Keysight EDU33211A Function Generator - MYO0000006
Apply

L'instrument est livré avec un nom d’hdte par défaut au format suivant : K-(numérodemodele)-(numérodesérie), ol
(numérodemodele) représente le numéro de modele de linstrument a 6 caracteéres (par exemple, 33212A), et (numé-
rodesérie) correspond aux cing derniers caractéres du numéro de série de l'instrument (par exemple, 45678 si le
numéro de série est MY12345678).

b. Configurez les adresses « Serveur DNS ». Appuyez sur [Back]. Appuyez sur Addresses > Modify pour configurer les
adresses du serveur DNS.

Saisissez le DNS primaire (DNS1) et le DNS secondaire (DNS2). Saisissez les chiffres en utilisant le clavier et les
touches de curseur. Appuyez sur Previous ou Next pour passer le curseur au champ suivant ou précédent. Consultez
votre administrateur réseau pour de plus amples informations.

KEYS
TECHNO

SN &AN

I/0 Config Lan &

1/0 Overview Modify
Control Ports: USB, LAN DNST

UsSB
VISA Address: USB0:10893:918:CN58217262::INSTR

Previous

LAN
Status:
IP: 23.66.40.108
Host name: Resolving

Domain name: Resolving

VISA address: TCPIP:K-33212A-00032:inst0:INSTR
TCPIP:K-33212A-00032::5025:S0CKET

mDNS hostname:
mDNS service: 61 1183 1140 0100 stor - MYO0000006
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4. Configurer le service mDNS (facultatif).

Votre instrument recoit en usine un nom de service mDNS unique que vous pouvez changer. Le nom de service
nDNS doit étre unique sur le LAN.

Pour configurer manuellement le nom de service de Uinstrument, utilisez la touche de fonction Services pour régler

mDNS sur ON.

SN &AN

170 Config

1/0 Overview

Frequ Control Ports:

Ampli  USB
VISA Address:

Offsel
LAN

Status:
IP:
Host name:

Phase

Domain name:

VISA address:

mDNS hostname:
mDNS service:

KEYSIGHT

TECHNOLOGIE

USB, LAN 0K OFF

Auto DNS
USB0:10893:918:CN59217262:INSTR ON""OFF

mDNS
0N " OFF
10.66.40.108
Resolving mDNS Service
Resolving

TCPIP:K-33212A-00032:inst0:INSTR
TCPIP:K-33212A-00032::5025::SOCKET

Keysight EDU33211A Function Generator - MYO0000006

Appuyez sur mDNS Service.

SN &AN

170 Config

1/0 Overview

Frequ Control Ports:

A mDns Service Name

Offs

Phas

Host name:
Domain name:
VISA address:

mDNS hostname:
mDNS service:

USB, LAN

Mext Char

meysight EDU33211A Function Generator - MY0O0000006

Prev Char

ABCDEFGHIJELMNOPORSTUVWXVZ

Resolving Delete

Resolving
TCPIP:K-33212A-00032:inst0:INSTR

TCPIP:K-33212A-00032::5025::SOCKET Clear All

%

Keysight EDU33211A Function Generator - MYO0000006
Apply

Utilisez les touches de fonction fournies pour définir un nom de service souhaité. Le nom doit commencer par une
lettre ; les autres caractéeres peuvent étre des majuscules ou des minuscules, des chiffres ou le caractere de sou-
lignement (« - »). Appuyez sur Apply pour enregistrer vos modifications.
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Services de socket SCPI

Cet instrument permet d’établir toute combinaison allant jusqu’a deux sockets de données simultanés, un socket de
controle et des connexions telnet.

Les instruments Keysight ont normalisé U'utilisation du port 5025 pour les services de socket SCPI. Un socket de
données sur ce port permet d'émettre ou de recevoir des commandes, des demandes et des réponses ASCII/SCPI.
Toutes les commandes doivent se terminer par une nouvelle ligne pour le message a traiter. Toutes les réponses
doivent également se terminer par une nouvelle ligne.

L'interface de programmation par sockets permet en outre une connexion par socket de controle. Le socket de
controle permet aux clients d'envoyer des commandes Device Clear et de recevoir des demandes de service.
Contrairement au socket de données, qui utilise un numéro de port fixe, le numéro de port d'un socket de controle
varie et doit étre obtenu en envoyant la requéte SCPI suivante au socket de données :
SYSTem:COMMunicate:TCPip:CONTrol?

Apres avoir obtenu le numéro de port, ouvrez une connexion par socket de contréle. Comme avec le socket de
données, toutes les commandes envoyées au socket de contréle doivent se terminer par une nouvelle ligne, et
toutes les réponses renvoyées par le socket de contréle sont terminées par une nouvelle ligne.

Pour envoyer un périphérique a supprimer, envoyez la chaine « DCL » au socket de contréle. Lorsque le systeme
d'alimentation a terminé d'exécuter la suppression de 'appareil, il renvoie la chaine « DCL » au socket de controle.

Les demandes de service sont activées pour les sockets de contréle a l'aide du registre d'activation des demandes
de service. Des que les demandes de service ont été activées, le programme client écoute la connexion de contréle.
Lorsque SRQ@ devient vrai, l'instrument envoie la chaine « SRQ +nn » au client. « nn » représente la valeur de 'octet
d'état, que le client peut utiliser pour déterminer la source de la demande de service.

En savoir plus sur les adresses IP et leur notation

Les adresses notées par points (« nnn.nnn.nnn.nnn » ol « nnn » est la valeur d'un octet comprise entre 0 et 255)
doivent étre soigneusement exprimées du fait que la plupart des logiciels des PC interpretent les octets avec des
zéros initiaux comme des nombres en base 8. Par exemple, « 192.168.020.011 » est en fait équivalent a la notation
décimale « 192.168.16.9 », car «.020 » est interprété comme « 16 » en nombre octal et « 011 » comme « 9 ». Pour
géviter toute confusion, utilisez uniguement des valeurs décimales comprises entre 0 et 255 sans zéro d'en-téte.
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Commande a distance

Vous pouvez controler Uinstrument via SCPI a l'aide des bibliotheques Keysight 10 Libraries ou via un panneau avant
simulé avec linterface Web de linstrument.

Interface Web

Vous pouvez surveiller et controler l'instrument a partir d'un navigateur Web en utilisant l'interface Web de

l'instrument. Pour vous connecter, saisissez simplement l'adresse IP ou le nom d'héte de l'instrument dans la barre
d'adresse de votre navigateur et appuyez sur Enter.

Sivous voyez une erreur indiquant 400 : Requéte incorrecte, ceci est lié a un probléme avec les « cookies » dans
votre navigateur Web. Pour éviter ce probléme, démarrez l'interface Web en utilisant l'adresse IP (pas le nom d'héte)
dans la barre d'adresse ou effacez les cookies de votre navigateur juste avant de lancer l'interface Web.

'W KEYSIGHT EDU33212A Arbitrary Waveform Generator

Login £
TECHNOLOGIES  serial number: CN60350047

Home Control Instrument Configure LAN (2]

Connected to EDU33212A Arbitrary Waveform Generator
at IP address 192.168.1.2

Description

Model number EDU33212A

Manufacturer

Serial number CN60350047

Firmware revision K-01.03.94-01.00-01.04-01.00-01.00-2020010101
Description
VISA instrument addresses

VXI-11 LAN protocol TCPIP::1192.168.1.2::inst0:INSTR

TCP/IP SOCKET protocol TCPIP::192.168.1.2:5025:SOCKET

USB (USBTMG/488) USB::0x2A8D::0x8D01::CN60350047::0:INSTR
GPIB N/A

v More Information

© Keysight Technologies 2021 | Support = Product = Keysight

L’'onglet Configure LAN en haut vous permet de modifier les parametres du réseau local de Uinstrument ; soyez
prudent lorsque vous faites cela, car vous pouvez interrompre votre communication avec Uinstrument.

Lorsque vous cliquez sur U'onglet Control Instrument, Uinstrument vous demandera un mot de passe (la valeur par
défaut est keysight), cela ouvrira une nouvelle page, représentée ci-dessous.
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M, KEYSIGHT EDU33212A Arbitrary Waveform Generator
TECHNOLOGIES so

Log out £
rial number: CN60350047

Home Control Instrument Configure LAN o

Control Instrument > Soft Front Panel

Warning: Should network communication issues
{5 the ront Panel may nof e

ur, the reported readings and instrumen nfiguration settings shown in
d readings from the

KEYSIGHT  Back

Frequency 1.000,000,000 kHz
Amplitude 100.0 mVpp S
Offset +0.000 V

Ramp

Phase 0.000°

annel 1 nnel 2

Ch: Chai
s [l onr [ [l onor

© Keysight Technologies 2021 Support  Product  Keysight

Cette interface vous permet d’utiliser U'instrument comme vous le feriez a partir du panneau avant. Notez les fleches
incurvées qui vous permettent de « faire pivoter » le bouton. Vous pouvez appuyer sur les touches fléchées pour faire
pivoter le bouton dans le sens des aiguilles d’'une montre et dans le sens inverse des aiguilles d’'une montre, tout
comme vous presseriez 'une des autres touches du panneau avant.

LIRE LAVERTISSEMENT
Veillez a lire et a comprendre l'avertissement en haut de la page Instrument de contréle.

Détails technigues de la connexion

Dans la plupart des cas, vous pouvez vous connecter facilement a lUinstrument avec la suite 10 Libraries ou
linterface Web. Dans certaines circonstances, il peut étre utile de connaitre les informations suivantes.

VXI-17 LAN Chaine VISA : TCPIPO::<Adresse IP>:inst0:INSTR
Exemple : TCPIP0::192.168.10.2::inst0::INSTR

U Web Numeéro de port 80, URL http://<Adresse IP >/

USB USBO::0x2A8D::<ID Prod>::Numéro de série>::0:INSTR

Exemple : USBO::0x2A8D::0x08D01::CN12340005::0:: INSTR
L'identifiant du fournisseur : 0x2A8D, lidentifiant du produit est 0x8D01 et le numéro de
série de l'instrument est CN12340005.

L'identifiant du produit varie selon le modele : 0x08C01 (EDU33211A) / 0x8D01
(EDU33212A).
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3 Utilisation des menus du panneau
avant

Sélectionner une terminaison de sortie

Réinitialiser Uinstrument

Envoyer un signal modulé

Envoyer un signal FSK

Envoyer un signal PWM

Envoyer un balayage en fréquence

Envoyer un signal en rafale

Déclencher un balayage ou une rafale

Enregistrer ou récupérer la configuration de l'instrument
Aide-mémoire des menus du panneau avant

Cette section présente les touches et les menus du panneau avant. Voir
Caractéristiques et Fonctions pour de plus amples informations sur
l'utilisation du panneau avant.
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Sélectionner la terminaison de sortie

L'instrument comporte un ensemble constant d’impédances de sortie de 50 Q sur les connecteurs du panneau
avant. Si l'impédance de charge réelle differe de la valeur spécifiée, lamplitude et les niveaux de décalage affichés
serontincorrects. Le réglage de limpédance de la charge est simplement un moyen pratique de garantir que la
tension affichée correspond a la charge prévue.

1. Appuyez sur la touche [Setup] d’une voie pour ouvrir 'écran de configuration de la voie. Remarquez que les valeurs

de l'impédance de sortie (toutes deux 50 Q dans ce cas) apparaissent dans les onglets en haut de l'écran.

KEYSIGHT

TECHNOLOGIES

Frequency 1.000,000,000 kHz -

Amplitude  100.0 mVpp Range
Suto " Hold

Offset +0.000V
Polarity

Mormal  Inverted
Phase 0.0° :

Voltage Limits
~9-

Mode
Mormal  Gated

2. Commencez par spécifier la terminaison de sortie en appuyant sur Qutput.

Set T
Frequency 1.000,000,000 kHz Egt(]h?n

Amplitude 100.0 mVpn Set To

CH 1 Output Load High Z
Offset +0.000V

50 Q Load

Phase 0.0°
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3. Choisissez la terminaison de sortie souhaitée en utilisant le bouton ou le clavier numérique pour choisir limpédance
de charge souhaitée ou en appuyant sur Set to 50 Q ou Set to High Z. Vous pouvez également définir une valeur
spécifique en appuyant sur Load.

Set To
Frequency 1.000,000,000 kHz 50 Ohm

Amplitude 100.0 mVpn Set To

CH 1 Output Load High Z
Offset +0.000V
Load

Phase 0.0° High-Z

Réinitialiser U'instrument

Pour réinitialiser l'instrument dans sa configuration par défaut a la sortie d’usine, appuyez sur [System] >
Store/Recall > Set to Defaults > Yes. Voir « Configuration par défaut a la sortie d’usine » dans le Guide de
programmation de la série EDU33270 pour plus d’informations.

S
Frequency 1.000,000,000 kHz
Amplitude 100.0 mVpp

Offset Y i

Return the instrument to its 'Factory Default’ state?

Phase 0.L
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Envoyer un signal modulé

Un signal modulé est composé d’un signal de porteuse et d’un signal modulant. En modulation d’amplitude (AM), le
signal modulant fait varier 'amplitude du signal porteur. Pour cet exemple, vous enverrez un signal AM avec une
profondeur de modulation de 80 %. Le signal porteur est un signal sinusoidal de 5 kHz ; le signal modulant est un
signal sinusoidal de 200 Hz.

. Sélectionnez la fonction, la fréquence et 'amplitude de la porteuse.

Appuyez sur [Waveform] > Sine. Appuyez sur les touches de fonction Frequency, Amplitude et Offset pour confi-
gurer le signal porteur. Pour cet exemple, sélectionnez un signal sinusoidal de 5 kHz, d’amplitude 5 Vpp avec un
décalage nul (0 V). Notez que vous pouvez spécifier 'amplitude en Vpp, Vrms ou dBm.

KEYSIGHT

TECHNOLOGIES

Parameter

Frequency 5.000,000,000 kHz Frequency

Amplitude 5.000 Vpp Amplitude

Offset +0.000V

Dffset
Phase 0.0°

Phase
~-
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2. Sélectionnez AM.

Appuyez sur [Modulate] et sélectionnez AM avec la touche de fonction Type. Appuyez ensuite sur la touche de fonc-
tion Modulate pour activer la modulation (ON).

KEYSIGHT
TECHNOLOGIES

SIN,HiZ
AM Modulated by Sine

Modulate
Frequency 5.000,000,000 kHz AM Depth  100.00 % 0K OFF

Amplitude  5.000 Vpp AM Freq 100.000,000 Hz -
) AN
Offset +0.000V
A
Phase 0.0° Depth
A
Freq

Shape

Sine

WMORE
142

3. Définissez la profondeur de modulation. Appuyez sur la touche de fonction AM Depth et utilisez le clavier numérique
ou le bouton et les fleches pour affecter la valeur 80 %.

KEYSIGHT
TECHNOLOGIES

SIN,HiZ
AM Modulated by Sine

] Percent
AM Depth  80_

Frequency 5.000,000,000 kHz

Amplitude  5.000 Vpp AM Freq 100.000,000 Hz

Offset +0.000V

Phase 0.0°

4. Sélectionnez la forme de signal de modulation. Appuyez sur la touche Shape pour sélectionner la forme du signal
modulant. Pour cet exemple, sélectionnez un signal Sine (sinusoidal).
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5. Appuyez sur AM Freq. Affectez 200 Hz a cette valeur a l'aide du clavier numérigue ou du bouton et des fleches.
Appuyez sur Hz pour terminer la saisie si vous utilisez le clavier numérique.

SIN,HiZ
AM Modulated by Sine

Frequency 5.000,000,000 kHz
Amplitude  5.000 Vpp

Offset +0.000V

Phase 0.0°

Envoyer un signal FSK

AM Freq 200

KEYSIGHT

TECHNOLOGIES

AM Depth  80.00 % ‘

Vous pouvez configurer l'instrument pour « faire dériver » sa fréquence de sortie entre deux valeurs prédéfinies
(appelées la « fréquence du signal porteur » et la « fréquence de saut ») avec la modulation FSK. La vitesse de dérive
de la sortie entre ces deux fréquences est déterminée par le générateur interne ou le niveau du signal sur le
connecteur Ext Trig du panneau avant. Dans cet exemple, vous affectez la valeur 5 kHz a la fréquence du « signal
porteur » et la valeur 500 Hz a la fréquence secondaire (fréguence de « saut »), avec une vitesse FSK égale a 100 Hz.
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1. Sélectionnez la fonction, la fréquence et lamplitude de la porteuse.

Appuyez sur [Waveform] > Sine. Appuyez sur les touches de fonction Frequency, Amplitude et Offset pour confi-
gurer le signal porteur. Pour cet exemple, sélectionnez un signal sinusoidal de 5 kHz, d’amplitude 5 Vpp avec un
décalage nul (O V).

KEYSIGHT
TECHNOLOGIES

Parameter

Frequency 5.000,000,000 kHz Frequency

Amplitude 5.000 Vpp Amplitude

Offset +0.000V

Dffset
Phase 0.0°

Phase
~-

2. Sélectionnez FSK.

Appuyez sur [Modulate] et sélectionnez FSK avec la touche de fonction Type. Appuyez ensuite sur la touche de fonc-
tion Modulate pour activer la modulation (ON).

KEYSIGHT
TECHNOLOGIES

SIN,50Q
FSK Modulated

Modulate
Frequency 5.000,000,000 kHz Hop Freq  100.000,000 Hz 0K OFF

Amplitude  5.000 Vpp FSK Rate  0.000,000 Hz ,, -
FSk

Offset +0.000V
Hop

Freq

Phase 0.0°
Fsk
Rate

Source

Internal
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3. Réglez la fréquence de « saut ».

Appuyez sur la touche de fonction Hop Freq et utilisez le clavier numérique ou le bouton et les fleches pour affecter
la valeur 500 Hz. Si vous utilisez le clavier numérique, n’oubliez pas de terminer la saisie en appuyant sur Hz.

KEYSIGHT
TECHNOLOGIES

SIN,50Q
FSK Modulated

Modulate
Frequency 5000,000,000 kHz Hop Freq @0000000 Hz ON""OFF

Amplitude  5.000 Vpp FSK Rate  0.000,000 Hz
Offset +0.000V
Phase 0.0°

Rate

Source

Internal

4. Définissez la vitesse de « dérive » FSK.

Appuyez sur la touche de fonction Fsk Rate et utilisez le clavier numérique ou le bouton et les fleches pour affecter
la valeur 100 Hz.

KE‘YS!GHrT
TECHNOLOGIES
SIN,50Q

FSK Modulated

Modulate
Frequency 5000,000,000 kHz Hop Freq 500.000,000 Hz ON""OFF

Amplitude 5,000 Vpp | FSK Rate [00.000000 Hz

Offset +0.000V

Phase 0.0°

Fsk
Rate

Source
Internal

A ce stade, l'instrument émettra un signal FSK, si la sortie de voie est activée.
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Envoyer un signal PWM

Vous pouvez configurer Uinstrument pour envoyer un signal PWM (modulation de la largeur d’impulsion). La
modulation PWM est disponible uniguement pour un train d’impulsions ; la largeur des impulsions varie en fonction
du signal modulant. La variation de la largeur des impulsions est appelée la largeur des impulsions ; elle peut étre
spécifiée en pourcentage de la période du signal (rapport cyclique) ou en unité de temps. Par exemple, si vous
spécifiez une impulsion avec un rapport cyclique égal a 20 % et activez ensuite la modulation PWM avec une
variation de b %, le rapport cycligue varie de 15 % a 25 % sous le contréle du signal modulant.

Pour modifier la largeur d’'impulsion en rapport cyclique d’'impulsion, appuyez sur [Units].

Dans cet exemple, vous spécifiez une largeur d'impulsion et une variation de la largeur d’impulsion pour un signal
d’'impulsions de 1 kHz avec un signal modulant sinusoidal de b-Hz.

. Sélectionnez les parameétres du signal porteur.

Appuyez sur [Waveform] > Pulse. Utilisez les touches de fonction Frequency, Amplitude, Offset (Tension de déca-
lage), Pulse Width et Edge Times pour configurer le signal porteur. Dans cet exemple, sélectionnez un signal
d’impulsions de 1 kHz avec une amplitude de 1 Vpp, un décalage nul, une largeur d'impulsion de 100 ms et un
temps de front (montant et descendant) de 50 ns.

Frequency 1.000,000,000 kHz Frequency

Amplitude 1.000 Vpp Amplitude

Offset +0.000V

Phase 0.0°
Pulse Width 100.000,000,0 ms
Edge Time 50.0ns

~»-

Pulse
Width

Edge
~5-
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2. Sélectionnez PWM.

Appuyez sur [Modulate] > Type PWM. Appuyez ensuite sur la touche de fonction Modulate pour activer la modu-
lation (ON).

KEYSIGHT
PULS,50Q o
PWM Modulated by Sine

— Oy Modulate
Frequency 1.000,000,000 kHz PWM Dev 0.000,000,000 s ’ oM " OFF

Amplitude 1.000 Vpp ., PWM Freq 10.000,000 Hz -

A
Offset +0.000V

Phase 0.0°
Pulse Width 100.000,000,0 ms
Edge Time 50.0ns

Source

Internal

3. Définissez la variation de la largeur.

Appuyez sur la touche de fonction PWM Dev et utilisez le clavier numérigue ou le bouton et les fleches pour affecter
la valeur 20 ps.

4. Définissez la fréquence de modulation.

Appuyez sur la touche de fonction PWM Freq et utilisez le clavier numérigue ou le bouton et les fleches pour affecter
la valeur 5 Hz.
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5. Sélectionnez la forme de signal de modulation.

Appuyez sur la touche Shape pour sélectionner la forme du signal modulant. Pour cet exemple, sélectionnez un
signal sinusoidal.

KEYSIGHT
PULS,500 TECHNOLOGIES

PWM Modulated by Sine Modulation

— Iy Modulate
PWM Dev  20.000,0 ps ’ ORTOFF

Amplitude 1.000 Vpp | PwM Freq 000000 Hz

Frequency 1.000,000,000 kHz

Type
P

Offset +0.000V
Phase 0.0°

Pulse Width 100.000,000,0 ms
Edge Time 50.0ns

Source

Internal

Pour afficher le signal PWM réel, vous devez 'envoyer a un oscilloscope. Si vous faites cela, vous constaterez la varia-
tion de la largeur des impulsions, dans ce cas de 80 a 120 us. Avec une fréquence de modulation de b Hz, la varia-
tion est tres visible.

Envoyer un balayage en fréquence

En mode balayage en fréquence, Uinstrument passe de la fréguence initiale a la fréquence finale a une vitesse de
balayage que vous spécifiez. Vous pouvez effectuer un balayage en fréquence croissant ou décroissant, et
linéairement ou selon une loi logarithmique, ou utiliser une liste de fréquences. Dans cet exemple, vous envoyez un
signal sinusoidal balayé de 50 Hz a b kHz.
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1. Sélectionnez la fonction et lamplitude du balayage.

Pour les balayages, vous pouvez sélectionner des signaux sinusoidaux, carrés, triangulaires, PRBS, arbitraires, des
rampes ou des impulsions (le bruit et le courant continu ne sont pas autorisés). Pour cet exemple, sélectionnez un
signal sinusoidal d’amplitude 5 Vpp.

KEYSIGHT
T ES

Parameter

Frequency 1.000,000,000 kHz Frequency

Amplitude 5.000 Vpp Amplitude

Offset +0.000V

Dffset
Phase 0.0°

Phase
~-

2. Sélectionnez le mode de balayage.

Appuyez sur [Sweep] et vérifiez que le mode de balayage Linear est sélectionné sur la deuxieme touche de fonction.
Appuyez sur la touche de fonction Sweep pour activer le balayage (ON). Remarquez le message d’état Linear Sweep
en haut de l'onglet de la voie active. Le bouton est également allumé.

KEYSIGHT
SIN,500Q T OGIES

Linear Sweep, Trig Imm ep

P . Sweep
Start Freq  100.000,000 Hz ON"" OFF

Amplitude  5.000 Vpp Stop Freq  1.000,000,000 kHz -
Sweep Time 1.000 s Linear
Hold Time 0.000s

Sweep
Return Time 0.000 s Time

Frequency Sweeping...

Offset +0.000V

Phase 0.0°

Start
Freq

Stop
Freq

Hold Return
~-
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3. Définissez la fréquence initiale.

Appuyez sur la touche de fonction Start Freq et utilisez le clavier numérique ou le bouton et les fleches pour affecter
la valeur 50 Hz.
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4. Définissez la fréquence finale.

Appuyez sur la touche de fonction Stop Freq et utilisez le clavier numérigue ou le bouton et les fleches pour affecter
la valeur 5 kHz.

KEYSIGHT
TECHNOLOGIES

SIN,500Q

Linear Sweep, Trig Imm ep

- Sweep
Frequency - Sweeping... Start Freq  50.000,000 Hz -

Amplitude 5,000 Vpp Stop Freq  [§000.000000 Hz -
Sweep Time 1.000 s Linear

Hold Time 0.000s
Sweep
Return Time 0.000 s Time

Offset +0.000V

Phase 0.0°

Start
Freq

Stop
Freq

Hold Return
~-

L'instrument envoie alors un balayage continu de 50 Hz a 5 kHz si la sortie est activée.

Vous pouvez également configurer les limites de la fréquence de balayage en utilisant une fréquence médiane et
une plage de fréquences. Ces parameétres similaires aux fréquences initiale et finale (ci-dessus) apportent une cer-
taine souplesse. Pour atteindre le méme résultat, réglez la fréquence médiane sur 2,525 kHz et la plage de fré-
quence sur 4,950 kHz.

Pour produire un balayage en fréquence, appuyez sur [Trigger] > Source Manual pour définir le déclenchement en

mode manuel. Appuyez sur [Trigger] pour envoyer un déclencheur. Pour plus d’informations, consultez Déclencher
un balayage ou une rafale.
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SIN,500Q

Linear Sweep, Trig Man

Frequency Sweeping...

Amplitude  5.000 Vpp

Offset +0.000V

Manual Trigger for CH1

Phase 0.0°

Envoyer un signal en rafale

Start Freq  50.000,000 Hz
Stop Freq  5.000,000,000 kHz
Sweep Time 1.000 s

e 0.000s

me 0.000s

i

KEYSIGHT

TECHNOLOGIES
Trigger
Source

Manual

Trigger Setup
~5-

Trig Out Setup
~9-

Sync
ON"" OFF

Vous pouvez configurer Uinstrument pour émettre un signal avec un nombre déterminé de cycles (rafale). Vous
pouvez contréler la durée écoulée entre des rafales au moyen de 'horloge interne ou du niveau du signal sur le
connecteur Ext Trig du panneau avant. Dans cet exemple, vous envoyez un signal sinusoidal sur 3 périodes de rafale

de 20 ms.

Sélectionnez la fonction et 'amplitude de la rafale.

Pour des signaux en rafale, vous pouvez sélectionner des signaux sinusoidaux, carrés, triangulaires, PRBS, arbi-
traires, des rampes ou des impulsions. Le bruit est autorisé uniguement en mode de rafale « commandée » ; le cou-
rant continu n’est pas autorisé. Pour cet exemple, sélectionnez un signal sinusoidal d’amplitude 5 Vpp.

Frequency 1.000,000,000 kHz

amplitude 000000 Vpp
Offset +0.000V

Phase 0.0°
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TECHNOLOGIES
Parameter

Frequency

Amplitude

Dffset

Phase
~-
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2. Sélectionnez le mode rafale.

Appuyez sur [Burst] > Burst ON | OFF.

KEYSIGHT
ECHNOLOGIES
SIN,500 -

N-Cycle Burst, Trig Imm Burst
— Burst

Frequency 1.000,000,000 kHz Start Phase 0.0° 0K OFF

Amplitude 5.000 Vpp # of Cycles 1

» NCycle |

Burst Period 10 ms Gated

Offset +0.000V

Phase 0.0°

Start Phase

i of Cycles

Burst Period

3. Définissez le nombre de rafales.

Appuyez sur # of Cycles et affectez la valeur « 3 » au nombre a l'aide du clavier numérique ou du bouton. Appuyez
sur Enter pour terminer la saisie si vous utilisez le clavier numérique.

!(E‘YS!GHrT
ECHNOLOGIES
SIN,500Q

N-Cycle Burst, Trig Imm

Frequency 1.000,000,000 kHz Start Phase 0.0°

Amplitude 5.000 Vpp # of Cycles 3_

Burst Period 10 ms
Offset +0.000V

Phase 0.0°
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4. Définissez la période de la rafale.

Appuyez sur Burst Period et affectez la valeur 20 ms a la période a l'aide du clavier numérique ou du bouton et des
fleches. La période de la rafale définit la durée entre le début d’une rafale et le début de la suivante. L'instrument
envoie alors une rafale continue de 3 salves a des intervalles de 20 ms.

Skl
SIN,500Q ECHNOLOGIES
N-Cycle Burst, Trig Imm

Frequency 1.000,000,000 kHz Start Phase 0.0°

Amplitude 5.000 Vpp # of Cycles 3
Burst Period 20_

Offset +0.000V

Phase 0.0°

seconds

Vous pouvez créer une seule rafale (avec le nombre spécifié de salves) en appuyant sur la touche [Trigger]. Pour plus
d’informations, consultez Déclencher un balayage ou une rafale.

KEYSIGHT
TECHNOLOGIES
SIN,50Q
N-Cycle Burst, Trig Man Trigaer
— Ty Source

Frequency 1.000,000,000 kHz Start Phase 0.0° Manual

Amplitude 5.000 Vpp #of Cycles 3 Trigger Setup
Burst Period 20 ms -
Offset +0.000V : "

Manual Trigger for CH1 Trig Out Setup
Phase 0.0° ~p-

Sync
ON"" OFF

Vous pouvez également utiliser le signal de déclenchement externe pour créer des rafales commandées lorsqu’une
rafale est produite lorsqu’un signal de gachette est présent a Uentrée.
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Déclencher un balayage ou une rafale
Vous pouvez émettre quatre types de déclenchements a partir du panneau avant pour les balayages et les rafales :

- Immediate ou « automatique » (par défaut) : U'instrument émet en permanence lorsque le mode balayage ou rafale
est sélectionné.

- External : le déclenchement est commandé sur le connecteur Ext Trig du panneau avant.

- Manual : déclenche un balayage ou une rafale chaque fois que vous appuyez sur la touche [Trigger]. Continuez a
appuyer sur [Trigger] pour redéclencher linstrument.

- Timer : envoie un ou plusieurs déclenchements a un intervalle de temps constant.

KEYSIGHT
TECHNOLOGIES

SIN,50Q

N-Cycle Burst, Trig Man Trigger

—EE——————— Im te Source

Frequency 1.000,000,000 kHz Start Phase 0.0° Manual

Amplitude 100.0 mVpp # of Cycles 1 Trigger Setup
Burst Period 10 ms Timer -

Offset +0.000V

Trig Out Setup

Phase 0.0° -
Sync

ON " OFF

Si le mode balayage ou rafale est actif, appuyez sur [Trigger] pour afficher le menu de déclenchement. La touche
allumée [Trigger] (en permanence ou clignotante) indique qu’une ou deux voies attendent un déclenchement
manuel. L'éclairage permanent a lieu lorsque le menu de déclenchement est sélectionné ; l'éclairage clignotant a
lieu lorsque le menu de déclenchement n’est pas sélectionné. La touche [Trigger] est désactivée lorsque
linstrument est en mode de commande a distance.

Appuyez sur la touche [Trigger] lorsqu’elle est allumée en permanence pour effectuer un déclenchement manuel.
Appuyez sur la touche [Trigger] lorsqu’elle clignote pour sélectionner le menu de déclenchement ; une deuxieme
pression effectue un déclenchement manuel.

Enregistrer ou récupérer la configuration de Uinstrument

Vous pouvez enregistrer les configurations de Uinstrument dans n’importe quel nombre de fichiers de configuration
(extension .sta). Cela est utile pour les sauvegardes ou vous pouvez enregistrer la configuration sur une clé USB
externe et la charger dans un autre instrument pour avoir des instruments avec des configurations identiques. Une
configuration enregistrée contient la fonction, la fréquence, lamplitude, la tension CC de décalage, le rapport
cyclique, la symétrie et tous les paramétres de modulation ou de rafale utilisés. L'instrument n’enregistre pas les
signaux arbitraires volatiles.
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Store Settings

Les parametres d’enregistrement vous permettent de naviguer vers un répertoire et de spécifier un nom de fichier,
puis de choisir si vous souhaitez enregistrer un fichier de configuration en interne ou sur une clé USB externe.

KEYSIGHT
TECH ES

Destination

Frequency 1.0n0. 0NN ANN LH-~ Int Ext

Store Settings
Amplitude 10 Store In

Store Destination: Internal State
Offset +0
Storein: State 0

Phase 0.C

Pour enregistrer (sauvegarder) la configuration actuelle de Uinstrument :
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1.

Sélectionnez la destination d’enregistrement souhaitée.
Appuyez sur [System] > Store/Recall > Store Settings > Destination.

KEYSIGHT
TECHNOLOGIES

SIN,50Q
N-Cycle Burst, Trig Imm

Destination

Frequency 1.0n0. 0NN ANN LH-~ Int  Ext

Store Settings
Amplitude 5.( Store In

Store Destination: Internal State 0

Offset +0
Store in: State 0

Phase 0.C

Sivous choisissez d’enregistrer la configuration de Uinstrument dans sa mémoire non volatile, choisissez Int. Passez
a l'étape 2.

Sivous choisissez d’enregistrer le fichier de configuration (.sta) dans une clé USB externe, choisissez Ext. Passez a
'étape 3.

Veillez a raccorder un disque flash USB avant de commencer. Si aucune clé USB n’est connectée, les
menus pour Destination Int | Ext seront grisés.
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2. Choisissez lemplacement d’enregistrement interne souhaité pour la configuration de Uinstrument.

Appuyez sur Store In et choisissez en Configuration 0, Configuration 1, Configuration 2, Configuration 3, ou Con-
figuration 4. Passez a 'étape 5.

KEYSIGHT
TECHNOLOGIES

SIN,50Q
N-Cycle Burst, Trig Imm

Destination
[nt " Ext

Frequency 1.0NN NNN NNN LLI-

Store Settings
Amplitude 5.( Store In

Store Destination: Internal State
Offset +0
Storein: State 0

Phase 0.C

3. Choisissez 'emplacement d’enregistrement externe souhaité pour le fichier de configuration (.sta).
Appuyez sur Select File | Path > Browse pour naviguer parmi les fichiers de configuration existants (.sta) dans la clé
USB externe connectée. Pour mettre en surbrillance un fichier de configuration existant (.sta), utilisez le bouton rota-
tif du panneau avant. Appuyez sur Select pour sélectionner le fichier surligné et revenir au menu précédent.
Vous pouvez également appuyer sur Rename pour renommer le fichier surligné ou sur Delete pour le supprimer.
Appuyez sur Select File | Path > Browse pour naviguer parmi les dossiers dans la clé USB externe pour enregistrer le
fichier de configuration (.sta). Pour mettre un dossier en surbrillance, utilisez le bouton rotatif du panneau avant.
Appuyez sur Select pour parcourir le dossier surligné. Appuyez sur Select Folder pour sélectionner le dossier sur-

ligné et revenir au menu précédent.

Vous pouvez également appuyer sur Rename pour renommer le dossier surligné ou sur Delete pour le supprimer.
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4. Facultatif : Sivous ne l'avez pas fait dans l'étape précédente, vous pouvez modifier le nom du fichier de confi-
guration.

Appuyez sur File Name pour spécifier le nom du fichier de configuration (.sta). Utilisez les touches de fonction four-
nies pour définir un nom.

KEYSIGHT

TECHNOLOGIES

Char Set
Frequency 1.0NN NNN NNN LLI- G

Store Settinas
Amp

File Name Next Char

Etate_2020‘l 205173300

Offs
Prev Char
Phas _ABCDEFGHIJKLMNOPORaTUVWXVZ

Delete

Clear &l

Apply

Appuyez sur Apply lorsque la saisie est terminée.
5. Enregistrez la configuration de l'instrument.

Appuyez sur Store.

KEYSIGHT

SIN,50Q TECHNOLOGIES
N-Cycle Burst, Trig Imm

Frequency 1.0nN.NNN NNN L~ D‘E:itinaEt;in
Store Settings

Amplitude 5.( So—
Store Destination: Internal State 1

Offset +0
Stor¢

Store applied

Phase 0.C
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Parametres de rappel

Les parametres de rappel vous permettent de parcourir 'état dans la mémoire interne ou de parcourir le fichier de
configuration (format .sta) dans la clé USB externe a rappeler.

Le fichier de configuration que vous avez rappelé doit provenir du méme modele d’instrument.

Pour restaurer (récupérer) une configuration d’instrument enregistrée :

. Sélectionnez la source de rappel souhaitée.
Appuyez sur [System] > Store/Recall > Recall Settings > Source.

KEYSIGHT

TECHNOLOGIES
System

Source
[nt " Ext

Frequency 1.0NN NNN NNN LLI-

Recall Settings
Amplitude 10 Recall
Recall from: Internal State
Offset +0
Recall: State 0

Phase 0.C

Recall

Sivous choisissez de récupérer un fichier de configuration de Uinstrument depuis sa mémoire interne non volatile,
sélectionnez Int. Passez a l'étape 2.

Sivous choisissez de Rappeler un fichier de configuration (.sta) depuis une clé USB externe connectée, sélectionnez
Ext. Passez a 'étape 3.

. Sélectionnez 'emplacement d’enregistrement interne depuis lequel rappeler la configuration.

Appuyez sur Recall, puis choisissez parmi les différentes configurations : State 0, State 1, State 2, State 3 ou State 4.
Passez a l'étape 4.

. Sélectionnez l'emplacement d’enregistrement externe que vous souhaitez rappeler.

Appuyez sur Browse et utilisez le bouton rotatif du panneau avant et les touches fléchées pour naviguer vers le
fichier de configuration souhaité (*sta) que vous voulez rappeler. Appuyez sur Select une fois 'opération terminée.

Rappelez la configuration d’instrument sélectionnée.

Appuyez sur Recall.
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Référence du menu du panneau avant

Cette section présente succinctement les menus du panneau avant. Le reste de cette section contient des exemples
d’utilisation de ces menus.

- Bouton [Waveform]

- Bouton [Parameter]

- Bouton [Units]

- Bouton [Modulate]

- Bouton [Sweep]

- Bouton [Burst]

- Bouton [Trigger]

- Bouton [System]

- Bouton [Setup] et [On/Off] de la voie

Bouton [Waveform]

Sélectionne un signal :
- Sinusoidal

- Carré

- Rampe

- Impulsion

- Arbitraire

- Triangle

- Bruit

- PRBS

-CC

Bouton [Parameter]

Parameater

Configure les parametres propres a un signal :
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- Période / Fréquence

- Amplitude ou tension haute et basse
- Décalage

- Phase

- Rapport cyclique

- Symétrie

- Largeur d’impulsion

- Temps de front

- Signal arbitraire

- Fréquence d’échantillonnage
- Filtre

- Phase arb

- Bande passante

- Données PRBS

- Débit binaire

- Front montant

- Front descendant

Bouton [Units]

Spécifie les unités et les préférences des parametres :

- Fréquence Arb : Sa/s, Freq ou Period

- Tension exprimée en Amplitude/décalage ou valeur Haute/Basse

- Unités de tension Vpp, Vrms, ou dBm

- Largeur d’impulsion ou rapport cyclique
- Phase de la rafale en degreés, radians ou secondes
- Phase arb en degrés, radians, secondes ou échantillons

- Balayage en fréguence comme Centre/Plage ou Initiale/Finale
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Bouton [Modulate]

| Maodulate

Configure les parametres de modulation :
- Modulation active ou inactive
- Type de modulation : AM, FM, PM, PWM, BPSK, FSK ou Somme

- Source de modulation

- Parametres de modulation (variables en fonction du type de modulation)

Bouton [Sweep]

=

Configure les parametres de balayage en fréquence :

- Balayage actif ou inactif

- Type de balayage : Linéaire, logarithmigue ou liste de fréquences
- Temps de balayage

- Fréquences initiale/finale ou fréquences centre/plage

- Délai, temps de maintien et de retour

Bouton [Burst]

o |

- Rafale active ou inactive

- Mode de rafale : déclenché (N cycles) ou déclenchement externe
- Cycles par rafale (1 a 100 000 000 ou infini)

- Angle de phase initial de la rafale (-360° a +360°)

- Période de la rafale

Bouton [Trigger]
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Configure les parametres de déclenchement et le signal de sortie de synchronisation :

- Exécution d’un déclenchement manuel lorsque la touche est allumée

- Spécification de la source du déclenchement du balayage, de la rafale ou du signal arbitraire

- Spécification du niveau de tension, du nombre et du retard du déclenchement

- Spécification de la pente (front montant ou descendant) de la source de déclenchement externe
- Spécification de la pente (front montant ou descendant) du signal de sortie de déclenchement
- Activation/désactivation de la sortie du signal sur le connecteur « Sync »

- Spécification de la source Sync, de la polarité, du mode, du point de marqueur et autres

Bouton [System]

Touche de fonction Store/Recall

Enregistre et rappelle des configurations de linstrument :
- Gestion des fichiers et dossiers
- Enregistrement des configurations de l'instrument dans la mémoire non volatile.

- Rappel de configurations enregistrées.

- Sélectionne la configuration a la mise sous tension de 'instrument (derniére extinction de linstrument ou

configuration de sortie d’usine).

- Restaure les parametres par défaut d’usine de linstrument.
Touche de fonction /0 Config

Configure les interfaces des entrées/sorties de linstrument :
- Activation/désactivation du réseau local
- Configuration du LAN (adresses et nom d’héte)

- Réinitialisation du réseau local
Touche de fonction Instr. Setup

Réalise les taches d’administration du systeme :

— Exécution de l'autotest
Touche de fonction User Settings

Configuration des parameétres du systeme :
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- Sélection de la langue des messages sur le panneau avant et l'aide
- Activation/désactivation du signal sonore d’erreur

- Activation/désactivation du clic de clavier

- Allumage et extinction de 'écran

- Réglage du comportement d’atténuation de 'écran

- Réglage de la date et de 'heure
Touche de fonction Help

Affiche la liste des rubrigues d’aide :
- Affichage des données « A propos de » : numéro de série, adresse IP, version du microprogramme, etc.

- Affiche la file d’attente des erreurs de Uinterface de commande a distance

Bouton [Setup] et [On / Off] de la voie

Active et configure les voies :

Bouton [On / Off]

Activation/désactivation de la voie

Bouton [Setup]

Configuration des parameétres relatifs a la voie :

- Spécification de la voie activée dans les menus

- Sélection de la terminaison de sortie (50 Q, élevée ou manuel)

- Activation/désactivation de la détection automatique de l'amplitude
— Sélection de la polarité des signaux (normale ou inversée)

- Spécification des limites de tension

- Spécification de la sortie normale ou commandée

Pour EDU33212A uniquement
Appuyez deux fois sur [Setup] pour accéder au mode double voie. Dans ce mode, appuyez sur [Setup]
pour basculer entre la vue en voie unique et la vue en voie double.
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4 Fonctions et caractéristiques

Configuration de sortie

Signaux d’impulsion

Modulation d’amplitude (AM) et Modulation de fréquence (FM)
Modulation de phase (PM)

Modulation par déplacement de fréquence (FSK)
Modulation de largeur d’impulsion (PWM)
Modulation par addition

Balayage de fréquence

Mode en salves

Déclenchement

Opérations systéeme

Opérations sur 2 voies

Ce chapitre détaille les caractéristiques de Uinstrument, y compris
l'utilisation des commandes du panneau avant et de linterface distante.
Lisez éventuellement d’abord la rubrique Utilisation des menus du
panneau avant. Consultez le Guide de programmation de la série
EDU332170 pour plus d’informations sur les commandes et les

requétes SCPI.
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Configuration de sortie

Cette rubrique décrit la configuration de la sortie des voies. De nombreuses commandes associées a la configuration
de sortie commencent par SOURce1: ou SOURceZ2: pour indiguer une certaine voie. Si cette option est oubliée, la
voie par défaut est la voie 1. Par exemple, VOLT 2.5 configure la sortie de la voie T sur 2.5V et SOUR2:VOLT2.5 fait la
méme chose pour la voie 2.

L’écran de linstrument affiche pour chaque voie un « onglet » qui récapitule divers aspects de la configuration de
sortie de chaque voie :

SIN,500Q
1

Linear Sweep, Trig Imm

ON

Sur un instrument deux voies, U'onglet de la voie 1 est jaune ; celui de la voie 2 est vert.

KEYSIGHT

TECHNOLOGIES

Frequency 1.000,000,000 kHz 1.000,000,000 kHz

Amplitude 100.0 mVpp Amplitude 100.0 mVpp

Offset +0.000V +0.000V

Phase 0.0° Fhase 0.0° Range
Suto " Hold

Output
~-

Polarity
Mormal  Inverted

Voltage Limits
~5-

Mode
Mormal  Gated

Fonction de sortie

L’instrument inclut huit signaux standard : sinusoidal, carré, rampe, impulsion, triangle, bruit PRBS (séquence
binaire pseudo aléatoire) et CC. Il existe également neuf signaux arbitraires intégrés.

Le tableau ci-dessous indigue les fonctions autorisées (@ avec la modulation, le balayage et les rafales. La sélection
d’une fonction non autorisée avec une modulation ou un mode désactive cette modulation ou ce mode.

Sinusoidal et carré o o o o [ o [ [
Impulsion o o o o o o [ [ [
Triangle et rampe o o o o o o [ [
Bruit gaussien o [ o
Séquence binaire pseudo o o o o o

aléatoire (PRBS)
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Signal arbitraire o e ¢ ¢ [ o [

1 Rafale commandée uniquement

2 S'appligue a I'horloge d’échantillonnage et non a 'ensemble du signal

- Limitations sur la fréguence : Le changement de fonction peut modifier la fréquence pour correspondre aux limites de
fréquence de la nouvelle fonction.

- Limitations sur l'amplitude : Lorsque l'unité de sortie est Vrms ou dBm, la modification de fonctions peut diminuer
U'amplitude au maximum pour la nouvelle fonction du fait d’'une variation de forme des signaux. Par exemple, un signal
carré de 5 Vrms (dans une impédance de 50 Q) modifié en signal sinusoidal diminue 'amplitude & 3.536 Vrms (limite
supérieure du signal sinusoidal).

- Iln’est pas possible de combiner lamplitude et la tension de décalage en dépassant les caractéristiques limites de
lUinstrument. Il est possible de modifier la derniere configuration pour rester dans les limites.

- Vous pouvez spécifier les limites supérieure et inférieure de la tension de sortie pour protéger un appareil testé (DUT).
Opérations depuis le panneau avant
- Pour activer une sortie : Appuyez sur [On/Off] correspondant a la voie souhaitée.
- Pour sélectionner un autre signal : Appuyez sur [Waveform].
Par exemple, pour spécifier un signal CC :

Appuyez sur [Waveform] > MORE 1 /2 > DC > Offset.

Utilisez le clavier numérigue ou le bouton et la fleche pour définir une valeur souhaitée. Si vous utilisez le clavier,
sélectionnez un préfixe unitaire pour terminer.

KEYSIGHT

TECHNOLOGIES

Offset
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2. Appuyez sur [On/Off] de la voie pour produire la sortie CC.

KEYSIGHT

TECHNOLOGIES
Parameter

Dffset

Offset A9500 v

Commande SCPI
[SOURce[1]|2]:]FUNCtion <function>

La commande APPLy configure un signal en une seule commande.

Fréquence de sortie

La plage de fréquence de sortie dépend du modele de fonction et de la tension de sortie, comme illustré ici. La
fréguence par défaut est égale a 1 kHz pour toutes les fonctions et les fréquences minimales sont représentées dans
le tableau ci-dessous.

Sinusoidal 1 pHz
Carré 1 pHz
Rampe/Triangle 1 pHz
Impulsion 1 pHz

Séquence binaire pseudo aléatoire (PRBS) 1 mbit/s
Arbitraire 1uSa/s

- Limitations sur la fréquence : Le changement de fonction peut modifier la fréquence pour correspondre aux
limites de fréquence de la nouvelle fonction. Les signaux arbitraires conservent le dernier réglage de fréquence.

- Limitations sur les rafales : Pour les rafales déclenchées en interne, la fréquence minimale est égale a 126 pHz.

- Limitations sur le rapport cyclique : Pour les signaux carrés et les impulsions, le rapport cyclique est limité par la
largeur minimale des impulsions spécifiée de 16 ns. Par exemple, a 1 kHz, il est possible de définir un rapport
cyclique aussi faible que 0,01 % du fait que cela implique une largeur d’impulsion de 100 ns. A T MHz, le rapport
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cyclique estégala 1.6 % eta 10 MHz il est égal a 16 %. La modification avec une fréquence qui ne génere pas le
rapport cycligue actuel ajuste le rapport cyclique pour remplir la condition de largeur minimale des impulsions.

La largeur d’impulsion minimale est de 16 ns.
Opérations depuis le panneau avant

Appuyez sur [Parameter] > Frequency. Utilisez le clavier numérique ou le bouton et la fleche pour définir une valeur
souhaitée. Sivous utilisez le clavier, sélectionnez un préfixe unitaire pour terminer.

KEYSIGHT
TECHNOLOGIES

Frequency 1 _ pHz

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Commande SCPI
[SOURce[1]2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

La commande APPLy configure un signal en une seule commande.

Amplitude de sortie

L’amplitude par défaut est égale a 100 mVpp (dans une impédance de 50 Q) pour toutes les fonctions.

- Limitations de la tension de décalage : La relation entre 'amplitude et la tension de décalage est indiguée ci-
dessous. Vmax est égale a +5 V pour une charge de 50 Q ou a +10 V pour une charge de haute impédance.

Vpp < 2(Vmax - |Vdécalage|)

- Limites imposées par la terminaison de sortie : Si 'amplitude est égale a 10 Vpp et si vous changez la terminaison
de sortie de 50 Q en « haute impédance » (OUTPut[1|2]:LOAD INF), lamplitude affichée double a 20 Vpp. La
maodification de « haute impédance » en 50 Q diminue de moitié lamplitude affichée. La terminaison de sortie
n’affecte pas la tension de sortie réelle ; elle modifie uniquement les valeurs affichées et récupérées de Uinterface
distante. La tension de sortie réelle dépend de la charge connectée.

- Limites imposées par la sélection de l'unité : Les limites d’amplitude sont parfois déterminées par 'unité de sortie
sélectionnée. Cela peut se produire lorsque Uunité est Vrms ou dBm du fait des différences entre les facteurs de
créte de diverses fonctions. Par exemple, si vous changez un signal carré 5 Vrms (dans une charge de 50 Q) en
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signal sinusoidal, U'instrument ajuste 'amplitude & 3.536 Vrms (limite maximale Vrms pour un signal sinusoidal).
L'interface distante produit également une erreur de conflit des parameétres (Settings conflict).

- Vous pouvez régler lamplitude de sortie en Vpp, Vrms ou dBm. Vous ne pouvez pas spécifier lamplitude de sortie
en dBm si la terminaison de sortie est configurée sur une impédance élevée. Voir Unités de sortie pour plus
d’informations.

- Limitations sur les signaux arbitraires : Pour les signaux arbitraires, 'amplitude est limitée si les points du signal
ne couvrent pas la plage complete du convertisseur N/A de sortie. Par exemple, le signal intégré « Sinc » n’utilise pas
la plage compléete des valeurs ; son amplitude est donc limitée a 6.087 Vpp (dans une charge de 50 Q).

- La modification de lamplitude peut interrompre brievement la sortie a certaines tensions a cause de la
commutation de 'atténuateur de sortie. Néanmoins, 'amplitude est contrélée de fagcon que la tension de sortie ne
soit jamais supérieure au réglage actuel lorsque la commutation a lieu. Pour éviter cette interruption, désactivez la
détection automatique de la tension avec la commande VOLTage:RANGe:AUTOOFF. La commande APPLy active
automatiquement la détection automatique.

- La configuration des niveaux haut et bas configure également l'amplitude et la tension résiduelle du signal. Par
exemple, si vous configurez le niveau haut sur +2 V et le niveau bas sur -3V, 'amplitude résultante est égale a 5 Vpp
avec une tension de décalage de -500 mV.

- Latension résiduelle CC controle le niveau de sortie CC d’un signal. Le niveau de sortie CC peut étre compris
entre £5 V dans une charge de 50 Q ou £10 V avec une charge de haute impédance.

Opérations depuis le panneau avant

Appuyez sur [Parameter] > Amplitude. Utilisez le clavier numérique ou le bouton et la fleche pour définir une valeur
souhaitée. Sivous utilisez le clavier, sélectionnez un préfixe unitaire pour terminer.

KEYSIGHT

TECHNOLOGIES

Frequency 1.000,000,000 kHz

Amplitude 100 _
Offset +0.000 V

Phase 0.0°

Pour utiliser un niveau élevé et un niveau faible a la place : Appuyez sur [Units] > Ampl/Offs | High/Low.
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KEYSIGHT
TECHNOLOGIES

Units

Frequency <

Frequency 1.000,000,000 kHz Periodc

High Level +50.00 mV Amp/0ffs
High/Low

Low Level -50.00 mV

Phase 0.0°

Commande SCPI

[SOURce[1]2]:]VOLTage {<amplitude>|MINimum|MAXimum|DEFault}
[SOURce[1]2]:]VOLTage:HIGH {<voltage>|MINimum|MAXimum|DEFault}
[SOURce[1]2]:]VOLTage:LOW {<voltage>|MINimum|MAXimum|DEFault}

La commande APPLy configure un signal en une seule commande.

Tension continue de décalage

La tension de décalage par défaut est égale a O V pour toutes les fonctions.

- Limites imposées par lamplitude : La relation entre la tension de décalage et lamplitude de sortie est illustrée ci-
dessous. La tension de sortie en créte (somme des tensions CC et CA) ne peut étre supérieure aux caractéristiques
nominales de l'instrument (+5 V dans une charge de 50 Q ou +10 V dans un circuit ouvert).

- Larelation entre la tension de décalage et lamplitude de sortie est illustrée ci-dessous. Vmax est la tension de
créte maximale autorisée pour la terminaison de sortie sélectionnée (5 V pour une charge de 50 Q ou 10 V pour une
charge haute impédance).

|Vdécalage| < Vmax - Vpp/ 2

Sila tension de décalage spécifiée n’est pas valide, l'appareil la regle automatiquement a la tension continue
maximale autorisée par lamplitude spécifiée. A partir de l'interface distante, 'erreur de données hors tolérances
(« Data out of range ») se produit également.

- Limites imposées par limpédance de sortie : La plage de la tension de décalage dépend de la terminaison de
sortie. Par exemple, si vous configurez une tension de décalage de 100 mVcc et changez ensuite la terminaison de
sortie de 50 Q en «haute impédance », la tension de décalage affichée sur la face avant est doublée a 200 mVcce
(aucune erreur ne se produit). Si vous changez de « haute impédance » a 50 Q, la tension de décalage affichée est
divisée par 2. La modification de la terminaison de sortie ne modifie pas la tension sur les bornes de sortie de
linstrument. Cela modifie uniguement les valeurs affichées sur la face avant et les valeurs demandées sur linterface
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distante. La tension sur la sortie de l'instrument dépend de la charge connectée a linstrument. Voir « OUTPut
[1]2]:LOAD » dans le Guide de programmation de la série EDU33210 pour plus d’informations.

- Limitations sur les signaux arbitraires : Pour les signaux arbitraires, 'amplitude est limitée si les points du signal
ne couvrent pas la plage complete du convertisseur N/A de sortie. Par exemple, le signal intégré « Sinc » n’utilise pas
la plage complete des valeurs ; son amplitude est donc limitée a 6.087 Vpp (dans une charge de 50 Q).

- La configuration des niveaux haut et bas configure également 'amplitude et la tension résiduelle du signal. Par
exemple, si vous configurez le niveau haut sur +2 V et le niveau bas sur -3V, lamplitude résultante est égale a 5 Vpp
avec une tension de décalage de -500 mV.

- Pour envoyer une tension continue, sélectionnez la fonction tension continue (FUNCtion DC) et configurez ensuite
la tension de décalage (VOLTage:OFFSet). Les valeurs acceptées sont comprises entre +5 \Vcc dans une charge de
50 Q ou +£10 Vce dans un circuit ouvert. Lorsque Uinstrument est en mode CC, le réglage de U'amplitude n'a pas
d’effet.

Opérations depuis le panneau avant

Appuyez sur [Waveform] > MORE 1/2 > DC > Offset. Utilisez le clavier numérique ou le bouton et la fleche pour
définir une valeur souhaitée. Si vous utilisez le clavier, sélectionnez un préfixe unitaire pour terminer.

KEYSIGHT

TECHNOLOGIES

Offset

Commande SCPI

[SOURce[1]2]:]VOLTage:0FFSet {<offset>|MINimum|MAXimum|DEFault}
[SOURce[1]2]:]VOLTage:HIGH {<voltage>|MINimum|MAXimum|DEFault}
[SOURce[1]2]:]VOLTage:LOW {<voltage>|MINimum|MAXimum|DEFault}

La commande APPLy configure un signal en une seule commande.

Unités de sortie

S’appliguent uniquement a lamplitude.

- Unités de sortie : Vpp (par défaut), Vrms ou dBm.
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- Ce parametre est volatile.

- La sélection des unités s’opere sur le panneau avant et l'interface distante. Par exemple, si vous sélectionnez
«VRMS » sur linterface distante, U'unité affichée sur le panneau avant est « VRMS ».

- L'unité d’amplitude ne peut pas étre dBm si limpédance de sortie est configurée sur une impédance élevée. Le
calcul de 'amplitude en dBm nécessite une impédance finie de la charge. Dans ce cas, la valeur est convertie en

Vpp.

— La conversion des unités est possible. Par exemple, pour convertir 2 Vpp en sa valeur Veff (Vrms) équivalente :
Appuyez sur [Units] > Amplitude Vpp > Amplitude Vrms.
La valeur convertie est de 707,17 mVrms pour un signal sinusoidal.

Opérations depuis le panneau avant

Appuyez sur [Units] > Amplitude.

Frequency

Frequency 1.000,000,000 kHz Periodc

Amplitude 100.0 mVpp

Amp/ Offs 4
High/Low

Offset +0.000V
Amplitude
Phase 0.0° s
Phase
Degrees

Sweep
StrtStor

Commande SCPI

[SOURce[1]2]:]VOLTage:UNIT {VPP|VRMS |DBM}

Terminaison de sortie

L'instrument comporte un ensemble constant d’impédances de sortie de 50 Q sur les connecteurs du panneau
avant. Si l'impédance de charge réelle differe de la valeur spécifiée, 'amplitude et les niveaux de décalage affichés
seront incorrects. Le réglage de 'impédance de la charge est simplement un moyen pratique de garantir que la
tension affichée correspond a la charge prévue.

- Terminaison de sortie : 1 Q a 10 kQ ou infinie. La valeur par défaut est de 50 Q.

- Sivous spécifiez une terminaison de 50 Q mais effectuez en réalité la terminaison dans un circuit ouvert, la sortie
sera égale a 2 fois la valeur spécifiée. Par exemple, si vous configurez la tension de décalage CC avec la valeur
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100 mVcc (et spécifiez une charge de 50 Q), mais effectuez la terminaison dans un circuit ouvert, la tension
résiduelle réelle sera égale a 200 mVce.

- La modification du réglage de la terminaison de sortie ajuste lamplitude et la tension de décalage affichées
(aucune erreur produite). Si lamplitude est égale a 10 Vpp et si vous changez la terminaison de sortie de 50 Q en
«haute impédance » (OUTPut[1|2]:LOAD INF), 'amplitude affichée double & 20 Vpp. La modification de « haute
impédance » en 50 Q diminue de moitié 'amplitude affichée. La terminaison de sortie n’affecte pas la tension de
sortie réelle ; elle modifie uniqguement les valeurs affichées et récupérées de l'interface distante. La tension de sortie
réelle dépend de la charge connectée.

La charge de sortie peut affecter la qualité du signal pour les impulsions ou d’autres fonctions dont les transitions
sont rapides. La résistance a charge élevée peut produire des réflexions.

- L'unité est convertie en Vpp si la terminaison de sortie est une impédance élevée.

- Vous ne pouvez pas modifier la terminaison de sortie lorsque des limites de tension sont actives du fait que
l'instrument ne peut pas savoir & quelle terminaison ces limites s’appliquent. A la place, désactivez les limites de
tension, configurez la nouvelle valeur de la terminaison, ajustez les limites de tension et réactivez-les.

Opérations depuis le panneau avant

Appuyez, pour la voie choisie, sur [Setup] > Output > Load.

KEYSIGHT

TECHNOLOGIES

SetT
Frequency 1.000,000,000 kHz 50 O

Amplitude 100.0 mVpn Set To

CH 1 Output Load High Z
Offset +0.000V

50 Q Load

Phase 0.0°

Commande SCPI

OUTPut[1]2] :LOAD {<ohms>|INFinity|MINimum|MAXimum|DEFault}

Rapport cyclique (signaux carrés)

Le rapport cyclique d’un signal carré est la partie de la durée d’un cycle pendant laguelle le signal est haut (en
supposant que le signal n’est pas inversé). (Voir Trains d’impulsions pour des informations sur le rapport cyclique
des impulsions).
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- Rapport cyclique : 0,017 % a 99,99 % aux basse fréquences ; la plage est réduite aux hautes fréquences. Enregistré
en mémoire volatile ; 50 % par défaut.

- Ce parametre est conservé lorsque vous passez a une autre fonction. Un rapport cyclique de 50 % est toujours
utilisé pour un signal carré modulant ; le rapport cyclique s’applique uniguement a un signal porteur carré.

Rapport cyclique de 20 % Rapport cyclique de 80 %

Opérations depuis le panneau avant

Appuyez sur [Waveform] > Square > Duty Cycle. Utilisez le clavier numérigue ou le bouton et la fleche pour définir
une valeur souhaitée. Sivous utilisez le clavier, appuyez sur Percent pour confirmer vos modifications.

i
Frequency 1.000,000,000 kHz Fercent
Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Duty Cycle 75_

Commande SCPI

[SOURce[1]2]:]FUNCtion:SQUare:DCYCle {<percent>|MINimum|MAXimum}

La commande APPLy configure le rapport cyclique avec la valeur 50 %.

Symétrie (rampes)

S’appliguent uniqguement aux rampes. La symétrie représente la partie de chague cycle pendant laquelle la rampe
est croissante (en supposant que le signal n’est pas inversé).
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Symétrie de 0 % Symeétrie de 100 %

- La symétrie (par défaut ) est enregistrée en mémoire volatile ; et conservée lorsque vous changez de type de
signal.

- Lorsqu’une rampe est le signal modulant pour AM, FM, PM ou PWM, la symétrie ne s’applique pas.
Opérations depuis le panneau avant

Appuyez sur [Waveform] > Ramp > Symmetry. Utilisez le clavier numérique ou le bouton et la fleche pour définir une
valeur souhaitée. Sivous utilisez le clavier, appuyez sur Percent pour confirmer vos madifications.

S
Frequency 1.000,000,000 kHz -
Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Symmetry 75_

Commande SCPI
[SOURce[1]2]:]FUNCtion:RAMP:SYMMetry {<percent>|MINimum|MAXimum|DEFault}

La commande APPLy configure la symétrie avec la valeur 100 %.

Détection automatique de la tension
La détection automatique est activée par défaut ; l'instrument sélectionne les meilleurs parametres de 'atténuateur.

Lorsque la détection automatique est désactivée, Uinstrument utilise les parametres actifs de Uatténuateur et ne
commute pas les relais de 'atténuateur.

94 Guide de I'utilisateur Keysight série EDU33210



- Vous pouvez désactiver la détection automatique pour supprimer les interruptions momentanées dues a la
commutation de latténuateur pendant une modification de 'amplitude. Cependant :

- La précision et la résolution de 'amplitude et de la tension de décalage (fidélité du signal) peuvent étre affectées si
'amplitude diminue au-dessous d’une modification de la plage qui se produit si la détection automatique est
activée.

- Vous ne pourrez peut-étre pas obtenir lamplitude minimale lorsque la détection automatique est activée.

- Certaines spécifications de U'instrument ne s’appliquent pas lorsque la détection automatique est désactivée.
Opérations depuis le panneau avant

Appuyez, en fonction de la voie, sur [Setup] > Range Auto | Hold or Range Auto | Hold.

KEYSIGHT

TECHNOLOGIES

Output
Frequency 1.000,000,000 kHz -

Amplitude  100.0 mVpp Range
Auto " Hold

Offset +0.000V

Polarity

Mormal  Inverted
Phase 0.0°

Symmetry 75.00 % Voltage Limits
-

Mode
Mormal  Gated

Commande SCPI
[SOURce[1]2]:]VOLTage:RANGe:AUTO {OFF|0O|ON|1]|ONCE}

La commande APPLy active toujours la détection automatique.

Contréle de la sortie

La sortie d’une voie est désactivée par défaut a la mise sous tension afin de protéger les autres matériels. Voir ci-
dessous pour activer la sortie d’'une voie. Lorsque la sortie d’une voie est activée, le bouton de cette voie est allumé.

Siun circuit externe applique une tension trop élevée au connecteur de sortie d’une voie, linstrument génére un
message d’erreur et désactive la sortie. Pour réactiver la sortie, supprimez la surcharge et activez a nouveau la voie.

Opérations depuis le panneau avant

Appuyez, pour la voie, sur [On/Off].
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KEYSIGHT

TECHNOLOGIES

Parameter

Dffset

Offset A9500 v

Commande SCPI
OUTPut[1]2] {ON|1|OFF|O0}

La commande APPLy active toujours le connecteur de sortie d’une voie.

Polarité du signal

En mode normal (par défaut), le signal est positif au début du cycle. En mode inversé, c’est le contraire.

- Comme indiqué ci-dessous, le signal est inversé par rapport a la tension de décalage. La tension de décalage reste
inchangée lorsque le signal est inversé.

Normal Inversé Normal Inverse

, // o rd
YN X YN /X

§ o "-.I / "'-. b

'l []"u" | 1 } Démlage

" / \U N4 \‘x J/f. oV
Sans tension Avec tension
de decalage de decalage

- Le signal Sync associé a un signal inversé n’est pas inversé.
Opérations depuis le panneau avant

Appuyez sur [Setup] > Polarity Normal | Inverted ou Polarity Normal | Inverted.
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KEYSIGHT
TECHNOLOGIES

Output
Frequency 1.000,000,000 kHz -

Amplitude  100.0 mVpp Range
Auto " Hold

Offset +0.000V

Polarity

Mormal  Inverted
Phase 0.0°

Symmetry 75.00 % Voltage Limits
-

Mode
Mormal  Gated

Commande SCPI

OUTPut[1|2]:POLarity {NORMal |INVerted}

Signal de sortie Sync

Le connecteur Sync du panneau avant fournit une sortie de synchronisation. Toutes les fonctions de sortie standard
(a l'exception de la tension continue et du bruit) sont associées a un signal Sync. Pour les applications dans
lesquelles vous ne voulez peut-étre pas envoyer le signal Sync, vous pouvez désactiver le connecteur Sync. Le signal
Sync peut étre dérivé d’une voie de sortie ou Uautre d’'un instrument 2 voies.

Comportement général

- Par défaut, le signal Sync est dérivé de la voie 1 et envoyé au connecteur Sync (activé).

- Lorsque le signal Sync est désactivé, le niveau de sortie sur le connecteur Sync est en logique « basse ».
- La commande OUTPut:SYNC:POLarity {INVerted|]NORMal} spécifie la polarité du signal Sync.

- Linversion d’un signal (voir Polarité du signal) n’inverse pas le signal Sync associé.

- Pour les signaux sinusoidaux, carrés, triangulaires, les impulsions et les rampes, le signal Sync est un signal carré
«haut» dans la premiére moitié du cycle et « bas » dans la deuxieme moitié. Les tensions du signal Sync sont
compatibles TTL lorsque son impédance de charge dépasse 1 kQ.

- Pour les signaux arbitraires, le signal Sync augmente au début du signal et chute au milieu. Vous pouvez ignorer ce
comportement par défaut : utilisez la commande MARKer:POINt pour spécifier le point dans le signal arbitraire ou le
signal Sync passe a l'état « bas ».

Modulation

- Pour des signaux AM, FM, PM et PWM modulés en interne, le signal Sync est normalement référenceé sur le signal
modulant (et non le signal porteur) et est un signal carré de rapport cyclique égal a 50 %. Le signal Sync est au
niveau TTL « haut » pendant la premiere moitié du signal modulant. Vous pouvez configurer le signal Sync pour
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suivre le signal porteur avec la commande OUTPut:SYNC:MODE {CARRier[NORMal|MARKer} lorsque la modulation
estinterne.

- Vous pouvez ignorer le comportement normal du signal Sync pour le forcer a suivre le signal porteur (OUTPut
[1]2]:SYNC:MODE CARRier).

- Pour la modulation par déplacement de fréquence (FSK), le signal Sync est référencé sur le débit FSK. Le signal
Sync est au niveau TTL « haut » pendant la transition vers la fréquence de « saut ».

Balayage

- Le signal Sync est un signal TTL « haut » au début du balayage et « bas » au point médian du balayage. Le signal
Sync est synchronisé avec le balayage mais n’est pas égal au temps de balayage du fait que sa temporisation inclut
le temps de réarmement.

- Pour les balayages de fréquence avec marqueur actif, le signal Sync est un signal TTL « haut » au début du
balayage et « bas » a la fréquence du marqueur. Vous pouvez modifier cela avec la commande OUTPut
[1]2]:SYNC:MODE MARKER.

Rafale

- Pour une rafale déclenchée, le signal Sync est au niveau TTL « haut » lorsque la rafale commence. Le signal Sync
est au niveau TTL « bas » a la fin du nombre de cycles spécifié (il ne peut pas étre le point de passage au zéro si le
signal est associé a une phase initiale). Pour un nombre infini de salves, le signal Sync est identique a un signal
continu.

- Pour une rafale commandée en externe, le signal Sync suit le signal de déclenchement externe. Cependant, le
signal ne passe pas au niveau TTL « bas » jusqu’a la fin du dernier cycle (il ne peut pas étre le point de passage au
zéro si le signal est associé a une phase initiale).

Configuration de la sortie de synchronisation

Opérations depuis le panneau avant

Pour activer et désactiver la synchronisation : Appuyez sur [Trigger] > Sync ON | OFF ou Sync ON | OFF.
KEYSIGHT

RAMP,50Q
Trigger

Source

Frequency 1.000,000,000 kHz Mt

Amplitude 100.0 mVpp Trigger Setup
-

Offset +0.000V

Trig Out Setup

Phase 0.0° -

Symmetry  75.00 % Sync
ON""OFF

Sync Setup
~9-
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Pour configurer la synchronisation : Appuyez sur [Trigger] > Sync Setup.

RAMP,500Q

Frequency 1.000,000,000 kHz CHI CHZ

Amplitude 100.0 mVpp Polarity
Mormal " Inverted

Offset +0.000V
Mode
Mormal

Phase 0.0°
Symmetry 75.00 %

Commande SCPI

OUTPut:SYNC {ON|1]|OFF|0}
OUTPut[1|2]:SYNC:MODE {NORMal|CARRier |MARKer}
OUTPut[1]|2]:SYNC:POLarity {NORMal|INVerted}

OUTPut :SYNC:SOURce {CH1|CH2}

Signaux d'impulsion

La figure ci-dessous illustre une impulsion ou un signal carré composé d’une période, d’'une largeur d’impulsion,
d’un front montant et d’un front descendant.

Largeur
d’impulsion
Temps du front montant Temps de front descendant
- Période >

Période

- Période : inverse de la fréquence maximale jusqu’a 1 000 000 s (1 ms par défaut).
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- L'instrument ajuste la largeur de l'impulsion et les temps de front en fonction de la période spécifiée.
Opérations depuis le panneau avant

. Sélectionner le signal d’'impulsion : Appuyez sur [Waveform] > Pulse.

. Sélectionner une période au lieu d’une fréquence : Appuyez sur [Units] > Frequency Periodic > Frequency Periodic.
Définir la période : Appuyez sur [Parameter] > Period. Utilisez le clavier numérique ou le bouton et la fleche pour défi-
nir une valeur souhaitée. Sivous utilisez le clavier, sélectionnez un préfixe unitaire pour terminer.

KEYSIGHT
PULS,500 TECHNOLOGIES

Period 100_

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°
Pulse Width 10.000,0 ps
Lead Edge 4.0ns

seconds

Trail Edge 4.0 ns

Commande SCPI

[SOURce[1]2]:]FUNCtion:PULSe:PERiod {<seconds>|MINimum|MAXimum|DEFault}

Largeur d’impulsion
La largeur des impulsions est le temps écoulé entre le niveau a 50 % du front montant et le niveau a 50 % du front
descendant suivant de limpulsion.

- Largeur d’impulsion : jusgu’a 1 000 000 s (voir les limitations ci-dessous). La largeur d’'impulsion par défaut est
égale a 100 ps. La largeur d'impulsion minimale est de 16 ns.

- La largeur d'impulsion spécifiée doit également étre inférieure a la différence entre la période et la largeur
minimale d'impulsion.

- L’instrument ajuste la largeur d’'impulsion pour tenir compte de la période spécifiée.
Opérations depuis le panneau avant

Appuyez sur [Waveform] > Pulse > Pulse Width. Utilisez le clavier numérique ou le bouton et la fleche pour définir
une valeur souhaitée. Si vous utilisez le clavier, sélectionnez un préfixe unitaire pour terminer.
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KEYSIGHT
TECHNOLOGIES

Period  100.000,000 ms

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°
Pulse Width 10_ seconds
Lead Edge 4.0ns

Trail Edge 4.0 ns

Commande SCPI

[SOURce[1]2]:]FUNCtion:PULSe:WIDTh {<seconds>|MINimum|MAXimum|DEFault}

Rapport cyclique d’impulsion

Le rapport cycligue d’une impulsion se définit comme suit :
Rapport cyclique = 100 (Largeur d’impulsion)/Période

La largeur des impulsions est le temps écoulé entre le niveau a 50 % du front montant et le niveau a 50 % du front
descendant suivant de limpulsion.

- Rapport cyclique d’impulsion : 0.07 % & 99.99 % (voir les limitations ci-dessous). La valeur par défaut est de 10%.

- Le rapport cyclique d’une impulsion doit respecter les conditions suivantes imposées par la largeur minimale de
limpulsion (Wmin).

L'instrument ajustera le rapport cyclique d’impulsion pour tenir compte de la période spécifiée.
Rapport cyclique> 100 (Largeur minimum d’impulsion) / Période
et
Rapport cyclique< 100 (1 - (Largeur d’impulsion/Période))

La largeur d’impulsion minimale est de 16 ns.

- Plus les fronts sont importants, plus la largeur d'impulsion minimum est grande. Des fronts importants limitent
donc le rapport cyclique.

Opérations depuis le panneau avant

. Sélection d’une fonction d'impulsion : Appuyez sur [Waveform] > Pulse.
. Basculer sur le rapport cyclique : Appuyez sur [Units] > Width Duty Cyc > Width Duty Cyc.
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3. Saisir le rapport cyclique : Appuyez sur [Parameter] > Duty Cycle. Utilisez le clavier numérique ou le bouton et la
fleche pour définir une valeur souhaitée. Sivous utilisez le clavier, appuyez sur la touche Percent pour terminer.

KEYSIGHT

TECHNOLOGIES

Period 100.000,000 ms Percent

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°
Duty Cycle 50_
Lead Edge
Trail Edge

Commande SCPI

[SOURce[1]2]:]FUNCtion:PULSe:DCYCle {<percent>|MINimum|MAXimum|DEFault}

Temps de front

Les temps de front indiquent la durée des transitions des fronts montant et descendant de Uimpulsion,
indépendamment ou ensemble. Le temps de front représente le temps entre 10 % et 90 % du seuil.

- Temps de front : Minimum de 8,4 ns. Maximum de 1 s et, par défaut, 10 ns.

- Le temps de front spécifié doit étre contenu dans la largeur d’impulsion spécifiée (voir ci-dessus). L'instrument
ajuste le temps de front afin qu’il tienne compte de la largeur d’'impulsion spécifiée.

Opérations depuis le panneau avant

1. Pour définir les délais de transition pour les fronts de l'impulsion de maniére indépendante : Appuyez sur [Wave-
form] > Pulse > Edge > Each Both.

2. Appuyez sur Lead Edge pour définir le délai de transition pour le front montant de Uimpulsion. Utilisez le clavier
numeérigue ou le bouton et la fleche pour définir une valeur souhaitée. Sivous utilisez le clavier, sélectionnez un pré-
fixe unitaire pour terminer.
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3. Appuyez sur Trail Edge pour définir le délai de transition pour le front descendant de Uimpulsion. Utilisez le clavier
numérique ou le bouton et la fleche pour définir une valeur souhaitée. Sivous utilisez le clavier, sélectionnez un pré-
fixe unitaire pour terminer.

Period  100.000,000 ms

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°
Duty Cycle 50.00 %
Lead Edge 4.0ns
Trail Edge 4.0 ns

1. Pour définir les délais de transition pour les fronts de U'impulsion de fagon conjointe : Appuyez sur [Waveform] >
Pulse > Edge > Each Both.

2. Appuyez sur Edge Time pour définir les délais de transition pour les fronts montant et descendant de l'impulsion. Uti-
lisez le clavier numérigue ou le bouton et la fleche pour définir une valeur souhaitée. Sivous utilisez le clavier, sélec-
tionnez un préfixe unitaire pour terminer.

KEYSIGHT
TECHNOLOGIES

PULS,500Q

Parameter

Each
Period  100.000,000 ms o

Amplitude 100.0 mVpp Edge

Time

Offset +0.000V

Phase 0.0°
Duty Cycle 50.00 %

Edge Time 1.0ns
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Commande SCPI
[SOURce[1]2]:]FUNCtion:PULSe:TRANsition:LEADing{<seconds>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]FUNCtion:PULSe:TRANsition:TRAiling
{<seconds>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]FUNCtion:PULSe:TRANsition[:BOTH] {<seconds>|MINimum|MAXimum|DEFault}

Modulation d’amplitude (AM) - Modulation de fréquence (FM)

Un signal modulé est composé d’un signal de porteuse et d’un signal modulant. En modulation d’amplitude (AM), la
tension du signal modulant fait varier 'amplitude du signal porteur. En modulation de fréquence (FM), la tension du
signal modulant fait varier la fréquence du signal porteur. Sur un instrument 2 voies, une voie peut moduler l'autre.

Sélectionnez AM ou FM avant de configurer un parametre de modulation. Pour en savoir plus sur la modulation, voir
Modulation.

Pour sélectionner AM ou FM

- L'instrument permet d’activer un seul mode de modulation sur une voie. Lorsque vous activez AM ou FM, toute
autre modulation est inactive. Sur les modeles 2 voies, les modulations des 2 voies sont indépendantes ; Uinstrument
peut ajouter des signaux modulés provenant des 2 voies. Consultez PHASe:SYNChronize and COMBine:FEED dans
le Guide de programmation de la série EDU33270 pour plus d’informations.

- Linstrument ne permet pas d’activer AM ou FM en mode balayage ou rafale. L’activation de la modulation (AM ou
FM) désactive les modes balayage et rafale.

- Pour éviter plusieurs modifications des signaux, activez la modulation apres avoir configuré les autres parametres
de modulation.

Opérations depuis le panneau avant
Appuyez sur [Modulate] > Type AM.
ou

Appuyez sur [Modulate] > Type AM > Type FM.
Puis activez la modulation : Appuyez sur [Modulate] > Modulate ON | OFF > Modulate ON | OFF.

104 Guide de I'utilisateur Keysight série EDU33210



KEYSIGHT
TECHNOLOGIES

SIN,50Q
FM Modulated by Sine

Modul
Frequency 1.000,000,000 kHz Mber 100 - OFF

Amplitude 100.0 mVpp FM Freq 10.000,000 Hz ,, -
) ; Fi

Offset +0.000V
Fi

Phase 0.0° Dev

Fi
Freq

Shape
Sine

Source

Internal

Le signal est envoyé en utilisant les parameétres actuels de la porteuse et du signal modulant.

Commande SCPI
[SOURce[1]|2]:]AM:STATe{ON|1|OFF |0}

[SOURce[1]2]:]FM:STATe {ON|1|OFF|0}

Forme du signal porteur

- Forme du signal porteur AM ou FM : Sinusoidal (par défaut), signal carré, rampe, impulsion triangle, bruit (AM
uniguement), PRBS ou signal arbitraire. Vous ne pouvez pas utiliser de courant continu comme signal porteur.

- Pour la modulation FM, la fréquence porteuse doit toujours étre supérieure ou égale a la variation de fréquence.
Une tentative de configuration d’une variation supérieure a la fréquence porteuse provoque la configuration de la
variation égale a la fréquence porteuse.

- Lafréguence porteuse augmentée de la variation ne peut pas étre supérieure a la fréquence maximale de la
fonction sélectionnée plus 100 kHz. Si vous essayez de configurer la variation avec une valeur incorrecte,
linstrument U'ajuste a la valeur maximale autorisée avec la fréquence porteuse active. L'interface distante produit
également l'erreur de données hors tolérances (Data out of range).

Opérations depuis le panneau avant
Appuyez sur [Waveform]. Sélectionnez ensuite une forme de signal.

Commande SCPI
[SOURce[1]2]:]FUNCtion <function>

La commande APPLy configure un signal en une seule commande.
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Fréquence porteuse

La fréquence porteuse maximale varie selon la fonction, le modele et la tension de sortie (voir ci-dessous). La valeur
par défaut est 1 kHz pour toutes les fonctions autres que le signal arbitraire. La « fréquence » d’un signal arbitraire se
définit également au moyen de la commande FUNCtion:ARBitrary:SRATe.

Opérations depuis le panneau avant

Appuyez sur [Parameter] > Frequency. Utilisez le clavier numérique ou le bouton et la fleche pour définir une valeur
souhaitée. Sivous utilisez le clavier, sélectionnez un préfixe unitaire pour terminer.

SIN,50Q
FM Modulated by Sine

Frequency 1_

FM Dev 100 Hz

Amplitude 100.0 mVpp -.._FM Freq 10.000,000 Hz
Offset +0.000V

Phase 0.0°

Commande SCPI
[SOURce[1]2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

La commande APPLy configure un signal en une seule commande.

Forme du signal modulant

Sur un instrument 2 voies, vous pouvez moduler les voies entre elles.

Vous ne pouvez pas moduler du bruit avec du bruit, un signal PRBS avec un signal PRBS ou un signal arbitraire avec
un signal arbitraire.

La forme du signal modulant (source interne) peut étre :

- Onde Sinusoidale
- Signal carré avec un rapport cyclique de 50 % |_|_|
- Signal triangle avec une symétrie de 50 % /\

- Rampe montante UpRamp avec une symétrie de 100 % /I
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- Rampe descendante DnRamp avec une symétrie de O % I\
— Bruit : Bruit blanc gaussien

- PRBS : Séquence binaire pseudo aléatoire (polyndme PN7)

- Arb : Signal arbitraire

Opérations depuis le panneau avant

Appuyez sur [Modulate] > Type AM.
ou
Appuyez sur [Modulate] > Type AM > Type FM.
Choisissez ensuite la forme de modulation : Appuyez sur Shape.
KEYSIGHT

SIN,500Q

FM Modulated by Sine Verhikien

— ey | i
Frequency 1.000,000,000 kHz Mber  100Hs - OFF

Amplitude 100.0 mVpp FM Freq 10.000,000 Hz ,, -
) ; Fi
Offset +0.000V

Phase 0.0°

Source

Internal

Commande SCPI
[SOURce[1l]|2]:]AM:INTernal :FUNCtion <function>

[SOURce[1]|2]:]FM:INTernal :FUNCtion <function>

Fréquence du signal modulant

Fréguence de modulation (source interne) : le minimum est de 1 uHz et les valeurs maximales varient selon la
fonction.

Opérations depuis le panneau avant
Appuyez sur [Modulate] > Type AM > AM Freq.
ou

Appuyez sur [Modulate] > Type AM > Type FM > FM Freq.
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Entrez ensuite la fréquence AM ou FM avec le bouton et le clavier numérique. Si vous utilisez le clavier, sélectionnez
un préfixe unitaire pour terminer.
KEYSIGHT

SIN,50Q
FM Modulated by Sine

Frequency 1.000,000,000 kHz FMDer 100 Hz e

Amplitude 100.0 mVpp I.__FM Freq 1

Offset +0.000V

Phase 0.0°

Commande SCPI
[SOURce[1]2]:]AM:INTernal :FREQuency {<frequency>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]FM:INTernal:FREQuency {<frequency>|MINimum|MAXimum|DEFault}

Profondeur de modulation (AM)

La profondeur de modulation est un pourcentage qui représente la variation d’amplitude. Pour une profondeur de
0 %, 'amplitude est égale a la moitié de 'amplitude du signal porteur. Pour une profondeur de 100 %, 'amplitude
varie en fonction du signal modulant de 0 % a 100 % de 'amplitude du signal porteur.

- Profondeur de modulation: 0 % a 120 %. La valeur par défaut est de 100 %.

- Méme a une profondeur supérieure a 100 %, l'instrument ne dépasse pas + 5 Vpeak sur la sortie (dans une charge
de 50 Q). Pour obtenir une profondeur de modulation supérieure a 100 %, 'amplitude du signal porteur peut étre
réduite.

Opérations depuis le panneau avant

Appuyez sur [Modulate] > Type AM > AM Depth. Utilisez le clavier numérique ou le bouton et la fleche pour définir
une valeur souhaitée. Sivous utilisez le clavier, appuyez sur la touche Percent pour terminer.
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KEYSIGHT
TECHNOLOGIES

SIN,50Q
AM Modulated by Sine

Frequency 1.000,000,000 kHz M Depth  [B Parcent

Amplitude 100.0 mVpp .,__AM Freq 100.000,000 Hz
Offset +0.000 V

Phase 0.0°

Commande SCPI

[SOURce[1]2]:]AM[:DEPTh] {<depth in percent>|MINimum|MAXimum}

Signal porteur AM supprimé a double bande latérale

L'instrument prend en charge deux types de modulation d’amplitude : « Normal » et Signal porteur AM supprimé a
double bande latérale (DSSC). En mode DSSC, le signal porteur est absent a moins que U'amplitude du signal
modulant soit positive.

Opérations depuis le panneau avant

Appuyez sur [Modulate] > Type AM > MORE 1 /2 > DSCC ON | OFF > DSCC ON | OFF.

KEYSIGHT
TECHNOLOGIES

SIN,50Q
AM Modulated by Sine

Frequency 1.000,000,000 kHz AM Depth  50.00% ornal

_—————— 0N OFF

Offset +0.000V

Phase 0.0°
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Commande SCPI

[SOURce[1]2]:]AM:DSSC{ON|1|OFF |0}

Variation de fréquence (FM)

Le réglage de déviation de fréquence représente la variation de créte dans la fréquence du signal modulé de la
fréquence porteuse.

Lorsque le signal porteur est de type PRBS, la variation de fréguence entraine une variation de la vitesse de
transmission égale a la moitié de la fréquence réglée. Par exemple, une variation de 10 kHz est équivalente a une
variation de b KBPS du débit binaire.

- Variation de fréquence : 1 uHz a (fréquence du signal porteur) / 2, 100 Hz par défaut.

- Pour la modulation FM, la fréquence porteuse doit toujours étre supérieure ou égale a la variation de fréguence.
Une tentative de configuration d’une variation supérieure a la fréquence porteuse provoque la configuration de la
variation égale a la fréquence porteuse.

- Lafréguence porteuse augmentée de la variation ne peut pas étre supérieure a la fréquence maximale de la
fonction sélectionnée plus 100 kHz. Si vous essayez de configurer la variation avec une valeur incorrecte,
Uinstrument Uajuste a la valeur maximale autorisée avec la fréquence porteuse active. Linterface distante produit
également l'erreur de données hors tolérances (Data out of range).

Opérations depuis le panneau avant

Appuyez sur [Modulate] > Type AM > Type FM > Freq Dev. Utilisez le clavier numérique ou le bouton et la fleche
pour définir une valeur souhaitée. Sivous utilisez le clavier, choisissez une unité de préfixe pour terminer.

SIN,50Q
FM Modulated by Sine

Frequency 1.000,000,000 kHz FM Dev 1

Amplitude 100.0 mVpp .,__FM Freq 1.000,000,000 kHz

Offset +0.000V

Phase 0.0°

Commande SCPI

[SOURce[1]2]:]FM[:DEViation] {<peak deviation in Hz>|MINimum|MAXimum|DEFault}
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Source modulante

Sur un instrument 2 voies, vous pouvez moduler les voies entre elles.
- Source modulante : Internal (par défaut) ou Channel#.

- Exemple AM : Avec une profondeur de modulation de 100 %, lorsque le signal modulant est a +5 V, lamplitude de
la sortie est maximale. Lorsque le signal modulant est a -5V, lamplitude de la sortie est minimale.

- Exemple FM : Avec une variation de 10 kHz, un signal +5 V correspond a une augmentation de fréquence de
10 kHz. Des signaux externes plus faibles produisent une variation moindre et les signaux négatifs réduisent la
fréquence au-dessous de la fréquence porteuse.

Opérations depuis le panneau avant

Apres avoir activé Type AM ou Type FM, sélectionnez la source modulante comme suit : Appuyez sur MORE1/2 >
Source.

KEYSIGHT
TECHNOLOGIES

SIN,50Q
AM Modulated by Sine

— Ty s
Frequency 1.000,000,000 kHz AM Depth 50.00% ource

= - [nternal
Channel2 :

Amplitude 100.0 mVpp | AMFreq  100.000,000 Hz J DSSC
- ON " OFF

Offset +0.000V

Phase 0.0°

Commande SCPI

[SOURce[1]2]:]AM:S0OURce {INTernal|CH1|CH2}

[SOURce[1]2]:]FM:SOURce {INTernal|CH1|CH2}

Modulation de phase (PM)

Un signal modulé est composé d’un signal de porteuse et d’un signal modulant. Le mode PM ressemble beaucoup
au mode FM, mais en mode PM, la phase du signal modulé varie en fonction de la tension instantanée du signal
modulant.

Pour des notions de base sur la modulation de phase, voir Modulation.
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Pour sélectionner la modulation de phase

- Un seul mode de modulation peut étre actif a un instant donné. L’'activation de la modulation de phase désactive le
mode de modulation précédent.

- L’activation de la modulation de phase désactive les modes balayage et rafale.

Opération depuis le panneau avant

Appuyez sur [Modulate] > Type AM > Type PM.

Le signal est envoyé en utilisant les parametres actuels de la porteuse et du signal modulant.

Pour éviter plusieurs modifications des signaux, activez la modulation aprés avoir configuré les autres parametres de
modulation.

Commande SCPI

[SOURce[1]2]:]PM:STATe {ON|1|OFF|0}

Forme du signal porteur

Forme du signal porteur en modulation de phase (PM) : sinusoide (par défaut), signal carré, rampe, triangle,
impulsion, PRBS ou signal arbitraire. Vous ne pouvez pas utiliser de bruit ou de courant continu comme signal
porteur.

Opération depuis le panneau avant

Appuyez sur [Waveform]. Sélectionnez ensuite un type de signal, a 'exception de Bruit ou CC.
Commande SCPI

[SOURce[1]|2]:]FUNCtion <function>

- La commande APPLy configure un signal en une seule commande.

- Lorsque le signal porteur est un signal arbitraire, la modulation a une influence sur « ’horloge » d’échantillonnage
a la place du cycle complet défini par 'ensemble d’échantillonnage du signal arbitraire. De ce fait, 'application de la
modulation de phase a des signaux arbitraires est limitée.

Fréquence porteuse

La fréquence porteuse maximale varie selon la fonction, le modele et la tension de sortie (voir ci-dessous). La valeur
par défaut est 1 kHz pour toutes les fonctions autres que le signal arbitraire. La fréquence du signal porteur doit étre
20 fois supérieure a la modulation de modulation en créte.

Opération depuis le panneau avant

Appuyez sur AM Freq ou FM Freq ou toute autre touche de fréquence. Utilisez le clavier numérique ou le bouton et
la fleche pour définir une valeur souhaitée. Si vous utilisez le clavier, choisissez une unité de préfixe pour terminer.

Commande SCPI

[SOURce[1]2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}
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La commande APPLy configure un signal en une seule commande.

Forme du signal modulant

La forme du signal modulant peut étre :

- Onde Sinusoidale

- Signal carré avec un rapport cyclique de 50 % |_|_|

- Signal triangle avec une symétrie de 50 % /\

- Rampe montante UpRamp avec une symétrie de 100 % /I

- Rampe descendante DnRamp avec une symétrie de 0 % I\
— Bruit : Bruit blanc gaussien

- PRBS : Séquence binaire pseudo aléatoire (polynéme PN7)

- Arb : Signal arbitraire

Vous pouvez utiliser le bruit comme signal modulant, mais vous ne pouvez pas utiliser le bruit ou le courant continu
comme signal porteur.

Opération depuis le panneau avant

Appuyez sur [Modulate] > Type AM > Type PM > Shape Sine.

KEYSIGHT
TECHNOLOGIES

SIN,50Q

PM Modulated by Sine Modulation

— Oy Modul
Frequency 1 .000,000,000 kHZ Phase Dev  180.0° W‘(.) ug::::

Amplitude 100.0 mvpp -.__PM Freq 1.000,000,000 kHz

Offset +0.000V

Phase 0.0°

Internal

Commande SCPI

SCPI:[SOURce[1]2]:]PM:INTernal:FUNCtion <function>
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Fréquence du signal modulant

Fréguence de modulation : par défaut 10 Hz, minimum 1 pHz, le maximum varie en fonction du modele, de la
fonction et de la tension de sortie, comme représenté ici.

Opération depuis le panneau avant

Appuyez sur [Modulate] > Type AM > Type PM > PM Freq.

Puis définissez la fréquence du signal de modulation avec le bouton et le clavier. Si vous utilisez le clavier, choisissez
une unité de préfixe pour terminer.
KEYSIGHT

SIN,50Q
PM Modulated by Sine

Frequency 1 .000,000,000 kHz Phase Dev  180.0° uHz

Amplitude 100.0 mVpp I.__PM Freq 1

Offset +0.000V

Phase 0.0°

Commande SCPI

SCPI : [SOURce[1l|2]:]PM:INTernal:FREQuency{<frequency>|MINimum|MAXimum|DEFault}

Variation de phase

Le réglage de déviation de phase représente la variation de créte dans la phase du signal modulé du signal de
porteuse. La variation de phase est configurable de 0 a 360 degrés (180 par défaut).

Opération depuis le panneau avant

Appuyez sur [Modulate] > Type AM > Type PM > Phase Dev.

Puis définissez la variation de phase avec le bouton et le clavier.

Commande SCPI

[SOURce[1]2]:]PM:DEViation {<deviation in degrees>|MINimum|MAXimum|DEFault}

Lorsque le signal porteur est un signal arbitraire, la variation s’applique a 'horloge d’échantillonnage. Par
conséquent, Ueffet du signal arbitraire complet est bien moindre que pour les signaux standard. La diminution de
l'effet dépend du nombre de points du signal arbitraire.
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Source modulante

Source modulante : Internal (par défaut) ou Channel#.
Opération depuis le panneau avant

Appuyez sur [Modulate] > Type AM > Type PM > Source.

KEYSIGHT
TECHNOLOGIES

SIN,50Q

PM Modulated by Sine Modulation

— Oy Modul
Frequency 1.000,000,000 kHZ Phase Dev 270.0° W‘(.) ug::::

Amplitude 100.0 mvpp -.__PM Freq 1.000,000,000 kHz

Offset +0.000V

Phase 0.0°

# Internal Source

~ _ [nternal
Channel2

Commande SCPI

[SOURce[1]2]:]PM:SOURce {INTernal|CH1|CH2}

Modulation par déplacement de fréquence (FSK)

Vous pouvez configurer Uinstrument pour « faire dériver » sa fréquence de sortie entre deux valeurs prédéfinies
(appelées la « fréguence du signal porteur » et la « fréquence de saut ») avec la commande FSK modulation. La
vitesse de dérive de la sortie entre ces deux fréquences est déterminée par le générateur interne ou le niveau du
signal sur le connecteur Ext Trig du panneau avant.

Voir Utilisation des menus du panneau avant - Envoyer un signal FSK pour plus d’'informations sur la modulation
FSK au moyen du panneau avant de Uinstrument.

Pour sélectionner le mode de modulation FSK

- Un seul mode de modulation peut étre actif a un instant donné. L’activation de la modulation FSK désactive le
mode de modulation précédent.

- Vous ne pouvez pas activer la modulation FSK lorsque le mode balayage ou rafale est activé. L’activation de la
modulation FSK désactive les modes balayage et rafale.

— Pour éviter plusieurs modifications des signaux, activez la modulation aprés avoir configuré les autres parametres
de modulation.
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Commande SCPI

FSKey:STATe {OFF|ON}

Fréquence du signal porteur FSK

La fréquence porteuse maximale varie selon la fonction, le modele et la tension de sortie (voir ci-dessous). La valeur
par défaut est 1 kHz pour toutes les fonctions autres que le signal arbitraire.

Lorsque le niveau logique est bas, la fréquence du signal porteur est envoyée. Lorsque le niveau logique est haut, la
fréguence de saut est envoyée.

Commande SCPI

[SOURce[1]2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

Fréquence de saut FSK

La fréguence secondaire (saut) maximale dépend de la fonction utilisée. La valeur par défaut est 100 Hz pour toutes
les fonctions. Le signal modulant interne est un signal carré de rapport cyclique égal a 50 %.

Fonction Fréquence de saut minimale Fréquence de saut maximale
Sinusoidal 1 pHz 20 MHz
Carré 1 pHz 10 MHz
Rampe/Triangle 1 pHz 200 kHz
Impulsion 1 pHz 10 MHz

Lorsque la source External est sélectionnée, la fréquence de sortie est déterminée par le niveau du signal sur le
connecteur Ext Trig du panneau avant. Lorsque le niveau logique est bas, la fréquence du signal porteur est
envoyée. Lorsque le niveau logique est haut, la fréquence de saut est envoyée.

Commande SCPI

[SOURce[1]2]:]FSKey:FREQuency {<frequency>|MINimum|MAXimum|DEFault}

Fréquence de cadencement FSK

La fréquence de cadencement FSK définit la cadence a laquelle la fréquence de sortie « dérive » entre la fréquence
du signal porteur et la fréquence de saut lors de l'utilisation de la source interne de modulation FSK.

- Fréguence de cadencement FSK (source interne) : 125 uHz a 1 MHz, 10 Hz par défaut.
- La fréguence de cadencement FSK est ignorée lorsque la source de modulation externe FSK est sélectionnée.
Commande SCPI

[SOURce[1]2]:]FSKey:INTernal :RATE {<rate in Hz>|MINimum|MAXimum}
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Source FSK

Peut étre Internal (défaut) ou External.

- Lorsque la source Internal est sélectionnée, la vitesse a laguelle la fréquence de sortie « dérive » entre la fréquence
du signal porteur et la fréquence de saut est déterminée par la fréquence de cadencement FSK. Le signal modulant
interne est un signal carré de rapport cyclique égal a 50 %.

- Lorsque la source External est sélectionnée, la fréquence de sortie est déterminée par le niveau du signal sur le
connecteur Ext Trig du panneau avant. Lorsque le niveau logique est bas, la fréquence de sortie est envoyeée.
Lorsque le niveau logique est haut, la fréquence de saut est envoyée.

- Le connecteur utilisé pour les signaux FSK déclenchés extérieurement (Ext Trig) n’est pas le méme que celui utilisé
pour les signaux modulés extérieurement AM, FM, PM et PWM (Modulation In). Lorsqu’il est utilisé pour la
modulation FSK, la polarité des fronts du connecteur Ext Trig n’est pas réglable.

Commande SCPI

[SOURce[1|2]:]FSKey:SOURce {INTernal |EXTernal}

Modulation de largeur d’'impulsion (PWM)

Cette rubrigue décrit la modulation de largeur d'impulsion (PWM). La modulation PWM est disponible uniguement
pour un train d'impulsions ; la largeur des impulsions varie en fonction du signal modulant. La variation de la largeur
des impulsions est appelée la largeur des impulsions ; elle peut étre spécifiée en pourcentage de la période du signal
(rapport cycliqgue) ou en unité de temps. Par exemple, si vous spécifiez une impulsion avec un rapport cyclique égal a
20 % et activez ensuite la modulation PWM avec une variation de 5 %, le rapport cyclique varie de 15 % a 25 % sous
le contréle du signal modulant.

Pour sélectionner la modulation de largeur d’impulsion (PWM)

Vous ne pouvez pas activer la modulation PWM lorsque le mode balayage ou rafale est activé.

Pour éviter plusieurs modifications des signaux, activez la modulation apres avoir configuré les autres parametres de
modulation.

Opérations depuis le panneau avant

1. Appuyez sur [Waveform] > Pulse.
2. Appuyez sur [Modulate] > Type AM > Type PWM.
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3. Appuyez sur Modulate ON | OFF > Modulate ON | OFF.

KEYSIGHT
PULS,50Q ECHNOLOGIES
PWM Modulated by Sine

-~y Modulate
Frequency 1.000,000,000 kHz PWM Dev  0.000,000,000's OO

Amplitude 100.0 mVpp .,__PWM Freq 10.000,000 Hz

Offset +0.000V

Phase 0.0°

Pulse Width 10.000,0 ps
Lead Edge 4.0ns

Trail Edge 4.0 ns

Source

Internal

Le signal est envoyé en utilisant les parameétres actuels de la porteuse et du signal modulant.

Commande SCPI

[SOURce[1]2] :]PWM:STATe {ON|1|OFF|0}

Forme du signal modulant

La forme du signal modulant (source interne) peut étre :

- Onde Sinusoidale

- Signal carré avec un rapport cyclique de 50 % |_|_|

- Signal triangle avec une symétrie de 50 % /\

- Rampe montante UpRamp avec une symétrie de 100 % /I

- Rampe descendante DnRamp avec une symétrie de 0 % I\
— Bruit : Bruit blanc gaussien
- PRBS : Séquence binaire pseudo aléatoire (polynéme PN7)

- Arb : Signal arbitraire
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Opérations depuis le panneau avant

1. Appuyez sur [Waveform] > Pulse.

2. Appuyez sur [Modulate] > Type PWM > Shape Sine.

PULS,50Q
PWM Modulated by Sine

Frequency 1.000,000,000 kHz
Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Pulse Width 10.000,0 ps
Lead Edge 4.0 ns

Trail Edge 4.0ns

Commande SCPI

KEYSIGHT

TECHNOLOGIES

— Oy Modulate
PWM Dev  0.000,000,000 s ‘ ON""OFF

PWM Freq  10.000,000 Hz

Type
Py

P
Dev

P
Freq

Shape
Sine

Source

Internal

[SOURce[1]2]:]PWM:INTernal:FUNCtion <function>

Fréquence du signal modulant

Fréquence de modulation : La valeur par défaut est 10 Hz et le minimum est 1 uHz. La fréquence maximale varie

selon la fonction, le modéle et la tension de sortie, comme illustré ici.
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Opérations depuis le panneau avant

1. Appuyez sur [Waveform] > Pulse.
2. Appuyez sur [Modulate] > Type PWM > PWM Freq.

Utilisez le clavier numérique ou le bouton et la fleche pour définir une valeur souhaitée. Si vous utilisez le clavier,
choisissez une unité de préfixe pour terminer.

KEYSIGHT
TECHNOLOGIES

PULS,50Q
PWM Modulated by Sine

Frequency 1.000,000,000 kHz PWM Dev  0.000,000,000 s

Amplitude 100.0 mVpp LPWM Freq 1_

Offset +0.000V

Phase 0.0°

Pulse Width 10.000,0 ps
Lead Edge 4.0 ns

Trail Edge 4.0ns

Commande SCPI

[SOURce[1]2]:]PWM:INTernal:FREQuency {<frequency>|MINimum|MAXimum|DEFault}

Variation de la largeur ou du rapport cyclique

La variation PWM est la variation de largeur en créte de Uimpulsion modulée. L'unité de ce parametre peut étre le
temps ou le rapport cyclique.

Opérations depuis le panneau avant

1. Appuyez sur [Waveform] > Pulse.
2. Appuyez sur [Modulate] > Type PWM > PWM Dev. Utilisez le clavier numérique ou le bouton et la fleche pour définir
une valeur souhaitée. Si vous utilisez le clavier, choisissez une unité de préfixe pour terminer.

Pour définir la variation en termes de rapport cyclique :

1. Appuyez sur [Units] >Width Duty Cyc > Width Duty Cyc.
2. Appuyez sur [Modulate] > Duty Cycle. Utilisez le clavier numérique ou le bouton et la fleche pour définir une valeur
souhaitée. Sivous utilisez le clavier, appuyez sur la touche Percent pour terminer.

Commande SCPI

[SOURce[1l]2]:]PWM:DEViation {<deviation>|MINimum|MAXimum|DEFault}
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- La somme de la largeur d’impulsion et de la variation doit remplir la formule :
Largeur d'impulsion + Variation < Période - 16 ns

- Sinécessaire, linstrument ajuste la variation afin qu’elle tienne compte de la période spécifiée.

Source modulante

Source modulante : Internal (par défaut) ou Channel#.
Opérations depuis le panneau avant

1. Appuyez sur [Waveform] > Pulse.
2. Appuyez sur [Modulate] > Type PWM > Source.

KEYSIGHT
TECHNOLOGIES

PULS,500Q

PWM Modulated by Sine Modulation

fodulate
Frequency 1.000,000,000 kHz PWM Dev  1.000.000.000 s ON" " OFF

Amplitude 100.0 mVpp PWM Freq  500.000,000 Hz o
) PWM

Offset +0.000V

Phase 0.0°

Pulse Width 10.000,0 ps
Lead Edge 4.0 ns

Trail Edge 4.0ns

_ - Internal
Channel2

Commande SCPI

[SOURce[1]2]:]PWM:SOURce {INTernal|CH1|CH2}

Signal d’impulsion
L'impulsion est la seule forme de signal prise en charge pour la modulation PWM.

Opérations depuis le panneau avant

Appuyez sur [Waveform] > Pulse.
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KEYSIGHT

TECHNOLOGIES

Parameter

Frequency 1.000,000,000 kHz Frequency

Amplitude 100.0 mVpp Amplitude

Offset +0.000V

Dffset
Phase 0.0°

Pulse Width 10.000,0 ps Phase
~5-
Lead Edge 4.0ns

Pulse

Trail Edge 4.0 ns Width

Edge
~5-

Commande SCPI
FUNCtion PULSe

La commande APPLy configure un signal en une seule commande.

Période de U'impulsion

La plage de période des impulsions est l'inverse de la fréquence maximale de 'instrument jusqu’a 1 000 000 s
(100 us par défaut). Remarque : la période du signal limite la variation maximale.

Opérations depuis le panneau avant

1. Appuyez sur [Waveform] > Pulse.
2. Appuyez sur [Units] > Frequency Periodic > Frequency Periodic.

KEYSIGHT

TECHNOLOGIES

Units

peiod  0.000100 s igh/Low
Amplitude  0.700000 Vpp Amplitude
Offset 0.000000 V M
Phase 0.000000 Phase
Pulse Width 0.000010 s egres
Lead Edge 0.000000 s Sweep

Trail Edge 0.000000 s trtStop

Frequency
Periodic ]
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Commande SCPI

[SOURce[1]2]:]FUNCtion:PULSe:PERiod {<seconds>|MINimum|MAXimum|DEFault}

Modulation par addition

La modulation par addition ajoute un signal modulant a un signal porteur ; elle s’utilise généralement pour ajouter
du bruit gaussien a un signal porteur. Le signal modulant est ajouté au signal porteur en tant que pourcentage de
U'amplitude du signal porteur.

Activer la somme

Pour éviter plusieurs modifications des signaux, activez Sum apres avoir configuré les autres parameétres de
modulation.

Opérations depuis le panneau avant

1. Appuyez sur [Modulate] > Type AM > Type Sum.
2. Appuyez sur Modulate ON | OFF > Modulate ON | OFF.

KEYSIGHT
PULS,50Q o
Sum Modulated by Sine

—ammy—————————— | s
Sum Ampl  100.0 m% ’ ON""OFF

Amplitude 100.0 mVpp l.-—Sum Freq  100.000,000 Hz

Period 100.000 ps

Type
Sum
Offset +0.000V

Sum

Ampl
Phase 0.0° -

Pulse Width 10.000,0 ps Sum
I S

Lead Edge 4.0ns

Trail Edge 4.0 ns

Source

Internal

Commande SCPI
[SOURce[1]2]:]1SUM:STATe {ON|1|OFF|0}
Forme du signal modulant

Sur un instrument 2 voies, vous pouvez moduler les voies entre elles.
La forme du signal modulant peut étre :

- Onde Sinusoidale
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- Signal carré avec un rapport cyclique de 50 % |_|_|
- Signal triangle avec une symétrie de 50 % /\
- Rampe montante UpRamp avec une symétrie de 100 % /I

- Rampe descendante DnRamp avec une symétrie de 0 % I\
- Bruit : Bruit blanc gaussien

- PRBS : Séquence binaire pseudo aléatoire (polyndme PN7)

- Arb : Signal arbitraire

Opérations depuis le panneau avant

Appuyez sur [Modulate] > Type Sum > Shape Sine.

SIN,50Q
Sum Modulated by Sine

Modulate
Frequency 1.000,000,000 kHz Sum Ampl  100.0 m% 0K OFF

Amplitude 100.0 mVpp l.-—Sum Freq  100.000,000 Hz -
Sum

Offset +0.000V

Sum

Ampl

Phase 0.0°
Sum
Freq

Source

Internal

Commande SCPI

[SOURce[1]2]:]SUM: INTernal :FUNCtion <function>

Fréquence du signal modulant

Sur un instrument 2 voies, vous pouvez moduler les voies entre elles.

Fréquence de modulation : La valeur par défaut est 100 Hz et le minimum est 1 uHz.
Opérations depuis le panneau avant

Appuyez sur [Modulate] > Type Sum > Sum Freq.

Utilisez le clavier numérique ou le bouton et la fleche pour définir une valeur souhaitée. Sivous utilisez le clavier,
choisissez une unité de préfixe pour terminer.
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KEYSIGHT
TECHNOLOGIES
SIN,50Q
Sum Modulated by Sine

Frequency 1.000,000,000 kHz ] e

Amplitude 100.0 mVpp I.__Sum Freq 1_

Offset +0.000V

Phase 0.0°

Commande SCPI

[SOURce[1]2]:]1SUM:INTernal:FREQuency {<frequency>|MINimum|MAXimum|DEFault}

Amplitude de la somme

L’amplitude de la somme représente 'amplitude du signal ajouté au signal porteur (en pourcentage de U'amplitude
du signal porteur).

- Parametre d’amplitude : 0 a 100 % de 'amplitude du signal porteur, résolution 0,07 %.

- L’amplitude de la somme reste une fraction importante de 'amplitude du signal porteur et suit ses variations.
Opérations depuis le panneau avant

Appuyez sur [Modulate] > Type Sum > Sum Ampl.

Utilisez le clavier numérique ou le bouton et la fleche pour définir une valeur souhaitée. Sivous utilisez le clavier,
appuyez sur la touche Percent pour terminer.
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SIN,50Q
Sum Modulated by Sine

Frequency 1.000,000,000 kHz
Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Commande SCPI

KEYSIGHT

TECHNOLOGIES

Sum Ampl 10_

Sum Freq  500.000,000 Hz

Percent

[SOURce[1]2]:]SUM:AMPLitude {<amplitude>|MINimum|MAXimum|DEFault}

Source modulante

Sur un instrument 2 voies, vous pouvez moduler les voies entre elles.

Source modulante : Internal (par défaut) ou Channel#.

Opérations depuis le panneau avant

Appuyez sur [Modulate] > Type Sum > Source.

SIN,50Q
Sum Modulated by Sine

Frequency 1.000,000,000 kHz
Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

126

KEYSIGHT

TECHNOLOGIES

— Oy Modulate
Sum Ampl 10.00 % OM" " OFF
Sum Freq  500.000,000 Hz T

ype

Sum

Sum
Ampl

Sum
Freq

Shape

INe

# Internal Source

Internal
Channel2
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Commande SCPI

[SOURce[1]2]:]1SUM:SOURce {INTernal|CH1|CH2}

Balayage de fréquence

En mode balayage de fréquence, l'instrument passe de la fréquence initiale a la fréquence finale a une vitesse de
balayage spécifiée. Vous pouvez effectuer un balayage en fréquence croissant ou décroissant, et linéairement ou
selon une loi logarithmique. Vous pouvez également configurer l'instrument pour envoyer un balayage de la
fréguence initiale a la fréquence finale en appliquant un déclencheur externe ou manuel. L'instrument peut balayer
des signaux sinusoidaux, carrés, triangulaires ou arbitraires, les rampes ou les impulsions (les signaux PRBS et CC et
le bruit ne sont pas autorisés).

Vous pouvez spécifier un temps de maintien pendant lequel le balayage reste a la fréquence finale, ainsi qu’un
temps de retour pendant lequel la fréquence change linéairement de la fréquence finale a la fréquence initiale.

Pour plus d’informations, voir Balayage en fréquence.

Pour sélectionner le balayage

L'instrument n’autorise pas activation du mode balayage ou liste lorsque le mode rafale ou un mode de modulation
est activé. Lorsque vous activez le balayage, le mode rafale ou modulation est désactivé.

Pour éviter plusieurs modifications des signaux, activez le mode balayage aprées avoir configuré les autres
parametres.

Opérations depuis le panneau avant

Appuyez sur [Sweep] > Sweep ON | OFF> Sweep ON | OFF.

KEYSIGHT
TECHNOLOGIES

SIN,500Q

Linear Sweep, Trig Imm ep

_ — T Sweep
Frequency - Sweeping... Start Freq 100.000,000 Hz -

Amplitude 100.0 mVpp Stop Freq  1.000,000,000 kHz -
Sweep Time 1.000 s Linear

Hold Time 0.000s
Sweep
Return Time 0.000 s Time

Offset +0.000V

Phase 0.0°

Start
Freq

Stop
Freq

Hold Return
~-

Commande SCPI

[SOURce[1]2] :]FREQuency:MODE SWEEP
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[SOURce[1]2] :]SWEep:STATe {ON|1|OFF|0}

Fréquence initiale et fréquence finale

Les fréquences initiale et finale définissent les limites supérieure et inférieure du balayage. Le balayage commence a
la fréquence initiale, balaie jusqu’a la fréquence finale et revient ensuite a la fréquence initiale.

- Fréquences initiale et finale : 1 1Hz & la fréquence maximale pour le signal. La phase du balayage est continue sur
l'ensemble de la plage des fréquences. La fréquence initiale par défaut est 100 Hz. La fréquence finale par défaut est
de 1 kHz.

- Pour balayer en fréquence vers le haut, définissez une fréquence initiale inférieure a la fréquence finale. Pour
balayer en fréquence vers le bas, inversez cette relation.

- Parametre Sync Normal : Uimpulsion Sync est haute au cours du balayage.

- Parametre Sync signal porteur : le rapport cyclique de Uimpulsion Sync est égal a 50 % pour chaque cycle du
signal.

- Parametre Sync marqueur : limpulsion Sync monte au début et baisse a la fréquence du marqueur. Vous pouvez
modifier cela avec la commande OUTPut[1|2]:SYNC:MODEMARKER.

Opérations depuis le panneau avant

Appuyez sur [Sweep] > Start Freq.

Utilisez le clavier numérique ou le bouton et la fleche pour définir une valeur souhaitée. Sivous utilisez le clavier,
choisissez une unité de préfixe pour terminer.

SIN,500Q

Linear Sweep, Trig Imm

Frequency Sweeping...

Start Freq 1_

Amplitude 100.0 mVpp Stop Freq  1.000,000,000 kHz
Sweep Time 1.000 s

Hold Time 0.000s
Return Time 0.000 s

Offset +0.000V

Phase 0.0°

Appuyez sur Stop Freq.

Utilisez le clavier numérique ou le bouton et la fleche pour définir une valeur souhaitée. Sivous utilisez le clavier,
choisissez une unité de préfixe pour terminer.
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KEYSIGHT
SIN,500Q ECHNOLOGIES

Linear Sweep, Trig Imm

Frequency Sweeping... Start Freq  1.000,000,000 kHz Vi

Amplitude 100.0 mVpp Stop Freq 2
Sweep Time 1.000 s

Hold Time 0.000s
Return Time 0.000 s

Offset +0.000V

Phase 0.0°

Commande SCPI

[SOURce[1]2]:]FREQuency:STARt {<frequency>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]FREQuency:STOP {<frequency>|MINimum|MAXimum|DEFault}

Frégquence médiane et plage de fréquences

Vous pouvez également configurer les limites de la fréquence de balayage en utilisant une fréquence médiane et
une plage de fréquences. Ces parameétres similaires aux fréguences initiale et finale (ci-dessus) apportent une
certaine souplesse.

- Fréquence médiane : 1 uHz a la fréquence maximale pour le signal. La valeur par défaut est de 550 Hz.
- Plage de fréquences : Toute valeur entre +fréquence maximale pour le signal. La valeur par défaut est de 900 Hz.

- Pour balayer en fréquence croissantes, définissez une plage de fréquences positives ; pour balayer en fréquences
décroissantes, définissez une plage de frégquences négatives.

- Parametre Sync Normal : Uimpulsion Sync est haute au cours du balayage.

- Parametre Sync signal porteur : le rapport cycligue de U'impulsion Sync est égal a 50 % pour chaque cycle du
signal.

- Parametre Sync marqueur : limpulsion Sync monte au début et baisse a la fréquence du marqueur. Vous pouvez
modifier cela avec la commande OUTPut[1]2]:SYNC:MODEMARKER.
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Opérations depuis le panneau avant

. Appuyez sur [Units] > Sweep StrtStop.

Frequency 1000.000000 Hz
Amplitude  (0.700000 Vpp

Offset 0.000000 V
Phase 0.000000

KEYSIGHT

TECHNOLOGIES

High/Low

Amplitude
Vop

. Appuyez sur [Sweep] > Start Freq ou Stop Freq. Utilisez le clavier numérique ou le bouton et la fleche pour définir
une valeur souhaitée. Si vous utilisez le clavier, choisissez une unité de préfixe pour terminer.

ou

. Appuyez sur [Units] > Sweep CntrSpan.

Frequency  1000.000000 Hz
Amplitude  0.700000 Vpp
Offset 0.000000 V
Phase 0.000000

2. Appuyez sur [Sweep] > Center ou Span. Utilisez le clavier numérique ou le bouton et la fleche pour définir une valeur

KEYSIGHT

TECHNOLOGIES

High/Low
Amplitude
Vop

Phase

Degrees

Sweep
CntrSpan

souhaitée. Sivous utilisez le clavier, choisissez une unité de préfixe pour terminer.
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Commande SCPI
[SOURce[1]|2]:]FREQuency:CENTer {<frequency>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]FREQuency:SPAN {<frequency>|MINimum|MAXimum|DEFault}

Mode de balayage

Vous pouvez effectuer un balayage en fréquence linéaire ou selon une loi logarithmique, ou utiliser une liste de
fréquences. Pour un balayage linéaire, l'instrument fait varier linéairement la fréquence de sortie pendant le
balayage. Un balayage logarithmique fait varier la fréquence selon une loi logarithmique.

Le mode sélectionné n'affecte pas le retour du balayage (de la fin au début si le retour est configuré).
Opérations depuis le panneau avant

Appuyez sur [Sweep] > Type Linear.

SIN,50Q

Linear Sweep, Trig Imm

Frequency Sweeping... Center 0.000,000 Hz

Amplitude 100.0 mVpp Span 0.000,000 Hz
Sweep Time 1.000 s
Offset +0.000V Hold Time 0.000 s

Return Time 0.000 s

Phase 0.0°

Span

Hold Return
~-

Commande SCPI

[SOURce[1]2]:]SWEep:SPACing {LINear|LOGarithmic}

Temps de balayage

Le temps de balayage spécifie la durée (en secondes) du balayage entre la fréquence initiale et la fréquence finale.
L'instrument calcule le nombre de points dans le balayage en fonction du temps de balayage.

Temps de balayage : T ms a 250 000 secondes, par défaut 1 s. Pour un balayage linéaire en mode de déclenchement
immeédiat, le temps total maximal de balayage (y compris le temps de maintien et le temps de retour) est égal a

8 000 s. Le temps total maximal de balayage pour les balayages linéaires dans les autres modes de balayage est égal
a 250000 s ; le temps total maximal de balayage pour les balayages logarithmigques est égal a 500 s.
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Opérations depuis le panneau avant

Appuyez sur [Sweep] > Sweep Time. Utilisez le clavier numérique ou le bouton et la fleche pour définir une valeur
souhaitée. Sivous utilisez le clavier, choisissez une unité de préfixe pour terminer.

KEYSIGHT
SIN,500Q ECHNOLOGIES

Linear Sweep, Trig Imm

FrequenCy Sweeplng... Center 0'000,000 Hz

Amplitude 100.0 mVpp Span 0.000,000 Hz
Sweep Time 1_

seconds

Offset +0.000 V Hold Time 0.000s

Phase 0.0° IhReturn Time 0.000's

Commande SCPI

[SOURce[1]2]:]SWEep:TIME {<seconds>|MINimum|MAXimum|DEFault}

Temps de maintien/retour

Le temps de maintien spécifie le temps (en secondes) ou la fréquence finale se maintient ; le temps de retour
spécifie le nombre de secondes pour revenir de la fréquence finale a la fréquence initiale.

Temps de maintien et temps de retour : 0 & 3 600 secondes (0 par défaut).
Opérations depuis le panneau avant

Appuyez sur [Sweep] > Hold Return > Hold Time ou Return Time. Utilisez le clavier numérique ou le bouton et la
fleche pour définir une valeur souhaitée. Si vous utilisez le clavier, choisissez une unité de préfixe pour terminer.
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KEYSIGH{T

TECHNOL

SIN,500Q

Linear Sweep, Trig Imm

Frequency Sweeplng... Center 0'000’000 Hz

Amplitude 100.0 mVpp Span 0.000,000 Hz
Sweep Time 1 ms
Offset +0.000V Hold Time 1

seconds

Return Time 0.000 s

Phase 0.0°

Commande SCPI

[SOURce[1]2]:]SWEep:HTIMe {<hold time>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]SWEep:RTIMe {<return time>|MINimum|MAXimum|DEFault}

Fréguence de marqueur

Vous pouvez éventuellement définir la fréquence a laquelle le signal sur le connecteur Sync Out du panneau avant
passe a l'état logique bas pendant le balayage. Le signal Sync passe toujours de l'état bas a 'état haut au début du
balayage.

- Fréquence de marqueur : 1 uHz a la fréquence maximale pour le signal. La valeur par défaut est de 500 Hz.

- Lorsque le mode balayage est activé, la fréquence de marqueur doit étre comprise entre les fréquences initiale et
finale spécifiées. Sivous essayez de la régler en dehors de cette plage, l'instrument la ramene a la fréquence initiale
ou finale (celle qui est la plus proche).

- Vous ne pouvez pas configurer la fréquence de marqueur avec les menus du panneau avant sauf si la source Sync
est la voie qui effectue le balayage.

Opérations depuis le panneau avant

1. Appuyez sur [Sweep] > Sweep ON | OFF > Sweep ON | OFF.
2. Appuyez sur [Trigger] > Sync ON | OFF > Sync set up.
3. Sélectionnez Mode Marker.
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4. Sélectionnez Marker Freq. Utilisez le clavier numérique ou le bouton et la fleche pour définir une valeur souhaitée.

vous utilisez le clavier, choisissez une unité de préfixe pour terminer.

KEYSIGHT
TECHNOLOGIES

SIN,50Q

Linear Sweep, Trig Imm

Frequency Sweeping... Center 550.000,000 Hz

Amplitude 100.0 mVpp Span 900.000,000 Hz
Sweep Time 1 ms

Hold Time 1_
Return Time 0.000 s

seconds

Offset +0.000V

Phase 0.0°

Commande SCPI

[SOURce[1]2] :]1MARKer:FREQuency {<frequency>|MINimum|MAXimum|DEFault}

Source de déclenchement du balayage

Si

En mode balayage, linstrument envoie un balayage lorsqu’il regoit un signal de déclenchement. Aprés un balayage

de la fréquence initiale a la fréguence finale, lUinstrument attend le déclenchement suivant pendant U'envoi de la
frégquence initiale.

- Source de déclenchement du balayage : Immediate (par défaut), External , Time, ou Manual.

- Avec la source Immediate (interne), linstrument envoie un balayage continu a une fréquence déterminée par le

temps total comprenant le temps de maintien, le temps de balayage et le temps de retour. Le temps de balayage de

cette source est limité a 8 000 secondes.

- Avec la source External, l'instrument accepte un déclencheur matériel sur le connecteur Ext Trig du panneau
avant et lance un balayage chaque fois que ce connecteur Ext Trig recoit une impulsion TTL avec la polarité
spécifiée.

- La période du déclenchement doit étre supérieure ou égale au temps de balayage spécifié.

- Avec la source Manual, Uinstrument envoie un balayage chaque fois que la touche [Trigger] du panneau avant est

enfonceée.
Opérations depuis le panneau avant

Appuyez sur [Trigger] > Source.
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SIN,500Q

Linear Sweep, Trig Timer

Frequency Sweeping...

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

— T Immediate

Center 0.000,000 Hz| g,
SHED) 0.000,000 Hz|  Manual

Sweep Time 1 ms
Hold Time 1.000s

Return Time 0.000 s

KEYSIGHT

TECHNOLOGIES
Trigger
Source

Timer

Trigger Setup
~5-

Trig Out Setup
~9-

Sync
0N OFF

Sync Setup
~9-

Pour spécifier la pente du front du signal de déclenchement : Appuyez sur [Trigger] > Trig Out Setup > Trig Out Off |

(Up) | (Down).

SIN,500Q

Linear Sweep, Trig Timer

Frequency Sweeping...
Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Commande SCPI

TRIGger[1|2] :SOURce {IMMediate|EXTernal|TIMer |BUS}

Center 0.000,000 Hz
Span 0.000,000 Hz
Sweep Time 1 ms

Hold Time 1.000s

Return Time 0.000 s

TRIGger[1|2]:SLOPe {POSitive|NEGative}

Voir Déclenchements pour en savoir plus.

Signal de sortie du déclenchement

KEYSIGHT

TECHNOLOGIES
Trigger
Source

CRT""Ch2

Trig Out
of "1ty

Voir Signal de sortie du déclenchement pour obtenir des informations détaillées.
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Opérations depuis le panneau avant

Pour spécifier si linstrument se déclenche sur le front montant ou descendant du connecteur Sync Out, appuyez sur
[Trigger] > Trig Out Setup. Appuyez ensuite sur Trig Out pour sélectionner le front voulu.
KEYSIGHT
SIN,50Q

Linear Sweep, Trig Timer

Frequency’ Sweeping... Center  0.000,000 Hz

Amplitude 100.0 mVpp Span 0.000,000 Hz T
Sweep Time 1 ms off "1 L

Offset +0.000 V Hold Time 1.000s

Return Time 0.000 s

Phase 0.0°

Commande SCPI

OUTPut:TRIGger:SLOPe {POSitive|NEGative}

OUTPut:TRIGger {ON|1|OFF |0}

Liste de fréquences

En mode liste de fréquence, l'instrument "parcourt" une liste de fréquences, en restant sur chague fréquence
pendant une durée spécifiée. Vous pouvez également controler la progression dans la liste avec un déclenchement.

- L’instrument n’autorise pas l'activation du mode balayage ou liste lorsque le mode rafale ou un mode de
modulation est activé. Lorsque vous activez le balayage, le mode rafale ou modulation est désactivé.

- Pour éviter plusieurs modifications des signaux, activez le mode liste aprés avoir configuré ses parametres.
Opérations depuis le panneau avant

Activez la liste avant de configurer les autres parametres de la liste. Appuyez sur [Sweep] > Type Linear > Type List.
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KEYSIGHT
TECHNOLOGIES

SIN,500Q

List Sweep, Trig Imm

ep

-y S
Dwell Time 1.000's ] O OFF

Frequency Sweeping...

Amplitude 100.0 mVpp Linear Type
List
Offset +0.000V
Duvell
Time
Phase 0.0°
View List
~5-

Select
List

Save
List

Sélectionnez View List pour afficher les paramétres de la liste. Vous pouvez modifier (Edit Freq) la valeur de
fréquence dans la liste de balayage, ajouter (Add Freq) ou supprimer (Delete Freq) une valeur de fréquence ou
réorganiser la liste de balayage (Reorder List).

KEYSIGHT
TECHNOLOGIES

SIN,500Q Are

List Sweep, X —
Sweep Frequency List Sweep

Frequency S 1 100.000000 Hz Edit Freq
2 1000.000000 Hz

Amplitude 1
3 550.000000 Hz

Offset +

Phase

Add Freq

Delete Freq

Reorder List
~-

Siune clé USB externe est connectée, appuyez sur Save List pour enregistrer la liste de balayage sur cette clé.

Pour récupérer une liste de balayage précédemment enregistrée de la clé USB externe connectée, appuyez sur
Select List.

Commande SCPI

[SOURcdA[1]2]:]FREQuency:MODE LIST

[SOURce[1]2]:]LIST:FREQuency <freqgl>[, <freqg2>, etc.]
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Le circuit de déclenchement contréle la progression dans la liste. Si la source de déclenchement est interne ou
immédiate, la durée des paliers (LIST:DWELL) détermine le temps passé pour chaque fréquence. Pour les autres
sources de déclenchement, la durée des paliers est déterminée par lintervalle de déclenchement.

Mode rafale

L'instrument peut envoyer pendant un nombre spécifié de cycles un signal alors baptisé rafale. Les rafales sont
autorisées avec des signaux sinusoidaux, carrés, triangulaires, PRBS, des rampes, des impulsions ou des signaux
arbitraires (le bruit est autorisé uniqguement en mode rafale commandée ; le courant continu n’est pas autorisé).

Pour plus d’informations, voir Rafale.

Pour sélectionner le mode rafale

Il n’est pas possible d’activer une rafale lorsque le mode balayage ou modulation est activé. L’activation du mode
rafale désactive le balayage et la modulation.

Pour éviter plusieurs modifications des signaux, activez le mode rafale apres avoir configuré les autres parametres.
Opérations depuis le panneau avant

Appuyez sur [Burst] > Burst ON | OFF > Burst ON | OFF.

Commande SCPI

[SOURce[1]2]:]BURSt:STATe {ON|1|OFF|0}
Mode rafale

[l existe deux modes rafale décrits ci-dessous. Le mode sélectionné contrdle la source de déclenchement et les
autres parametres qui s’appliquent.

- Mode rafale commandée (par défaut) : L'instrument envoie un signal pendant un nombre spécifié de cycles
(nombre de salves) chaque fois que le signal déclencheur est regu. Aprées avoir envoyé ce nombre de cycles,
Uinstrument s’arréte et attend le déclenchement suivant. L'instrument peut utiliser un signal déclencheur interne
pour démarrer la rafale ou vous pouvez effectuer un déclenchement externe en appuyant sur la touche [Trigger] du
panneau avant, en appliquant le signal déclencheur sur le connecteur Ext Trig du panneau avant ou en envoyant
une commande de déclenchement au moyen du logiciel de Uinterface distante.

- Mode rafale commandée externe : Le signal de sortie est actif ou inactif en fonction du niveau du signal externe
appliqué sur le connecteur Ext Trig du panneau avant. Lorsque le signal de commande est vrai, Uinstrument envoie
un signal continu. Si le signal de commande est faux, le cycle en cours se termine, puis l'instrument s’arréte et sa
tension reste au niveau correspondant a la phase de rafale initiale du signal sélectionné. La sortie du signal de bruit
s'arréte immédiatement lorsque le signal de commande devient faux.

Paramétre Mode rafale Nombre de salves Période de la rafale Phase de la rafale Source de déclen-

(BURS:MODE) (BURS:NCYC) (BURS:INT:PER) (BURS:PHAS) chement
(TRIG:SOUR)

Mode rafale commandée : TRIGgered Disponible Disponible Disponible IMMediate
Déclencheur interne
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Mode rafale commandée : TRIGgered Disponible Non utilisé Disponible EXTernal, BUS
Déclenchement externe

Mode rafale commandée : GATed Non utilisé Non utilisé Disponible Non utilisé
Déclenchement externe
Mode rafale temporisée :  TRIGgered Disponible Non utilisé Disponible TIMer

Déclencheur interne

- En mode commandé, le nombre de salves, la période de la rafale et la source de déclenchement sont ignorés
(utilisés uniquement pour les rafales déclenchées). Déclenchements manuels ignorés ; aucune erreur produite.

- En mode commandé, vous pouvez spécifier la polarité du signal sur le connecteur Ext Trig du panneau avant
([SOURce [1|2]:]BURSt:GATE:POLarity {NORMal|INVerted}). La valeur par défaut est NORMal (vrai/haut).

Opérations depuis le panneau avant

Appuyez sur [Burst] > N Cycle Gated ou N Cycle Gated.

KEYSIGHT

SIN,SOQ TECHNOLOGIES
Gated Burst, Trig Timer "

., Burs
Frequency 1.000,000,000 kHz Start Phase 0.0° wiw‘-!urOtFF

# of Cycles 1

Amplitude 100.0 mVpp M Cycle

Burst Period 10 ms » bated <

Offset +0.000V
Polarity

Pos Neg
Phase 0.0° e

Start Phase

Commande SCPI

[SOURce[1]2] :]BURSt:MODE {TRIGgered|GATed}

Frégquence du signal

Vous pouvez spécifier la fréquence du signal pendant la rafale dans les modes rafale commandée externe et interne.
En mode déclenché, le nombre de cycles spécifié par le nombre de salves est envoyé a la fréquence du signal. En
mode externe commandé, la fréquence du signal est envoyée lorsque le signal de commande externe est vrai. Cela
est différent de la « période de la rafale » qui spécifie U'intervalle entre les salves (mode déclenché uniquement).
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Fréguence du signal : 1 uHz jusqu’a la fréquence maximale du signal. (1 kHz par défaut). (Pour un signal de rafale
déclenchée en interne, la fréquence minimale est égale a 126 pHz).

Opérations depuis le panneau avant

Appuyez sur [Parameter] > Frequency. Utilisez le clavier numérique ou le bouton et la fleche pour définir une valeur
souhaitée. Sivous utilisez le clavier, choisissez une unité de préfixe pour terminer.

KEYSIGHT

TECHNOLOGIES

Frequency 1_

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Commande SCPI
[SOURce[1]2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

La commande APPLy configure un signal en une seule commande.

Nombre de salves

Nombre de cycles (1 a 100 000 000 ou infini) a envoyer par rafale. Utilisé uniquement en mode rafale déclenchée
(source interne ou externe).

- Avec la source immédiate de déclenchement, le nombre de cycles spécifié est envoyé en permanence a une
vitesse déterminée par la période de la rafale. La période de la rafale est le temps entre les démarrages de rafales
consécutives. Egalement, le nombre de salves doit &tre inférieur au produit de la période de la rafale et de la
fréquence du signal :

Période rafale > (Nbre cycles ) / Fréquence du signal) + 1 usec

- L'instrument augmente la période de la rafale jusqu’a sa valeur maximale pour prendre en charge le nombre de
salves spécifié (mais la fréquence du signal ne change pas).

- En mode rafale commandée, le nombre de salves est ignoré. Cependant, si vous modifiez le nombre de salves a
partir de Uinterface distante en mode commandé, l'instrument conserve le nouveau nombre gu’il utilise lorsque le
mode déclenché est sélectionné.
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Opérations depuis le panneau avant

Appuyez sur [Burst] > # of Cycles. Utilisez le clavier numérique ou le bouton et la fleche pour définir une valeur
souhaitée. Sivous utilisez le clavier, appuyez sur Enter pour terminer.

Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Commande SCPI

[SOURce[1]2]:]BURSt:NCYCles {<num cycles>|INFinity|MINimum|MAXimum}

Période de la rafale

La période de la rafale, qui est utilisée uniguement en mode rafale commandée interne, est le temps écoulé entre le
début d’'une salve et le début de la salve suivante (1 us a 8 000 s, 10 ms par défaut). La période de la rafale est
différente de la « fréquence du signal » qui spécifie la fréquence du signal.

La période de la rafale s’utilise uniquement lorsque le déclenchement immédiat est activé. La période de la rafale est
ignorée lorsque le déclenchement externe ou manuel (ou lorsque le mode rafale commandée est sélectionné).

Vous ne pouvez pas spécifier une période de rafale trop petite pour Uinstrument a envoyer avec le nombre de salves
et la fréquence spécifiés. Si la période de rafale est trop faible, U'instrument 'augmente afin de redéclencher la rafale
en permanence.

Opérations depuis le panneau avant

Appuyez sur [Burst] > Burst Period. Utilisez le clavier numérique ou le bouton et la fleche pour définir une valeur
souhaitée. Sivous utilisez le clavier, choisissez une unité de préfixe pour terminer.
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KEYSIGHT

TECHNOLOGIES

Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

seconds

Commande SCPI

[SOURce[1]2]:]BURSt:INTernal:PERiod {<seconds>|MINimum|MAXimum}

Phase initiale

La phase initiale de la rafale, de -360 a +360 degrés (par défaut 0).
- Spécifiez l'unité de la phase initiale avec la commande UNIT:ANGLe.

- Toujours affichée en degrés sur le panneau avant (jamais en radians). Si elle est définie en radians depuis
linterface distante, l'instrument

Convertit la valeur en degrés sur le panneau avant.

- Pour les signaux sinusoidaux, carrés et les rampes, O degré est le point auquel le signal traverse la tension de 0 V
(ou la tension de décalage CC) dans le sens positif. Pour les signaux arbitraires, O degré est le premier point du
signal. La phase initiale n’a pas d’effet sur le bruit.

- Phase initiale également utilisée en mode rafale commandée. Lorsque le signal de gachette devient faux, le cycle
du signal actif se termine et la sortie reste a la tension de la phase initiale de la rafale.

Opérations depuis le panneau avant

Appuyez sur [Burst] > Start Phase. Utilisez le clavier numérique ou le bouton et la fleche pour définir une valeur
souhaitée. Sivous utilisez le clavier, appuyez sur Degrees pour terminer.
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KEYSIGHT

TECHNOLOGIES

Frequency 1.000,000,000 kHz Degrees

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Commande SCPI

[SOURce[1]2]:]BURSt:PHASe {<angle>|MINimum |MAXimum}

Source de déclenchement de la rafale

En mode rafale déclenchée :

- L'instrument envoie un signal pendant un nombre spécifié de cycles (nombre de salves) lorsqu’un signal
déclencheur est regu. Aprés le nombre de cycles spécifié, Uinstrument s'arréte et attend le déclenchement suivant.

- IMMediate (interne) : Uinstrument envoie la sortie en permanence lorsque le mode rafale est activé. La commande
BURSt:INTernal:PERiod détermine la vitesse de génération de la rafale.

- EXTernal : linstrument accepte un déclenchement matériel sur le connecteur Ext Trig du panneau avant.
L'instrument envoie une rafale du nombre spécifié de cycles chague fois que le connecteur Ext Trig recoit une
transition de niveau de polarité correcte (TRIGger[1|2]:SLOPe). Les signaux de déclenchement externe pendant une
rafale sontignorés.

- BUS (logiciel) : Vinstrument démarre une rafale chaque fois qu’'une commande de déclenchement sur le bus (*TRG)
est recue. La touche [Trigger] du panneau avant est allumée lorsque Uinstrument attend un déclenchement sur le
bus.

- EXTernal ou BUS : le nombre de salves et la phase de la rafale restent effectifs, mais la période de la rafale est
ignorée.

- TIMer : les événements de déclenchement sont espacés d’une temporisation ; le premier déclenchement a lieu des
gue la commande INIT se produit.

Opérations depuis le panneau avant

Appuyez sur [Trigger] > Trigger Setup > Source.
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KEYSIGHT

TECHNOLOGIES
Trigger

I diat Source

Frequency 1.000,000.000 kHz [ - R s i —

XLerna
CH 1 Trigger Setu

Amplitude  100.0 - P Manual

T Delay

Offset +0.000 Source Immediate

B 00° Delay 0s

Pour spécifier si l'instrument se déclenche sur un front montant ou descendant du signal sur le connecteur Ext Trig,
sélectionnez la source de déclenchement externe avant de choisir Trigger Setup.

Commande SCPI
TRIGger[1|2] :SOURce {IMMediate|EXTernal|TIMer |BUS}
TRIGger[1|2]:SLOPe {POSitive|NEGative}

Voir Déclenchements pour en savoir plus.

Si le rapport cyclique est modifié sur un signal carré en rafale commandé avec le mode de déclenchement défini sur
Timer, la rafale en cours s’arréte et une rafale de plus sera exécutée avant la modification du rapport cyclique de la
rafale.

Signal de sortie du déclenchement

Voir Signal de sortie du déclenchement pour obtenir des informations détaillées.
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Opérations depuis le panneau avant

1. Appuyez sur [Burst] > Burst ON | OFF > Burst ON | OFF.

KEYSIGHT

TECHNOLOGIES

SIN,50Q
N-Cycle Burst, Trig Imm

Burst

— Burst
Frequency 1000.000000 HZ | 5151t phase 0.000000 OKV""OFF

Amplitude  0.700000 Vpp # of Cycles 1.000000
Offset 0.000000 V Burst Period 0.010000 s

—

Phase 0.000000
Start Phase

# of Cycles

Burst Period

2. Appuyez sur [Trigger] > Trig Out Setup.
3. Utilisez ensuite cette touche de fonction pour choisir la direction souhaitée du front : Appuyez sur Trig Out Off | (Up) |
(Down).

KEYSIGHT
TECHNOLOGIES

SIN,500Q

N-Cycle Burst, Trig Imm Trigger

Frequency 1.000,000,000 kHz Stort Phase 90.0° T e

Amplitude 100.0 mVpp # of Cycles 10 Trig Out
Burst Period 1 ms off 1L
Offset +0.000V e

Phase 0.0°

Commande SCPI

OUTPut:TRIGger:SLOPe {POSitive|NEGative}

OUTPut:TRIGger {ON|1|OFF |0}
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Déclenchement

Cette rubrique décrit le systeme de déclenchement de l'instrument.

Présentation des déclenchements

Les informations de déclenchement s’appliquent uniquement aux balayages et aux rafales. Vous pouvez envoyer des
signaux de déclenchement de balayages ou de rafales par déclenchement interne, externe, temporisé ou manuel.

- Interne ou « automatique » (par défaut) : Uinstrument émet en permanence lorsque le mode balayage ou rafale est
sélectionné.

- Externe : utilise le connecteur Ext Trig du panneau avant pour commander le balayage ou la rafale. L'instrument
démarre un balayage ou envoie une rafale chaque fois que Ext Trig regoit une impulsion. Vous pouvez choisir si
linstrument se déclenche sur un front montant ou descendant.

- Manuel : le déclenchement lance un balayage ou envoie une rafale chaque fois que vous appuyez sur la touche
[Trigger] du panneau avant.

- Lorsque vous effectuez un balayage en mode liste, le déclenchement déplace le signal a la fréguence suivante
dans la liste.

- La touche [Trigger] est désactivée en mode distant et lorsqu’une fonction autre que le balayage ou la rafale est
sélectionnée.

Sources de déclenchement

Les informations de déclenchement s’appliquent uniguement aux balayages et aux rafales. Vous devez spécifier la
source pour lagquelle Uinstrument accepte un déclenchement.

- Source de déclenchement du balayage et de la rafale : Immediate (par défaut), External, Manual ou Timer.

- L'instrument accepte un déclenchement manuel, un déclenchement matériel sur le connecteur Ext Trig du
panneau avant ou envoie en permanence des balayages ou des rafales au moyen d’un déclencheur interne. Vous
pouvez également déclencher des rafales temporisées. Le déclenchement immédiat est sélectionné a la mise sous
tension.

- Le paramétre de la source de déclenchement est volatile ; il est configuré comme déclenchement interne
(panneau avant) ou immédiat (interface distante) par la mise sous tension ou *RST (réinitialisation).

Opérations depuis le panneau avant

Activez le balayage ou la rafale. Ensuite :

Appuyez sur [Trigger] > Source.
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SIN,500Q

Linear Sweep, Trig Imm

Frequency Sweeping...
Amplitude 100.0 mVpp

Offset +0.000V

Start Freq
Stop Freq

100.000,000
1.000,000,00

Sweep Time 1.000 s

Hold Time

0.000s

External
al
Timer

Iz

KEYSIGHT

TECHNOLOGIES
Trigger
Source

Immediate

Trigger Setup
~5-

Trig Out Setup

Return Time 0.000 s -

Phase 0.0°

Sync
0N OFF

Sync Setup
~9-

Commande SCPI
TRIGger[1|2] :SOURce {IMMediate|EXTernal|TIMer |BUS}

La commande APPLy configure automatiquement la source comme immédiate.

Déclenchement immédiat

Mode de déclenchement interne (par défaut) : l'instrument envoie en permanence un balayage ou une rafale
(spécifié par le temps du balayage ou la période de la rafale).

Opérations depuis le panneau avant
Appuyez sur [Trigger] > Source Immediate.
Commande SCPI

TRIGger:SOURce IMMediate

Déclenchement manuel

Mode de déclenchement manuel (panneau avant uniquement) : Appuyez sur la touche [Trigger] pour déclencher
manuellement linstrument. L'instrument déclenche un balayage ou une rafale chaque fois gue vous appuyez sur la
touche [Trigger]. Le bouton est allumé lorsque vous étes dans le menu de déclenchement et Uinstrument attend un
déclenchement manuel. Le bouton clignote lorsque l'instrument attend un déclenchement manuel, mais n’étes pas
dans le menu de déclenchement. La touche est désactivée lorsque l'instrument est en mode de commande a
distance.

Opérations depuis le panneau avant

Appuyez sur [Trigger] > Source Manual.
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Déclenchement externe

En mode de déclenchement externe, Uinstrument accepte un déclenchement matériel sur le connecteur Ext Trig du
panneau avant. L'instrument démarre un balayage ou envoie une rafale chaque fois que Ext Trig recoit une
impulsion TTL avec le front spécifié. Le mode de déclenchement externe est similaire au mode de déclenchement
manuel sauf que vous appliquez le déclencheur sur le connecteur Ext Trig.

Voir Signal d’entrée du déclenchement ci-dessous.
Opérations depuis le panneau avant

Appuyez sur [Trigger] > Source External.

Pour spécifier si l'instrument se déclenche sur un front ascendant ou descendant, appuyez sur Trigger Setup et
sélectionnez la direction du front en appuyant sur Slope.

Commande SCPI

TRIGger:SOURce EXTernal

TRIGger[1|2]:SLOPe {POSitive|NEGative}

Déclenchement par logiciel (Bus)

Disponible uniquement a partir d’'une interface distante, ce déclenchement est similaire au mode de déclenchement
manuel a partir du panneau avant, mais vous déclenchez l'instrument avec une commande de déclenchement sur le
bus. L'instrument démarre un balayage ou envoie une rafale chaque fois qu’'une commande de déclenchement sur le
bus est regue. La touche clignote lorsqu’une commande de déclenchement sur le bus est recue.

Pour sélectionner la source de déclenchement sur le bus, exécutez la commande TRIGger:SOURce BUS.

Pour déclencher linstrument a partir d’une interface distante (USB ou réseau local (LAN)) lorsque la source Bus est
sélectionnée, exécutez la commande TRIG ou *TRG (déclenchement). La touche [Trigger] du panneau avant est
allumée lorsque Uinstrument attend un déclenchement sur le bus.

Opérations depuis le panneau avant

Appuyez sur [Trigger] > Source Manual.

Déclenchement temporisé

Le mode de déclenchement temporisé envoie un signal de déclenchement a intervalles de temps constants. Pour
sélectionner la source de déclenchement sur le bus, envoyez la commande TRIGger:SOURce TIMer.

Opérations depuis le panneau avant

Appuyez sur [Trigger] > Source Timer.

Signal d’entrée de déclenchement

Ce connecteur du panneau avant s’utilise dans les modes suivants :
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- Mode de balayage déclenché : Appuyez sur [Trigger]> Trigger Setup > Source External, ou exécutez la commande
TRIG:SOUR EXT (le mode balayage doit étre activé). Lorsqu’une transition de niveau de polarité correcte est recue
sur le connecteur Ext Trig, l'instrument envoie un balayage unique.

- Mode rafale commandée : Appuyez sur [Trigger] >Trigger Setup > Source External, ou exécutez la commande
TRIG:SOUR EXT (le mode rafale doit étre activé). L'instrument envoie un signal pendant un nombre spécifié de cycles
(nombre de salves) chaque fois que le signal déclencheur est recu de la source de déclenchement spécifiée.

- Mode rafale commandée externe : Appuyez sur la touche de fonction Gated ou exécutez la commande
BURS:MODE GAT avec le mode rafale activé. Lorsque le signal de commande externe est vrai, linstrument envoie un
signal continu. Si le signal de commande externe est faux, le cycle en cours se termine, puis l'instrument s’arréte et
sa tension reste au niveau correspondant a la phase de rafale initiale. Pour le bruit, la sortie s’arréte des que le signal
de commande devient faux.

Signal de sortie de déclenchement

Le signal de sortie de déclenchement est référencé sur le chassis. Faites bien attention a ne pas toucher les deux
signaux simultanément en connectant ou déconnectant les cables. Coupez l'alimentation des connexions a la sortie
de l'instrument avant de connecter ou déconnecter ces cébles.

- Un signal de sortie du déclenchement (« trigger out ») est fourni sur le connecteur Sync Out du panneau avant
(utilisé uniguement avec une rafale et un balayage). Lorsqu’il est activé, une impulsion un front montant (par défaut)
ou descendant est envoyée de ce connecteur au début du balayage ou de la rafale.

SORTIE

Sortie Sync +33V

h}1“5 -

oV

Front montant illustré.

— Source de déclenchement Internal (immédiat) ou Timer : Uinstrument envoie un signal carré de rapport de cycle
égal a 50 % provenant du connecteur Sync Out au début du balayage ou de la rafale. La période du signal est égale
au temps de balayage spécifié ou a la période de la rafale.

- Source de déclenchement externe : Uinstrument désactive le signal « sortie de déclenchement ».

- Source de déclenchement manuel ou sur le Bus (logiciel) : Uinstrument envoie une impulsion (largeur >1 ps) a
partir du connecteur Sync Out au début du balayage ou de la rafale.

Opérations depuis le panneau avant

1. Activez le balayage ou la rafale.
2. Appuyez ensuite sur [Trigger] > Trig Out Setup.
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3. Utilisez ensuite cette touche de fonction pour choisir la direction souhaitée du front : Trig Out Off | (Up) | (Down).

KEYSIGHT
TECHNOLOGIES

SIN,500Q

Linear Sweep, Trig Trigger

= Source
Frequency - Sweeping... Start Freq 100.000,000 Hz ————

Amplitude 100.0 mVpp Stop Freq  1.000,000,000 kHz Trig Out
Sweep Time 1.000 s off "1t

Hold Time 0.000s
Return Time 0.000 s

Offset +0.000V

Phase 0.0°

Commande SCPI

OUTPut:TRIGger:SLOPe {POSitive|NEGative}

OUTPut:TRIGger {ON|1|OFF |0}

Opérations systeme

Cette rubrique décrit Uenregistrement des configurations de 'instrument, le rappel apres extinction, les conditions
d’erreur, les auto-tests et le contréle de affichage. Bien que cela n’ait pas de lien avec la génération de signaux, ces
opérations sont utiles pour utiliser l'instrument.

Enregistrement des configurations de l'appareil

- Ilexiste deux manieres d’enregistrer et de récupérer des configurations de l'instrument :

- par les noms de fichiers de configuration sur le panneau avant ou en utilisant les commandes
MMEMory:STORe:STATe et MMEMory:LOAD:STATe

- par les emplacements en mémoire O et 4, en utilisant les commandes *SAV et *RCL

- Les deux méthodes d’enregistrement conservent la fonction sélectionnée (y compris les signaux arbitraires), la
fréquence 'amplitude, la tension résiduelle CC, le rapport cyclique, la symétrie et les paramétres de modulation.

- Lacommande *RST n’affecte pas les configurations enregistrées ; une configuration reste enregistrée tant qu’elle
n’est pas remplacée ou supprimée.

Opérations depuis le panneau avant

Voir Enregistrer ou récupérer les configurations de linstrument.
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Ftat de linstrument a la mise sous tension

A la mise sous tension, vous pouvez configurer linstrument avec 'emplacement 0 de la configuration a l'extinction.
Par défaut, la configuration par défaut a la sortie d’usine est adoptée a la mise sous tension.

Opérations depuis le panneau avant
Appuyez sur [System] > Power On Setting > Power On Factory Default ou Power On State 0.
Commande SCPI

MEMory:STATe:RECall:AUTO {ON|1|OFF |0}

Situations d’erreur

Il est possible d’enregistrer jusqu’a 20 erreurs matérielles ou de syntaxe dans la file des erreurs. Voir « Messages
d’erreur SCPI » dans le Guide de programmation de la série EDU33270 pour plus d’informations.

Opérations depuis le panneau avant
Appuyez sur [System] > Help > Error View.
Commande SCPI

SYSTem:ERRor?

Contréle de l'avertisseur sonore

L'instrument émet normalement un bip en cas d’erreur sur le panneau avant ou l'interface distante.

Ce parametre est non volatile ; il n'est pas modifié par une remise sous tension ou par la commande *RST.
Opérations depuis le panneau avant

Appuyez sur [System] > User Settings > Beeper ON | OFF.

Commande SCPI

SYSTem:BEEPer:STATe {ON|1|OFF |0}

SYSTem:BEEPer

Key Click

L'instrument émet un clic lorsque vous appuyez sur une touche ou une touche de fonction du panneau avant.
Ce parametre est non volatile ; il n'est pas modifié par une remise sous tension ou par la commande *RST.
Opérations depuis le panneau avant

Appuyez sur [System] > User Settings > Key Click ON | OFF.
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Commande SCPI

SYSTem:CLICk:STATe {ON|1|OFF|O0}

Désactiver [’écran

Pour des raisons de sécurité ou pour accélérer I'exécution des commandes de Uinterface distante par Uinstrument,
vous voudrez peut-étre désactiver 'écran.

Opérations depuis le panneau avant

Appuyez sur [System] > User Settings > Display ON | OFF.

Appuyez sur une touche quelconque pour le rallumer.
Commande SCPI

DISPlay {ON|1|OFF|0}

Luminosité de 'écran

Vous pouvez régler la luminosité de l'écran sur atténuation automatique (100 % a 10 %) apres 2 minutes d’inactivité.
Vous ne pouvez régler cette caractéristique que depuis le panneau avant.

Ce parametre est non volatile ; il n'est pas modifié par une remise sous tension ou par la commande *RST.
Opérations depuis le panneau avant

Appuyez sur [System] > User Settings > Auto Dimming ON | OFF.

Date et heure

Vous pouvez régler la date et 'heure de Uinstrument.
Opérations depuis le panneau avant

Appuyez sur [System] > User Settings > Date / Time.
Commande SCPI

SYSTem:DATE <yyyy>, <mm>, <dd>
SYSTem:TIME <hh>, <mm>, <ss>
Gérer les fichiers

Vous pouvez effectuer des opérations de gestion des fichiers (copier, renommer, supprimer et créer des dossiers).
Opérations depuis le panneau avant

Appuyez sur [System] > Store/Recall > File Manager.
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Vous pouvez copier, renommer ou supprimer des fichiers et des dossiers. La suppression d’un dossier supprime tous
ses fichiers ; vérifiez donc que vous voulez supprimer tous les fichiers d’un dossier.

La touche de fonction la plus importante est Switch Pane ; elle permet de spécifier lemplacement de U'opération a
effectuer. Apres avoir choisi l'emplacement de l'action a effectuer, appuyez sur Select pour sélectionner le fichier a
gérer. Lorsque vous étes prét a exécuter Uopération, appuyez sur Rename, Copy ou Delete.

Commande SCPI

Voir les « MEMory » et « sous-systemes MMEMory » dans le Guide de programmation de la série EDU33270.

Auto-Test

Un autotest limité a lieu a la mise sous tension de l'instrument afin de vérifier qu’il est opérationnel. Vous pouvez
également effectuer un autotest plus complet. Pour plus d’informations, reportez-vous a « Procédures d’auto-test »
dans le Guide des services de la série EDU33270.

Opérations depuis le panneau avant
Appuyez sur [System] > Instr. Setup > Self Test.
Commande SCPI

*TST

Demande de la version du microprogramme

Exécutez la commande *IDN? pour déterminer la version du microprogramme actuellement installée. Cette
demande retourne une chaine de caracteres sous la forme :

Keysight Technologies,[Numéro de modele],[Numéro de série & 10 caracteres],[Numéro de version du
microprogramme]

Exemple de numéro de version du microprogramme : K-01.00.04-01.00-01.00-01.00-01.00
Opérations depuis le panneau avant

Appuyez sur [System] > Help > About. Numérisez le code QR affiché pour voir la documentation associée a
Uinstrument.

Commande SCPI

*IDN?

Demande de la version du langage SCPI

L’instrument est conforme aux regles et aux conventions de la version actuelle du langage SCPI (Commandes
standard pou linstrumentation programmable). Utilisez la commande SYSTem:VERSion? pour déterminer la version

SCPI de Uinstrument. Cette demande retourne une chaine de caracteres sous la forme « YYYY.V » qui représente
'année et le numéro de la version de cette année (ex. 1999.0).
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Config. d’E/S

Voir Connexions de linterface distante et Configuration de linterface distante pour plus d’informations.

Opérations sur 2 voies

Cette rubrique couvre la plupart des sujets en rapport avec le fonctionnement sur 2 voies.

Passage en configuration 2 voies

Appuyez sur un bouton de configuration de voie pour passer ne configuration 2 voies, puis sur Dual Channel.

KEYSIGHT

TECHNOLOGIES

—_— Freq Cpl
Frequency 1. oy q pyal Channel Operation ON"TOFF

Amplitude 1! Frequencies Independent Freq Cpl Settings

-
Offset + Offset CH2 - CH1 =  +0.000,000 Hz

Amplitudes & Offsets Independent Qr:? K D‘g

Tracking

Phase 0.

Tracking
OFF

Combine
CH2 " OFF

Couplage des fréquences

Le couplage des fréquences permet de coupler des fréquences ou des fréquences d'échantillonnage entre des voies,
soit dans un rapport constant ou un décalage entre elles. Appuyez sur Freq Cpl ON | OFF pour activer/désactiver le
couplage des fréquences, puis sur Freq Cpl Settings pour configurer le couplage.

La touche de fonction Freq Cpl Settings ouvre le menu ci-dessous. La premiére touche de fonction permet de
spécifier si vous voulez coupler les fréquences avec un rapport ou un décalage ; la deuxieme permet de spécifier ce
rapport ou ce décalage.
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KEYSIGHT

TECHNOLOGIES

— | offser <
Frequency 1. oy 1 pyal Channel Operation Riatio

Amplitude 1! Frequencies Independent Freq Couple

Offset
Offset + Offset CH2 - CH1 = +0.000,000 Hz

Amplitudes & Offsets Independent

Tracking

Phase 0.

Couplage des amplitudes

Le couplage des amplitudes, activé avec la touche de fonction Ampl Cpl ON | OFF, permet de coupler 'amplitude et
la tension résiduelle entre les voies de fagon gqu’une modification d’une de ces grandeurs se répercute sur les 2 voies.

Poursuite

La poursuite, activée par la touche de fonction Tracking comporte 3 modes : OFF, identique, et inversé.
- Lorsque la poursuite est OFF, les 2 voies fonctionnent indépendamment.
- Lorsqu’elle est Identical, elles se comportent comme une seule voie.

- Le troisieme mode, Inverted, inverse chaque voie par rapport a l'autre : le résultat est une voie différentielle
utilisant les 2 voies.

Grouper

La fonction Combine associe 2 sorties sur un connecteur. Si vous choisissez CH2 dans le menu Channel 1, les voies
sont associées sur la voie 1 ; si vous choisissez CH1 dans le menu Channel 2, elles sont associées sur la voie 2.

Dans lillustration ci-dessous, le signal du haut est un signal sinusoidal 100 mVpp / 1 kHz sur la voie 1 ; le signal au-
dessous est un signal sinusoidal 100 mVpp / 5 kHz sur la voie 2.
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L'image ci-dessous montre les deux sorties combinées sur le canal 1. Notez que l'axe X a été compressé (zoom
arriere) pour afficher plus de cycles.

DI B ] 4 Bk S by @ INe

Informations sur le fonctionnement

Les signaux groupés ne doivent pas étre de méme type ; par exemple, cette illustration représente la méme voie
5 kHz sur la voie 2 groupée avec un signal carré 100 mVpp sur la voie 1.

TR T T | o L L R

Lorsque les signaux sont groupés, les valeurs de la tension résiduelle CC ne sont pas ajoutées. Seule la tension
résiduelle CC de la voie réceptrice est utilisée dans la sortie groupée. La figure ci-dessous montre un décalage de
50 amV CC ajouté au canal 1. Le décalage de 50 mV ajouté au canal 2 est ignoré.
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Vous pouvez également utiliser la fonction Combine avec des rafales. Par exemple, Uillustration ci-dessous
représente un signal sinusoidal 1 kHz sur la voie 1 et une rafale de 3 salves d'un signal sinusoidal 5 kHz sur la voie 2.

E e | e § [ ] W Bl BRI Pw f @ IR

Lorsque ces signaux sont groupés sur la voie 1, le résultat est une simple addition de lamplitude des deux signaux
(voir ci-dessous).

E e | e § [ ] W Bl RIS w f @ IR

Vous pouvez également grouper les signaux sur la voie 2 (ci-dessous).

L B ] L} 4 G IR Bw 1 W ISe
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o Caractéristiques et specifications

Pour connaitre les caractéristiques et les spécifications du générateur de signaux arbitraires Trueform série
EDU33210, consultez la fiche technique sur : https://www.keysight.com/us/en/assets/3121-1004/data-
sheets/EDU33210-Series-20-MHz-Function-Arbitrary-Waveform-Generators.pdf.
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o Didacticiel pour la réalisation de
mesures

Signaux arbitraires

Bruit quasi-gaussien

Séquence binaire pseudo aléatoire (PRBS)
Modulation

Rafale

Balayage de fréquence

Attributs des signaux CA

Imperfections des signaux

Cette rubrigue décrit la théorie de U'utilisation pour divers types de
signaux et de modes de fonctionnement de Uinstrument. Les deux
dernieres rubrigues contiennent des informations qui peuvent vous aider
a améliorer la qualité des signaux.
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Signaux arbitraires

Les signaux arbitraires peuvent correspondre a des besoins que ne remplissent pas les signaux standard de
Uinstrument. Par exemple, vous aurez peut-étre besoin d’une seule impulsion ou voudrez peut-étre simuler des
imperfections dans un signal (ex. suroscillation, oscillations, parasites ou bruit). Les signaux arbitraires, qui peuvent
étre tres complexes, sont adaptés a la simulation des signaux rencontrés dans les systemes modernes de
communications.

Vous pouvez créer des signaux arbitraires a partir de 8 points au minimum jusqu’a 1 000 000 points. L’instrument
mémorise les valeurs numériques correspondant a ces points (échantillons) et les convertit en tensions au cours de
la génération du signal. La fréquence de lecture des points est la « fréquence d’échantillonnage » ; la fréquence du
signal est égale a la fréquence d’échantillonnage divisée par le nombre de points dans le signal. Par exemple,
supposons gu’un signal comporte 40 points et que la fréquence d’échantillonnage soit égale a 10 MHz. La fréquence
est alors (10 MHz)/40 = 250 kHz, d’ou une période de 4 s.

L'instrument peut lire directement les fichiers .ARB. Pour charger le fichier arb spécifié (.arb) dans la mémoire
interne ou USB, appuyez sur [Waveforms] > Arb > Arbs > Select ARB.

Vous pouvez également importer des fichiers de données d'une colonne au format .CSV. Pour importer un fichier,
appuyez sur [Waveforms] > Arb > Arbs > Import Data. Un menu vous guide alors pour importer un fichier.

Chagque valeur du fichier .CSV est limitée a 7 caracteres (y compris le signe moins et la virgule décimale) ; par
exemple -0,1234.

Si le fichier .CSV contient plus de 7 caractéres, le générateur de fonctions ne peut pas importer le fichier .CSV.

Filtres des signaux

L'instrument comporte deux filtres de signaux qui lissent les transitions entre les points lorsque des signaux
arbitraires sont générés.

- Filtre normal : fournit une réponse en fréquence plate étendue, mais sa réponse aux transitoires présente une
oscillation transitoire et une suroscillation

- Filtre a paliers : fournit une réponse quasi-idéale aux transitoires, mais présente une oscillation plus importante
dans la réponse en fréquence que le filtre normal

- Eteint: la sortie change brusquement entre les points avec un temps de transition d’environ 10 ns.

La fréquence de coupure de chaque filtre est une fraction constante de la fréquence d’échantillonnage du signal. La
réponse du filtre Normal est -3 dB a 27 % de la fréquence d’échantillonnage, tandis que la réponse du filtre a paliers
est-3dBa 13 % de la fréquence d’échantillonnage. Par exemple, pour un signal arbitraire a 100 M.éch/s, la
fréquence de la bande passante de -3 dB du filtre Normal est 27 MHz.

Eteindre le filtre peut diminuer la fréquence d’échantillonnage si elle était supérieure & 250 M.éch/s avant
Uextinction.

Bruit quasi-gaussien

Le signal Bruit est optimisé pour les propriétés statistiques qualitatives et quantitatives. Il ne se répéte pas pendant
plus de 50 ans de fonctionnement continu. A la différence d’une vraie répartition gaussienne, il n’existe pas de
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probabilité d’obtenir une tension inférieure au réglage Vpp de linstrument. Le facteur de créte (tension en créte
divisée par la tension efficace) est approximativement égal a 4.6.

Vous pouvez faire varier la bande passante du bruit de T mHz a la bande passante maximale de linstrument.
L’énergie contenue dans le signal de bruit est concentrée entre le courant continu et la bande passante
sélectionnée, de fagon que la densité spectrale du signal soit plus importante dans la bande intéressante lorsque la
bande passante est configurée avec une valeur faible. Dans le travail sur le son, par exemple, vous voudrez peut-étre
configurer la bande passante a 30 kHz de fagon que la force du signal dans la bande audio soit 30 dB supérieure a la
bande passante configurée & 30 MHz.

Séquence binaire pseudo aléatoire (PRBS)

Une séquence binaire pseudo aléatoire (PRBS) comporte deux niveaux (haut et bas) et bascule entre eux d’une
maniere difficilement prévisible sans connaitre U'algorithme de génération de la séquence. Un registre a décalage a
rétroaction linéaire (LFSR) génére une séquence PRBS (ci-dessous).

XOR |
Séquence
binaire
pseudo
aléatoire
1 2 3 4 5 » B T 8 9 » (FRES)

Un registre a décalage a rétroaction linéaire (LFSR) est spécifié par le nombre d’étages qu'’il contient et les étages
(piquages) en entrée des portes XOR (OU exclusif) dans son réseau de rétroaction. La sortie PRBS provient du
dernier étage. Avec des piguages correctement choisis, un registre LFSR a étage en L génere un signal PRBS
répétitif de longueur 2" - 1. La fréquence d’horloge du registre LFSR détermine la « vitesse de transmission » de la
sequence PRBS.

Vous pouvez configurer L avec les valeurs 7,9, 11, 15, 20 ou 23, d’ou des séquences de longueur comprise entre 127
et 8 388 607.

La valeur par défaut pour L est de 7, d’ot une séguence de longueur de 127.
Modulation

Modulation d’amplitude (AM)

L'instrument met en place deux formes de modulation d’amplitude :

- Double bande latérale a porteuse pleine (DSB-FC), qui dispose d’une désignation ITU de A3E et est utilisée dans la
radiodiffusion de modulation d’amplitude.

L’équation pour DSB-FC est
y(©)=[(V2)+(V2)-d-m(D)]-Az-sin(w, t)
ou

m(t) est signal de modulation
A est 'amplitude de la porteuse
w, est la fréequence de la porteuse
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d est la « profondeur de modulation » ou une fraction de la plage d’amplitude est utilisée par la
modulation

Par exemple, une profondeur de 80 % entraine une variation d’amplitude de 10 % a 90 % du réglage d’amplitude
(90 % - 10 % = 80 %) avec un signal de modulation interne ou un signal de modulation externe pleine échelle (+5 V).
Vous pouvez définir une profondeur jusqu’a 120 %, tant que vous ne dépassez pas la tension de sortie maximale de
linstrument de (+5V en 50 Q, +10 V en impédance élevée).

La trace supérieure ci-dessous représente le signal modulant et la trace inférieure la porteuse modulée.

— Double bande latérale a suppression de porteuse (DSSC). De nombreux systemes modernes de communications
utilisent la modulation DSSC sur chacune des deux porteuses de méme fréquence mais déphasées de 90 degrés.
Cela s’appelle une modulation d’amplitude en quadrature (QAM).

L’équation pour DSCC est
y(t)=d-m(t)-sin(w, t)

Avec DSB-SC, le signal de porteuse est inversé dés que m(t) < 0. Avec QAM, le second signal de porteuse serait cos
(we 1), ce qui le déphase de 90 degrés par rapport a la premiére porteuse.

Modulation de fréquence (FM)

La modulation de fréquence modifie la fréquence d’un signal de porteuse en fonction du signal modulant :
y(t)=Ac-sin[(wg+d-m(t) )-t]

Ou m(t) est le signal modulant et d est la déviation de fréquence. La modulation FM est a bande étroite si la variation
est inférieure a 1 % de la bande passante du signal modulant (large bande autrement). Vous pouvez vous approcher
de la bande passante du signal modulé grace aux équations suivantes.

BW ~ 2-(Bande passante de signal modulant) pour FM a bande étroite
BW = 2-(Déviation+Bande passante de signal modulant) pour FM a large bande

La trace supérieure ci-dessous représente le signal modulant et la trace inférieure la porteuse modulée.
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Modulation de phase (PM)

La modulation PM est similaire a la FM, mais c’est la phase du signal de porteuse qui est modifiée et non la
fréquence :

y(t)=sin[w, t+d-m(t) ]

ou m(t) est le signal modulant et d est la déviation de phase.

Modulation par déplacement de fréquence (FSK)

La modulation par déplacement de fréquence (FSK) est similaire a la modulation de fréquence (FM), sauf que la
fréquence de la porteuse alterne entre deux valeurs prédéfinies : la fréquence de la porteuse et la fréquence de saut.
Parfois, les fréquences de saut et porteuse sont respectivement baptisées « Marque » et « Espace ». La vitesse de
commutation entre ces valeurs est déterminée par une horloge interne ou le signal sur le connecteur Ext Trig du
panneau avant. Les variations de fréquence sont instantanées et a phase continue.

Le signal modulant interne est un signal carré de rapport cyclique égal a 50 %.

La trace supérieure ci-dessous représente le signal modulant et la trace inférieure la porteuse modulée.
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Modulation par déplacement binaire de phase (BPSK)

La modulation BPSK est similaire a la modulation FSK, sauf si c’est la phase de la porteuse, plutét que la fréquence,
qui bascule entre deux valeurs. La vitesse de commutation entre ces valeurs est déterminée par une horloge interne
ou le signal sur le connecteur Ext Trig du panneau avant. Les variations de phase sont instantanées.

Le signal modulant interne est un signal carré de rapport cyclique égal a 50 %.

Modulation de largeur d'impulsion (PWM)

La modulation PWM est disponible uniquement pour un train d'impulsions ; la largeur des impulsions varie en
fonction du signal modulant. La variation de la largeur des impulsions est appelée la largeur des impulsions ; elle
peut étre spécifiée en pourcentage de la période du signal (rapport cyclique) ou en unité de temps. Par exemple, si
vous spécifiez une impulsion avec un rapport cyclique égal a 20 % et activez ensuite la modulation PWM avec une
variation de 5 %, le rapport cyclique varie de 15 % a 25 % sous le contréle du signal modulant.

Modulation additive (somme)

La fonction « Sum » ajoute le signal modulant a la porteuse. Par exemple, vous pouvez ajouter a un signal des
guantités contrélées de bruit a bande passante variable ou créer des signaux a deux fréquences porteuses. Le
générateur interne de modulation de Uinstrument peut produire le méme signal continu que le générateur principal ;
la fonction Sum permet de créer de nombreux signaux qui auraient nécessité deux instruments auparavant.

La fonction Sum augmente lamplitude du signal de sortie de lamplitude du signal modulant. Cela peut entrainer
linstrument dans une plage de tension supérieure en sortie qui provoque une perte momentanée de signal. Si cela
pose un probléme dans votre application, activez la fonction de maintien de la plage (Range Hold). Si une
augmentation de tension peut endommager votre appareil en test, appliquez des limites de tension.

Rafale

Vous pouvez configurer Uinstrument pour émettre un signal avec un nombre déterminé de cycles (rafale). Vous
pouvez utiliser les rafales dans un des deux modes suivants : rafales a N-cycles (également baptisées "rafale
déclenchée") ou rafale commandée.

Une rafale a N cycles est constituée d’'un nombre donné de cycles de signaux (de 1 a 1 000 000). Elle est toujours
provoquée par un événement de déclenchement. Vous pouvez également configurer le nombre de cycles de rafale
sur « Infini », ce qui génére un signal continu lorsque Uinstrument est déclenché.

Dans l'image ci-dessous, la trace supérieure représente la sortie de synchronisation et la trace inférieure la sortie
principale.
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Signal en rafale de trois cycles

Pour les rafales, la source de déclenchement peut étre un signal externe, une horloge interne, une touche ou une
commande émise sur l'interface distante. L’entrée des signaux externes de déclenchement est le connecteur Ext
Trig du panneau avant. Ce connecteur est référencé par rapport au chassis (et non par rapport a la masse flottante).
Lorsqu’il n’est pas utilisé comme entrée, le connecteur Ext Trig peut étre configuré comme sortie pour permettre a
linstrument déclencher d’autres instruments au moment du déclenchement interne.

Une rafale a N cycles commence et finit toujours au méme point du signal, appelé phase initiale.

En mode de rafale commandée (GATed), le signal de sortie est actif ou inactif en fonction du signal sur le connecteur
Ext Trig du panneau avant. Sélectionnez la polarité de ce signal avec la commande BURSt:GATE:POLarity. Lorsque
le signal de commande est vrai, U'instrument envoie un signal continu. Si le signal de commande est faux, le cycle en
cours se termine, puis Uinstrument s’arréte et sa tension reste au niveau correspondant a la phase de rafale initiale
du signal. Pour un signal de bruit, la sortie s’arréte immédiatement lorsque le signal de commande devient faux.

Balayage de fréquence

Le balayage en fréquence est similaire & la modulation de fréquence (FM) mais sans utiliser de signal modulant. A la
place, l'instrument regle la fréquence de sortie d’apres une fonction linéaire ou logarithmique ou une liste de 128
fréquences (maxi) spécifiées par l'utilisateur. Un balayage linéaire change la fréquence de sortie d’une valeur
constante en Hz ; un balayage logarithmique change la fréquence d’une valeur constante de décades par seconde.
Les balayages logarithmigques permettent de couvrir les plages de fréquence étendues ou la résolution aux basses
fréquences serait potentiellement perdue dans un balayage linéaire.

Les balayages en fréguence sont caractérisés par un temps de balayage (pendant lequel la fréquence change
régulierement de la fréquence initiale a la fréquence finale), un temps de maintien (pendant lequel la fréquence reste
a la fréquence finale) et un temps de retour (pendant lequel la fréquence revient régulierement et linéairement a la
fréquence initiale). Les parametres de déclenchement déterminent le moment du balayage suivant.
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Fréquence
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(Déclenchement du balayage) {DéclenchemEnt du baldayage suivant)

Attributs des signaux CA

Le signal CA le plus courant est sinusoidal. En fait, tout signal périodique correspond a la somme de différentes
ondes sinusoidales. En général, 'amplitude d’'une onde sinusoidale est donnée par sa valeur créte, créte a créte ou
de moyenne quadratique (RMS ou efficace). Ces mesures supposent que le signal ait un décalage de tension nul.

N VF"EHI'C
VRMS =0.707 UPEER

Vekpx

<—T=1 >

La tension de créte d’un signal est la valeur absolue maximale de tous ses points. La tension entre crétes est la
différence entre le maximum et le minimum. La tension efficace (RMS) est 'écart-type de tous les points du signal ;
elle représente également la puissance moyenne dans un cycle du signal diminuée de la puissance de n'importe
guelle composante CC du signal. Le facteur de créte est égal a la valeur créte d’un signal divisée par sa valeur
efficace. Il varie selon le signal. Le tableau ci-dessous présente plusieurs signaux courants avec les facteurs de créte
et les valeurs efficaces respectifs.
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Forme du
signal

Facteur de
créte (C.F.)

1.414

1.732

Siun voltmetre a lecture de valeur moyenne est utilisé pour mesurer la « composante continue » d’un signal, la
lecture peut ne pas étre conforme au réglage de la tension de décalage CC. Ce risque existe parce que le signal peut
avoir une valeur moyenne non nulle qui s’ajouterait a la tension continue de décalage.

Vous pouvez rencontrer des niveaux CA exprimés en « décibels par rapport a 1 milliwatt » (dBm). Comme le gain dBm
représente un niveau de puissance, vous devez connaitre la tension efficace (RMS) du signal et la résistance de
charge pour effectuer le calcul.

dBm = 10xlogqq (P /0.001) ot P = VRMS? / RL

Pour un signal sinusoidal dans une charge de 50 Q, le tableau ci-dessous indique la tension en fonction du gain

dBm.

dBm Tension efficace (RMS)  Tension créte a créte
+23,98 dBm 3,54 Vrms 10,00 Vpp
+13,01 dBm 1,00 Vrms 2,828 Vpp
+10,00 dBm 707 mVrms 2,000 Vpp
+6,99 dBm 500 mVrms 1,414 Vipp
3,98 dBm 354 mVrms 1,000 Vpp
0,00 dBm 224 mVrms 632 mVpp
-6,99 dBm 100 mVrms 283 mVpp
-10,00 dBm 70,7 mVrms 200 mVpp
-16,02 dBm 35,4 mVrms 100 mVpp
-30,00 dBm 7,07 mVrms 20,0 mvp
-36,02 dBm 3,54 mVrms 10,0 mVpp
-50,00 dBm 0,707 mVrms 2,00 mVpp
-56,02 dBm 0,354 mVrms 1,00 mVpp

Pour des charges de 75 Q ou 600 Q, utilisez les conversions suivantes :

dBm (75Q)=dBm (50 Q) - 1.76
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dBm (600 Q) =dBm (50 Q) - 10.79

Imperfections des signaux

Pour les signaux sinusoidaux, les imperfections courantes sont plus faciles a décrire et a observer dans le domaine
des fréquences a l'aide d’'un analyseur de spectre. Toute composante d’un signal de sortie ayant une fréquence
différente de la fondamentale (ou « porteuse ») est considérée somme une distorsion. Ces imperfections peuvent se
classer en distorsion harmonique, parasites non harmoniques ou en bruit de phase ; elles sont exprimées en décibels
par rapport au niveau de la porteuse ou «dBc. »

Distorsion harmonique

Les composantes harmoniques se produisent a des fréquences multiples de la fréquence fondamentale et sont
généralement créées par des composantes non linéaires dans la propagation du signal. Aux faibles amplitudes du
signal, une autre source possible de distorsion harmonique est le signal Sync qui est un signal carré avec de
nombreuses composantes harmoniques fortes qui peuvent s’introduire dans le signal principal. Bien que le signal
Sync soit fortement isolé des sorties du signal principal de l'instrument, le couplage peut se produire dans le
cablage externe. Pour de meilleurs résultats, utilisez des cables coaxiaux avec double ou triple blindage. Si le signal
Sync n’est pas indispensable, ne le connectez pas ou ne l'activez pas.

Parasites non harmoniques

Une source de parasites non harmoniques est le convertisseur numérique/analogique (DAC) qui convertit le signal
numérique en tension. La non-linéarité de ce convertisseur produit des harmoniques qui peuvent étre supérieures a
la fréquence de Nyquist et sont donc repliées a une fréquence inférieure. Par exemple, la cinquiéme harmonique de
30 MHz (150 MHz) peut créer un parasite a 100 MHz.

Le couplage de sources de signaux sans relation (horloge systéeme par exemple) avec le signal de sortie est une
autre source de parasites non harmoniques. Ces parasites ont en général une amplitude constante et sont plus
perturbants avec des amplitudes du signal inférieures a 100 mVpp. Pour la meilleure pureté du signal aux faibles
amplitudes, conservez un niveau relativement élevé de la sortie de Uinstrument et utilisez un atténuateur externe.

Bruit de phase

Le bruit de phase est provoqué par de légéres variations instantanées de la fréquence de sortie (« gigue »). Sur un
analyseur de spectre, il apparait comme une augmentation du bruit de fond apparent a proximité de la fréquence du
signal de sortie. Le bruit de phase représente les amplitudes du bruit dans les bandes 1 Hz séparées de 1 kHz,

10 kHz et 100 kHz d’un signal sinusoidal 30 MHz. N’oubliez pas que les analyseurs de spectre comportent
également du bruit de phase ; les niveaux que vous lisez peuvent comporter du bruit de phase des analyseurs.

Bruit de quantification

La résolution finie dans le convertisseur numérique/analogique du signal entraine des erreurs de quantification. En
supposant que les erreurs sont uniformément réparties sur une plage de +0.5 fois le bit de poids faible, le niveau de
bruit de signaux standard est environ égal & -95 dBc. A ce niveau, les autres sources de bruit dans l'instrument sont
dominantes. Cependant, le bruit de quantification peut poser un probleme dans les signaux arbitraires qui n’utilisent
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pas la plage compléte des codes du convertisseur numérique/analogique (-32 767 a +32 767). Dans la mesure du
possible, mettez a l'échelle les signaux arbitraires pour utiliser la plage complete.
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AvVisos

Aviso de copyright
© Keysight Technologies 2021, 2022

Queda prohibida la reproduccién total o parcial de este manual por cualguier medio (incluyendo almacenamiento
electrénico o traduccidn a un idioma extranjero) sin previo consentimiento por escrito de Keysight Technologies, de
acuerdo con las leyes de copyright estadounidenses e internacionales.

NUmero de referencia del manual
EDU33212-90006

Edicién

Edicién 3, noviembre de 2022

Publicado por

Keysight Technologies

Zona franca industrial Bayan Lepas,
11900 Bayan Lepas, Penang
Malasia

Garantia

EL MATERIAL INCLUIDO EN ESTE DOCUMENTO SE PROPORCIONA EN EL ESTADO ACTUAL Y PUEDE
MODIFICARSE, SIN PREVIO AVISO, EN FUTURAS EDICIONES. KEYSIGHT DESCONOCE, TANTO COMO PERMITAN
LAS LEYES APLICABLES, TODAS LAS GARANTIAS, EXPRESAS O IMPLICITAS, RELATIVAS A ESTE MANUAL Y LA
INFORMACION AQUI PRESENTADA, INCLUYENDO PERO SIN LIMITARSE A LAS GARANTIAS IMPLICITAS DE
CALIDAD E IDONEIDAD PARA UN FIN CONCRETO. KEYSIGHT NO SERA RESPONSABLE DE ERRORES NI DANOS
ACCIDENTALES O DERIVADOS RELATIVOS AL SUMINISTRO, AL USO O A LA CUMPLIMENTACION DE ESTE
DOCUMENTO O LA INFORMACION AQUI INCLUIDA. SI KEYSIGHT Y EL USUARIO TUVIERAN UN ACUERDO APARTE
POR ESCRITO CON CONDICIONES DE GARANTIA QUE CUBRAN EL MATERIAL DE ESTE DOCUMENTO Y
CONTRADIGAN ESTAS CONDICIONES, TENDRAN PRIORIDAD LAS CONDICIONES DE GARANTIA DEL OTRO
ACUERDO.

Licencias tecnoldgicas

El hardware y el software descritos en este documento se suministran con una licencia y solo pueden utilizarse y
copiarse de acuerdo con las condiciones de dicha licencia.
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Derechos del gobierno estadounidense

El software es «software informatico comercial», segun la definicion de la Regulaciéon de adquisiciones federales
(«<FAR») 2.101. De acuerdo con FAR 12.212y 27.405- 3y el Suplemento FAR del Departamento de Defensa
(«DFARS») 227.7202, el gobierno estadounidense adquiere software informéatico comercial bajo las mismas
condiciones que lo suele adquirir el publico. Por ende, Keysight suministra el Software al gobierno estadounidense
con su licencia comercial estdndar, plasmada en el Acuerdo de Licencia de usuario final (EULA), cuya copia se
encuentra en http://www.keysight.com/find/sweula. La licencia establecida en el EULA representa la autoridad
exclusiva por la cual el gobierno estadounidense puede usar, modificar, distribuir y divulgar el Software. ELEULA Yy la
licencia alli presentados no exigen ni permiten, entre otras cosas, que Keysight: (1) Suministre informacién técnica
relacionada con software informético comercial o documentacion de software informatico comercial que no se
suministre habitualmente al publico; o (2) Ceda o brinde de algun otro modo al gobierno derechos superiores a los
brindados habitualmente al publico para usar, modificar, reproducir, lanzar, cumplimentar, mostrar o revelar
software informatico comercial o documentacion de software informético comercial. No se aplica ningun requisito
gubernamental adicional no estipulado en el EULA, excepto que las condiciones, los derechos o las licencias se
exijan explicitamente a todos los proveedores de software informatico comercial de acuerdo con FAR y DFARS, y se
especifiquen por escrito en otra parte del EULA. Keysight no tiene ninguna obligacién de actualizar, corregir ni
modificar el Software de manera alguna. En cuanto a los datos técnicos tal como se definen en FAR 2.101, de
acuerdo con FAR 12.211y 27.404.2 y DFARS 227.7102, el gobierno estadounidense no tiene nada mas que los
derechos limitados definidos en FAR 27.401 o DFAR 227.7103-5 (c), como corresponde para cualquier dato técnico.

Licencias de terceros

Parte de este software tiene licencias de terceros, incluso los términos y condiciones del cédigo abierto. En la
medida en que dichas licencias requieran que Keysight ponga a disposicion el cddigo fuente, lo haremos sin costo
alguno. Para obtener mas informacidn, péngase en contacto con el servicio de asistencia de Keysight en
https://www.keysight.com/find/assist.

Equipos electrénicos y eléctricos en los desperdicios (WEEE)

Este instrumento cumple con el requisito de rotulado de la Directiva WEEE. La etiqueta adherida al producto (ve
mas abajo) indica que usted no debe desechar este producto eléctrico/electrénico junto con los desperdicios
domeésticos.

Categoria del producto: En cuanto a los tipos de equipos del Anexo 1 de la directiva WEEE, este producto se
clasifica como “Instrumento de control y supervision”. No desechar con desperdicios del hogar.

Para devolver productos no deseados, contdctese con su oficina local de Keysight, o consulte

About.keysight.com/en/companyinfo/environment/takeback.shtml para ver mas informacion.
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Soporte técnico

Sitiene preguntas sobre su envio, o si necesita informacion sobre la garantia, el servicio o el soporte técnico,
poéngase en contacto con Keysight Technologies: www.keysight.com/find/assist.

Declaracidn de conformidad

Las declaraciones de conformidad de este producto y otros productos Keysight se pueden descargar de Internet.
Vaya a https://regulations.about.keysight.com/DoC/default.htm. Puede buscar por ndmero de producto la
declaracion de conformidad mas reciente.

Informacién de seguridad

Un aviso de PRECAUCION indica peligro. Informa sobre un procedimiento o practica operativa que, si no se realiza o se cumple en
forma correcta, puede resultar en dafios al producto o pérdida de informacidn importante. En caso de encontrar un aviso de
PRECAUCION no prosiga hasta que se hayan comprendido y cumplido totalmente las condiciones indicadas.

ADVERTENCIA

Un aviso de ADVERTENCIA indica peligro. Informa sobre una préctica, un procedimiento operativo o alguna tarea similar que, si no
se realiza o cumple en forma correcta, podria causar lesiones o la muerte. En caso de encontrar un aviso de ADVERTENCIA, inte-
rrumpa el procedimiento hasta que se hayan comprendido y cumplido las condiciones indicadas.
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Informacion reglamentaria y de seguridad

Consideraciones de seguridad

Las siguientes precauciones generales de seguridad deben respetarse en todas las fases de operacidn, servicio y
reparacion de este instrumento. Si no se respetan estas precauciones o las advertencias especificas mencionadas
en este manual, se violan las normas de seguridad de disefio, fabricacion y uso intencional del instrumento. Keysight
Technologies no asumira ninguna responsabilidad si el cliente no cumple con estos requisitos.
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IESEREREY GENERAL

No utilice este producto de una manera que no esté especificada por el fabricante. Las caracteristicas de proteccidn
de este producto pueden verse perjudicadas si se utiliza de una manera no especificada en las instrucciones de fun-
cionamiento.

ANTES DE CONECTAR LA ELECTRICIDAD
Verifique que se tomen todas las precauciones de seguridad. Realice todas las conexiones antes de conectar la elec-
tricidad.

CONECTE A TIERRA EL INSTRUMENTO

Este producto esta provisto de terminales de conexidn tierra de proteccidn. Para reducir el riesgo de descarga eléc-
trica, el instrumento debe conectarse a la red eléctrica de AC a través de un cable de alimentacidn con conexidn a tie-
rra, y el conjunto de cables de conexidn a tierra debe conectarse a una toma de tierra eléctrica (toma de tierra de
seguridad) con conductor de proteccion (de puesta a tierra) a la toma de corriente. Cualquier interrupcion del con-
ductor de proteccién (conexidn a tierra) o desconexion del terminal a tierra de proteccidn causard un peligro potencial
de descarga eléctrica que podria resultar en lesiones personales.

NO UTILICE EL PRODUCTO EN UNA ATMOSFERA EXPLOSIVA O AMBIENTES HUMEDOS.
No utilice el instrumento cerca de gases o emanaciones inflamables, vapores o en ambientes himedos

NO UTILICE INSTRUMENTOS DANADOS O DEFECTUOSOS
Debe interrumpir la operacidn de cualquier instrumento que parezca dafiado o defectuoso para protegerlos de usos
indebidos hasta que el personal de servicio calificado pueda repararlo.

NO SUSTITUYA PARTES O MODIFIQUE EL INSTRUMENTO

Debido al peligro de introducir peligros adicionales, no instale piezas de recambio ni realice ninguna modificacién no
autorizada en el instrumento. Si el producto precisa mantenimiento o reparaciones, devuélvalo a la oficina de ventas y
reparaciones de Keysight Technologies para asegurarse de que se mantengan las medidas de seguridad. Para comu-
nicarse con Keysight y solicitar asistencia técnica o de ventas, consulte los enlaces de soporte de estos sitios web de
Keysight: www.keysight.com/find/assist (informacidn de contacto para reparacién y servicio en todo el mundo).

UTILICE EL CABLE DE ALIMENTACION SUMINISTRADO
Utilice el instrumento con el cable de alimentacién suministrado en el envio.

NO BLOQUEE LOS ORIFICIOS DE VENTILACION
No bloquee los orificios de ventilacién del instrumento.

CONSULTE TODAS LAS LEYENDAS EN EL INSTRUMENTO ANTES DE CONECTARSE AESTE
Observe todas las leyendas en el instrumento antes de realizar conexiones de cableado.

ASEGURESE DE QUE LA COBIERTA ESTA ASEGURADA EN SU LUGAR
No opere el Instrumento sin la cubierta o si esta estd floja. Solo el personal calificado y entrenado para dicho servicio
debe retirar la tapa del instrumento.

ASEGURESE DE QUE EL INSTRUMENTO ESTE BIEN UBICADO
No coloque el instrumento en una zona que presente dificultades durante su desconexidn.

CABLE DE ALIMENTACION DE CA

El método de desconexidn para quitar la alimentacidn del instrumento es extraer el cable de alimentacién de CA. Ase-
gurese de contar con el acceso adecuado al cable de alimentacidn para permitir la desconexién de la alimentacion de
CA. Use solo el cable de alimentacidn especificado por Keysight para el pais de uso o uno con clasificaciones equi-
valentes.

Guia del usuario de la serie Keysight EDU33210 11



LIMPIE CON UN PANO LIGERAMENTE HUMEDECIDO

Limpie el exterior del instrumento con un pafio suave que no deje pelusas humedecido. No utilice detergentes, liqui-
dos volatiles ni quimicos disolventes.

Simbolos de seguridad

Simbolo Descripcion

f"f Precaucion, peligro (consulte este manual para obtener informacion especffica respecto de Advertencia o Precaucidn).

@ Terminal a tierra de proteccion
N

Conexidn a tierra

Corriente Alterna (CA)
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Marcas regulatorias

Simbolo Descripcion

c € ICES/NMB-001]| La marca CE es una marca registrada de la Comunidad Europea. Esta marca CE indica que el producto cumple
ISMGRP 1-A | con todas las Directivas legales europeas relevantes.

ICES/NMB-001 indica que este dispositivo ISM cumple con la norma canadiense ICES-001.

Cet appareil ISM est conforme a la norme NMB-001 du Canada.

ISM GRP. 1 Clase A indica que este es un producto Clase A 1 del Grupo Industrial, Cientifico y Médico.

La marca CSA es una marca registrada de la Asociacion Canadiense de Estandares.

La marca RCM es una marca registrada de la Autoridad Australiana de Comunicaciones y Medios de
Informacion.

Este simbolo indica el periodo durante el cual se espera que ningun elemento de sustancias peligrosas o
téxicas se filtre o se deteriore por el uso normal. Cuarenta afios es la vida Util esperada del producto.

Este simbolo es una declaracién de EMC clase A de Corea del Sur. Se trata de un instrumento de clase A
disefiado para uso profesional y en entornos electromagnéticos fuera del hogar.

Este Instrumento cumple con el requisito de rotulado de la Directiva WEEE. Esta etiqueta adosada al producto
indica que no se debe desechar este producto eléctrico o electrénico con los desperdicios del hogar.

iiafolic G,

Declaraciédn de EMC clase A de Corea del Sur:
Informacion al usuario:

Este equipo ha sido evaluado para su conformidad en entornos empresariales. En un entorno residencial, este
equipo puede causar interferencias de radio.

- Esta declaracion de EMC se aplica al equipo solo para uso en el entorno empresarial.

AETHOHUW E

01D ERE HBUHANANEE SH2Z HegddIIE 22 IIIZA
8 E BF0AM AtSote 22 JI2tE2e 22t ASLICH

- NEN U222 "ERELSSAINX "0 HEEHCH

A
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Seguridad y requisitos de EMC

Esta fuente de alimentacion estd disefiada para cumplir con los siguientes requisitos de seguridad y compatibilidad
electromagnética (EMC):

- Directiva de Baja Tension 2014/35/UE
- Directiva EMC 2014/30/UE

Condiciones ambientales

Este instrumento esta disefiado para uso en interiores y en un area con baja condensacion. La tabla a continuacion
muestra los requisitos ambientales generales para este instrumento.

Condicion ambiental Requisito

Temperatura Condiciones de funcionamiento: 0 °C a 55 °C
Condiciones de almacenamiento: -40°Ca 70 °C

Humedad Condicion de operacién/almacenamiento: Hasta el 80 % de HR a temperaturas de hasta
40 °C (sin condensacion)

Altitud Hasta 3000 m

Grado de contaminacién 2

Categoria de sobretension I

Fuente de alimentacidn y frecuencia de 100/120V, 100/240V

la linea 50/60 Hz

Consumo de energia <4H5W

Fluctuaciones de tension de la ali- Las fluctuaciones de tension de la alimentacion eléctrica de la red no pueden exceder el
mentacion eléctrica 10 % de la tensidn nominal de alimentacion.
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1 Introduccidon al Instrumento

Breve descripcion del instrumento

Breve descripcion del panel frontal

Breve descripcién de la pantalla del panel frontal
Entrada de numeros en el panel frontal

Breve descripcion del panel posterior
Dimensiones del instrumento

El Generador de Forma de Onda arbitraria Trueform de la serie
EDU33210 de Keysight es una serie de generadores de forma de onda
sintetizados con capacidades de pulso y de forma de onda arbitraria
incorporadas.

Guia del usuario de la serie Keysight EDU33210
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Breve descripcion del instrumento

El Generador de Forma de Onda arbitraria Trueform de la serie EDU33210 de Keysight es una serie de generadores
de forma de onda sintetizados con capacidades de pulso y de forma de onda arbitraria incorporadas.

Existen dos modelos disponibles:

- EDU33211A: Generador de formas de onda arbitrarias Trueform de 20 Mhz y un solo canal
- EDU33212A: Generador de formas de onda arbitrarias Trueform de 20 Mhz y de dos canales
Caracteristicas principales:

- Modulacién incorporaday 17 formas de onda populares

- Capacidad de forma de onda arbitraria de 16 bits con memoria de hasta 8 Msa/canal

- Dos canales independientes que pueden acoplarse en amplitud y frecuencia (EDU33212A)
- Una colorida pantalla WVGA de 7 pulgadas llena de informacion.

- Excelente uso.

- Interfaz de ES USBy LAN

- Interfaz web

— Compatibilidad SCPI (Comandos estandar para instrumentos programables)

- Incluye el software Pathwave BenchVue

- 3 afios de garantia estandar
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Breve descripcion del panel frontal

KEYSIGHT EDU33212A Waveform Generator

SIN,50Q

Frequency 1.000,000,000 kHz 1.000,000,000 kHz

Amplitude 100.0 mVpp 100.0 mVpp Frequency
Offset +0.000V +0.000V

Phase 0.0° 0.0°

100.00% Amplitude

\\/

A0 | —)

= |

Channel 2

<

1 Pantalla WVGA de 7 pulgadas -Pantalla del canal 1

2 Pantalla del canal 2 (solo EDU33212A)

3 Interruptor [ON/OFF](ENCENDIDO/APAGADO)

4 Puerto USB: permite conectar una unidad flash USB externa al instrumento

La serie EDU33210 admite memorias USB con la siguiente especificacién: USB
2.0, formato FAT32, de hasta 32 GB. Recomendamos usar una unidad flash
SanDisk Cruzer Blade para el puerto USB del panel frontal.

5 Botdn [Back] (Atr4s)

Mantenga presionado el botdn [Back] (Atrés) durante mas de 3 segundos mien-
tras la unidad flash USB externa estd conectada para capturar automaticamente la
pantalla del instrumento. La imagen capturada se guardard en la unidad flash USB

conectada.
6 Teclas de funcién
7 Conector CAL
8 Connector Ext Trig/Gate/FSK/Burst
9 Conector Sync/Trigger Out (Sincronizacién/Salida de disparo)
10 Botones de funcion fija
1 Teclado numérico
12 Perilla y flechas del cursor
13 Conectores de los canales 1y 2 (solo EDU33212A) y botones relacionados
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Breve descripcion de la pantalla del panel frontal

Vista de un solo canal

Frequency 1.000,000,000 kHz

Amplitude 1.000 mVpp

Offset +1.000V

Phase 0.0°

KEYSIGHT

TECHNOLOGIES
Parameter

Frequency

Amplitude

1 Informacion del canal 1

Indicadores de estado

Pardmetros de la forma de onda del canal 1
Pardmetros de barrido, modulacion o réfaga
Visualizacidn de la forma de onda del canal 1

Nombre de la funcidn

~N| OO o W N

Etiquetas de la tecla de funcion

18
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Vista de doble canal (aplicable solo para EDU33212A)

Pulse dos veces la tecla [Setup] (Configuracion) para entrar en el modo de vista de dos canales. En este modo, al
pulsar [Setup] (Configuracion) se alterna entre la vista de un solo canal y la vista de dos canales.

KEYSIGHT

TECHNOLOGIES

Output

Frequency 1.000,000,000 kHz equency 1.000,000,000 kHz

Amplitude 100.0 mVpp Am 100.0 mVpp

Offset +0.000V ffset +0.000V

Phase 0.0° ‘ 0.0° Range
100.00 % Suto Hold

Qutput
~5-

Polarity
Mormal " Inverted

Voltage Limits
-

Mode
Mormal  Gated

—

Informacion del canal 1

Informacion del canal 2

Indicadores de estado

Pardmetros de la forma de onda del canal 1
Pardmetros de la forma de onda del canal 2
Visualizacion de la forma de onda del canal 1
Visualizacion de la forma de onda del canal 2

Nombre de la funcion

O | 0| O |lo | &~ w N

Etiquetas de la tecla de funcién

Indicadores de estado del instrumento

- Se muestra cuando el modo remoto esta activado

- Se muestra después de que se envia el comando SYSTem:RWL

La unidad flash USB esté conectada

@ La LAN est4 conectada

Guia del usuario de la serie Keysight EDU33210
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Leyenda Descripcion
- Se produjo un error en el instrumento

Entrada de nimeros en el panel frontal

Puede introducir nimeros desde el panel frontal de dos maneras:

- Utilice la perilla y las teclas del cursor para modificar el nimero. Gire la perilla para cambiar un digito (aumenta a
la derecha). Las flechas debajo de la perilla mueven el cursor.

- Utilice el teclado para introducir nimeros y las teclas programables para seleccionar unidades. La tecla [+/-]
cambia el signo del nimero.

Breve descripcion del panel posterior

2045
MADE IN CHINA MAY CONTAN FOREIGN OR DOMESTIC COMPONENTS

2-Channel Waveform Generator o
&'E EDU33212A S/N:Cwmmesunes %
MAC: I AT

Leyenda Descripcion

1 Traba Kensington

2 Conector de interfaz de bus serie universal (USB-B)
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Conector de interfaz de la red de drea local (LAN)
Conector de alimentacion de CA
Ventilador

Numero de serie del instrumento y la direccion MAC

~N| O |o | &~ W

Seguridad y etiquetas reglamentarias del instrumento

Este es un equipo de clase de proteccidn 1 (el chasis debe estar conectado a una toma de tierra de proteccidn). El
enchufe de la linea solo debe insertarse en una toma con terminal a tierra de proteccién

Dimensiones del instrumento
Altura: 164.70 mm x ancho: 313.60 mm

| | | =

00
00
00
00

164.70

D000
D000
0000
0(0)
v,

0
0

o| 0

I@_

5

g

o

°| 5885880
©

o) 0

[‘
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Largo: 124.58 mm

124.58

22 Guia del usuario de la serie Keysight EDU33210



2 Introduccion

Preparacion del instrumento para su uso

Configurar la frecuencia de salida

Configurar la amplitud de la salida

Configurar la tensién de compensacién de CC
Configurar valores de nivel alto y bajo

Emitir una tensién de CC

Configurar un ciclo de trabajo de una onda cuadrada
Configurar una forma de onda de pulso

Seleccionar una forma de onda arbitraria almacenada
Como usar el sistema de ayuda incorporado
Actualizar el firmware

Conexiones de la interfaz remota

Configuracion de la interfaz remota

Control remoto

En esta seccion se describen los procedimientos basicos que lo ayudaran
a comenzar a usar rapidamente el instrumento.
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Preparacion del instrumento para su uso

Cuando recibe su instrumento, busque cualquier dafio obvio que pueda haber ocurrido durante el envio. Si hay
dafios, notifiqgue inmediatamente al transportista y a la oficina de ventas y soporte de Keysight mas cercana.
Consulte www.keysight.com/find/assist.

Hasta que haya verificado el instrumento, conserve el carton de envio y los materiales de embalaje por si debe
devolver la unidad. Revise la lista de a continuacion y verifique que ha recibido estos articulos con su instrumento. Si
falta algo, comuniguese con la oficina de ventas y soporte de Keysight més cercana.

- Gufa de inicio rapido

- Cable de alimentacién de CA (para el pafs de destino)

- Certificado de calibracion y aviso de vida Util

- Folleto de seguridad de Keysight (9320-6797)

- Anexo de RoHS para Generadores de Forma de Onda Arbitraria (China) (9320-6667)

Documentacion y revisiones del firmware

La documentacion que aparece a continuacion puede descargarse gratuitamente desde nuestro sitio web en
www.keysight.com/find/EDU33211A-manuals.

- Guia de inicio rapido de Generadores de forma de onda arbitraria Trueform de la serie EDU33210 de Keysight.

- Guia del usuario de Generadores de forma de onda arbitraria Trueform de la serie EDU33210 de Keysight. Este
manual.

- Guia de programacion de Generadores de forma de onda arbitraria Trueform de la serie EDU33210 de Keysight.
- Guia de servicio de Generadores de forma de onda arbitraria Trueform de la serie EDU33270 de Keysight.

Para consultar la ultima revision del firmware y las instrucciones de actualizacion del firmware, vaya a.
-EDU33211A: www.keysight.com/find/EDU33211A-sw

-EDU33212A: www.keysight.com/find/EDU33212A-sw

Intervalo de Calibracién Recomendado

Keysight Technologies recomienda un ciclo de calibracion de un afio para este instrumento.

Configure el instrumento

Coloque la base del instrumento en una superficie horizontal planay lisa. Conecte el cable de alimentacion al panel
traseroy luego conéctelo a la alimentacion principal. Conecte los cables LAN o USB como desee, y también puede
asegurar el instrumento con un cable de cierre de seguridad. Finalmente, encienda el instrumento con el botén
[On/Off] (Encendido/apagado) del panel frontal.

Elinstrumento ejecuta una prueba automatica de encendido y muestra un mensaje Acerca de cdmo obtener ayuda,
junto con la direccidn IP actual.
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Configurar la frecuencia de salida

La frecuencia predeterminada es 1 kHz. Puede cambiar la frecuencia, y puede especificar la frecuencia en unidades

de perfodo en lugar de Hz.
Presione [Parameter] > Frequency ([Pardmetro] > Frecuencia).

KEYSIGHT

TECHNOLOGIES

Parameter

Frequency  [J000.000000 Frequency

Amplitude 100.0 mVpp Amplitude

Offset +0.000V

Dffset
Phase 0.0°

Phase
~-

- Utilice la perilla para cambiar el valor numérico y/o utilice las flechas del cursor para mover el cursor al digito

siguiente o anterior, 0

— Utilice el teclado numérico para establecer un valor numérico. Seleccione una unidad de prefijo (uHz, mHz, Hz,

kHz 0 MHz) para confirmar los cambios.

Presione [Units] > Frequency Periodic ([Unidades] > Frecuencia Periddica) para cambiar las unidades a periodo en

lugar de a frecuencia.

KEYSIGHT

TECHNOLOGIES
Units
Frequency

Period  100.000 ps 1 | e

Amplitude 100.0 mVpp > AmplOffs <
High/Low

Offset +0.000V
Amplitude

Phase 0.0° \ J -

Phase
Degrees

Sweep
Stristop

Guia del usuario de la serie Keysight EDU33210
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Configurar la amplitud de la salida

La funcién por defecto del instrumento es una onda sinusoidal de 1 kHz, 100 mVpp (en una terminacién 50 Q).

Los siguientes pasos cambian la amplitud a 50 mVpp.

. Presione [Units] > Amp/Offs High/Low ([Unidades] > Ampl/Comp Alto/Bajo) para especificar la tensiéon como ampli-

tud y compensacion.

La amplitud mostrada es el valor de encendido o la amplitud previamente seleccionada. Cuando se cambia de fun-
cion, se utiliza la misma amplitud si es valida para la nueva funcién. Para elegir especificar la tension como valores
altos y bajos en su lugar, presione Amp/Offs High/Low. (Ampl/Comp Alto/Bajo).

En este ejemplo, destacaremos el Amp/Offs High/Low. (Ampl/Comp Alto/Bajo).

Frequency 1.000,000,000 kHz Periodic

Amplitude 100.0 mVpp AmpiOffs 4
High/Low
Offset +0.000V
Amplitude
Phase 0.0° -
Phase
Degrees

Sweep
StrtStor
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2. Introduzca la magnitud de la amplitud deseada.

Presione [Parameters] > Amplitude ([Pardametros] > Amplitud). Con el teclado numérico, introduzca el nimero 50.

Frequency 1.000,000,000 kHz

Amplitude 50 _
Offset +0.000V

Phase 0.0°

3. Seleccione las unidades deseadas.

Presione la tecla de funcidn que corresponde a las unidades deseadas. Al seleccionar las unidades, el instrumento
da salida a la forma de onda con la amplitud visualizada (si la salida esté activada). Para este ejemplo, presione
mVpp.

También puede introducir el valor deseado con la perilla y las flechas. Si lo hace, no necesita usar una tecla de fun-
cion de unidades. Puede convertir facilmente los tipos de unidades. Simplemente presione [Units] > Amplitude ([Uni-
dades] > Amplitud) y seleccione las unidades deseadas.

Frequency 1.000,000,000 kHz

Amplitude 50.00 mVpp Amp/0ffs
High/Low
Offset +0.000V
Amplitude
Phase 0.0° -
Phase

Degrees

Sweep
StrtStop
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Configurar la tension de compensacion de CC

Al encender el instrumento, la compensacion de CC es de O V. Los siguientes pasos cambian la compensacion a 1.5
VCC.

1. Presione [Parameter] >Offset ([Pardmetro] >Compensacion).
La tension de compensacion que se muestra es el valor de encendido o la compensacion seleccionada previamente.

Cuando se cambian las funciones, se utiliza la misma compensacion si el valor actual es valido para la nueva fun-
cion.

KEYSIGHT

TECHNOLOGIES

Parameter
Frequency 1.000,000,000 kHz Frequency

Amplitude 50.00 mVpp Amplitude

Offset [Joooo v

Phase 0.0°

2. Introduzca la compensacion deseada.
En este caso, usaremos el teclado numérico para introducir 1.5.

i
Frequency 1.000,000,000 kHz
Amplitude 50.00 mVpp

Offset 15

Phase 0.0°
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3. Seleccione las unidades deseadas.

Presione la tecla de funcidn para las unidades deseadas. Al seleccionar las unidades, el instrumento da salida a la
forma de onda con la compensacion. visualizada (si la salida esta activada). Para este ejemplo, presione V. La ten-
Sidn se ajustara como se muestra a continuacion.

KEYSIGHT

Parameter
Frequency 1.000,000,000 kHz Frequency

Amplitude 50.00 mVpp Amplitude

Offset 5000 v

Dffset
Phase 0.0°

Phase
-

También puede introducir el valor deseado con la perilla y las flechas.

Configurar valores de nivel alto y bajo

Se puede especificar una sefial ajustando su amplitud y la compensacion de CC, descrita anteriormente. También
puede especificar la sefial como valores altos (méaximos) y bajos (minimos). Esto suele ser conveniente para
aplicaciones digitales. En el siguiente ejemplo, fijaremos el nivel alto en 1.0 V y el nivel bajoen 0.0 V.

Guia del usuario de la serie Keysight EDU33210 29



1. Presione [Units] > Ampl/Offs High/Low. ([Unidades] > Ampl/Comp Alto/Bajo). Cambie a High/Low (Alto/Bajo) como
se muestra a continuacion.

KEYSIGHT

TECHNOLOGIES

[nits

» Frequency

Frequency 1.000,000,000 kHz Periodic

High Level +50.00 mV Amp/0ffs
»  High/low <

Low Level -50.00 mV

Phase 0.0°

2. Presione [Parameter] > High Level ([Parametro] > Nivel alto). Con el teclado numérico o la perilla y las flechas, selec-
cione un valor de 1.0 V. (Si utiliza el teclado, deberd seleccionar la tecla de funcién Unidad V para ingresar el valor).

KEYSIGHT

TECHNOLOGIES

Frequency 1.000,000,000 kHz

High Level 1.0

Low Level -50.00 mV

Phase 0.0°
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3. Presione la tecla de funcién Low Level (Nivel bajo) y ajuste el valor. De nuevo, utilice el teclado numérico o la perilla
para introducir un valor de 0.0 V.

KEYSIGHT

TECHNOLOGIES

Frequency 1.000,000,000 kHz

High Level +1.000V

Low Level 0.0_

Phase 0.0°

Estos ajustes (nivel alto = 1.0 V'y nivel bajo = 0.0 V) equivalen a establecer una amplitud de 1.0 Vpp y una
compensacion de 500 mV.
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Emitir una tensiéon de CC

Puede emitir una tensién constante de CC,de-bVa+bVenb0Q,0de-10Va+10V en una carga de alta
impedancia.

1. Presione [Waveform] > MORE 1/ 2 > DC > Offset ([Forma de onda] > MAS 1 /2 > CC > Compensacién). Se selec-
ciona el valor de Compensacion.

KEYSIGHT

TECHNOLOGIES
Parameter

Offset

Offset 5000 v

2. Introduzca la compensacion de tensidn deseada. Ingrese 1.0 con el teclado numérico o la perilla y presione la tecla
de funcién Compensacion si utilizo el teclado.

KEYSIGHT

TECHNOLOGIES

Offset 1.0_
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Configurar un ciclo de trabajo de una onda cuadrada

Elvalor predeterminado de encendido para el ciclo de trabajo de onda cuadrada es del 50 %. El ciclo de trabajo esta
limitado por la especificacion de la amplitud de pulso minimo de 16 ns. El siguiente procedimiento cambia el ciclo de
trabajo al 75 %.

1. Seleccione la funcién de onda cuadrada.
Presione [Waveform] > Square ([Forma de onda] > Cuadrado).

KEYSIGHT

TECHNOLOGIES

Frequency 1.000,000,000 kHz Frequency

High Level +1.000V High Level

Low Level -1.000 mV

Low Level
Phase 0.0°

Duty Cycle 50.00 % Phase
~5-

Duty Cycle

2. Presione la tecla de funcién Duty Cycle (Ciclo de trabajo).

El ciclo de trabajo que se muestra es el valor de encendido o el porcentaje seleccionado previamente. El ciclo de tra-
bajo representa la cantidad de tiempo por ciclo que la onda cuadrada estd en un nivel alto.

KEYSIGHT

TECHNOLOGIES

Parameter
Frequency 1.000,000,000 kHz Frequency

High Level +1.000V High Level
igh Leve

Low Level -1.000 mV

Low Level
Phase 0.0°

Duty Cycle @.00 % Phase
~-

Duty Cycle
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3. Introduzca el ciclo de trabajo deseado.

Con el teclado numérico o la perilla y las flechas, seleccione un valor de ciclo de trabajo de 75. Si estd usando el
teclado numérico, presione Percent (Porcentaje) para terminar la entrada. El instrumento ajusta el ciclo de trabajo
inmediatamente y emite una onda cuadrada con el valor especificado (si la salida estd activada).

KEYSIGHT

TECHNOLOGIES

Frequency 1.000,000,000 kHz Percent

High Level +1.000V

Low Level -1.000 mV

Phase 0.0°
Duty Cycle 75_

Configurar una forma de onda de pulso

Puede configurar el instrumento para que emita una forma de onda de pulso con la amplitud de pulso y tiempo de
borde variables. Los siguientes pasos configuran una forma de onda de pulso periddico de 500 ms con una amplitud
de pulso de 10 msy tiempos de borde de 50 ns.
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1.

2. Configure el periodo de pulso.

Seleccione la funcién de pulso.

Frequency 1.000,000,000 kHz

High Level +1.000V

Low Level -1.000 mV

Phase 0.0°

Pulse Width 10.000,0 ps
Lead Edge 4.0ns

Trail Edge 4.0 ns

Period 500
High Level +1.000V

Low Level -1.000 mV

Phase 0.0°

Pulse Width 10.000,0 ps
Lead Edge 4.0ns

Trail Edge 4.0 ns

Guia del usuario de la serie Keysight EDU33210

Presione [Waveform] > Pulse([Forma de onda] > Pulso) para seleccionar la funcién de pulso.

Frequency
High Level

Low Level

Phase
~-

Pulse
Width

Edge
~5-

Presione la tecla [Units] [Unidades] y luego presione la tecla Frequency Periodic(Frecuencia periddica). A con-
tinuacion, presione [Parameter] > Period ([Parametro] > Periodo). Configure el periodo a 500 ms.

KEYSIGHT

TECHNOLOGIES

seconds
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3. Configure el ancho del pulso.

Presione [Parameter] > Pulse Width ([Parametro] > Ancho del pulso). Luego, configure la amplitud de pulso a 10 ms.
La amplitud de pulso representa el tiempo que pasa entre el 50 % del borde ascendente del pulso y el 50 % del
siguiente borde descendente.

KEYSIGHT

TECHNOLOGIES

Period 500.000,000 ms

High Level +1.000V

Low Level -1.000 mV

Phase 0.0°
Pulse Width 10_ seconds
Lead Edge 4.0ns

Trail Edge 4.0ns
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4. Configure el tiempo de borde para ambos bordes.
Presiona la tecla de funcién Edge (Borde) y luego Each Both (Cada una Ambas).

KEYSIGHT

TECHNOLOGIES

Parameter

Each
Period 900.000,000 ms Both

High Level +1.000V Edge
Time

Low Level -1.000 mV

Phase 0.0°
Pulse Width 10.000,000,0 ms
Edge Time 0.000,000,000 s

Presione Edge Time (Tiempo de borde) para fijar el tiempo de borde tanto para el borde de entrada como para el de
salida en 50 ns. El tiempo de borde representa el tiempo desde el umbral del 10% hasta el umbral del 90 % de cada
borde.

Period 900.000,000 ms
High Level +1.000V

Low Level -1.000 mV

Phase 0.0°
Pulse Width 10.000,000,0 ms

seconds

Edge Time 50_

Seleccionar una forma de onda arbitraria almacenada

Hay nueve formas de onda arbitrarias incorporadas almacenadas en la memoria no volatil. Son Cardiaco, D-Lorentz,
Calda Exponencial, Subida Exponencial, Gaussiano, Haversine, Lorentz, Rampa Negativa, y Sinc.

Este procedimiento selecciona la forma de onda de «subida exponencial" incorporada en el panel frontal.

Guia del usuario de la serie Keysight EDU33210 37



1. Presione [Waveform] > Arb > Arbs ((Forma de onda] > Arb > Arbs).

KEYSIGHT

TECHNOLOGIES

Parameter

Select

samp Rate 0.000,000 Sa/s arb

High Level +1.000V Arbs in Memory
-
Low Level -1.000 mV

Samples 250

Arb Name EXP_RISE.arb Import Data
~»-

Save
Changes

2. Elige Arbs in Memory (Arbs en Memoria) y use la perilla para seleccionar EXP_RISE. Presione (Seleccionar Arbs).

KEYSIGHT
TECHNOLOGIES

ARB,500
Arb Memory Catalog - Channel 1 Parameter

CEIES 1 INTABUILTIN\EXP_RISE.ARB
High Lev

Low Leve

Samples

Arb Nam

Como usar el sistema de ayuda incorporado

El sistema de ayuda incorporado proporciona ayuda de acuerdo con el contexto en cualquier tecla del panel frontal
o tecla de funcién del mend. También encontrard disponible una lista de temas de ayuda que pueden ayudarlo a
aprender sobre el instrumento.

Consulte la informacion de ayuda de un botdn o tecla de funcion

Mantenga presionado cualquier tecla de funcién o botén del panel frontal, como [Waveform] [Forma de onda].
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? QUICK HELP o
elp

Opens t veform list, with a "MORE" softkey for additional iterns. Pressing a softkey highlights it,
and the waveform's parameters appear. 0K

Available waveforms include Sine, Square, Triangle, Pulse, Ramp, Noise, Arbitrary (user defined),
PRBS (Pseudo-Random Binary Sequence) and DC. To configure the selected waveform, press
[Parameters).

Si el mensaje contiene mas informacion de la que cabe en la pantalla, presione la tecla de funcién de flecha hacia
abajo para ver la informacion restante.

Presione OK (Aceptar) para salir de la ayuda.

Ayuda en el idioma local

Todos los mensajes, la ayuda contextual y los temas de ayuda estéan disponibles en inglés, francés, alemdn, espafiol,
chino simplificado, chino tradicional, japonés, coreano y ruso. Las etiquetas de las teclas de funcién y los mensajes
de la linea de estado no se traducen (es decir, siempre en inglés). Para seleccionar el idioma, presione [System] >
User Settings > Language (Sistema > Configuracién de usuario > Idioma). Luego seleccione el idioma deseado.

Actualizar el firmware

Nunca apague el instrumento durante una actualizacién.

Presione [System] > Help > About ([Sistema] > Ayuda > Acerca de) para determinar el nimero de versién del
firmware del instrumento instalado actualmente.

Vaya a www.keysight.com/find/EDU33211A-sw para encontrar la dltima versién del firmware. Si esto coincide con
la version instalada en su instrumento, no hay necesidad de continuar con este procedimiento. De lo contrario,
descargue la utilidad de actualizacion del firmware y un archivo ZIP del firmware. Las instrucciones detalladas para
la actualizacion del firmware se encuentran en la pagina de descargas.

Conexiones de la interfaz remota

Esta seccién describe cémo conectarse a las diversas interfaces de comunicacién de su instrumento. Para obtener
mas informacion sobre la configuracion de las interfaces remotas, consulte Configuracidn de la interfaz remota.

Siatn no lo ha hecho, instale la Keysight 10 Libraries Suite, que se puede encontrar en www.keysight.com/find/iolib.
Para obtener informacion detallada sobre las conexiones de las interfaces, consulte la Guia de Conectividad de Inter-
faces USB/LAN/GPIB de Keysight Technologies, incluida en la Keysight 10 Libraries Suite.
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Conéctese al instrumento a través del USB

En la siguiente figura se presenta un tipico sistema de interfaz USB.

Cable USB
_ \ Conectar al puerto Conectar al
USB de la PC puerto USB del
instrumento

1. Conecte el instrumento al puerto USB de su computadora con un cable USB.

2. Al ejecutar la utilidad Connection Expert de Keysight 10 Libraries Suite, la computadora reconocera auto-
maticamente el instrumento. Esto puede tardar varios segundos. Cuando el instrumento se reconozca, su com-
putadora mostrard el alias de VISA, la cadena de IDN y la direccion de VISA. También puede ver la direccion VISA del
instrumento en el mend del panel frontal.

3. Ahora puede usar la ES interactiva dentro del Connection Expert para comunicarse con su instrumento, o puede pro-
gramar su instrumento mediante diversos entornos de programacion.

No se recomienda que el cable USB tenga mas de 3 metros de longitud.

Conéctese al instrumento a través del LAN (local o privada)

Red local LAN

Unared local LAN es una red de érea local en la que los instrumentos y las computadoras habilitados para LAN se
conectan a la red a través de enrutadores, concentradores y/o conmutadores. Generalmente, son grandes redes
que se gestionan de forma centralizada con servicios como DHCP y servidores DNS. En la siguiente figura se
presenta un sistema de red local LAN tipico.

Ala tarjeta Al puerto LAN

de interfaz
d:/ red (NIC) A red local LAN \

© C,
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1.

1.

Conecte elinstrumento a la red local LAN o0 a su computadora mediante un cable LAN. La configuracion de la LAN
del instrumento en el momento de su envio estd configurada para obtener automaticamente una direccién IP de la
red mediante un servidor DHCP (DHCP est&d ACTIVADO de forma predetermianda). El servidor DHCP registraré el
nombre de host del instrumento con el servidor DNS dindmico. El nombre de host y la direccidn IP pueden utilizarse
para comunicarse con el instrumento. El indicador LAN del panel frontal se encendera cuando el puerto LAN se haya
configurado.

Si necesita configurar manualmente cualquier configuracién de la LAN del instrumento, consulte Con-
figuracion de la interfaz remota para obtener informacién sobre cédmo configurar la configuracién de la
LAN desde el panel frontal del instrumento.

Utilice la utilidad Connection Expert de Keysight IO Libraries Suite para afiadir el instrumento y verificar una cone-
xién. Para afiadir el instrumento, puede solicitar al Connection Expert que detecte el instrumento. Si no se puede
encontrar el instrumento, afiddalo usando su nombre de host o direccién IP.

Si esto no funciona, consulte las “Instrucciones para la resolucion de problemas” en la Guia de Conec-
tividad de Interfaces USB/LAN/GPIB de Keysight Technologies, incluida en la Keysight IO Libraries
Suite.

Ahora puede usar la ES interactiva dentro del Connection Expert para comunicarse con su instrumento, o puede pro-
gramar su instrumento mediante diversos entornos de programacion.

LAN privada

Una red privada LAN es una red en la que los instrumentos y las computadoras habilitados para LAN estan
conectados directamente, y no conectados a una red local LAN. Generalmente, son pequefias, sin recursos
gestionados de forma centralizada. En la siguiente figura se presenta un sistema de red privada LAN tipico.

Ala tarjeta Al puerto LAN
de interfaz
de red (NIC) \
\ Cable cruzado CATS
=

Conecte el instrumento a la computadora con un cable cruzado LAN. Alternativamente, conecte la computadoray el
instrumento a un concentrador o interruptor independiente utilizando cables LAN normales.
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Asegurese de que su computadora esté configurada para obtener su direccion del DHCP y que el
NetBIOS sobre TCP/IP esté activado. Tenga en cuenta que si la computadora se ha conectado a una
red local LAN, puede que aun conserve los ajustes de red anteriores de la red local LAN. Espere un
minuto después de desconectarlo de la red local LAN antes de conectarlo a la red privada LAN. Esto
permite a Windows detectar que esta en una red diferente y reiniciar la configuracién de la red.

2. Los ajustes de la LAN del instrumento enviados de fabrica estan configurados para obtener automaticamente una
direccion IP de una red local utilizando un servidor DHCP. Puede dejar estos ajustes como estan. La mayoria de los
productos Keysight y la mayoria de las computadoras elegiran automaticamente una direccion IP usando auto-IP si
no hay un servidor DHCP. Cada uno se asigna a si mismo una direccion IP del bloque 169.254.nnn. Tenga en cuenta
que esto puede tardar hasta un minuto. Elindicador LAN del panel frontal se encendera cuando el puerto LAN se
haya configurado.

Desactivar el DHCP reduce el tiempo necesario para configurar completamente una conexién de red
cuando se enciende la fuente de alimentacion. Para configurar manualmente la configuracion de la LAN
del instrumento, consulte Configuracion de la interfaz remota para obtener informacion sobre cémo
configurar los ajustes de la LAN desde el panel frontal del instrumento.

3. Utilice la utilidad Connection Expert de Keysight 10 Libraries Suite para afiadir la fuente de alimentacion y verificar
una conexion. Para afiadir el instrumento, puede solicitar al Connection Expert que detecte el instrumento. Si no se
puede encontrar el instrumento, afiddalo usando su nombre de host o direccion IP.

Si esto no funciona, consulte las “Instrucciones para la resolucién de problemas” en la Guia de Conec-
tividad de Interfaces USB/LAN/GPIB de Keysight Technologies, incluida en la Keysight IO Libraries
Suite.

4. Ahora puede usar la ES interactiva dentro del Connection Expert para comunicarse con su instrumento, o puede pro-
gramar su instrumento mediante diversos entornos de programacion.

Configuracion de la interfaz remota

Elinstrumento admite la comunicacion de interfaz remota a través de dos interfaces: USB y LAN. Ambos estan
"activos" al momento de encenderse.

- Interfaz USB: Utiliza el puerto USB del panel posterior para comunicarse con su PC. No se requiere ninguna
opcidn de configuracion para la interfaz USB. Simplemente conecte el instrumento a su PC con un cable USB.

- Interfaz LAN: Utiliza el puerto LAN del panel posterior para comunicarse con su PC. De manera predeterminada,
el DHCP esté activado, lo que puede permitir la comunicacion a través de la LAN. El acrénimo DHCP significa
Protocolo de Configuracion Dinamica de Host, un protocolo para asignar direcciones IP dindmicas a los dispositivos
en red. Con el direccionamiento dindmico, un dispositivo puede tener una direccién IP diferente cada vez que se
conecta a la red.
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Se recomienda eliminar cualquier conexién de interfaz remota no utilizada.

Keysight IO Libraries Suite

Asegurese de que Keysight IO Libraries Suite esté instalado antes de continuar con la configuracion de la interfaz
remota.

Keysight 10 Libraries Suite es una coleccion de software de control de instrumentos gratuito que detecta
automaticamente los instrumentos y le permite controlarlos a través de interfaces LAN, USB, GPIB, RS-232 y otras.
Para mas informacion, o para descargar 10 Libraries, vaya a www.keysight.com/find/iosuite.

Configuracion de la LAN

Las siguientes secciones describen las funciones de configuracion de la LAN en el menu del panel frontal

Cuando se envia, el DHCP estéa activado, lo que puede permitir la comunicacion a través de la LAN. El acrénimo
DHCP significa Protocolo de Configuracion Dinamica de Host, un protocolo para asignar direcciones IP dinamicas a
los dispositivos en de una red. Con el direccionamiento dindmico, un dispositivo puede tener una direccion IP
diferente cada vez que se conecta a la red.

Algunas configuraciones de la LAN requieren que apague y encienda el instrumento para activarlas. El instrumento
muestra brevemente un mensaje cuando este es el caso, asi que observe la pantalla con atencién cuando cambie la
configuracion de la LAN.

Después de cambiar la configuracidn de la LAN, debe guardar los cambios. Presione Apply (Aplicar) para guardar la
configuracién. Si no guarda esta configuracion, al salir del mend Config E/S también se le pedird que presione Yes
(si) para guardar la configuracidn de la LAN o No (no) para salir sin guardarla. Si presiona Yes (si) se enciende y
apaga el instrumento y se activan los ajustes. La configuracién de la LAN no es volatil, no se modificara al encendery
apagar el instrumento ni si se restablecen los valores de fabrica (*RST). Si no quiere guardar los cambios, presione
No (No) para cancelar todos los cambios.

Vea la configuracién de la LAN

Presione [System] > I/0 Config (Sistema> Configuracién de E/S) para ver la configuracion de la LAN.

El estado de la LAN puede ser diferente de los ajustes del menu de configuracién del panel frontal, dependiendo de
la configuracion de la red. Si las configuraciones son diferentes, es porque la red ha asignado automaticamente sus
propias configuraciones.
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KEYSIGHT

TECHNOLOGIES

SN &AN

170 Config

1/0 Overview LAN Settings

Frequ Control Ports: USB, LAN ~5-

Ampli  USB
VISA Address: USBO0:10893:918:CN59217262::INSTR

LAN Reset

Offsel
LAN

Status:
IP:
Host name: Resolving

Phase

Domain name: Resolving

VISA address: TCPIP:K-33212A-00032:inst0:INSTR
TCPIP:K-33212A-00032::5025::SOCKET

mDNS hostname:
mDNS service:

Presione LAN Settings (Configuracién de LAN) para acceder al ment de configuracion de LAN. Consulte Cambiar la
configuracién de LAN para obtener méas detalles.

Presione LAN Reset (Restablecer LAN) para restaurar los ajustes de LAN a los valores predeterminados.

KEYSIGHT

SN &AN

I/0 Config

1/0 Overview

Frequ Control Ports: USB, LAN

Ampli  USB
VISA Address: USB0:10893:918:CN59217262:INSTR
Offsel

Are you sure you want to reset LAN settings and then restart LAN?

Phase
10.66.40.108

Host name: Resolving
Domain name: Resolving

VISA address: TCPIP:K-33212A-00032:inst0:INSTR .
TCPIP:K-33212A-00032::5025:S0CKET /

mDNS hostname:
mDNS service: Keysight EDU33211A Function Generator - MYO0000006

Modificar la configuracién de la LAN

Tal como se envia de fabrica, los ajustes preconfigurados del instrumento deberian funcionar en la mayorfa de los
entornos de la LAN. Consulte la seccion “Ajustes no volatiles” de la Guia de programacion para obtener informacion
sobre la configuracion de la LAN predeterminados de fabrica.
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1.

Acceda al menu Configuracion de LAN.
Presione la tecla de funcién LAN Settings (Configuracién de LAN).

KEYSIGHT
SIN ENN TECHNOLOGIES

LAN Settings Lan

MAC Address: 80-09-02-09-b9-e0 Services

Config Mode: Manual -
. DHCP: ON

Ampli Auto DNS: ON

mDNS:

Frequ

Offsel P

Subnet mask: 255.255.0. Host Mame
Phase Gateway:

DNS1:

DNS2:

Host name:
Domain name:
mDNS service:

SN &AN

LAN Settings

MAC Address: 80-09-02-09-b3-e0

Config Mode: Manual

DHCP: ON

Auto DNS: Auto DNS
mDNS: ON""OFF

IP:

Subnet mask:
Gateway:
DNS1:

DNS2:

mDNS
ON""OFF

mDNS Service
Host name:
Domain name: G t
mDNS service: - A tion Generator - MY00000006 / M

Con el DHCP activado, el DHCP (Dynamic Host Configuration Protocol o Protocolo de configuracion dindmica de
host) establecerd autométicamente una direccion IP cuando conecte el instrumento a la red, siempre se encuentre
el servidor DHCP y pueda hacerlo. EL DHCP también se ocupa automaticamente de la mascara de subred y la direc-
cion de la puerta de enlace, si es necesario. Esta suele ser la forma mas facil de establecer la comunicacion LAN
para su instrumento. Todo lo que tiene que hacer es dejar el DHCP encendido. Péngase en contacto con su admi-
nistrador de LAN para obtener mas detalles.
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2. Establecer una "Configuracion de IP".

Sino estd utilizando el DHCP (Use la tecla de funcién Services (Servicios) para configurar el DHCP en OFF (des-
conectado)) debe establecer una configuracién de IP, incluida una direccién IP, y posiblemente una méascara de
subred y una direccion de puerta de enlace.

SN &AN

Frequ

Ampli

Offsel

Phase

LAN Settings

MAC Address:

Config Mode:
DHCP:

Auto DNS:
mDNS:

IP:

Subnet mask:
Gateway:
DNS1:

DNS2:

Host name:
Domain name:
mDNS service:

KEYSIGHT
TECHNOLOGIES

la

80-09-02-09-b9-e0 DHCP

Manual -

OFF

ON Auto DNS
ON""OFF

mDNS
OM" " OFF

mDNS Service

Presione [Back] > Addresses > Modify ([Atrds] > Direcciones > Modificar) para configurar la direccion IP, la mascara
de subredy la direccién de la puerta de enlace.

SN &AN

Frequ

Ampli

Offsel

Phase

170 Config

1/0 Overview
Control Ports:

USB
VISA Address:

LAN
Status:
IP:
Host name:
Domain name:
VISA address:

mDNS hostname:
mDNS service:

® |P Address Modify

USB, LAN (b [P"Addre:

Previous
USB0:10893:918:CN59217262:INSTR

10.66.40.108
Resolving
Resolving

TCPIP:K-33212A-00032:inst0:INSTR
TCPIP:K-33212A-00032::5025::SOCKET

flo 66 1140 0108 stor - MYOOO000OG

Pdngase en contacto con el administrador de la red para obtener la direccion IP, la mascara de subred y la puerta de

enlace.

Direccién IP Todas las direcciones IP toman la forma de notacién de punto “nnn.nnn.nnn.nnn” donde “nnn” en cada
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caso es un valor de byte en el rango de 0 a 255. Puede introducir una nueva direccidn IP con lel teclado numérico
(no la perilla). Escriba los nimeros con el teclado y las teclas del cursor. Presione Previous o Next (Anterior o
Siguiente) para mover el cursor al campo siguiente o anterior. No escriba ceros iniciales.

Mascara de subred La division en subredes permite al administrador de la LAN subdividir una red para simplificar la
administracion y reducir el tréfico de la red. La mascara de subred indica la parte de la direccion de host utilizada
para indicar la subred. Escriba los nimeros con el teclado y las teclas del cursor. Presione Previous o Next (Anterior
o Siguiente) para mover el cursor al campo siguiente o anterior.

Puerta de entrada: Una puerta de enlace es un dispositivo de red que conecta redes. La configuracion pre-
determinada de la puerta de enlace es la direccion IP de dicho dispositivo. Escriba los nimeros con el teclado y las

teclas del cursor. Presione Previous o Next (Anterior o Siguiente) para mover el cursor al campo siguiente o anterior.

Presione Apply (Aplicar) para guardar los cambios.
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3. Configurar la "DNS Setup” (configuracién de DNS, opcional)

EL DNS (Servicio de nombres de dominio) es un servicio de Internet que transforma los nombres de dominio en direc-
ciones IP. Pregunte a su administrador de red si se usan ajustes de DNS. Si es asi, pregunte el nombre de host, el
nombre de dominio y la direccion del servidor DNS que debe usar.

Normalmente, DHCP detecta la informacion de la direccidon DNS. Solo necesita cambiar esto si DHCP no estd en
uso o no funciona. Para configurar manualmente el direccionamiento del instrumento, utilice la tecla de funcion Ser-
vices (Servicios) para poner Auto DNS (DNS automético) en OFF (Desactivado).

SN &AN

170 Config

1/0 Overview

Frequ Control Ports:

Ampli  USB
VISA Address:
Offsel
LAN

Status:
IP:
Host name:

Phase

Domain name:
VISA address:

mDNS hostname:
mDNS service:

USB, LAN

USB0:10893:918:CN59217262:INSTR

10.66.40.108
Resolving
Resolving

TCPIP:K-33212A-00032:inst0:INSTR
TCPIP:K-33212A-00032::5025::SOCKET

%

Keysight EDU33211A Function Generator - MYO0000006

KEYSIGHT

TECHNOLOGIES

Lan

DHCP
0N " OFF

Auto DNS
ON""OFF

mDNS
ON""OFF

mDNS Service

a. Configure el “hostname” (nombre de host). Presione [Back] >Host Name ([Atras] >Nombre del host) e introduzca
el nombre del host. El nombre de host es la parte de host del nombre de dominio, que se traduce en una direccidn
IP. El nombre del host se introduce como una cadena de caracteres con las teclas de funcidon. El nombre de host
puede incluir letras, nimeros y guiones (“-").
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KEYSIGHT
TECHNOLOGIES

SN &AN

170 Config

1/0 Overview

Frequ Control Ports: USB, LAN

Amp

Host Name Mext Char
[3-33212A-00032

Offs

Prev Char
Phas ABCDEFGHlJnLMNOPORSTUVWXYZ

Host name: Resolving Delete
Domain name: Resolving

VISA address: TCPIP:K-33212A-00032:inst0:INSTR .
TCPIP:K-33212A-00032::5025::SOCKET / Clear All
mDNS hostname:

mDNS service: Keysight EDU33211A Function Generator - MYO0000006
Apply

Elinstrumento se envia con un nombre de host predeterminado con el siguiente formato: K-{modelnumber-serial-
number, donde {modelnumber es el nimero de modelo de 6 caracteres del instrumento (por ejemplo, 33212A), y
serialnumber son los Ultimos cinco caracteres del nimero de serie del instrumento (por ejemplo, 45678 si el nimero
de serie es MY12345678).

b. Configure las direcciones del “DNS Server” (servidor de DNS). Presione Back (Atras). Presione Addresses > Modify
(Direcciones > Modificar) para configurar las direcciones del servidor DNS.

Introduzca el DNS primario (DNS1) y el segundo DNS (DNS2). Escriba los nimeros con el teclado y las teclas del cur-
sor. Presione Previous o Next (Anterior o Siguiente) para mover el cursor al campo siguiente o anterior. Consulte con
su administrador de red para obtener mas detalles.

KEYSI
TECHNOLO

SN &AN

I/0 Config Lan £

1/0 Overview Modify
Control Ports: USB, LAN DNST

UsSB
VISA Address: USB0:10893:918:CN58217262::INSTR

Previous

LAN
Status:
IP: 23.66.40.108
Host name: Resolving

Domain name: Resolving

VISA address: TCPIP::K-33212A-00032:inst0:INSTR
TCPIP:K-33212A-00032::5025:S0CKET

mDNS hostname:
mDNS service: 61 1183 1140 0100 stor - MYO0000006
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4. Configurar el servicio mDNS (opcional).

Su instrumento recibe un nombre de servicio mDNS Unico en la fabrica, pero puede cambiarlo. El nombre del ser-
vicio mDNS debe ser unico en la LAN.

Para configurar manualmente el nombre de servicio del instrumento, use la tecla de funcién Services (Servicios)
para poner mDNS en (Activado).

KEYSIGHT
TECHNOLOGIES

SN &AN

170 Config

1/0 Overview \
Control Ports: USB, LAN ON""OFF

Frequ

Ampli  USB Auto DNS
VISA Address: USB0:10893:918:CN59217262:INSTR ON™"0FF
Offsel
LAN mDNS
Status: 0K OFF
IP: 10.66.40.108
Host name: Resolving mDNSService

Phase

Domain name: Resolving

VISA address: TCPIP:K-33212A-00032:inst0:INSTR
TCPIP:K-33212A-00032::5025::SOCKET

mDNS hostname:
mDNS service: Keysight EDU33211A Function Generator - MYO0000006

Presione mDNS Service (Servicio mDNS).

SN &AN

170 Config

1/0 Overview

Frequ Control Ports: USB, LAN

sl mDns Service Name Mext Char

Offs meysight EDU33211A Function Generator - MY00000006

Prev Char

Phas ABCDEFGH I JLMNOPORS TUVWX YZ

Host name: Resolving Delete

Domain name: Resolving

VISA address: TCPIP:K-33212A-00032:inst0:INSTR .
TCPIP:K-33212A-00032::5025::SOCKET / Clear All

mDNS hostname:

mDNS service: Keysight EDU33211A Function Generator - MYO0000006
Apply

Utilice las teclas de funcidn que se proporcionan para establecer un nombre de servicio deseado. El nombre debe
comenzar con una letra, los demds caracteres pueden ser mayusculas o mintsculas, digitos numéricos o guiones ("-
"). Presione Apply (Aplicar) para guardar los cambios.
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Servicios de socket SCPI

Este instrumento permite realizar cualquier combinacion de hasta dos sockets de datos, socket de controly
conexiones telnet simultaneas.

Los instrumentos Keysight se han estandarizado en el uso del puerto 5025 para los servicios de socket SCPI. Un
socket de datos en este puerto se puede usar para enviar y recibir comandos ASCII/SCPI, consultas y respuestas a
consultas. Todos los comandos deben ser terminados con una nueva linea para que el mensaje sea analizado. Todas
las respuestas a las consultas se terminardn también con una nueva linea.

La interfaz de programacion de socket también permite una conexién de socket de control. Un cliente puede utilizar
el socket de control para enviar un mensaje "Device Clear" y para recibir solicitudes de servicio. A diferencia del
socket de datos, que utiliza un nimero de puerto fijo, el nimero de puerto de un socket de control varia y debe
obtenerse enviando la siguiente consulta SCPI al socket de datos: SYSTem:COMMunicate:TCPip:CONTrol?

Después de obtener el nimero de puerto, se puede abrir una conexién de socket de control. Aligual que con el
socket de datos, todos los comandos del socket de control deben terminarse con una nueva linea, y todas las
respuestas de consulta que se devuelvan en el socket de control terminaran con una nueva linea.

Para enviar un mensaje “Device clear”, envia la cadena "DCL" al socket de control. Cuando el sistema de
alimentacion termina de despejar el dispositivo, devuelve la cadena "DCL" al socket de control.

Las solicitudes de servicio se habilitan para el socket de control mediante el registro Service Request Enable
(Habilitar solicitudes de servicio). Una vez activadas las solicitudes de servicio, el programa cliente escucha a la
conexion de control. Cuando el SRQ se cumpla, el instrumento enviaré la cadena "SRQ +nn" al cliente. EL "nn" es el
valor del byte de estado, que el cliente puede utilizar para determinar la fuente de la solicitud de servicio.

Mas informacion sobre direcciones IP y notacion de puntos

Las direcciones de notacién de puntos (“nnn.nnn.nnn.nnn” donde “nnn” es un valor de byte de 0 a 255) deben
expresarse con cuidado, ya que la mayorfa del software web de las PC interpreta los valores de bytes con ceros
iniciales como numeros octales (de base 8). Por ejemplo, “192.168.020.011” es en realidad equivalente al decimal
“192.168.16.9” debido a que “.020” se interpreta como “16” expresado en octal, y “.011” como “9”. Para evitar
confusiones, use solo valores decimales de O a 255, sin ceros iniciales.
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Control remoto

Puede controlar el instrumento a través de SCPI mediante la Keysight |10 Libraries o a través de un panel frontal
simulado con la interfaz web del instrumento.

Interfaz web

Puede monitoreary controlar el instrumento desde un navegador Web mediante la interfaz Web del instrumento.

Para conectarse, simplemente introduzca la direccion IP o el nombre de host del instrumento en la barra de
direcciones de su navegador y presione Intro.

Si ve un error que indica 400:Bad Request (Solicitud Incorrecta), esto se relaciona con un problema con las
"cookies" en su navegador web.Para evitar este problema, inicie la interfaz web utilizando la direccién IP (no el nom-

bre del host) en la barra de direcciones), o borre las cookies de su navegador inmediatamente antes de iniciar la
interfaz web.

,W KEYSIGHT EDU33212A Arbitrary Waveform Generator

Login £
TECHNOLOGIES  serial number: CN60350047

Home Control Instrument Configure LAN (-]

Connected to EDU33212A Arbitrary Waveform Generator
at IP address 192.168.1.2

Description
Model number EDU33212A
Manufacturer
Serial number CN60350047

Firmware revision K-01.03.94-01.00-01.04-01.00-01.00-2020010101

Description

VISA instrument addresses

VXI-11 LAN protocol TCPIP::1192.168.1.2:inst0:INSTR

TCP/IP SOCKET protocol TCPIP::192.168.1.2::5025::SOCKET

USB (USBTMC/488) USB::0x2A8D::0x8D01::CN60350047::0::INSTR
GPIB N/A

v More Information

© Keysight Technologies 2021 = Support = Product = Keysight

La pestafia Configurar la LAN en la parte superior le permite cambiar los pardmetros de la LAN del instrumento;
tenga cuidado al hacerlo, ya que puede interrumpir su capacidad de comunicacion con el instrumento.

Cuando haga clic en la pestafia Instrumento de control, el instrumento le pedird una contrasefia (de forma
predeterminada es keysight), y luego abrird una nueva pagina, que se muestra a continuacion.
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M, KEYSIGHT EDU33212A Arbitrary Waveform Generator
TECHNOLOGIES  sar

Log out £
ial number: CN60350047

Home Control Instrument Configure LAN o

Control Instrument > Soft Front Panel

Warning: Should network communication issues occur, the reported readings and instrument configuration settings shown in
A the Soft Front Panel may not represent tr
Soft Front Panel to determine if a circuit that r
Note: Please allow some time for the page to be rel

Frequency 1.000,000,000 kHz
Amplitude 100.0 mVpp S
Offset +0.000 V

Ramp

Phase 0.000°

Pulse

Arb

annel 1 nnel 2

Ch Chai
P]IHFE E\  onvor | E‘ onor |

© Keysight Technologies 2021 Support  Product  Keysight

Esta interfaz le permite usar el instrumento como si fuera el panel frontal. Fijese en las teclas de flechas curvas que
le permiten "girar" la perilla. Puede presionar las teclas de flecha para girar la perilla hacia la derecha o viceversa,
igual que si presionara cualquiera de las otras teclas del panel frontal.

LEER ADVERTENCIA
Asegurese de leer y comprender la advertencia en la parte superior de la pdgina del Instrumento de Control.

Detalles técnicos de la conexion

En la mayoria de los casos, puede conectarse facilmente al instrumento con |0 Libraries Suite o la interfaz web. En
ciertas circunstancias, puede ser Util conocer la siguiente informacion.

VXI-11 LAN Cadena VISA: TCPIPO::<IP Address>::inst0::INSTR
Ejemplo: TCPIP0::192.168.10.2::inst0::INSTR

Ul de laweb Puerto nimero 80, URL http://<IP address>/

USB USBO::0x2A8D::<Prod ID>::<Serial Number>::0::INSTR

Ejemplo: USBQ::0x2A8D::0x8D01::CN12340005::0::INSTR

ID del vendedor: Ox2A8D, el ID del producto es 0x8D01, y el nimero de serie del ins-
trumento es CN12340005.

La identificacion del producto varfa segun el modelo: 0x08C01 (EDU33211A) / 0x8D01
(EDU33212A).
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3 Operaciones del menu del panel fron-
tal

Seleccionar una terminacion de salida
Restablecer el instrumento

Emitir una forma de onda modulada

Emitir una forma de onda FSK

Emitir una forma de onda PWM

Emitir un barrido de frecuencia

Emitir una forma de onda de rafaga

Disparar un barrido o rafaga

Almacenar o recuperar el estado del instrumento
Referencia del menu del panel frontal

Esta seccion presenta las teclas y menus del panel frontal. Consulte
Funciones y operaciones para obtener informacion adicional sobre el
funcionamiento del panel frontal.
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Seleccionar una terminacion de salida

Elinstrumento tiene una impedancia de salida en serie fija de 50 Q a los conectores de canal del panel frontal. Si la

impedancia de carga real difiere del valor especificado, los niveles de amplitud y compensacion mostrados seran
incorrectos. El ajuste de la impedancia de carga es simplemente una conveniencia para asegurar que la tension

mostrada coincida con la carga esperada.

1. Pulse una tecla [Setup]([Configuracién]) de canal para abrir la pantalla de configuracién de canal. Observe que los
valores actuales de terminacion de salida (ambos 50 Q en este caso) aparecen en las pestafias de la parte superior

de la pantalla.

Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

KEYSIGHT

TECHNOLOGIES

Output
~-

Range
Suto Hold

Polarity
Mormal  Inverted

Voltage Limits
~5-

Mode
Mormal  Gated

2. Empiece a especificar la terminacién de la salida pulsando Output (Salida).

Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpr

CH 1 Output Load
Offset +0.000V

50Q

Phase 0.0°

Guia del usuario de la serie Keysight EDU33210
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TECHNOLOGIES

Set To
50 Ohm

Set To
High Z

Load
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3. Seleccione la terminacidn de salida deseada utilizando la perilla o el teclado numérico para seleccionar la impe-
dancia de carga deseada o pulsando Set to 50 Q o Set to High Z. (Establecer a 50 Q o Establecer a High Z). Tam-
bién puede establecer un valor especifico pulsando Load (Cargar).

KEYSIGHT

TECHNOLOGIES

SetT
Frequency 1.000,000,000 kHz 50 O

Amplitude 100.0 mVpn Set To

CH 1 Output Load High Z
Offset +0.000V
Load

Phase 0.0° High-Z

Restablecer el instrumento

Para restablecer el instrumento a su estado predeterminado de fébrica, presione [System] > Store/Recall > Set to
Defaults > Yes ([Sistema] > Almacenar/Recuperar > Restaurar configuracién a los valores predeterminados > Si).
Consulte "Estado de reinicio de fabrica" en la Guia de programacion de la serie EDU33270 para obtener méas
detalles.

Frequency 1.000,000,000 kHz
Amplitude 100.0 mVpp

Offset Y i

Return the instrument to its 'Factory Default’ state?
Phase 0.0
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Emitir una forma de onda modulada

Una forma de onda modulada consta de una forma de onda transportadora y una forma de onda de modulacién. En
AM (modulacién de la amplitud), la amplitud de la transportadora varfa segun la forma de onda moduladora. Para
este ejemplo, emitird una forma de onda AM con una profundidad de modulacion del 80 %. La transportadora sera
una onda sinusoidal de 5 kHz y la forma de onda moduladora sera una onda sinusoidal de 200 Hz.

. Seleccione la funcidn, la frecuencia y la amplitud de la transportadora.

Pulse [Waveform] > Sine ([Forma de onda] > Sinusoidal). Presione las teclas defuncién Frequency, Amplitude y
Offset (Frecuencia, Amplitud y Compensacién) para configurar la forma de onda de la transportadora. Para este
ejemplo, seleccione una onda sinusoidal de 5 kHz con una amplitud de 5 Vpp, con una compensacion de 0 V. Tenga
en cuenta que puede especificar la amplitud en Vpp, Vrms o dBm.

Frequency 5.000,000,000 kHz Frequency

Amplitude 5.000 Vpp Amplitude

Offset +0.000V
Dffset
Phase 0.0°

Phase
~-
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2. Seleccione AM.

Presione [Modulate] ([Modular]) y luego seleccione AM con la tecla de funcién Type (Tipo). Luego presione la tecla
de funcién Modulate (Modular) para activar (ON) la modulacion.

KEYSIGHT
TECHNOLOGIES

SIN,HiZ
AM Modulated by Sine

— Oy Modulat
Frequency 5.000,000,000 kHz AM Depth  100.00% N OFF

Amplitude  5.000 Vpp ., AM Freq 100.000,000 Hz

Type
A
Offset +0.000V
AM
Phase 0.0° i
AM
Freq

Shape

Sine

WMORE
142

3. Establezca la profundidad de modulacién. Presione la tecla de funcion AM Depth (Profundidad AM) y luego ajuste el
valor a 80 % usando el teclado numérico o la perilla y las flechas.

KEYSIGHT
TECHNOLOGIES

SIN,HiZ
AM Modulated by Sine

] Percent
AM Depth  80_

Frequency 5.000,000,000 kHz

Amplitude  5.000 Vpp ., AM Freq 100.000,000 Hz

Offset +0.000V

Phase 0.0°

4. Seleccione la forma de forma de onda modulante. Presione Shape (Forma) para seleccionar la forma de onda modu-
ladora. Para este ejemplo, seleccione una onda Sine (Sinusoidal).
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5. Presione AM Freq. Ajuste el valor a 200 Hz con el teclado numérico o la perilla y las flechas. Pulse Hz para terminar
de introducir el nimero si esta usando el teclado numérico.

KEYSIGHT
TECHNOLOGIES

SIN,HiZ
AM Modulated by Sine

Frequency 5.000,000,000 kHz AM Depth  80.00 % ‘

Amplitude 5.000 Vpp AM Freq 200_

Offset +0.000V

Phase 0.0°

Emitir una forma de onda FSK

Puede configurar el instrumento para que su frecuencia de salida "cambie" entre dos valores preestablecidos
(denominados "frecuencia transportadora" y "frecuencia de salto") utilizando la modulacién FSK. La velocidad a la
gue la salida cambia entre estas dos frecuencias la determina el generador de velocidad interna o el nivel de la sefial
en el conector de disparo Ext Trig del panel frontal. Para este ejemplo, se establece la frecuencia "transportadora”
en b kHz y la frecuencia de "salto" en 500 Hz, con una tasa de FSK de 100 Hz.
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1. Seleccione la funcidn, la frecuencia y la amplitud de la transportadora.

Pulse [Waveform] > Sine ([Forma de onda] > Sinusoidal). Presione las teclas defuncién Frequency, Amplitude y
Offset (Frecuencia, Amplitud y Compensacién) para configurar la forma de onda de la transportadora. Para este
ejemplo, seleccione una onda sinusoidal de 5 kHz con una amplitud de 5 Vpp, con una compensacion de O V.

Frequency 5.000,000,000 kHz

Amplitude  5.000 Vpp

Offset

Phase

+0.000 V

0.0°

2. Seleccione FSK.

KEYSIGHT
TECHNOLOGIES

Parameter

Frequency

Amplitude

Dffset

Phase
~-

Presione [Modulate] ((Modular]) y luego seleccione FSK con la tecla de funcién Type (Tipo). Luego presione la tecla

de funcién Modulate (Modular) para activar (ON) la modulacién.

SIN,500Q

FSK Modulated

Frequency 5.000,000,000 kHz

Amplitude  5.000 Vpp

Offset

Phase

60

+0.000V

0.0°

Hop Freq
FSK Rate

100.000,000 Hz

0.000,000 Hz

KEYSIGHT

TECHNOLOGIES
Modulate
ON""OFF

Type
FSk

Hop
Freq

Fsk
Rate

Source

Internal
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3. Configure la frecuencia de "salto".

Presione la tecla de funcién Hop Freq (Frec de salto) y luego ajuste el valor a 500 Hz usando el teclado numérico o la
perillay las flechas. Si utiliza el teclado numérico, asegurese de terminar la entrada pulsando Hz.

KEYSIGHT
TECHNOLOGIES

SIN,50Q
FSK Modulated

— Oy Modulate
Hop Freq  [§00.000000 Hz 0N OFF

Amplitude 5.000 Vpp FSK Rate  0.000,000 Hz

Frequency 5.000,000,000 kHz

Type

FSk

Offset +0.000V

Hop

Phase 0.0° i
Fsk
Rate

Source

Internal

4. Configure la velocidad de “cambio” FSK.

Presione la tecla de funcién Fsk Rate (Tasa Fsk) y luego ajuste el valor a 100 Hz usando el teclado numérico o la peri-
llay las flechas.

KEYSIGHT
SIN,500Q ECHNOLOGIES

FSK Modulated , -
Modulation

— Oy Modulate
Hop Freq 500.000,000 Hz ON™ " OFF

Amplitude 5,000 Vpp | FSK Rate [00.000000 Hz

Frequency 5.000,000,000 kHz

Type
FSk

Offset +0.000V

Hop
Freq

Phase 0.0°

Fsk
Rate

Source
Internal

En este punto, el instrumento genera una forma de onda FSK si la salida del canal est4 habilitada.
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Emitir una forma de onda PWM

Puede configurar el instrumento para que emita una forma de onda de amplitud de pulso modulado (PWM). PWM
solo estéa disponible para la forma de onda de pulso, y la amplitud de pulso varfa segun la sefial de modulacion. La
cantidad en que varia la amplitud de pulso se denomina desviacién de amplitud, y puede especificarse como un
porcentaje del periodo de la forma de onda (es decir, el ciclo de trabajo) o en unidades de tiempo. Por ejemplo, si se
especifica un pulso con un 20 % de ciclo de trabajo y luego se activa PWM con un 5 % de desviacidn, el ciclo de
trabajo varia entre el 15 % y el 25 % bajo el control de la sefial moduladora.

Para cambiar la amplitud de pulso a un ciclo de trabajo de pulso, pulse [Units] ((Unidades]).

Para este ejemplo, se especificard una amplitud de pulso y una desviacion de la amplitud de pulso para una forma
de onda de pulso de T kHz con una forma de onda sinusoidal moduladora de b Hz.

. Seleccione los parametros de la forma de onda transportadora.

Pulse [Waveform] > Pulse ([Forma de onda] > Pulso). Utilice las teclas de funcién Frequency, Amplitude, Offset,
Pulse Width y Edge Times (frecuencia, amplitud, compensacién, amplitud de pulso y tiempos de borde) para con-
figurar la forma de onda transportadora. Para este ejemplo, seleccione una forma de onda de pulso de 1 kHz con
una amplitud de 1 Vpp, compensacion cero, un ancho de pulso de 100 msy un tiempo de borde de 50 ns (tanto de
entrada como de salida).

KEYSIGHT
TECHNOLOGIES

Parameter

Frequency 1.000,000,000 kHz Frequency

Amplitude 1.000 Vpp Amplitude

Offset +0.000V

Phase 0.0°
Pulse Width 100.000,000,0 ms
Edge Time 50.0ns

~»-

Pulse
Width

Edge
~5-
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2. Seleccione PWM.

Pulse [Modulate] > Type PWM. [Modular] > Tipo PWM. Luego presione la tecla de funcién Modulate (Modular) para

activar (ON) la modulacion.

PULS,50Q
PWM Modulated by Sine

Frequency 1.000,000,000 kHz
Amplitude 1.000 Vpp

Offset +0.000V

Phase 0.0°
Pulse Width 100.000,000,0 ms
Edge Time 50.0ns

KEYSIGHT
TECHNOLOGIES

Modulation

PP, . S— Modhlate
PWM Dev  0.000,000,000 s ’ O "OFF

PWM Freq 10.000,000 Hz

Type
P

Source

Internal

3. Establezca la desviacion de la amplitud.

Presione la tecla de funcion PWM Dev (Desviacionde PWM) y luego ajuste el valor a 20 us usando el teclado numé-

rico o la perilla y las flechas.

4. Establezca la frecuencia de modulacion.

Presione la tecla de funciéon PWM Freq (Frec. PWM) y luego ajuste el valor a 5 Hz usando el teclado numérico o la

perillay las flechas.
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5. Seleccione la forma de forma de onda modulante.

Presione Shape (Forma) para seleccionar la forma de onda moduladora. Para este ejemplo, seleccione una onda
sinusoidal.

KEYSIGHT
PULS,50Q ECHNOLOGIES
PWM Modulated by Sine

— Iy Modulate
PWM Dev  20.000,0 ps ’ ORTOFF

Amplitude 1.000 Vpp | PwM Freq 000000 Hz

Frequency 1.000,000,000 kHz

Type
P

Offset +0.000V
Phase 0.0°

Pulse Width 100.000,000,0 ms
Edge Time 50.0ns

Source

Internal

Para ver la forma de onda PWM real, necesita dirigirla a un osciloscopio. Al hacerlo, verd como la amplitud de pulso
varia, en este caso, de 80 a 120 ps. A una frecuencia de modulacion de 5 Hz, la desviacidn es facilmente visible.

Emitir un barrido de frecuencia

En el modo de barrido de frecuencia, el instrumento se mueve de la frecuencia de inicio a la de detencidn a la
velocidad de barrido que usted especifique. Puede barrer la frecuencia hacia arriba o hacia abajo y con espaciado
lineal o logaritmico o usando una lista de frecuencias. Para este ejemplo, se emitira una onda sinusoidal barrida de
50 Hz a b kHz.
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1. Seleccione la funcién y la amplitud para el barrido.

Para los barridos, puede seleccionar formas de onda sinusoidales, cuadradas, de rampa, de pulso, triangulares,

PRBS, o formas de onda arbitrarias (no se permiten el ruido ni la CC). Para este ejemplo, seleccione una onda sinu-

soidal con una amplitud de 5 Vpp.

Frequency 1.000,000,000 kHz

Amplitude  5.000 Vpp

Offset +0.000V

Phase 0.0°

2. Seleccione el modo de barrido.

KEYSIGHT
TECHNOLOGIES

Parameter

Frequency

Amplitude

Dffset

Phase
~-

Presione [Sweep] ([Barrido]) y verifique que el modo de barrido lineal esté actualmente seleccionado en la segunda
tecla de funcién. Presione la tecla de funcién de [Sweep] (Barrido) para activar (ON) el barrido. Tenga en cuenta en
el mensaje de estado del Linear Sweep (Barrido lineal) en la parte superior de la pestafia del canal actual. El botén

también estd iluminado.

SIN,50Q

Linear Sweep, Trig Imm

Frequency Sweeping...
Amplitude  5.000 Vpp

Offset +0.000V

Phase 0.0°

KEYSIGHT

TECHNOLOGIES

Sweep

Sweep

Start Freq  100.000,000 Hz OR""OFF
Stop Freq  1.000,000,000 kHz Type
Sweep Time 1.000 s Linear

Hold Time 0.000s
Sweep

Return Time 0.000 s Time

Start
Freq

Stop
Freq

Hold Return
~-
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3. Configure la frecuencia de inicio.

Pulse Start Freq (Fec. de inicio) y luego ajuste el valor a 50 Hz con el teclado numérico o la perilla y las flechas.

66 Guia del usuario de la serie Keysight EDU33210



4. Ajuste la frecuencia de detencion).

Pulse Stop Freq (Frec. de detencidn) y ajuste el valor a 5 kHz con el teclado numérico o la perilla y las flechas.

KEYSIGHT
SIN.500 A

Linear Sweep, Trig Imm

_ — T Sweep
Frequency - Sweeping... Start Freq  50.000,000 Hz -

Amplitude 5,000 Vpp Stop Freq  [§000.000000 Hz -
Sweep Time 1.000 s Linear

Hold Time 0.000s
Sweep
Return Time 0.000 s Time

Offset +0.000V

Phase 0.0°

Start
Freq

Stop
Freq

Hold Return
~-

En este punto, el instrumento produce un barrido continuo de 50 Hz a b kHz si la salida estd habilitada.

También puede establecer los limites de la frecuencia de barrido del barrido utilizando una frecuencia central y un
intervalo de frecuencia. Estos pardmetros son similares a la frecuencia de inicio y de parada (arriba) y proporcionan
una mayor flexibilidad. Para obtener el mismo resultado, configure la frecuencia central a 2.525 kHz y la amplitud de
frecuencia a 4.950 kHz.

Para generar un barrido de frecuencia, pulse [Trigger] > Source Manual ([Disparo] > Origen Manual) para que el dis-
paro quede en modo manual. Presione [Trigger] [Disparo] para enviar un disparo. Para obtener mds informacion,
consulte Disparar un barrido o rafaga.

KEYSIGHT
SIN.500 VY Temowses.

Linear Sweep, Trig Man Trigaer
- Source
Frequency ~Sweeping... Start Freq  50.000,000 Hz ——
Amplitude 5.000 VPP Stop Freq 5.000,000,000 kHz Trigger Setup
Sweep Time 1.000 s -

Offset +0.000V e 0.000s

; . o Trig Out Setup
anual Irigger for me 0.000 s he

Phase 0.0°

Sync
| ’ ' o 0FF
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Emitir una forma de onda de rafaga

Puede configurar el instrumento para que emita una forma de onda con un nimero determinado de ciclos, llamado
rafaga. Puede controlar la cantidad de tiempo que transcurre entre las rafagas con el temporizador interno o el nivel
de sefial en el conector Ext Trig del panel frontal. Para este ejemplo, emitird una onda sinusoidal de tres ciclos con
un periodo de rafaga de 20 ms.

. Seleccione la funcién y la amplitud de la rafaga.

Para las formas de onda de réfaga, puede seleccionar sinusoidal, cuadrada, de rampa, de pulso, formas de onda arbi-
trarias, triangulares o PRBS. El ruido solo se permite en el modo de rafaga "cerrada" y no se permite el CC. Para este
ejemplo, seleccione una onda sinusoidal con una amplitud de 5 Vpp.

KEYSIGHT
TECHNOLOGIES

Parameter

Frequency 1.000,000,000 kHz Frequency

amplitude 000000 Vpp Amplitude

Offset +0.000V
Dffset
Phase 0.0°

Phase
~-
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2. Seleccione el modo de rafaga.

Presione [Burst] > Burst ON | OFF ([Réfaga] > Réfaga Activada | Desactivada).

KEYSIGHT
ECHNOLOGIES
SIN,500 -

N-Cycle Burst, Trig Imm -
— sy B
Start Phase 0.0° R OFF

Amplitude 5.000 Vpp # of Cycles 1

Frequency 1.000,000,000 kHz

» NCycle

Burst Period 10 ms Gated

Offset +0.000V
» 3 Cycles
Phase 0.0° Infinite

Start Phase

i of Cycles

Burst Period

3. Establece el conteo de rafagas.

Presione # of Cycles (N.° de Ciclos) y establezca el conteo en "3" usando el teclado numérico o la perilla. Pulse Enter
(Intro) para finalizar la entrada de datos si utiliza el teclado numérico.

!(E‘YS!GHrT
ECHNOLOGIES
SIN,500Q

N-Cycle Burst, Trig Imm
Start Phase 0.0°

Amplitude 5.000 Vpp #of Cycles 3_
Burst Period 10 ms

Frequency 1.000,000,000 kHz

Offset +0.000V

Phase 0.0°
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4. Establezca el periodo de rafaga.

Pulse Burst Period (Periodo de rafaga) y establezca el periodo en 20 ms mediante el teclado numérico o la perilla y
las flechas. El periodo de rafaga establece el tiempo desde el comienzo de una rafaga hasta el comienzo de la
siguiente rafaga. En este punto, el instrumento emite una rafaga continua de tres ciclos a intervalos de 20 ms.

SIN,50Q
N-Cycle Burst, Trig Imm

Frequency 1.000,000,000 kHz
Amplitude  5.000 Vpp

Offset +0.000V

Phase 0.0°

KEYSIGHT
TECH OGIES

Start Phase 0.0°

# of Cycles 3
Burst Period 20_

seconds

Puede generar una sola réfaga (con el recuento especificado) pulsando la tecla [Trigger] ([Disparo]). Para obtener
mas informaciodn, consulte Disparar un barrido o rafaga.

SIN,50Q
N-Cycle Burst, Trig Man

Frequency 1.000,000,000 kHz
Amplitude  5.000 Vpp

Offset +0.000V

Manual Trigger for CH1

Phase 0.0°

KEYSIGHT

TECHNOLOGIES

Trigger

Source

Start Phase 0.0° Manual

# of Cycles 3 Trigger Setup

Burst Period 20 ms -

Trig Out Setup
~9-

Sync
ON"" OFF

También se puede utilizar la sefial de la puerta externa para crear rafagas cerradas, donde se produce una rafaga
mientras una sefial de puerta estd presente en la entrada.
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Disparar un barrido o rafaga
Puedes seleccionar uno de los cuatro tipos diferentes de disparos del panel frontal para los barridos y las réafagas:

- Inmediato o "automatico" (predeterminado): el instrumento emite de forma continua cuando se selecciona el
modo de barrido o de rafaga.

- Externo: disparo controlado por el conector Ext Trig del panel frontal.

- Manual: Inicia un barrido o ré&faga cada vez que presiona [Trigger] ([Disparo]). Continte presionando [Trigger]
([Disparo]) para volver a activar el instrumento.

- Temporizador: emite uno o mas disparos en una cantidad de tiempo fija aparte.

KEYSIGHT
TECHNOLOGIES

SIN,50Q

N-Cycle Burst, Trig Man

Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpp

—EEE—————— In
Start Phase 0.0°

# of Cycles 1

Burst Period 10 ms Timer

Trigger

Source
Manual

Trigger Setup

-

Offset +0.000V

Trig Out Setup

Phase 0.0° -
Sync

ON " OFF

Si el barrido o la réfaga estan activados, al pulsar [Trigger] ([Disparo]) aparece el menu de disparo. Una tecla
iluminada de [Trigger] ([Disparo]) (sélida o parpadeante) indica que uno o ambos canales estan esperando un
disparo manual. La iluminacién sélida se produce cuando se selecciona el menu de disparo, y la iluminacién
intermitente se produce cuando no se lo selecciona. La tecla [Trigger] ([Disparo]) se desactiva cuando el
instrumento estd en el control remoto.

Si presiona [Trigger] ([Disparo]) cuando esté iluminado se ejecuta un disparo manual. Si presiona [Trigger]
([Disparo]) mientras parpadea, se selecciona el menu de disparo; una segunda pulsacién provoca un disparo
manual.

Almacenar o recuperar el estado del instrumento

Puede almacenar los estados de los instrumentos en cualquier nimero de archivos de estado, (extension .sta).
Puede hacer esto como copia de seguridad, o puede guardar el estado en una memoria USB externa y cargarla en
otro instrumento para tener instrumentos con configuraciones adecuadas. Un estado almacenado contiene la
funcién seleccionada, la frecuencia, la amplitud, la desviacion de CC, el ciclo de trabajo, la simetria y cualquier
pardmetro de modulacion o rafaga en uso. El instrumento no almacena formas de onda arbitrarias volatiles.
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Almacenar ajustes

La opcion Store Settings (Almacenar ajustes) le permite navegar hasta un directorio y especificar un nombre de
archivo, y elegir si desea almacenar un archivo de estado de forma interna o en una unidad flash USB externa.

KEYSIGHT

TECHNOLOGIES

Destination
[nt " Ext

Frequency 1.0NN NNN NNN LLI-

Store Settings
Amplitude 10 Store In

Store Destination: Internal State
Offset +0
Store in: State 0

Phase 0.C

Para almacenar (guardar) el estado actual del instrumento:
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seleccione el destino de almacenamiento deseado.

Presione [System] > Store/Recall > Store Settings > Destination ([Sistema] > Almacenar/Recuperar > Configuracién

de almacenamiento > Destino).

SIN,50Q
N-Cycle Burst, Trig Imm

Frequency 1.0NN NNN NNN LLI-

Store Settings
Amplitude 5.(

Store Destination:

Offset +0

Store in:

Phase 0.C

KEYSIGHT

TECHNOLOGIES

Destination
[nt " Ext

Store In
Internal State'l

State 0

Si elige almacenar el estado del instrumento en la memoria interna no volatil del instrumento, seleccione Int. Pro-

ceda al paso 2.

Si elige almacenar el archivo de estado (.sta) en una unidad flash USB externa conectada, seleccione Ext. Proceda al

paso 3.

Asegurese de conectar una unidad flash USB antes de proceder. Si no conecté una unidad flash USB,
los menus en Destination Int | Ext (Destino Int | Ext) estardn en gris.
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2. Seleccione el lugar de almacenamiento interno deseado para guardar el estado del instrumento.

Presione Store In (Almacenar en), y seleccione entre el Estado 0, el Estado 1, el Estado 2, el Estado 3 o el Estado 4.
Proceda al paso b.

KEYSIGHT
TECHNOLOGIES
SIN,50Q
N-Cycle Burst, Trig Imm -

Destination
[nt " Ext

Frequency 1.0NN NNN NNN LLI-

Store Settings
Amplitude 5.( Store In

Store Destination: Internal ) State 0
Offset +0
Store in: State 0

Phase 0.C

3. Seleccione la ubicacién de almacenamiento externo deseada para guardar el archivo de estado (.sta) en.

Presione Select File | Path > Browse (Seleccionar archivo | Ruta > Examinar) para buscar los archivos de estado exis-
tentes (.sta) en la unidad flash USB externa conectada. Use la perilla del panel frontal para resaltar un archivo de
estado existente (.sta). Pulse Select (Select) para seleccionar el archivo resaltado y volver al menu anterior.

También puede pulsar Rename (Renombrar) para cambiar el nombre del archivo resaltado o pulsar Delete (Eliminar)
para eliminar el archivo resaltado.

Pulse Select File | Path > Browse (Seleccionar archivo | Ruta > Examinar) para buscar carpetas en la unidad flash
USB externa para almacenar el archivo de estado (.sta). Utilice la perilla del panel frontal para resaltar una carpeta.
Presione Select (Seleccionar) para explorar la carpeta resaltada. Pulse Select Folder (Seleccionar carpeta) para
seleccionar la carpeta resaltada y volver al menu anterior.

También puede pulsar Rename (Renombrar) para cambiar el nombre de la carpeta resaltada o pulsar Delete (Eli-
minar) para eliminar la carpeta resaltada.
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4. Opcional: Sino lo ha hecho en el paso anterior, puede cambiar el nombre del archivo de estado.

Presione File Name (Nombre de archivo) para especificar el nombre del archivo de estado (.sta). Utilice las teclas de
funcion proporcionadas para establecer un nombre de archivo deseado.

KEYSIGHT

TECHNOLOGIES

Char Set

Uppercase

Frequency 1.0NN NNN NNN LLI-

Store Settinas
Amp

File Name Mext Char
State_20201205173300

Offs

Prev Char
Phas _ABCDEFGHIJKLMNOPORBTUVWXVZ

Clear &ll

Apply

Pulse Apply (Aplicar) cuando haya terminado de introducir el nombre.
5. Se almacena el estado del instrumento.
Presione Store (Almacenar).

KEYSIGHT
TECHNOLOGIES

SIN,50Q
N-Cycle Burst, Trig Imm

Destination

Frequency 1.0NN NNN NNN LLI- It " Ext
Store Settings

Amplitude 5.( Store In

Store Destination: Internal State']

Offset +0

Stor¢

Store applied

Phase 0.C
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1.

Recuperar ajustes

Recall Settings (Recuperar ajustes): le permite navegar hasta el estado en la memoria interna o navegar hasta el
archivo de estado del instrumento (formato .sta) en la unidad flash USB externa a recuperar.

El archivo de estado que recupere debe ser del mismo modelo que el instrumento.

Para restaurar (recuperar) un estado de instrumento almacenado:

Seleccione el origen de recuperacion deseado.

Presione [System] > Store/Recall > Recall Settings > Source. ([Sistema] > Almacenar/Recuperar > Configuracion de
recuperacion > Fuente).

KEYSIGHT

TECHNOLOGIES

Source
[nt " Ext

Frequency 1.0NN NNN NNN LLI-

Recall Settings
Amplitude 10 Recall

Recall from: Internal State 0
Offset +0
Recall: State 0

Phase 0.C

Recall

Sielige recuperar un archivo de estado del instrumento desde la memoria interna no volatil del instrumento, selec-
cione Int. Proceda al paso 2.

Sielige recuperar un archivo de estado (.sta) de una unidad flash USB externa conectada, seleccione Ext. Proceda al
paso 3.

Seleccione la ubicacién de almacenamiento interno desde la que desea recuperar.

Presione Recall (Recuperar), y seleccione entre el Estado O, el Estado 1, el Estado 2, el Estado 3 o el Estado 4.
Proceda al paso 4.

Seleccione el lugar de almacenamiento externo deseado desde el cual se puede recuperar.

Presione Browse (Explorar) y utilice la perilla del panel frontal y las teclas de flecha para navegar hasta el archivo de
estado deseado (*sta) que quiera recuperar. Presione Select (Seleccionar) cuando termine.
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4. Serecupera el estado del instrumento seleccionado.

Presione Recall (Recuperar).

Referencia del menu del panel frontal

Esta seccion comienza con un resumen de los menus del panel frontal. El resto de esta seccién contiene ejemplos de
uso de los menus del panel frontal.

- Botén [Waveform] (Forma de onda)

- Botdn [Parameter] (Parametro)

- Botén [Units] (Unidades)

- Botén [Modulate] (Modular)

— Boton [Sweep] (Barrido)

- Boton [Burst] (Rafaga)

- Botdn [Trigger] (Disparo)

— Boton [System] (Sistema)

- Canal [Setup] (Configuracién) y botén [0On/Off] (Encendido/Apagado)

Botdn [Waveform] (Forma de onda)

Selecciona la forma de onda:
- Sinusoidal

- Cuadrada

- Rampa

- Pulso

- Arbitraria

- Triangulo

- Ruido

- PRBS

-CC

Guia del usuario de la serie Keysight EDU33210 77



Botdn [Parameter] (Parametro)

Parameater

Configura los parametros especificos de la forma de onda:

- Perfodo / Frecuencia

- Amplitud o tensién alta y baja
- Compensacion

- Fase

- Ciclo de trabajo

- Simetria

- Amplitud de pulso

- Tiempos de borde

- Forma de onda arbitraria
- Tasa de muestreo

- Filtro

- Fase Arb

- Ancho de banda

- Datos PRBS

- Tasa de bits

- Borde de entrada

- Borde de salida

Botdn [Units] (Unidades)

Especifica las preferencias de unidades y parametros:

- Frecuencia Arb: Sa/s, Frec. o Periodo

- tension como Amplitud/Compensacion o Alto/Bajo
- Unidades de tension como Vpp, Vrms o0 dBm

- Amplitud de pulso o ciclo de trabajo

- Fase de rafaga como grados, radianes o segundos
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- Fase Arb como grados, radianes, segundos o muestras

- Barrido de frecuencia como Centro/Ampl o Inicio/Detencion

Botdn [Modulate] (Modular)

| Modulate

Configura los parametros de modulacion:
- Modulacion activada o desactivada
- Tipo de modulacion: AM, FM, PM, PWM, BPSK, FSK o Suma

- Fuente de modulacién

- Pardmetros de modulacion (varfan segun el tipo de modulacién)

Boton [Sweep] (Barrido)

=

Configura los parametros de barrido de frecuencia:

- Barrido activado o desactivado

- Tipo de barrido: Lineal, logaritmica o lista de frecuencias

- Tiempo de barrido

- Frecuencias de inicio/detencidn o frecuencias centro/ampl

- Tiempo de permanencia, espera y retorno

Botdn [Burst] (Rafaga)

- Réfaga activado o desactivado

- Modo réfaga: disparo (N Ciclo) o admitida de forma externa
- Ciclos por réfaga (1 a 100.000.000 o infinito)

- Angulo de la fase inicial de la rafaga (-360° a +360°)

- Periodo de réfaga
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Botdn [Trigger] (Disparo)

Configura los parametros de disparo y la sefial de salida de sincronizacion:

- Realiza un disparo manual, cuando se ilumina

- Especifica el origen del disparo para el barrido, la rafaga o el avance arbitrario de la forma de onda
- Especifica el nivel de tension de disparo, el conteo y el retardo

- Especifica la pendiente (borde ascendente o descendente) para una fuente de disparo externa

- Especifica la pendiente (borde ascendente o descendente) de la sefial de salida del disparador

- Activa / desactiva la salida de la sefial del conector "Sync".

- Especificar el origen, la polaridad, el modo, el punto de marcador, etc. de Sync.

Botdn [System] (Sistema)

Tecla de funcion Store/Recall (Almacenar/Recuperar)

Almacena y recuerda los estados de los instrumentos:

- Administra los archivos y las carpetas

- Almacena los estados del instrumento en la memoria no volatil.

- Recuerda los estados de los instrumentos almacenados.

- Selecciona la configuracién de encendido del instrumento (Ultimo apagado o predeterminado de fabrica).

- Devuelve el instrumento a su estado de fabrica.
Tecla de funcién I/0 Config (Configuracion de ES)

Configura las interfaces de E/S del instrumento:
- Enciende y apaga los servicios de la LAN
- Configura la LAN (direcciones y nombre del host)

- Reinicia la LAN
Tecla de funcidn Instr. Setup (Configuracion del instrumento)

Realiza tareas de administracion del sistema:

- Realiza la prueba automatica

80 Guia del usuario de la serie Keysight EDU33210



Tecla de funcién User Settings (Configuracion del usuario)

Configura los parametros relacionados con el sistema:

- Selecciona elidioma local para los mensajes del panel frontal y el texto de ayuda
- Activa o desactiva el pitido de error

- Activa o desactiva el clic del teclado

- Enciende y apaga la pantalla

- Ajusta el comportamiento de atenuacién de la pantalla

- Establece la fechay la hora
Tecla de funcion Help (Ayuda)

Muestra la lista de temas de ayuda:

- Muestra datos "Acerca de": nimero de serie, direccion IP, version del firmware, etc.

- Muestra la cola de errores del mando a distancia

Canal [Setup] (Configuracion) y botén [On/Off] (Encendido/Apagado)

Habilita y configura los canale

Botén [On / Off] (encendido / apagado)

Enciende y apaga el canal

Botén [Setup] [Configuracién].

Configurar los pardmetros relacionados con los canales:

- Especifica qué canal es el foco de los menus

- Selecciona la terminacién de la salida (50 Q, High Z, o Manual)
- Activa/desactiva el cambio automaético de amplitud

- Selecciona la polaridad de la forma de onda (normal o invertida)
- Especifica los limites de tension

- Especifica si la salida es normal o cerrada
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Solo para EDU33212A

Pulse dos veces la tecla [Setup] (Configuracidn) para entrar en el modo de vista de dos canales. En este

modo, al pulsar [Setup] (Configuracidn) se alterna entre la vista de un solo canal y la vista de dos cana-
les.
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4 Funciones y operaciones

Configuracion de salida

Formas de onda de pulso

Modulacién de amplitud (AM) y modulacién de frecuencia (FM)
Modulacién de fase (PM)

Modulacién de introduccién de cambios de frecuencia (FSK, Frequency-
Shift Keying)

Modulacién de amplitud de pulso (PWM)
Modulacién de suma

Barrido de frecuencia

Modo Burst (rafaga)

Disparos

Operaciones relacionadas con el sistema
Operacidon de doble canal

Este capitulo contiene detalles sobre las caracteristicas del instrumento,
que incluyen el panel frontal y el funcionamiento de la interfaz remota. Es
posible que desee leer primero el Funcionamiento del menu del panel
frontal. Consulte la Guia de Programacidn de la serie EDU33270 para
obtener detalles sobre los comandos y consultas del SCPI.
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Configuracion de salida

Esta seccidn describe la configuracidon del canal de salida. Muchos comandos asociados a la configuracion de salida
comienzan con SOURce1: 0 SOURce2: para indicar un determinado canal. Si se omite, el valor por defecto es el
canal 1. Por ejemplo, VOLT 2.5 ajusta la salida del canal 1 a 2.5V, y SOUR2:VOLT2.5 hace lo mismo para el canal 2.

La pantalla del instrumento incluye una "pestafia" para cada canal que resume varios aspectos de la configuracion
de salida de cada canal:

SIN,500

1 Linear Sweep, Trig Imm

ON

En un instrumento de doble canal, la pestafia del canal 1 esta en amarillo, y la del canal 2 esta en verde.

Frequency 1.000,000,000 kHz Frequency 1.000,000,000 kHz
Amplitude 100.0 mVpp Amplitude 100.0 mVpp
Offset +0.000V ffset +0.000V

Phase 0.0° Phase 0.0° Hange
Suto " Hold

Output
~5-

Polarity
Mormal  Inverted

Voltage Limits
~9-

; Mode
Mormal  Gated

Funcidon de salida

Elinstrumento incluye ocho formas de onda estandar: sinusoidal, cuadrada, rampa, pulso, triangulo, ruido, PRBS
(secuencia binaria pseudoaleatoria) y CC. También hay nueve formas de onda arbitrarias incorporadas.

El cuadro siguiente muestra las funciones permitidas (@ con modulacién, barrido y réfaga. Al seleccionar una
funcién que no estd permitida con una modulaciéon o modo se desactiva la modulacién o el modo.

Sinusoidal y cuadrado [ [ [ [ [ o [ [
Pulso [ [ [ [ o [ [ [ o
Triangulo y rampa [ [ o [ o o [ [
Ruido Gaussiano [ o @
PRBS [ [ [ o L
Forma de onda arbitraria [ o @ @ [ o [

1 Solo réafaga admitida
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2 Se aplica al reloj de muestra, no a la forma de onda completa

- Limitaciones de frecuencia: El cambio de funciones puede modificar la frecuencia para cumplir con los limites de
frecuencia de la nueva funcion.

- Limitaciones de amplitud: Cuando las unidades de salida son Vrms o dBm, el cambio de funciones puede reducir la
amplitud al méximo para la nueva funcion debido a la variacion de las formas de onda. Por ejemplo, una onda cuadrada
de 5 Vrms (en 50 Q) que se cambia a sinusoidal disminuird a 3.536 Vrms (limite superior sinusoidal).

- Laamplitud y la compensacién no pueden combinarse para superar la capacidad del instrumento. Puede cambiar el
ultimo establecido para mantenerse dentro de los limites.

- Puede proteger un dispositivo bajo prueba (DUT) especificando los limites de tension de salida superior e inferior.

Operaciones del panel frontal

- Para encender una salida: Presione Canal [On/Off] (Encendido/Apagado) para el canal que desee.

— Para seleccionar otra forma de onda: Pulse [Waveform] ([Forma de onda]

Por ejemplo, para especificar una sefial de CC:

Presione [Waveform] > MORE 1/ 2 > DC > Offset ((Forma de onda] > MAS 1/2 > CC > Compensacién).

Utilice el teclado numérico o la perilla y las flechas para establecer un valor deseado. Si utiliza el teclado, seleccione
un prefijo de unidad para terminar.

KEYSIGHT

TECHNOLOGIES
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2. Presione Canal [On/Off] (Encendido/Apagado) para producir la salida de CC.

KEYSIGHT

TECHNOLOGIES
Parameter

Dffset

Offset A9500 v

Comando SCPI
[SOURce[1]|2]:]FUNCtion <function>

El comando APPLy configura una forma de onda con un comando.

Frecuencia de salida

El rango de frecuencia de salida depende de la funcion, el modelo y la tensidn de salida, como se muestra aqui. La
frecuencia por defecto es de 1 kHz para todas las funciones, y las frecuencias minimas se muestran en la tabla
siguiente.

Sinusoidal 1 pHz
Cuadrada 1 pHz
Rampa/triangular 1 pHz
Pulso 1 pHz
PRBS 1 mbps
Arbitraria 1 uSa/s

- Limitaciones de frecuencia: El cambio de funciones puede modificar la frecuencia para cumplir con los limites de
frecuencia de la nueva funcion. Las formas de onda arbitrarias conservan su Ultima configuracion de frecuencia.

- Limitacion de rafagas: Para las rafagas de disparo interno, la frecuencia minima es de 126 pHz.

- Limitaciones del ciclo de trabajo: Para Cuadrada y Pulso, el Ciclo de trabajo esté limitado por la especificacion de
la amplitud de pulso minima de 16ns. Por ejemplo, a 1 kHz, el Ciclo de trabajo puede fijarse tan bajo como 0,01 %,
porque eso darfa como resultado una amplitud de pulso de 100 ns. A 1 MHz, el Ciclo de trabajo minimo es del 1.6 %,
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ya 10 MHz es del 16 %. Cambiar a una frecuencia que no pueda producir el ciclo de trabajo actual ajustara el ciclo
de trabajo para cumplir con la especificacion de la amplitud de pulso minima.

La amplitud minima del pulso es de 16 ns.
Operaciones del panel frontal

Presione [Parameter] > Frequency ([Pardmetro] > Frecuencia). Utilice el teclado numérico o la perillay las flechas
para establecer un valor deseado. Si utiliza el teclado, seleccione un prefijo de unidad para terminar.

KEYSIGHT
TECHNOLOGIES

Frequency 1 _ pHz

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Comando SCPI
[SOURce[1]2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

El comando APPLy configura una forma de onda con un comando.

Amplitud de salida

La amplitud por defecto es de 100 mVpp (en 50 Q) para todas las funciones.

- Limitaciones de tension de compensacion: A continuacion, se muestra la relacion entre la amplitud y la
compensacion. Vmax es +5 V para una carga de 50 Q 0 +10 V para una carga de alta impedancia.

Vpp < 2(Vmax - [Voffset|)

- Limites que dependen la terminacion de la salida: Si la amplitud es de 10 Vpp y cambia el ajuste de terminacion

de salida de 50 Q a "alta impedancia" (OUTPut[1]|2]:LOAD INF), la amplitud mostrada se duplica a 20 Vpp. El cambio
de "alta impedancia" a 50 Q reduce a la mitad la amplitud mostrada. El ajuste de terminacion de la salida no afecta a
la tension de salida real; solo cambia los valores visualizados y consultados desde la interfaz remota. La tension de
salida real depende de la carga conectada.

- Limites debido a la seleccion de unidades: Los limites de amplitud estdn a veces determinados por las unidades
de salida seleccionadas. Esto puede ocurrir cuando las unidades son Vrms o dBm debido a las diferencias en los
factores de cresta de las diversas funciones. Por ejemplo, si se cambia una onda cuadrada de 5 Vrms (en 50 Q) por
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una onda sinusoidal, el instrumento ajustaré la amplitud a 3.536 Vrms (el limite superior para el sinusoidal en Vrms).
La interfaz remota también generaré un error de "Conflicto de ajustes".

- La amplitud de salida se puede configurar en Vpp, Vrms 0 dBm. La amplitud de salida no se puede especificar en
dBm si la terminacién de salida esta configurada como alta impedancia Consulte Unidades de salida para obtener
mas detalles.

- Limitaciones arbitrarias de la forma de onda: En el caso de las formas de onda arbitrarias, la amplitud esta
limitada si los puntos de datos de la forma de onda no abarcan todo el rango del DAC (conversor digital-analdgico)
de salida. Por ejemplo, la forma de onda "Sinc" incorporada no utiliza todo el rango de valores, por lo que su
amplitud méxima esta limitada a 6.087 Vpp (en 50 Q).

- Elcambio de amplitud puede interrumpir brevemente la salida a ciertas tensiones debido a la conmutacion del
atenuador de salida. Sin embargo, la amplitud esta controlada, por lo que la tensidn de salida nunca excedera el
ajuste de corriente mientras se conmuta de rango. Para prevenir esta interrupcion, deshabilite el cambio automatico
de tension usando VOLTage:RANGe:AUTOOFF. El comando APPLy permite el rango automatico de forma
automatica.

- Al establecer los niveles altos y bajos también se establece la amplitud y la compensacion de la forma de onda.
Por ejemplo, si fija el nivel alto en +2 V'y el nivel bajo en -3 V, la amplitud resultante es de 5 Vpp, con una
compensacion de -500 mV.

- Elnivel de salida de la sefial ACC esta controlado por la tensién de compensacion (Tensién de compensacion de
CC). Elnivel de CC puede estar entre +5 V en una carga de 50 Q o +10 V con una carga de alta impedancia.

Operaciones del panel frontal

Presione [Parameter] > Amplitude ([Pardmetro] > Amplitud). Utilice el teclado numérico o la perillay las flechas para
establecer un valor deseado. Si utiliza el teclado, seleccione un prefijo de unidad para terminar.

Frequency 1.000,000,000 kHz

Amplitude 100 Y
- pp

Offset +0.000V

mifrms
Phase 0.0°

Para usar un nivel alto y un nivel bajo: Presione [Units] > Ampl/Offs | High/Low([Unidades] > Ampl/Comp Alto/Bajo).
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KEYSIGHT
TECHNOLOGIES

Units

Frequency <

Frequency 1.000,000,000 kHz Periodc

High Level +50.00 mV Amp/0ffs
High/Low

Low Level -50.00 mV

Phase 0.0°

Comando SCPI

[SOURce[1]2]:]VOLTage {<amplitude>|MINimum|MAXimum|DEFault}
[SOURce[1]2]:]VOLTage:HIGH {<voltage>|MINimum|MAXimum|DEFault}
[SOURce[1]2]:]VOLTage:LOW {<voltage>|MINimum|MAXimum|DEFault}

El comando APPLy configura una forma de onda con un comando.

Tension de compensacion de CC

La compensacion predeterminada para todas las funciones es de O V.

- Limites que dependen de la amplitud La relacion entre la tension de compensacion y la amplitud de la salida se
muestra a continuacion. El pico de tension de salida (CC més CA) no puede exceder el rango de salida del
instrumento (+5 V en una carga de 50 Q, 0 +10 V en un circuito abierto).

- Larelacion entre la tensidon de compensacion y la amplitud de la salida se muestra a continuacion. Vmax es el pico
de tension para la terminacién de salida seleccionada (5 V para una carga de 50 Q o 10 V para una carga de alta
impedancia).

|Voffset| < Vmax - Vpp/ 2

Sila tension de compensacion especificada no es valida, el instrumento la ajustard a la maxima tension de CC
permitida con la amplitud especificada. Desde la interfaz remota, también se generard un error de "Datos fuera de
rango".

- Limites que dependen de la terminacion de salida: El rango de compensacion depende de la configuracion de la
terminacion de la salida. Por ejemplo, si ajusta la compensacion a 100 mVDC y luego cambia la terminacion de
salida de 50 Q a "alta impedancia", la tensidon de compensacion que se muestra en el panel frontal se duplica a 200
mVDC (no se genera ningun error). Si cambia de "alta impedancia" a 50 Q, la tensién de compensacién mostrada se
reducira a la mitad. Cambiar el ajuste de terminacion de salida no cambia la tensidn presente en los terminales de
salida del instrumento. Esto solo cambia los valores mostrados en el panel frontal y los valores consultados desde la
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interfaz remota. La tensién presente en la salida del instrumento depende de la carga conectada al instrumento.
Consulte "OUTPut[1|2]:LOAD” en la Guia de programacion de la serie EDU33210 para obtener mas detalles.

- Limitaciones arbitrarias de la forma de onda: En el caso de las formas de onda arbitrarias, la amplitud esta
limitada si los puntos de datos de la forma de onda no abarcan todo el rango del DAC (conversor digital-analégico)
de salida. Por ejemplo, la forma de onda "Sinc" incorporada no utiliza todo el rango de valores, por lo que su
amplitud méxima estd limitada a 6.087 Vpp (en 50 Q).

- Al establecer los niveles altos y bajos también se establece la amplitud y la compensacion de la forma de onda.
Por ejemplo, si fija el nivel alto en +2 V y el nivel bajo en -3V, la amplitud resultante es de 5 Vpp, con una
compensacion de -500 mV.

- Para emitir un nivel de tensién de CC, seleccione la funcién de tensién de CC (FUNCtion DC) y luego ajuste la
tension de compensacion (VOLTage:OFFSet). Los valores vélidos estan entre +5 VCC en 50 Q 0 +10 VCC en un
circuito abierto. Mientras el instrumento esté en modo CC, el ajuste de la amplitud no tiene ningun efecto.

Operaciones del panel frontal

Presione [Waveform] > MORE 1/2 > DC > Offset ([Forma de onda] > MAS 1/2 > CC > Compensacidn). Utilice el
teclado numérico o la perilla y las flechas para establecer un valor deseado. Si utiliza el teclado, seleccione un
prefijo de unidad para terminar.

KEYSIGHT

TECHNOLOGIES

Offset

Comando SCPI

[SOURce[1]2]:]VOLTage:0FFSet {<offset>|MINimum|MAXimum|DEFault}
[SOURce[1]2]:]VOLTage:HIGH {<voltage>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]VOLTage:LOW {<voltage>|MINimum|MAXimum|DEFault}

El comando APPLy configura una forma de onda con un comando.

Unidades de salida

Se aplica solo a la amplitud de salida.
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- Unidades de salida: Vpp (por defecto), Vrms, o dBm.
- El ajuste es volatil.

- Laseleccion de las unidades se aplica a las operaciones del panel frontal y de la interfaz remota. Por ejemplo, si
selecciona "VRMS" a distancia, las unidades se muestran como "VRMS" en el panel frontal.

- Las unidades de amplitud no pueden ser dBm si la terminacién de la salida se establece a alta impedancia. El
célculo de dBm requiere una impedancia de carga finita. En este caso, las unidades se convierten en Vpp.

- Puede convertir entre unidades. Por ejemplo, para convertir 2 Vpp al equivalente en Vrms:
Pulse [Units] > Amplitude Vpp > Amplitude Vrms ((Unidades] > Amplitud Vpp > Amplitud Vrms).
Elvalor convertido es de 707.1 mVrms para una onda sinusoidal.
Operaciones del panel frontal
Pulse [Units] > Amplitude ([Unidades] > Amplitud).
ok
[nits
Frequency 1.000,000,000 kHz 1| e
Amplitude 100.0 mVpp > AmplOffs <

High/Low
Offset +0.000 V

Amplitude

Phase 0.0° Wrms -
dBm Phase
Degrees

Sweep
Stristop

Comando SCPI

[SOURce[1]2]:]VOLTage:UNIT {VPP|VRMS|DBM}

Terminacién de salida

Elinstrumento tiene una impedancia de salida en serie fija de 50 Q a los conectores de canal del panel frontal. Si la
impedancia de carga real difiere del valor especificado, los niveles de amplitud y compensacion mostrados seran
incorrectos. El ajuste de la impedancia de carga es simplemente una conveniencia para asegurar que la tension
mostrada coincida con la carga esperada.

- Terminacion de la salida: 1 Q a 10 kQ, o infinito. El valor por defecto es 50 Q.
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- Si especifica una terminacion 50 Q, pero en realidad termina en un circuito abierto, la salida serd el doble del valor
especificado. Por ejemplo, si establece la compensacion de CC a 100 mVDC (y se especifica una carga de 50 Q),
pero termina en un circuito abierto, la compensacion real serd de 200 mVDC.

- Cambiar la configuracion de la terminacion de la salida, se ajusta la amplitud y la compensacién de la salida
visualizada (no se genera ningun error). Si la amplitud es de 10 Vpp y cambia el ajuste de terminacion de salida de
50 Q a "alta impedancia" (OUTPut[1|2]:LOAD INF), la amplitud mostrada se duplica a 20 Vpp. El cambio de "alta
impedancia" a 50 Q reduce a la mitad la amplitud mostrada. El ajuste de terminacién de la salida no afecta a la
tension de salida real; solo cambia los valores visualizados y consultados desde la interfaz remota. La tension de
salida real depende de la carga conectada.

La carga de salida puede afectar a la calidad de la sefial para el pulso u otras funciones con transiciones de alta velo-
cidad. La alta resistencia a la carga puede producir reflejos.

- Las unidades se convierten a Vpp si la terminacion de la salida es de alta impedancia.

- No se puede cambiar la terminacion de la salida con los limites de tensidn activados, porque el instrumento no
puede saber a qué terminacion se aplican los limites. En su lugar, deshabilite los limites de tension, establezca el
nuevo valor de terminacion, ajuste los limites de tensién y vuelva a habilitar los limites de tension.

Operaciones del panel frontal

Pulse Canal [Setup] > Output > Load ([Configuracién] > Salida > Cargar).

SetT
Frequency 1.000,000,000 kHz 30 O

Amplitude 100.0 mVpn Set To

CH 1 Output Load High Z
Offset +0.000V

50 Q Load

Phase 0.0°

Comando SCPI

OUTPut [1]2] :LOAD {<ohms>|INFinity|MINimum|MAXimum|DEFault}

Ciclo de trabajo (ondas cuadradas)

El ciclo de trabajo de una onda cuadrada es la fraccion de tiempo por ciclo que la forma de onda esté en un nivel
alto (suponiendo que la forma de onda no esté invertida). (Consulte Formas de onda de pulso para ver detalles del
ciclo de trabajo del pulso).
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- Ciclo de trabajo 0.07 % a 99.99 % en las frecuencias bajas; rango reducido en las frecuencias altas. Almacenado en
la memoria volatil; por defecto 50 %.

- Este ajuste se recuerda cuando se cambia a otra funcidn. Siempre se utiliza un ciclo de trabajo del 50 % para una
forma de onda cuadrada moduladora; el ajuste del ciclo de trabajo se aplica solo a una transportadora de onda
cuadrada.

20% de cido de trabajo  80% de ciclo de trabajo

Operaciones del panel frontal

Pulse [Waveform] > Square > Duty Cycle ([Forma de onda] > Cuadrada > Ciclo de trabajo). Utilice el teclado
numeérico o la perillay las flechas para establecer un valor deseado. Si utiliza el teclado, pulse Percent (Porcentaje)
para confirmar los cambios.

S
Frequency 1.000,000,000 kHz -
Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Duty Cycle 75_

Comando SCPI

[SOURce[1|2]:]FUNCtion:SQUare:DCYCle {<percent>|MINimum|MAXimum}

El comando APPLy establece el ciclo de trabajo en un 50 %.
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Simetria (Ondas de rampa)

Se aplica solo a las ondas de rampa. La simetria representa la fraccion de cada ciclo en que la onda de rampa se
eleva (suponiendo que la forma de onda no esté invertida).

0% de simetria 100% de simetria

- La simetrfa (por defecto) se almacena en la memoria volétil; y se recuerda cuando se cambia a y desde otras
formas de onda.

- Cuando la rampa es la forma de onda moduladora para AM, FM, PM o PWM, el ajuste de simetria no se aplica.
Operaciones del panel frontal

Presione [Waveform] > Ramp > Symmetry ([Forma de onda] > Rampa > Simetria). Utilice el teclado numérico o la
perillay las flechas para establecer un valor deseado. Si utiliza el teclado, pulse Percent (Porcentaje) para confirmar
los cambios.

RAMP,500Q

Frequency 1.000,000,000 kHz -
Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Symmetry 75_

Comando SCPI
[SOURce[1]2]:]FUNCtion:RAMP:SYMMetry {<percent>|MINimum|MAXimum|DEFault}

El comando APPLy establece la simetria al 100 %.
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Rango automatico de tension

El rango automatico estd activado por defecto y el instrumento selecciona los ajustes dptimos del atenuador. Con el
rango automatico desactivado, el instrumento utiliza la configuracién actual del atenuador y no cambia los relés del
atenuador.

- Puede desactivar el rango automatico para eliminar las interrupciones momentaneas causadas por la conmutacion
del atenuador al cambiar la amplitud. Sin embargo:

- La precisién y resolucién de la amplitud y la compensacion (y la fidelidad de la forma de onda) pueden verse
afectadas negativamente cuando se reduce la amplitud por debajo de un cambio de rango que se produciria con el
rango automatico.

- No se puede alcanzar la amplitud minima con el rango automético activado.
- Algunas especificaciones de los instrumentos no se aplican con la funcién de rango automatico.
Operaciones del panel frontal

Pulse Canal [Setup] > Range Auto | Hold o Range Auto | Hold ([Configuracién] > Rango Automético | Retener o
Rango Automatico | Retener.

KEYSIGHT
TECHNOLOGIES

Frequency 1.000,000,000 kHz -

Amplitude  100.0 mVpp Range
Auto " Hold

Offset +0.000V

Polarity

Mormal  Inverted
Phase 0.0° :

Symmetry 75.00 % Voltage Limits
-

Mode
Mormal  Gated

Comando SCPI
[SOURce[1]2]:]VOLTage:RANGe:AUTO {OFF|0|ON|1|ONCE}

El comando APPLy siempre permite el rango automatico

Control de salida

Al encender el instrumento, la salida de canal esta desactivada de manera predeterminada para proteger otros
equipos. Para habilitar la salida de un canal, consulte a continuacién. Cuando se activa la salida de canal, se ilumina
el botdn de canal correspondiente.
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Siun circuito externo aplica una tensién excesiva al conector de salida de un canal, el instrumento genera un
mensaje de error y desactiva la salida. Para volver a activar la salida, quite la sobrecarga y vuelva a encender el
canal.

Operaciones del panel frontal

Presione Canal [On/Off] ((Encendido/Apagado)).

KEYSIGHT

TECHNOLOGIES
Parameter

Offset

Offset A9500 v

Comando SCPI
OUTPut[1]2] {ON|1|OFF|O0}

El comando APPLY siempre activa el conector de salida del canal.

Polaridad de la forma de onda

En el modo normal (por defecto), la forma de onda se vuelve positiva al principio del ciclo. El modo invertido hace lo
contrario.

- Como se muestra a continuacion, la forma de onda se invierte en relacion con la tension de compensacion. La
tensidon de compensacion permanece sin alteraciones cuando la forma de onda se invierte.

Normal Invertido Normal Invertido
. // o rd
NN X M, -
I ."n. "rf l‘l'"-. / kY
{ - OV .- y - Compensacida
\ /: AN A ,f. oV

Sintension de compensacion ~ Con tension de compensacion

- La sefial de sincronizacién asociada a una forma de onda invertida no esta invertida.
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Operaciones del panel frontal

Presione [Setup] > Polarity Normal | Inverted o Polarity Normal | Inverted ([Configuracién] > Polaridad Normal |
Invertida o Polaridad Normal | Invertida.

RAMP,500Q

Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpp

Auto " Hold

Offset +0.000V

Polarity

Mormal  Inverted
Phase 0.0° :

Symmetry 75.00 % Voltage Limits
-

Mode
Mormal  Gated

Comando SCPI

OUTPut[1|2]:POLarity {NORMal |INVerted}

Sefial de salida de sincronizacién

Se proporciona una salida de sincronizacion en el conector de sincronizacion del panel frontal. Todas las funciones
de salida estandar (excepto CC y ruido) tienen una sefial de sincronizacién asociada. Para las aplicaciones en las que
no se quiera emitir la sefial de sincronizacion, se puede desactivar el conector de sincronizacion. La sefial de
sincronizacion puede derivarse de cualquiera de los canales de salida en un instrumento de dos canales.

Comportamiento general
- Por defecto, la sefial de sincronizacion se deriva del canal 1y se dirige al conector de sincronizacion (activado).

- Cuando la sefial de sincronizacion esta desactivada, el nivel de salida del conector de sincronizacién esta en un
"bajo" logico.

- La polaridad de la sefial de sincronizacién se especifica en OUTPut:SYNC:POLarity {INVerted|]NORMal}.
- Invertir una forma de onda (consulte Polaridad de la forma de onda), no invierte la sefial Sync asociada.

- Para las ondas sinusoidales, de pulso, de rampa, cuadradas y triangulares, la sefial Sync (de sincronizacién) es una
onda cuadrada que es "alta" en la primera mitad del ciclo y "baja" en la dltima mitad. Las tensiones de la sefial de
sincronizacion son compatibles con TTL cuando su impedancia de carga supera 1 kQ.

- Para las formas de onda arbitrarias, la sefial de sincronizacion sube al principio de la forma de onday cae en el
medio de la forma de onda arbitraria. Puede anular este comportamiento por defecto usando MARKer:POINt para
especificar el punto dentro de la forma de onda arbitraria en el que la sefial de sincronizacion pasa a "baja".

Modulacién
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- Enelcaso de AM, FM, PMy PWM con modulacion interna, la sefial de sincronizacion se refiere normalmente a la
forma de onda moduladora (no a la transportadora) y es una forma de onda cuadrada con un ciclo de trabajo del
50 %. La sefial de sincronizacion es un TTL "alto" durante la primera mitad de la forma de onda moduladora. Puede
configurar la sefial de sincronizacién para que siga la forma de onda transportadora usando el comando
OUTPut:SYNC:MODE {CARRier|[NORMal|MARKer} cuando modula con modulacion interna.

- Puede anular el comportamiento normal de la sincronizacién para forzar a la sincronizacién a seguir siempre la
forma de onda portadora (OUTPut[1]2]:SYNC:MODE CARRier).

- Para FSK, la sefial de sincronizacion se refiere a la tasa de FSK. La sefial de sincronizacion es un TTL "alto" en la
transicion a la frecuencia de "salto".

Barrido

- La sefial de sincronizacion es un TTL "alto" al principio del barrido y pasa a "bajo" en el punto medio del barrido. La
sefial de sincronizacion estd sincronizada con el barrido, pero no es igual al tiempo de barrido porque su
sincronizacion incluye el tiempo de rearme.

- Para los barridos de frecuencia con el marcador activado, la sefial de sincronizacion es un TTL "alto" al principio
del barrido y "bajo" en la frecuencia del marcador. Puede cambiar esto con OUTPut[1]2]:SYNC:MODE MARKER.

Réfaga

- Para una rafaga disparada, la sefial de sincronizacion es un TTL "alto" cuando la réfaga comienza. La sefial de
sincronizacion es un TTL "bajo" al final del nimero de ciclos especificado (es posible que no sea el punto de cruce
cero si la forma de onda tiene una fase de inicio asociada). Para una rafaga de conteo infinita, la sefial de
sincronizacion es la misma que para una forma de onda continua.

- Para una rafaga de puerta externa, la sefial de sincronizacion sigue la sefial de la puerta externa. Sin embargo, la
sefial no se "bajard" hasta el final del ultimo ciclo (puede que no sea un cruce cero si la forma de onda tiene una fase
de inicio asociada).

Configuracion de la salida de sincronizacion

Operaciones del panel frontal

Para activar y desactivar la sincronizacion: Pulse [Trigger] > Sync ON | OFF o Sync ON | OFF ([Disparo] > Sinc.
Activada | Desactivada o Sinc. Activada | Desactivada.
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KEYSIGHT

TECHNOLOGIES

Trigger

Source

Frequency 1.000,000,000 kHz Mkt

Amplitude 100.0 mVpp Trigger Setup
-

Offset +0.000V

Trig Out Setup

Phase 0.0° -

Symmetry  75.00 % Sync
ON""OFF

Sync Setup
~9-

Para configurar la sincronizacion: Pulse [Trigger] > Sync Setup ([Disparo] > Configurar sincronizacion).

KEYSIGHT

TECHNOLOGIES
Trigger

Sync Src

Frequency 1.000,000,000 kHz CHT ' CH2

Amplitude 100.0 mVpp Polarity
Mormal " Inverted
Offset +0.000V
Mode

Mormal

Phase 0.0°

Symmetry 75.00 %

Comando SCPI

OUTPut:SYNC {ON|1|OFF |0}
OUTPut[1]2] :SYNC:MODE {NORMal |CARRier |MARKer}
OUTPut[1]2]:SYNC:POLarity {NORMal |INVerted}

OUTPut:SYNC:SOURce {CH1|CH2}
Formas de onda de pulso

Como se muestra a continuacién, un pulso u onda cuadrada consiste en un periodo, una amplitud de pulso, un
borde ascendente y un borde descendente.
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Ancho de pulso

Tiempo de borde de entrada Tiempo de borde de salida
( Periodo

Y

Periodo

- Periodo: reciproco de frecuencia maxima a 1.000.000 s. El valor por defecto es 1 ms.

- Elinstrumento ajusta la amplitud de pulso y el tiempo de borde segln sea necesario para acomodar el periodo
especificado.

Operaciones del panel frontal

. Seleccione Forma de onda de pulso: Pulse [Waveform] > Pulse ([Forma de onda] > Pulso).

. Seleccione el perfodo en lugar de la frecuencia: Pulse Frequency Periodic > Frequency Periodic ((Unidades] > Fre-
cuencia Periddica > Frecuencia Periédica).

. Establezca el periodo: Pulse [Parameter] > Period ([Pardmetro] > Periodo). Utilice el teclado numérico o la perilla y
las flechas para establecer un valor deseado. Si utiliza el teclado, seleccione un prefijo de unidad para terminar.

KEYSIGHT
PULS,50Q TECHNOLOGIES
Period 100_
Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°
Pulse Width 10.000,0 ps
Lead Edge 4.0 ns

seconds

Trail Edge 4.0ns

Comando SCPI

[SOURce[1]2]:]FUNCtion:PULSe:PERiod {<seconds>|MINimum|MAXimum|DEFault}
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Amplitud de pulso

La amplitud pulso es el tiempo que pasa entre el 50 % del borde ascendente del pulso y el 50 % del siguiente borde
descendente.

- Amplitud de pulso: hasta 1.000.000 s (ver restricciones més abajo). La amplitud de pulso predeterminada es de
100 ps. La amplitud minima del pulso es de 16 ns.

- La amplitud de pulso especificada también debe ser inferior a la diferencia entre el periodo y la amplitud de pulso
minima.

- Elinstrumento ajustard la amplitud de pulso para acomodarse al periodo especificado.
Operaciones del panel frontal

Pulse [Waveform] > Pulse > Pulse Width ([Forma de onda] > Pulso > Amplitud del pulso). Utilice el teclado numérico
o la perillay las flechas para establecer un valor deseado. Si utiliza el teclado, seleccione un prefijo de unidad para
terminar.

Period  100.000,000 ms

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°
Pulse Width 10_ seconds
Lead Edge 4.0ns

Trail Edge 4.0 ns

Comando SCPI

[SOURce[1]2]:]FUNCtion:PULSe:WIDTh {<seconds>|MINimum|MAXimum|DEFault}

Ciclo de trabajo de pulso

El ciclo de trabajo de pulso se define de la siguiente manera:
Ciclo de trabajo = 100 (Amplitud de pulso)/Periodo

La amplitud pulso es el tiempo que pasa entre el 50 % del borde ascendente del pulsoy el 50 % del siguiente borde
descendente.

Ciclo de trabajo de pulso: 0.01 % a 99.99 % (consulte las restricciones a continuacion). La configuracion
predeterminada es 10 %.
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- El ciclo de trabajo de pulso debe respetar las siguientes restricciones determinadas por la amplitud de pulso
minima (Wmin).

Elinstrumento ajustara el ciclo de trabajo del pulso para acomodarse al periodo especificado.

Ciclo de trabajo » 100 (Amplitud de pulso minimo) / Periodo

y
Ciclo de trabajo < 100 (1 - (Amplitud de pulso minimo/ periodo))

La amplitud minima del pulso es de 16 ns.

- Cuanto mas largos son los bordes, mayor es el ancho minimo de pulso. Por lo tanto, los bordes mas largos
restringiran el ciclo de trabajo méas que los bordes mas cortos.

Operaciones del panel frontal

. Seleccione la funcién de pulso: Pulse [Waveform] > Pulse ([Forma de onda] > Pulso).

. Cambie a Ciclo de Trabajo: Pulse [Units] > Width Duty Cyc > Width Duty Cyc ([Unidades] > Amplitud Ciclo de Tra-
bajo > Ciclo de Trabajo).

. Entrw en el ciclo de servicio: Pulse [Parameter] > Duty Cycle([Parametro] > Ciclo de servicio). Utilice el teclado
numeérico o la perilla y las flechas para establecer un valor deseado. Si utiliza el teclado, pulse Percent (Porcentaje)
para terminar.

KEYSIGHT

TECHNOLOGIES

Period 100.000,000 ms Percent

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°
Duty Cycle 50_
Lead Edge
Trail Edge

Comando SCPI

[SOURce[1]2]:]FUNCtion:PULSe:DCYCle {<percent>|MINimum|MAXimum|DEFault}

Tiempos de borde

Los tiempos de los bordes establecen los tiempos de transicion para los bordes de entrada y salida del pulso, ya sea
de forma independiente o conjunta. El tiempo de borde representa el tiempo entre los umbrales del 10 % y el 90 %.

- Tiempo de borde: Minimo de 8.4 ns. Maximo de 1 us y por defecto 10 ns.
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- El tiempo de borde especificado debe ajustarse a la amplitud de pulso especificada como se muestra arriba. El
instrumento ajustara el tiempo de borde para acomodar la amplitud de pulso especificada.

Operaciones del panel frontal

1. Para establecer los tiempos de transicion para los bordes del pulso de forma independiente: Pulse [Waveform] >
Pulse > Edge > Each Both ([Forma de onda] > Pulso > Borde > Cada uno Ambos.

2. Presione Lead Edge (Borde de entrada) para fijar el tiempo de transicién para el borde de entrada del pulso. Utilice
el teclado numérico o la perilla y las flechas para establecer un valor deseado. Si utiliza el teclado, seleccione un pre-
fijo de unidad para terminar.

3. Presione Trail Edge (Borde de salida) para fijar el tiempo de transicién para el borde de salida del pulso. Utilice el
teclado numérico o la perilla y las flechas para establecer un valor deseado. Si utiliza el teclado, seleccione un prefijo
de unidad para terminar.

KEYSIGHT

TECHNOLOGIES

Parameter

Each 4

Period 100.000,000 ms Both

Amplitude 100.0 mVpp Lead
Edge

Offset +0.000 V

Trail
Phase 0.0° Edge
Duty Cycle 50.00 %
Lead Edge 4.0ns

Trail Edge 4.0ns

1. Paraestablecer los tiempos de transicion para los bordes del pulso juntos: Pulse [Waveform] > Pulse > Edge > Each
Both ([Forma de onda] > Pulso » Borde > Cada uno Ambos.
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2. Presione Edge Time (Tiempo de borde) para fijar el tiempo de transicién tanto para el borde de entrada de pulso
como para el de salida. Utilice el teclado numeérico o la perilla y las flechas para establecer un valor deseado. Si uti-
liza el teclado, seleccione un prefijo de unidad para terminar.

Period  100.000,000 ms

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°
Duty Cycle 50.00 %

Edge Time 1.0ns

Comando SCPI
[SOURce[1]2]:]FUNCtion:PULSe:TRANsition:LEADing{<seconds>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]FUNCtion:PULSe:TRANsition:TRAiling
{<seconds>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]FUNCtion:PULSe:TRANsition[:BOTH] {<seconds>|MINimum|MAXimum|DEFault}

Modulacion de amplitud (AM) y modulacién de frecuencia (FM)

Una forma de onda modulada consta de una forma de onda transportadora y una forma de onda de modulacién. En
AM, la amplitud de la transportadora varfa segun el nivel de tension de la forma de onda moduladora. En FM, la
frecuencia transportadora varia segun el nivel de tensién de la forma de onda moduladora. En un instrumento de
dos canales, un canal puede modular el otro.

Seleccione AM o FM antes de configurar cualquier otro pardmetro de modulacion. Para obtener mas informacion
sobre la modulacién, consulte Modulacién.

Para seleccionar AM o FM

- Elinstrumento solo permite habilitar un modo de modulacién en un canal. Cuando se activa AM o FM, todas las
demas modulaciones estan desactivadas. En los modelos de dos canales, las modulaciones de los dos canales son
independientes entre si, y el instrumento puede afiadir formas de onda moduladas de dos canales. Consulte
PHASe:SYNChronize and COMBIine:FEED en la Guia de programacicn de la serie EDU33270 para obtener mas
detalles.
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- Elinstrumento no permitirda que se active AM o la FM con barrido o rafaga. Al activar AM o FM, se apaga el barrido
y la rafaga.

- Para evitar multiples cambios en la forma de onda, habilite la modulacién después de configurar los demas
parametros de modulacion.

Operaciones del panel frontal

Pulse [Modulate] > Type AM ([Modular] > Tipo AM).

0

Presione [Modulate] > Type AM > Type FM ((Modular] > Tipo AM > Tipo FM).

Luego, active la modulacién: Pulse [Modulate] > Modulate ON | OFF > Modulate ON | OFF ([(Modular] > Modular
Activado | Desactivado > Modular Activado | Desactivado).

SIN,50Q
FM Modulated by Sine

. S Modu
Frequency 1.000,000,000 kHz EM Dev 100 Hz w(.) ur?;?

Amplitude 100.0 mVpp FM Freq 10.000,000 Hz | Type
- FI
Offset +0.000V

Phase 0.0°

Internal

La forma de onda se emite utilizando la transportadora actual y modulando los ajustes de la forma de onda.
Comando SCPI

[SOURce[1]2]:]AM:STATe{ON|1|OFF|0}

[SOURce[1]2]:]FM:STATe {ON|1|OFF|0}

Forma de onda transportadora

- Forma transportadora AM o FM: Sinusoidal (por defecto), cuadrada, rampa, pulso, tridngulo, ruido (solo AM),
PRBS, o forma de onda arbitraria. No puede usar CC como forma de onda transportadora.

- Para FM, la frecuencia transportadora debe ser siempre mayor que o igual a la desviacion de frecuencia. El intento
de establecer una desviacion mayor que la frecuencia transportadora hara que el instrumento establezca una
desviacion igual a la frecuencia transportadora.
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- La frecuencia transportadora mas la desviacion no puede exceder la frecuencia méxima de la funcién seleccionada
mas 100 kHz. Si intenta ajustar la desviacién a un valor no valido, el instrumento la ajusta al maximo valor permitido
con la frecuencia transportadora actual. La interfaz remota también genera un error de "Datos fuera de rango".

Operaciones del panel frontal

Pulse [Waveform] ([Forma de onda] Luego, seleccione una forma de onda.
Comando SCPI

[SOURce[1]|2]:]FUNCtion <function>

El comando APPLy configura una forma de onda con un comando.

Frecuencia transportadora

La frecuencia maxima de la transportadora varia segun la funcion, el modelo y la tensién de salida, como se muestra
aqui. El valor por defecto es de 1 kHz para todas las funciones que no sean formas de onda arbitrarias. La
"frecuencia" de la forma de onda arbitraria también se establece usando el comando FUNCtion:ARBitrary:SRATe.

Operaciones del panel frontal

Presione [Parameter] > Frequency ([Pardmetro] > Frecuencia). Utilice el teclado numérico o la perilla y las flechas
para establecer un valor deseado. Si utiliza el teclado, seleccione un prefijo de unidad para terminar.

KEYSIGHT
TECHNOLOGIES

SIN,50Q
FM Modulated by Sine

FM Dev 100 Hz

Amplitude  100.0 mVpp .,__FM Freq 10.000,000 Hz

Frequency 1 _

Offset +0.000V

Phase 0.0°

Comando SCPI
[SOURce[1]2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

El comando APPLy configura una forma de onda con un comando.

Modulacién de la forma de onda

En un instrumento de dos canales se puede modular un canal con el otro.
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No se puede modular el ruido con el ruido, PRBS con PRBS, o una forma de onda arbitraria con una forma de onda

arbitraria.
La forma de onda moduladora (fuente interna) puede ser:

- Onda sinusoidal

- Cuadrada con un ciclo de trabajo del 50 % |_|_|

- Tridngulo con 50 % de simetrl’a/\

- UpRamp (Rampa ascendente) con 100 % de simetria/]

- DnRamp (Rampa descendiente) con 0 % de simetria I\

- Ruido Ruido blanco gaussiano

- PRBS Secuencia de bits seudoaleatoria (polinomio PN7)

- Arb: forma de onda arbitraria

Operaciones del panel frontal

Pulse [Modulate] > Type AM ([Modular] > Tipo AM).

0

Presione [Modulate] > Type AM > Type FM ([Modular] > Tipo AM > Tipo FM).

Luego, elija la forma de modulacién: Presione Shape (Forma).

SIN,50Q
FM Modulated by Sine

. S Modu
Frequency 1.000,000,000 kHz EM Dev 100 Hz w(.) ur?;?

Amplitude 100.0 mVpp FM Freq 10.000,000 Hz | Type
- FI
Offset +0.000V

Phase 0.0°

Source

Internal

Comando SCPI

[SOURce[1l]|2]:]AM:INTernal :FUNCtion <function>

[SOURce[1]2]:]FM:INTernal :FUNCtion <function>
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Frecuencia de forma de onda de modulacion

Frecuencia de modulacién (fuente interna): el minimo es 1 uHz, y los valores méximos varfan segun la funcion.
Operaciones del panel frontal

Pulse [Modulate] > Type AM > AM Freq ([Modular] > Tipo AM > Frec. AM).

0

Presione [Modulate] > Type AM > Type FM > FM Freq ([Modular] > Tipo AM > Tipo FM> Frec. FM).

Luego introduzca la frecuencia AM o FM con la perilla y el teclado. Si utiliza el teclado, seleccione un prefijo de

unidad para terminar.

SIN,50Q
FM Modulated by Sine

Frequency 1.000,000,000 kHz EM Dev 100 Hz

Amplitude 100.0 mVpp I.__FM Freq 1

Offset +0.000V

Phase 0.0°

Comando SCPI

[SOURce[1]2]:]AM:INTernal:FREQuency {<frequency>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]FM:INTernal :FREQuency {<frequency>|MINimum|MAXimum|DEFault}

Profundidad de modulacién (AM)

La profundidad de modulacién es un porcentaje que representa la variacion de la amplitud. A una profundidad del
0 %, la amplitud es la mitad del ajuste de amplitud de la transportadora. A 100 % de profundidad, la amplitud varia
segun la forma de onda moduladora, de O % a 100 % de la amplitud de la transportadora.

- Profundidad de modulacién: 0 % a 120 %. La configuracion predeterminada es 100%.

- Incluso a més del 100 % de profundidad, el instrumento no excederd de +5 Vpeak en la salida (en una carga de 50
Q). Para lograr una profundidad de modulacion superior al 100 %, se puede reducir la amplitud de la transportadora
de salida.
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Operaciones del panel frontal

Presione [Modulate] > Type AM > AM Depth ((Modular] > Tipo AM > Profundidad AM). Utilice el teclado numérico o
la perilla y las flechas para establecer un valor deseado. Si utiliza el teclado, pulse Percent (Porcentaje) para
terminar.

KEYSIGHrT
TECHNOLOGIES
SIN,50Q

AM Modulated by Sine

AM Depth  50_

Frequency 1.000,000,000 kHz Percent
Amplitude 100.0 mVpp . AM Freq 100.000,000 Hz
Offset +0.000V

Phase 0.0°

Comando SCPI

[SOURce[1]2]:]AM[:DEPTh] {<depth in percent>|MINimum|MAXimum}

Transportadora suprimida de doble banda lateral AM

Elinstrumento admite dos formas de modulacion de amplitud, "Normal" y "Transportadora Suprimida de Doble
Banda Lateral" (DSSC). En la DSSC, la transportadora no esté presente a menos que la sefial moduladora tenga una
amplitud mayor que cero.

Operaciones del panel frontal

Pulse [Modulate] > Type AM > MORE 1 /2 > DSCC ON | OFF > DSCC ON | OFF ([Modular] > Tipo AM > MAS1/2>
DSCC Activado | Desactivado)> DSCC Activado | Desactivado).
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KEYSIGHT
TECHNOLOGIES

SIN,50Q
AM Modulated by Sine

Frequency 1.000,000,000 kHz

AM Depth  50.00 % Internal

- 0N OFF
Offset +0.000V

Phase 0.0°

Comando SCPI

[SOURce[1]2] :]AM:DSSC{ON|1|OFF |0}

Desviacion de frecuencia (FM)

La configuracion de desviacion de frecuencia representa la variacion pico entre la frecuencia de la forma de onda
modulada y la frecuencia de transportadora.

Cuando la transportadora es PRBS, la desviacion de frecuencia causa un cambio en la tasa de bits igual a la mitad
de la frecuencia establecida. Por ejemplo, una desviacién de 10 kHz equivale a un cambio de 5 KBPS en la velocidad
de bits.

- Desviacién de la frecuencia: 1 uHz a (frecuencia transportadora) / 2, por defecto 100 Hz.

- Para FM, la frecuencia transportadora debe ser siempre mayor que o igual a la desviacion de frecuencia. El intento
de establecer una desviacion mayor que la frecuencia transportadora hara que el instrumento establezca una
desviacion igual a la frecuencia transportadora.

- La frecuencia transportadora mas la desviacion no puede exceder la frecuencia méxima de la funcidn seleccionada
mas 100 kHz. Siintenta ajustar la desviacién a un valor no valido, el instrumento la ajusta al maximo valor permitido
con la frecuencia transportadora actual. La interfaz remota también genera un error de "Datos fuera de rango".

Operaciones del panel frontal

Presione [Modulate] > Type AM > Type FM > Freq Dev ((Modular] > Tipo AM > Tipo FM> Frec. Dev.). Utilice el
teclado numérico o la perilla y las flechas para establecer un valor deseado. Si utiliza el teclado, seleccione una
unidad de prefijo para terminar.
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KEYSIGHT
TECHNOLOGIES
SIN,50Q
FM Modulated by Sine

( uHz
FM Dev 1_

Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpp .,__FM Freq 1.000,000,000 kHz

Offset +0.000V

Phase 0.0°

Comando SCPI

[SOURce[1|2]:]FM[:DEViation] {<peak deviation in Hz>|MINimum|MAXimum|DEFault}

Fuente moduladora

En un instrumento de dos canales se puede modular un canal con el otro.
- Fuente moduladora: Internal (Interna) (por defecto) o Channel# (N.° de canal).

- Ejemplo AM: Con una profundidad de modulacion del 100 %, cuando la sefial de modulacion esté a +5 V, la salida
estard a la maxima amplitud. Cuando la sefial moduladora esté a -5 V, la salida serd de amplitud minima.

- Ejemplo FM: Con una desviacion de 10 kHz, entonces un nivel de sefial de +5 V corresponde a un aumento de 10
kHz en la frecuencia. Los niveles de sefial externa mas bajos producen menos desviacién y los niveles de sefial
negativa reducen la frecuencia por debajo de la frecuencia transportadora.

Operaciones del panel frontal

Después de habilitar el Tipo AM o el Tipo FM, seleccione la fuente de modulacién como se muestra: Presione MORE
1/2 > Source (MAS 1/2 > Fuente).
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KEYSIGHT
TECHNOLOGIES

SIN,50Q
AM Modulated by Sine

Frequency 1 .000,000,000 kHz AM Depth 50.00 % i ) Internal

Channel2

- ON""OFF

Offset +0.000V

Phase 0.0°

Comando SCPI
[SOURce[1]2]:]AM:SOURce {INTernal|CH1|CH2}

[SOURce[1]2]:]FM:SOURce {INTernal|CH1|CH2}

Modulacion de fase (PM)

Una forma de onda modulada consta de una forma de onda transportadora y una forma de onda de modulacion. PM
es muy similar a FM, pero en PM la fase de la forma de onda modulada varia por la tension instantdnea de la forma
de modulacion.

Para obtener mas informacion sobre los fundamentos de la modulacién de fase, consulte Modulacion.

Para seleccionar la modulacion de fase

- Solo se puede activar un modo de modulacién a la vez. Al activar el PM se desactiva el modo de modulacion
anterior.

- Al activar la PM se desactiva el barrido y la rafaga.

Operacion del panel frontal

Presione [Modulate] > Type AM > Type PM ([Modular] > Tipo AM > Tipo FM).

La forma de onda se emite utilizando la transportadora actual y modulando los ajustes de la forma de onda.

Para evitar multiples cambios en la forma de onda, habilite la modulacién después de configurar los demas
parametros de modulacion.

Comando SCPI

[SOURce[1]2]:]PM:STATe {ON|1|OFF |0}

112 Guia del usuario de la serie Keysight EDU33210



Forma de onda transportadora

Forma transportadora PM: Sinusoidal (por defecto), cuadrada, rampa, tridngulo, pulso, PRBS o arbitraria. No puede
usar Ruido o CC como forma de onda transportadora.

Operacion del panel frontal
Pulse [Waveform] ([Forma de onda] Luego, seleccione cualquier forma de onda excepto Ruido o CC.

Comando SCPI
[SOURce[1]2]:]FUNCtion <function>
El comando APPLy configura una forma de onda con un comando.

- Cuando la transportadora es una forma de onda arbitraria, la modulacion afecta al "reloj" de la muestra en lugar
del ciclo completo definido por el conjunto de la muestra de la forma de onda arbitraria. Por ello, la aplicacion de la
modulacidn de fase a formas de onda arbitrarias es limitada.

Frecuencia transportadora

La frecuencia méaxima de la transportadora varia segun la funcion, el modelo y la tension de salida, como se muestra
aqui. El valor por defecto es de 1 kHz para todas las funciones que no sean formas de onda arbitrarias. La frecuencia
transportadora debe ser mayor que 20 veces la frecuencia de modulacion maxima.

Operacion del panel frontal

Presione la tecla de frecuencia AM o FM o cualquier otra tecla de frecuencia. Utilice el teclado numérico o la perilla
y las flechas para establecer un valor deseado. Si utiliza el teclado, seleccione una unidad de prefijo para terminar.

Comando SCPI
[SOURce[1]2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

El comando APPLy configura una forma de onda con un comando.

Modulacién de la forma de onda

La forma de onda moduladora puede ser:

- Onda sinusoidal

- Cuadrada con un ciclo de trabajo del 50 % |_|_|

- Tridangulo con 50 % de simetrfa/\

- UpRamp (Rampa ascendente) con 100 % de simetrl’a/l

- DnRamp (Rampa descendiente) con 0 % de simetria I\
- Ruido Ruido blanco gaussiano

- PRBS Secuencia de bits seudoaleatoria (polinomio PN7)
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- Arb: forma de onda arbitraria

Puede usar el ruido como forma de onda moduladora, pero no puede usar el ruido o CC como forma de onda
transportadora.

Operacion del panel frontal

Presione [Modulate] > Type AM > Type PM > Shape Sine ([Modular] > Tipo AM > Tipo PM > Forma Sinusoidal).

SIN,50Q
PM Modulated by Sine

... S
Frequency 1.000,000,000 kHz Phase Dev 1800° o OFF

Amplitude 100.0 mVpp .,__PM Freq 1.000,000,000 kHz

Offset +0.000V

Phase 0.0°

Source

Internal

Comando SCPI

SCPI:[SOURce[1l]2]:]PM:INTernal:FUNCtion <function>

Frecuencia de forma de onda de modulacion

Frecuencia de modulacion: predeterminada 10 Hz, minima 1 pHz; la méxima varia segun el modelo, la funciony la
tension de salida, como se muestra aqui.

Operacion del panel frontal

Presione [Modulate] > Type AM > Type PM > PM Freq ([Modular] > Tipo AM > Tipo FM> Frec. FM).

Luego, establezca la frecuencia de la forma de onda moduladora con la perilla y el teclado. Si utiliza el teclado,
seleccione una unidad de prefijo para terminar.
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KEYSIGHT
TECHNOLOGIES
SIN,50Q
PM Modulated by Sine

Frequency 1 .000,000,000 kHz Phase Dev  180.0° uHz

Amplitude 100.0 mVpp I.__PM Freq 1

Offset +0.000V

Phase 0.0°

Comando SCPI

SCPI: [SOURce[1]|2]:]PM:INTernal:FREQuency{<frequency>|MINimum|MAXimum|DEFault}

Desviacidn de fase

La configuracion de desviacion de fase representa la variacion pico entre la fase de la forma de onda modulada y la
forma de onda transportadora. La desviacién de fase se puede establecer de O a 360 grados (por defecto 180).

Operacion del panel frontal

Pulse [Modulate] > Type AM > Type PM > Phase Dev ([Modular] > Tipo AM > Tipo PM > Desviacién de fase).

Luego, establezca la desviacion de fase con la perillay el teclado.

Comando SCPI
[SOURce[1]2]:]PM:DEViation {<deviation in degrees>|MINimum|MAXimum|DEFault}

Cuando la transportadora es una forma de onda arbitraria, la desviacion se aplica al reloj de muestra. Por lo tanto, el
efecto sobre la forma de onda arbitraria completa es mucho menor que el que se observa con las formas de onda
estandar. El alcance de la reduccion depende del nimero de puntos de la forma de onda arbitraria.

Fuente moduladora

Fuente moduladora: Internal (Interna) (por defecto) o Channel# (N.° de canal).
Operacion del panel frontal

Presione [Modulate] > Type AM > Type PM > Source ([Modular] > Teclee AM > Teclee PM > Fuente).
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KEYSIGHT
SIN,50Q ECHNOLOGIES
PM Modulated by Sine

Modulat
Frequency ~1.000,000,000 kHz ohase Dev  270.0° o OFF

Amplitude 100.0 mVpp .,__PM Freq 1.000,000,000 kHz
Offset +0.000V

Phase 0.0°

$ Internal Source

_ - Internal
Channel2

Comando SCPI

[SOURce[1]2]:]PM:SOURce {INTernal|CH1|CH2}

Modulacion de introduccién de cambios de frecuencia (FSK, Frequency-Shift Keying)

Puede configurar el instrumento para que su frecuencia de salida "cambie" entre dos valores preestablecidos
(denominados "frecuencia transportadora" y "frecuencia de salto") utilizando la Modulacién FSK. La velocidad a la
que la salida cambia entre estas dos frecuencias la determina el generador de velocidad interna o el nivel de la sefial
en el conector de disparo Ext Trig del panel frontal.

Consulte Operacion del menu del panel frontal - Emitir una forma de onda FSK para obtener detalles sobre el FSK
usando el panel frontal.

Para seleccionar modulacion FSK

- Solo se puede activar un modo de modulacion a la vez. Al activar la FSK se desactiva el modo de modulacion
anterior.

- No puede habilitar la FSK cuando el barrido o la rafaga estan activados. - Al activar la FSK se desactiva el barrido y
la réfaga.

- Para evitar multiples cambios en la forma de onda, habilite la modulacién después de configurar los demas
pardmetros de modulacion.

Comando SCPI

FSKey:STATe {OFF|ON}
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Frecuencia transportadora FSK

La frecuencia maxima de la transportadora varia segun la funcién, el modelo y la tension de salida, como se muestra
aqui. El valor por defecto es de 1 kHz para todas las funciones que no sean formas de onda arbitrarias.

Cuando se presenta un bajo ldgico, se emite la frecuencia transportadora. Con una légica alta, la frecuencia de salto
crea la salida.

Comando SCPI

[SOURce[1]2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

Frecuencia "de salto" de FSK

La frecuencia maxima alterna ("salto") depende de la funcidn. La frecuencia predeterminada para todas las
funciones es de 100 Hz. La forma de onda moduladora interna es una onda cuadrada de ciclo de trabajo del 50 %.

Funcion Frecuencia minima de salto Frecuencia maxima de salto
Sinusoidal 1 pHz 20 MHz
Cuadrada 1 pHz 10 MHz
Rampa/triangular 1 pHz 200 kHz
Pulso 1 pHz 10 MHz

Cuando se selecciona la fuente Externa, la frecuencia de salida se determina por el nivel de la sefial en el conector
Ext Trig del panel frontal. Cuando se presenta un bajo légico, se emite la frecuencia transportadora. Con una légica
alta, la frecuencia de salto crea la salida.

Comando SCPI

[SOURce[1]2]:]FSKey:FREQuency {<frequency>|MINimum|MAXimum|DEFault}

Velocidad de FSK

La velocidad de FSK es la velocidad a la que la frecuencia de salida "cambia" entre la frecuencia transportadora y la
frecuencia de salto utilizando la fuente FSK interna.

- Velocidad de FSK (fuente interna): 125 pHz hasta 1 MHz, por defecto 10 Hz.

- La velocidad de FSK se ignora cuando se selecciona la fuente externa de FSK.

Comando SCPI

[SOURce[1|2]:]FSKey:INTernal :RATE {<rate in Hz>|MINimum|MAXimum}

Fuente FSK

Puede ser Interno (por defecto) o Externo.
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- Cuando se selecciona la fuente interna, la velocidad a la que la frecuencia de salida "cambia" entre la frecuencia
transportadora y la frecuencia de salto esta determinada por la velocidad de FSK. La forma de onda moduladora
interna es una onda cuadrada de ciclo de trabajo del 50 %.

- Cuando se selecciona la fuente Externa, la frecuencia de salida se determina por el nivel de la sefial en el conector
Ext Trig del panel frontal. Cuando se presenta un bajo légico, se emite la frecuencia transportadora. Con una légica
alta, la frecuencia de salto crea la salida.

- El conector utilizado para las formas de onda FSK controladas externamente (Ext Trig) no es el mismo conector
gue se utiliza para las formas de onda AM, FM, PM y PWM (Modulation In) moduladas externamente. Cuando se usa
para FSK, el conector Ext Trig no tiene polaridad de borde ajustable.

Comando SCPI

[SOURce[1]2]:]FSKey:S0OURce {INTernal |EXTernal}

Modulaciéon de amplitud de pulso (PWM)

Esta seccion trata sobre PWM, que significa modulacion de amplitud de pulso. PWM solo esté disponible para la
forma de onda de pulso, y la amplitud de pulso varia segun la sefial de modulacién. La cantidad en que varia la
amplitud de pulso se denomina desviacion de amplitud, y puede especificarse como un porcentaje del periodo de la
forma de onda (es decir, el ciclo de trabajo) o en unidades de tiempo. Por ejemplo, si se especifica un pulso con un
20 % de ciclo de trabajo y luego se activa PWM con un 5 % de desviacion, el ciclo de trabajo varia entre el 15 % y el
25 % bajo el control de la sefial moduladora.

Para seleccionar PWM

- No puede habilitar la PWM cuando el barrido o la réfaga estan activados.

Para evitar multiples cambios en la forma de onda, habilite la modulacién después de configurar los demas
pardametros de modulacion.

Operaciones del panel frontal

1. Pulse [Waveform] > Pulse ([Forma de onda] > Pulso).
2. Presione [Modulate] > Type AM > Type PWM ([Modular] > Tipo AM > Tipo FM).
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3. Pulse Modulate ON | OFF > Modulate ON | OFF (Modular Activado | Desactivado > Modular Activado | Desactivado).

PULS,50Q
PWM Modulated by Sine

Frequency 1.000,000,000 kHz PWM Dev  0.000,000,000s ’

Amplitude  100.0 mVpp '.._PWM Freq 10.000,000 Hz
Offset +0.000V

Phase 0.0°
Pulse Width 10.000,0 ps
Lead Edge 4.0ns

Trail Edge 4.0 ns

La forma de onda se emite utilizando la transportadora actual y modulando los ajustes de la forma de onda.

Comando SCPI

[SOURce[1]2]:]PWM:STATe {ON|1|OFF|O0}

Modulacién de la forma de onda

La forma de onda moduladora (fuente interna) puede ser:

- Onda sinusoidal

- Cuadrada con un ciclo de trabajo del 50 % |_|_|

- Tridngulo con 50 % de simetria/\

- UpRamp (Rampa ascendente) con 100 % de simetrl’a/l

- DnRamp (Rampa descendiente) con 0 % de simetria I\
- Ruido Ruido blanco gaussiano
- PRBS Secuencia de bits seudoaleatoria (polinomio PN7)

- Arb: forma de onda arbitraria
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Operaciones del panel frontal

1. Pulse [Waveform] > Pulse ([Forma de onda] > Pulso).
2. Presione [Modulate] > Type PWM > Shape Sine ([Modular] > Tipo PWM > Forma Sinusoidal).

KEYSIGHT
PULS,50Q o
PWM Modulated by Sine

P Modulate S Modulate
PWM Dev  0.000,000,000 s ON""OFF

Amplitude 100.0 mVpp .,__PWM Freq 10.000,000 Hz

Frequency 1.000,000,000 kHz

Type
Py ﬂ
Offset +0.000V

Py

Dev
Phase 0.0°

Pulse Width 10.000,0 ps : e Y
8 Freq

Lead Edge 4.0ns

Trail Edge 4.0ns . Sbape

INe

Source

Internal

Comando SCPI

[SOURce[1]|2]:]PWM: INTernal :FUNCtion <function>

Frecuencia de forma de onda de modulacién

Frecuencia de modulacién: El valor por defecto es 10 Hz, y el minimo es 1 uHz. La frecuencia maxima varfa segun la
funcion, el modelo y la tensidn de salida, como se muestra aqui.
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Operaciones del panel frontal

. Pulse [Waveform] > Pulse ([Forma de onda] > Pulso).
. Pulse [Modulate] > Type PWM > PWM Freq ((Modular] > Tipo AM > Frec. AM).

Utilice el teclado numérico o la perilla y las flechas para establecer un valor deseado. Si utiliza el teclado, seleccione
una unidad de prefijo para terminar.

KEYSIGHT
PULS,50Q ECHNOLOGIES
PWM Modulated by Sine

i} H
PWM Dev  0.000,000,000 s .

Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpp I.__PWM Freq 1_

Offset +0.000V

Phase 0.0°

Pulse Width 10.000,0 ps
Lead Edge 4.0ns

Trail Edge 4.0 ns

Comando SCPI

[SOURce[1]2]:]PWM: INTernal:FREQuency {<frequency>|MINimum|MAXimum|DEFault}

Desviacion de la amplitud o del ciclo de trabajo

El ajuste de la desviacion PWM es el pico de variacion en la amplitud de la forma de onda del pulso modulado.
Puede configurarlo en unidades de tiempo o ciclo de trabajo.

Operaciones del panel frontal

. Pulse [Waveform] > Pulse ([Forma de onda] > Pulso).

. Presione [Modulate] > Type PWM > PWM Dev ([Modular] > Tipo PWM > Dev PWM). Utilice el teclado numérico o la
perillay las flechas para establecer un valor deseado. Si utiliza el teclado, seleccione una unidad de prefijo para ter-
minar.

Para establecer la desviacion en términos de ciclo de trabajo:

. Pulse [Units] >Width Duty Cyc > Width Duty Cyc ([Unidades] > Amplitud Ciclo de Trabajo > Ciclo de Trabajo).
. Pulse [Modulate] > Duty Cycle ((Modular] > Ciclo de trabajo). Utilice el teclado numérico o la perilla y las flechas
para establecer un valor deseado. Si utiliza el teclado, pulse Percent (Porcentaje) para terminar.

Guia del usuario de la serie Keysight EDU33210 121



Comando SCPI
[SOURce[1l]2]:]PWM:DEViation {<deviation>|MINimum|MAXimum|DEFault}
- La suma de la amplitud de pulso y la desviacién debe satisfacer la formula:

Amplitud de pulso + Desviacion < Periodo - 16 ns

- Sies necesario, el instrumento ajustard la desviacion para acomodarse al periodo especificado.

Fuente moduladora

Fuente moduladora: Internal (Interna) (por defecto) o Channel# (N.° de canal).
Operaciones del panel frontal

1. Pulse [Waveform] > Pulse ([Forma de onda] > Pulso).
2. Pulse [Modulate] > Type PWM > Source ([Modular] > Tipo PWM > Fuente).

PULS,50Q
PWM Modulated by Sine

— Oy Modulate

Frequency 1.000,000,000 kHz PWM Dev  1.000,000,000's OO

Amplitude 100.0 mVpp .,__PWM Freq 500.000,000 Hz

Offset +0.000V

Phase 0.0°

Pulse Width 10.000,0 ps
Lead Edge 4.0ns

Trail Edge 4.0 ns

® Internal Source
. - Internal
Channel2

Comando SCPI

[SOURce[1]2]:]PWM:SOURce {INTernal|CH1l|CH2}

Forma de onda de pulso

El pulso es la Unica forma de onda admitida para PWM.
Operaciones del panel frontal

Pulse [Waveform] > Pulse ([Forma de onda] > Pulso).
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Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Pulse Width 10.000,0 ps
Lead Edge 4.0ns

Trail Edge 4.0 ns

Comando SCPI
FUNCtion PULSe

El comando APPLy configura una forma de onda con un comando.

Perfodo de pulso

KEYSIGHT
TECHNOLOGIES
Parameter

Frequency

Amplitude

Dffset

Phase
~-

Pulse
Width

Edge
~5-

El rango del periodo de pulso va desde el reciproco de la frecuencia méaxima del instrumento hasta 1.000.000 s (por

defecto 100 us). Tenga en cuenta que el periodo de la forma de onda limita la méxima desviacion.

Operaciones del panel frontal

1. Pulse [Waveform] > Pulse ([Forma de onda] > Pulso).

2. Pulse Frequency Periodic > Frequency Periodic ([Unidades] > Frecuencia Periddica > Frecuencia Periédica).

Period 0.000100 s
Amplitude  (0.700000 Vpp

Offset 0.000000 V
Phase 0.000000
Pulse Width 0.000010 s

Lead Edge 0.000000 s
Trail Edge 0.000000 s

Guia del usuario de la serie Keysight EDU33210

KEYSIGHT
TECHNOLOGIES

Units
Amp/0ffs <

High/Low

Amplitude
Vor

Phase
Degrees

Sweep
StrtStop

Frequency
Periodic ]
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Comando SCPI

[SOURce[1]2]:]FUNCtion:PULSe:PERiod {<seconds>|MINimum|MAXimum|DEFault}

Modulaciédn de suma

La modulacion de suma afiade una sefial moduladora a cualquier forma de onda transportadora. Generalmente, se
utiliza para afiadir ruido gaussiano a una transportadora. La sefial moduladora se afiade a la transportadora como
un porcentaje de la amplitud de la forma de onda de la transportadora.

Habilitar la suma

Para evitar multiples cambios en la forma de onda, habilite Sum (Suma) después de configurar otros pardmetros de
modulacion.

Operaciones del panel frontal

1. Presione [Modulate] > Type AM > Type Sum ([Modular] > Tipo AM > Tipo SUMA).
2. Pulse Modulate ON | OFF > Modulate ON | OFF (Modular Activado | Desactivado > Modular Activado | Desactivado).

KEYSIGHT
PULS,50Q ECHNOLOGIES
Sum Modulated by Sine

Modulate
Period 100.000 ps sum Ampl  100.0 m% ON'" " OFF

Amplitude 100.0 mVpp l.-—Sum Freq  100.000,000 Hz -
Sum
Offset +0.000V
Sum

Ampl
Phase 0.0° -

Freq

Lead Edge 4.0ns

Pulse Width 10.000,0 ps ‘ ‘ ‘ ‘ ’ ‘ ‘ ’ Sum

Trail Edge 4.0 ns

Source

Internal

Comando SCPI
[SOURce[1]2]:]SUM:STATe {ON|1|OFF |0}
Modulacién de la forma de onda

En un instrumento de dos canales se puede modular un canal con el otro.
La forma de onda moduladora puede ser:

- Onda sinusoidal
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- Cuadrada con un ciclo de trabajo del 50 % |_|_|
- Tridngulo con 50 % de simetria/\
- UpRamp (Rampa ascendente) con 100 % de simetrfa/]

- DnRamp (Rampa descendiente) con 0 % de simetria I\
- Ruido Ruido blanco gaussiano
- PRBS Secuencia de bits seudoaleatoria (polinomio PN7)

- Arb: forma de onda arbitraria
Operaciones del panel frontal

Presione [Modulate] > Type Sum > Shape Sine ([Modular] > Tipo Suma > Forma Sinusoidal).

KEYSIGHT
SIN,50Q ECHNOLOGIES
Sum Modulated by Sine oo
— Oy Modulate

Frequency 1.000,000,000 kHz Sum Ampl  100.0 m% 0K OFF

Amplitude 100.0 mVpp l.-—Sum Freq  100.000,000 Hz

Type
Sum
Offset +0.000V

Sum
Ampl
Phase 0.0°

Sum
Freq

Source

Internal

Comando SCPI

[SOURce[1]2]:]1SUM: INTernal :FUNCtion <function>

Frecuencia de forma de onda de modulacion

En un instrumento de dos canales se puede modular un canal con el otro.

Frecuencia de modulacion: El valor por defecto es 100 Hz y el minimo es 1 pHz.
Operaciones del panel frontal

Pulse [Modulate] > Type Sum > Sum Freq. ((Modular] > Tipo Suma > Frec. Suma).

Utilice el teclado numérico o la perilla y las flechas para establecer un valor deseado. Si utiliza el teclado, seleccione
una unidad de prefijo para terminar.

Guia del usuario de la serie Keysight EDU33210 125



KEYSIGHT
TECHNOLOGIES
SIN,50Q
Sum Modulated by Sine

] H
Sum Ampl  100.0 m% e

Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpp I.__Sum Freq 1_

Offset +0.000V

Phase 0.0°

Comando SCPI

[SOURce[1]2]:]SUM:INTernal:FREQuency {<frequency>|MINimum|MAXimum|DEFault}

Amplitud de suma

La amplitud de la suma representa la amplitud de la sefial afiadida a la transportadora (en porcentaje de la amplitud
de la transportadora).

- Configuracion de la amplitud: 0 a 100 % de la amplitud de la transportadora, 0.01 % de resolucion.

- La amplitud de la suma sigue siendo una fraccidn constante de la amplitud de la transportadora y sigue los
cambios de amplitud de la transportadora.

Operaciones del panel frontal

Pulse [Modulate] > Type Sum > Sum Ampl ((Modular] > Tipo Suma > Suma Ampl).

Utilice el teclado numérico o la perilla y las flechas para establecer un valor deseado. Si utiliza el teclado, pulse
Percent (Porcentaje) para terminar.
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SIN,50Q
Sum Modulated by Sine

Frequency 1.000,000,000 kHz
Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Comando SCPI

KEYSIGHT

TECHNOLOGIES

- Percent
Sum Ampl 10_

Sum Freq  500.000,000 Hz

[SOURce[1]2]:]SUM:AMPLitude {<amplitude>|MINimum|MAXimum|DEFault}

Fuente moduladora

En un instrumento de dos canales se puede modular un canal con el otro.

Fuente moduladora: Internal (Interna) (por defecto) o Channel# (N.° de canal).

Operaciones del panel frontal

Presione [Modulate] > Type Sum > Source ([Modular] > Tipo Suma > Fuente).

SIN,50Q
Sum Modulated by Sine

Frequency 1.000,000,000 kHz
Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

KEYSIGHT

) Modulate
Sum Ampl 10.00 % OM" " OFF
Sum Freq  500.000,000 Hz T

ype

Sum

Sum
Ampl

Sum
Freq

Shape

Sine

# Internal Source

[nterna

Channel2
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Comando SCPI

[SOURce[1]|2]:]1SUM:SOURce {INTernal|CH1|CH2}

Barrido de frecuencia

En el modo de barrido de frecuencia, el instrumento se mueve desde la frecuencia de inicio a la frecuencia de parada
a una velocidad de barrido especificada. Se puede barrer la frecuencia hacia arriba o hacia abajo con espaciado
lineal o logaritmico. También puede configurar el instrumento para que genere un barrido desde la frecuencia de
inicio a la frecuencia de parada aplicando un disparador externo o manual. El instrumento puede barrer formas de
onda sinusoidales, cuadradas, de pulso, de rampa, triangulares o arbitrarias (no se permiten PRBS, ruido y CC).

Se puede especificar un tiempo de retencidn, durante el cual el barrido permanece en la frecuencia de parada, y un
tiempo de retorno, durante el cual la frecuencia cambia linealmente de la frecuencia de parada a la frecuencia de
inicio.

Para obtener mas informacién, consulte Barrido de frecuencia.

Para seleccionar barrido

Elinstrumento no permitird que se habilite el modo de barrido o de lista al mismo tiempo que se habilita el modo de
rafaga o cualquier modo de modulacién. Cuando se activa el barrido, se desactiva el modo de rafaga o modulacion.

Para evitar multiples cambios de forma de onda, habilite el modo de barrido después de configurar los demas
parametros.

Operaciones del panel frontal

Pulse [Sweep] > Sweep ON | OFF> Sweep ON | OFF ([Barrido] > Barrido Activado | Desactivado > Barrido Activado |
Desactivado).

SIN,50Q

Linear Sweep, Trig Imm

Frequency Sweeping... StartFreq  100000000Hz | ——

Amplitude 100.0 mVpp Stop Freq  1.000,000,000 kHz s
Sweep Time 1.000 s Linear
Offset +0.000V Hold Time 0.000's

Sweep

Return Time 0.000 s Time

Phase 0.0°
Start

Freq

Stop
Freq

Hold Return
~-

Comando SCPI

[SOURce[1]2]:]FREQuency:MODE SWEEP
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[SOURce[1]|2] :]SWEep:STATe {ON|1|OFF|0}

Frecuencia de inicio y frecuencia de detencion

La frecuencia de inicio y la frecuencia de parada establecen los limites de frecuencia superior e inferior del barrido.
El barrido comienza en la frecuencia de inicio, barre hasta la frecuencia de detencién y luego regresa a la de inicio.

- Frecuencias de inicio y parada: 1 pHz a la frecuencia maxima para la forma de onda. El barrido es de fase continua
en todo el rango de frecuencias. La frecuencia de inicio predeterminada es 100 Hz. La frecuencia de detencion
predeterminada es 1 kHz.

- Para barrer la frecuencia hacia arriba, configure la frecuencia de inicio de manera inferior a la frecuencia de
detencion. Para barrer la frecuencia hacia abajo, configure la relacién opuesta.

- Ajuste de sincronizacién Normal: El pulso de sincronizacién es alto en todo el barrido.

- Ajuste de sincronizacion Transportadora: El pulso de sincronizacidn tiene un ciclo de trabajo del 50 % por cada
ciclo de forma de onda.

- Ajuste de sincronizacion Marcador: El pulso de sincronizacion sube al principio y baja en la frecuencia del
marcador. Puede cambiar esto con OUTPut[1]2]:SYNC:MODEMARKER.

Operaciones del panel frontal

Presione [Sweep] > Start Freq ([Barrido] > Iniciar Frecuencia)

Utilice el teclado numérico o la perillay las flechas para establecer un valor deseado. Si utiliza el teclado, seleccione
una unidad de prefijo para terminar.

SIN,500Q

Linear Sweep, Trig Imm

Start Freq 1_

Frequency Sweeping...

Amplitude 100.0 mVpp Stop Freq  1.000,000,000 kHz
Sweep Time 1.000 s

Hold Time 0.000s
Return Time 0.000 s

Offset +0.000V

Phase 0.0°

Presione Stop Freq (Detener Frec.).

Utilice el teclado numérico o la perilla y las flechas para establecer un valor deseado. Si utiliza el teclado, seleccione
una unidad de prefijo para terminar.
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KEYSIGHT
SIN,500Q ECHNOLOGIES

Linear Sweep, Trig Imm
Start Freq  1.000,000,000 kHz

Amplitude 100.0 mVpp Stop Freq 2
Sweep Time 1.000 s

Hold Time 0.000s

Frequency Sweeping...

Offset +0.000V

Return Time 0.000 s

Phase 0.0°

Comando SCPI

[SOURce[1]2]:]FREQuency:STARt {<frequency>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]FREQuency:STOP {<frequency>|MINimum|MAXimum|DEFault}

Frecuencia central e intervalo de frecuencia

También puede establecer los limites de la frecuencia de barrido del barrido utilizando una frecuencia central y un
intervalo de frecuencia. Estos pardmetros son similares a la frecuencia de inicio y de parada (arriba) y proporcionan
una mayor flexibilidad.

- Frecuencia central: 1 pHz a la frecuencia maxima para la forma de onda. El valor por defecto es 550 Hz.

- Intervalo de frecuencia: Cualquier valor entre frecuencia tmaxima para la forma de onda. El valor por defecto es
900 Hz.

- Para barrer la frecuencia hacia arriba, establezca un intervalo de frecuencia positivo; para barrer hacia abajo,
establezca un intervalo de frecuencia negativo.

- Ajuste de sincronizacion Normal: El pulso de sincronizacion es alto en todo el barrido.

- Ajuste de sincronizacion Transportadora: El pulso de sincronizacion tiene un ciclo de trabajo del 50 % por cada
ciclo de forma de onda.

- Ajuste de sincronizacion Marcador: El pulso de sincronizacion sube al principio y baja en la frecuencia del
marcador. Puede cambiar esto con OUTPut[1|2]:SYNC:MODEMARKER.
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1.

Operaciones del panel frontal

Frequency

Amplitude

Offset

Phase

Pulse [Units] > Sweep StrtStop([Unidades] > Barrido Inicio/Parada.

1000.000000 Hz
0.100000 Vpp

0.000000 V
0.000000

KEYSIGHT

TECHNOLOGIES

High/Low

Amplitude
Vop

2. Pulse [Sweep] > Start Freq o Stop Freq.([Barrido] > Frecuencia de inicio o Frecuencia de parada). Utilice el teclado
numérico o la perilla y las flechas para establecer un valor deseado. Si utiliza el teclado, seleccione una unidad de
prefijo para terminar.

0

1. Pulse [Units] > Sweep CntrSpan ([Unidades] > Barrido Centro/Intervalo).

Frequency 1000.000000 Hz
Amplitude  0.700000 Vpp AmplOffs 4
Offset 0.000000 V High/Low

Phase 0.000000 Amplitude
Vop

Phase

Degrees

Sweep
CntrSpan

2. Presione [Sweep] > Center o Span ([Barrido] > Centro o Intervalo). Utilice el teclado numérico o la perilla y las fle-
chas para establecer un valor deseado. Si utiliza el teclado, seleccione una unidad de prefijo para terminar.
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Comando SCPI

[SOURce[1]2]:]1FREQuency:CENTer {<frequency>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]FREQuency:SPAN {<frequency>|MINimum|MAXimum|DEFault}

Modo de barrido

Puede realizar un barrido con un espaciado lineal o logaritmico, o con una lista de frecuencias de barrido. Para un
barrido lineal, el instrumento varia la frecuencia de salida linealmente durante el barrido. Un barrido logaritmico
varfa la frecuencia de salida de forma logaritmica.

El modo seleccionado no afecta al retorno del barrido (desde la parada hasta el inicio, si esté configurado).
Operaciones del panel frontal

Presione [Sweep] > Type Linear([Barrido] > Tipo Lineal).

SIN,50Q

Linear Sweep, Trig Imm

Frequency Sweeping... Center 0.000,000 Hz

Amplitude  100.0 mVpp Span 0.000000Hz  rypwey
Sweep Time 1.000 s Log
Offset +0.000 V Hold Time 0.000's

List

Return Time 0.000 s ’

Phase 0.0°

Span

Hold Return
~-

Comando SCPI

[SOURce[1]2]:]SWEep:SPACing {LINear|LOGarithmic}

Tiempo de barrido

El tiempo de barrido especifica la cantidad de segundos necesaria para barrer desde la frecuencia de inicio hasta la
de detencidn. Elinstrumento calcula el nimero de puntos del barrido basandose en el tiempo de barrido.

Tiempo de barrido: T ms a 250.000 segundos, por defecto 1 s. Para un barrido lineal en el modo de disparo
inmediato, el tiempo total méximo de barrido (incluyendo el tiempo de retencién y el tiempo de retorno) es de 8.000
s. El tiempo total maximo de barrido para los barridos lineales que utilizan otros modos de disparo es de 250.000 s;
el tiempo total méximo de barrido para los barridos logaritmicos es de 500 s.
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Operaciones del panel frontal

Pulse [Sweep] > Sweep Time ([Barrido] > Tiempo de barrido). Utilice el teclado numérico o la perilla y las flechas
para establecer un valor deseado. Si utiliza el teclado, seleccione una unidad de prefijo para terminar.

SIN,500Q

Linear Sweep, Trig Imm

Frequency Sweeping... ‘ Center 0'000’000 Hz

Amplitude 100.0 mVpp Span 0.000,000 Hz
Sweep Time 1_

seconds

Offset +0.000 V Hold Time 0.000s

Phase 0.0° IhReturn Time 0.000 s

Comando SCPI

[SOURce[1]2]:]SWEep:TIME {<seconds>|MINimum|MAXimum|DEFault}

Tiempo de retencion/retorno

Eltiempo de retencion especifica el tiempo (en segundos) para permanecer en la frecuencia de parada, y el tiempo
de retorno especifica el nimero de segundos para volver de la frecuencia de parada a la frecuencia de inicio.

Tiempo de retencién y de retorno: 0 a 3600 segundos (por defecto 0).
Operaciones del panel frontal

Presione [Sweep] > Hold Return > Hold Time o Return Time ([Barrido] > Retencién Retorno> Tiempo de retencion o
Tiempo de Retorno). Utilice el teclado numérico o la perilla y las flechas para establecer un valor deseado. Si utiliza
el teclado, seleccione una unidad de prefijo para terminar.
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SIN,500Q

Linear Sweep, Trig Imm

Frequency Sweeplng... Center 0'000’000 Hz

Amplitude 100.0 mVpp Span 0.000,000 Hz
Sweep Time 1 ms
Offset +0.000V Hold Time 1

seconds

Phase 0.0° Il‘_Return Time 0.000's

Comando SCPI

[SOURce[1]2]:]SWEep:HTIMe {<hold time>|MINimum|MAXimum|DEFault}

[SOURce[1]2]:]SWEep:RTIMe {<return time>|MINimum|MAXimum|DEFault}

Frecuencia del marcador

Si lo desea, puede establecer la frecuencia a la que la sefial del conector Sync Out del panel frontal pasa a un nivel
légico bajo durante el barrido. La sefial de sincronizacidn siempre va de bajo a alto al principio del barrido.

- Frecuencia del marcador: 1 uHz a la frecuencia méaxima para la forma de onda. El valor por defecto es 500 Hz.

- Cuando se activa el modo de barrido, la frecuencia del marcador debe estar entre la frecuencia de inicio y la
frecuencia de parada especificadas. Si intenta establecer la frecuencia del marcador a una frecuencia que no esté
en este rango, el instrumento establecerd la frecuencia del marcador igual a la frecuencia de inicio o de parada (la
que esté mas cerca).

- No puede configurar la frecuencia del marcador con los menus del panel frontal a menos que la fuente de
sincronizacion sea el canal de barrido.

Operaciones del panel frontal

1. Pulse [Sweep] > Sweep ON | OFF > Sweep ON | OFF ([Barrido] > Barrido Activado | Desactivado > Barrido Activado |
Desactivado).

2. Pulse [Trigger] > Sync ON | OFF > Sync Setup ([Disparo] > Sinc. Activada | Desactivada o Configuracién de Sinc.).

3. Seleccione Mode Marker (Modo marcador).
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4. Seleccione Marker Freq. (Frecuencia del marcador). Utilice el teclado numérico o la perilla y las flechas para esta-
blecer un valor deseado. Si utiliza el teclado, seleccione una unidad de prefijo para terminar.

KEYSIGHT
TECHNOLOGIES

SIN,50Q

Linear Sweep, Trig Imm

Frequency Sweeping... Center 550.000,000 Hz

Amplitude 100.0 mVpp Span 900.000,000 Hz
Sweep Time 1 ms

Hold Time 1_
Return Time 0.000 s

seconds

Offset +0.000V

Phase 0.0°

Comando SCPI

[SOURce[1]2]:]MARKer:FREQuency {<frequency>|MINimum|MAXimum|DEFault}

Fuente de disparo de barrido

En modo de barrido, el instrumento genera un solo barrido al recibir una sefial de disparo. Después de un barrido
desde la frecuencia de inicio a la frecuencia de parada, el instrumento espera al siguiente disparo mientras emite la
frecuencia de inicio.

- Fuente del disparo de barrido: Immediate (por defecto), External, Time o Manual (Inmediato, Externo, Tiempo o
Manual).

- Con la fuente Inmediata (interna), el instrumento produce un barrido continuo a una velocidad determinada por el
total del tiempo de retencidn, el tiempo de barrido y el tiempo de retorno. El tiempo de barrido de esta fuente esta
limitado a 8000 segundos.

- Con la fuente Externa, el instrumento acepta un disparo de hardware en el conector Ext Trig del panel frontal e
inicia un barrido cada vez que el Ext Trig recibe un pulso TTL con la polaridad especificada.

- El periodo de activacion debe ser mayor o igual al tiempo de barrido especificado.

- Con la fuente Manual, el instrumento da un barrido cada vez que se pulsa la tecla [Trigger] (Disparo) del panel
frontal.

Operaciones del panel frontal

Presione [Trigger] > Source ([Disparo] > Fuente).
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KEYSIGHT
sIN,SOQ TECHNOLOGIES
Linear Sweep, Trig Timer Trigaer
. —EET————————  Immediate Source
Frequency Sweeplng... Center 0.000,000 Hz| Timer
Amplitude 100.0 mVpp 2 0.000,000 Hz ~ Manual Trigger Setup

Sweep Time 1 ms -
Hold Ti d
old Time 1.000s Trig Out Setup

Return Time 0.000 s -

Offset +0.000V

Phase 0.0°

Sync
0N OFF

Sync Setup
~9-

Para especificar la pendiente del borde de la sefial de disparo: Pulse [Trigger] > Trig Out Setup > Trig Out Off | (Up) |
(Down) ([Disparo] > Configuracion de salida de disparo > Salida de disparo Desactivada | (Arriba) | (Abajo).

KEYSIGHT
SIN,50Q ECHNOLOGIES
Linear Sweep, Trig Timer -
: — Ty Source
Frequency Sweeping... i 0,000,000 Hz M

Amplitude 100.0 mVpp Span 0.000,000 Hz T
Sweep Time 1 ms off "1 L

Hold Time 1.000s
Return Time 0.000 s

Offset +0.000V

Phase 0.0°

Comando SCPI

TRIGger[1]|2] :SOURce {IMMediate|EXTernal|TIMer |BUS}
TRIGger[1|2] :SLOPe {POSitive|NEGative}

Consulte Disparo para obtener mas informacion.

Sefial de salida de disparo

Consulte Sefial de salida de disparo para obtener mas detalles.
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Operaciones del panel frontal

Para especificar si el instrumento se dispara en el borde ascendente o descendente del conector Sync Outn, pulse
[Trigger] > Trig Out Setup ([Disparo] > Configuracion de salida de disparo). A continuacion, seleccione el borde
deseado pulsando Trig Out (Salida de disparo).

KEYSIGHT
SIN,500Q ECHNOLOGIES

Linear Sweep, Trig Timer Trigger

. Source
Frequency Sweeping... . 0.000,000 Hz CH1 "CH2

Amplitude  100.0 mVpp Span 0.000,000 Hz Trig Out
Sweep Time 1 ms off Tty

Hold Time 1.000s
Return Time 0.000 s

Offset +0.000V

Phase 0.0°

Comando SCPI

OUTPut:TRIGger:SLOPe {POSitive|NEGative}

OUTPut:TRIGger {ON|1|OFF|0}

Lista de frecuencias

En el modo de lista de frecuencias, el instrumento "pasa" a través de una lista de frecuencias, deteniéndose en cada
una de ellas durante un periodo determinado. También puede controlar el progreso a través de la lista con el
disparo.

- Elinstrumento no permitira que se habilite el modo de barrido o de lista al mismo tiempo que se habilita el modo
de rafaga o cualquier modo de modulacién. Cuando se activa el barrido, se desactiva el modo de rafaga o
modulacion.

- Para evitar multiples cambios de forma de onda, habilite el modo de lista después de configurar los demas
parametros.

Operaciones del panel frontal

Habilite la lista antes de establecer cualquier otro parametro de la lista. Presione [Sweep] > Type Linear > Type List
([Barrido] » Tipo Lineal > Tipo Lista).
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KEYSIGHT
TECHNOLOGIES

SIN,500Q

List Sweep, Trig Imm

ep

— Ty Sweep
Dwell Time 1.000s ON""OFF

Frequency Sweeping...
Amplitude 100.0 mVpp » Type

List
Offset +0.000 V

Duvell

Phase 0.0° i

View List
~-

Select
List

Save
List

Seleccione View List (Ver lista) para ver los pardmetros de la lista. Puede editar el valor de frecuencia (Edit Freqg) en
la lista de barrido, afiadir (Add Freq) o eliminar (Delete Freq) un valor de frecuencia y reordenar la lista de barrido
(Reorder List).

KEYSIGHT
TECHNOLOGIES

SIN,500Q Are

List Sweep, X -
Sweep Frequency List Sweep

Frequency S 1 100.000000 Hz Edit Freq
2 1000.000000 Hz

Amplitude 1
3 550.000000 Hz

Offset +

Phase

Add Freq

Delete Freq

Reorder List
~-

Sitiene una unidad flash USB externa conectada, pulse Save List (Guardar lista) para guardar la lista de barrido en
la unidad flash USB externa.

Para recuperar una lista de barrido previamente guardada de la unidad flash USB externa conectada, pulse Select
List (Seleccionar lista).

Comando SCPI

[SOURcdA[1]2] :]FREQuency:MODE LIST

[SOURce[1]2]:]LIST:FREQuency <freqgl>[, <freg2>, etc.]
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El progreso a través de la lista estd controlado por el sistema de disparo. Si la fuente de disparo es interna o
inmediata, la configuracion del tiempo de permanencia (LIST:DWELL) determina el tiempo de permanencia en cada
frecuencia. Para cualquier otra fuente de activacion, el tiempo de permanencia esta determinado por el
espaciamiento de los eventos de activacion.

Modo Burst (rafaga)

Elinstrumento puede emitir una forma de onda durante un nimero determinado de ciclos, llamado rafaga. Se
permite la rafaga con formas de onda sinusoidales, cuadradas, triangulares, de rampa, de pulso, PRBS o arbitrarias
(el ruido solo se permite en el modo de rafaga cerrada; no se permite CC).

Para ver mas detalles, consulte Rafaga.

Para seleccionar la rafaga

No se puede activar la rafaga cuando se activa el barrido o la modulacién. Al activar la rafaga se desactiva el barrido
y la modulacion.

Para evitar multiples cambios de forma de onda, habilite el modo rafaga después de configurar otros parametros.
Operaciones del panel frontal

Pulse [Burst] > Burst ON | OFF > Burst ON | OFF ([Rafaga] > Réfaga Activado | Desactivado > Rafaga Activado |
Desactivado).

Comando SCPI
[SOURce[1]2]:]BURSt:STATe {ON|1|OFF|0}
Modo Burst (rafaga)

La rafaga tiene dos modos, descritos a continuacidn. El modo seleccionado controla la fuente de disparo permitiday
qué otros parametros de rafaga se aplican.

- Modo de réfaga disparada (predeterminado): El instrumento emite una forma de onda para un nimero de ciclo
especificado (recuento de rafagas) cada vez que se recibe un disparo. Después de emitir un nimero determinado de
ciclos, el instrumento se detiene y espera al siguiente disparo. El instrumento puede utilizar un disparo interno para
iniciar la réfaga, o puede proporcionar un disparo externo pulsando la tecla [Trigger] (Disparo) del panel frontal,
aplicando la sefial de disparo al conector Ext Trig del panel frontal, o enviando el comando de disparo del software
desde la interfaz remota.

- Modo de réfaga de admisién externa: La forma de onda de salida estd activada o desactivada, segun el nivel de la
sefial externa aplicada al conector Ext Trig del panel frontal. Cuando la sefial admitida es verdadera, el instrumento
emite una forma de onda continua. Cuando la sefial admitida se vuelve falsa, el ciclo de la forma de onda actual se
completay el instrumento se detiene mientras permanece en el nivel de tension correspondiente a la fase de inicio
de la forma de onda seleccionada. En el caso de una forma de onda de ruido, la salida se detiene inmediatamente
cuando la sefial admitida se vuelve falsa.
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Modo réfaga disparada: ~ TRIGgered Disponible Disponible Disponible IMMediate
Disparador interno

Modo réfaga disparada: ~ TRIGgered Disponible No se utiliza Disponible EXTernal, BUS
Disparo externo

Modo de rdfaga admitida: GATed No se utiliza No se utiliza Disponible No se utiliza
Disparo externo

Modo de rdfaga del tem-  TRIGgered Disponible No se utiliza Disponible TIMer
porizador: Disparador
interno

- En el modo admitido, se ignoran el recuento de réfagas, el periodo de réfagas y la fuente de disparo (se utiliza solo
para las réfagas disparadas). Disparos manuales ignorados; no se ha generado ningun error.

- En modo admitido, puede especificar la polaridad de la sefial en el conector Ext Trig del panel frontal ([SOURce
[1]2]:]BURSt:GATE:POLarity {NORMal|INVerted}). Por defecto es NORMal (true-high).

Operaciones del panel frontal

Pulse [Burst] > N Cycle Gated o N Cycle Gated. ([Réfaga] > N Ciclo Admitida o N Ciclo Admitida).

SIN,50Q
Gated Burst, Trig Timer

Frequency 1.000,000,000 kHz

Start Phase 0.0°

Amplitude 100.0 mVpp # of Cycles 1
Burst Period 10 ms

Offset +0.000V

Polarity

Pos Neg
Phase 0.0° e

Start Phase

Comando SCPI

[SOURce[1]2]:]BURSt:MODE {TRIGgered|GATed}

Frecuencia de la forma de onda

Puede especificar la frecuencia de la sefial durante la rafaga en los modos de disparo y admitido. En el modo de
disparo, el nimero de ciclos especificado por el recuento de rafagas se emite a la frecuencia de la forma de onda. En
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el modo admitido, la frecuencia de la forma de onda se emite cuando la sefial de la puerta externa es verdadera.
Esto difiere del "periodo de réfaga", que especifica el intervalo entre las réfagas (solo en modo activado).

Frecuencia de la forma de onda: T uHz a la méxima frecuencia de la forma de onda. El valor por defecto es 1 kHz.
(Para una forma de onda de réfaga activada internamente, la frecuencia minima es 126 puHz.)

Operaciones del panel frontal

Presione [Parameter] > Frequency ([Pardmetro] > Frecuencia). Utilice el teclado numérico o la perillay las flechas
para establecer un valor deseado. Si utiliza el teclado, seleccione una unidad de prefijo para terminar.

KEYSIGHT

TECHNOLOGIES

Frequency 1_

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Comando SCPI
[SOURce[1]2]:]FREQuency {<frequency>|MINimum|MAXimum|DEFault}

El comando APPLy configura una forma de onda con un comando.

Recuento de rafagas

Numero de ciclos (1 a 100.000.000 o infinito) a generarse por réfaga. Se utiliza solo en el modo de rafaga disparada
(fuente interna o externa).

- Con la fuente de activacion inmediata, el nimero de ciclos especificado se emite continuamente a una velocidad
determinada por el periodo de rafaga. El periodo de réfagas es el tiempo entre el inicio de las rafagas consecutivas.
Ademas, el recuento de réfagas debe ser menor que el producto del periodo de réfaga y la frecuencia de la forma de
onda:

Periodo de rafaga > (Recuento de rafagas) / (Frecuencia de formas de onda) + 1 psec

- Elinstrumento aumentaré el periodo de réfagas hasta su valor maximo para acomodar el nimero de rafagas
especificado (pero no se cambiaré la frecuencia de la forma de onda).
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- En el modo de rafaga admitida, se ignora el recuento de rafagas. Sin embargo, si cambia el recuento de rafagas
desde la interfaz remota mientras estd en el modo admitido, el instrumento recuerda el nuevo recuento y lo utilizara
cuando se seleccione el modo disparo.

Operaciones del panel frontal

Presione [Burst] > # of Cycles ([Rafaga] > N.° de Ciclos). Utilice el teclado numérico o la perilla y las flechas para
establecer un valor deseado. Si utiliza el teclado, pulse Enter (Intro) para terminar.

Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Comando SCPI

[SOURce[1]2]:]BURSt:NCYCles {<num cycles>|INFinity|MINimum|MAXimum}

Periodo de rafaga

El periodo de rafaga, que se utiliza solo en el modo de réfaga disparada interna, es el tiempo que transcurre desde el
inicio de una réfaga hasta el inicio de la siguiente (1 us a 8000 s, por defecto 10 ms). El periodo de rafaga difiere de
la "frecuencia de la forma de onda", que especifica la frecuencia de la sefial de rafaga.

El periodo de rafaga se utiliza solo cuando se activa el disparo inmediato. El periodo de réfaga se ignora cuando se
activa el disparo manual o externo (o cuando se selecciona el modo de réfaga admitida).

No se puede especificar un periodo de rafaga que sea demasiado corto para que el instrumento genere el recuento y
la frecuencia de rafaga especificados. Si el periodo de réafaga es demasiado corto, el instrumento lo aumentara
segun sea necesario para volver a disparar continuamente la rafaga.

Operaciones del panel frontal

Presione [Burst] > Burst Period ([Rafaga] > Periodo de Réfaga). Utilice el teclado numérico o la perilla y las flechas
para establecer un valor deseado. Si utiliza el teclado, seleccione una unidad de prefijo para terminar.
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KEYSIGHT

TECHNOLOGIES

Frequency 1.000,000,000 kHz

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

seconds

Comando SCPI

[SOURce[1]2]:]1BURSt:INTernal:PERiod {<seconds>|MINimum|MAXimum}

Fase de inicio

Fase de inicio de la réfaga, de -360 a +360 grados (por defecto 0).
- Especifique las unidades de la fase de inicio con UNIT:ANGLe.

- Siempre se muestra en grados en el panel frontal (nunca radianes). Si se ajusta en radianes desde la interfaz
remota, el instrumento

convierte el valor en grados en el panel frontal.

- Para sinusoidal, cuadrada y rampa, O grados es el punto en el que la forma de onda cruza 0 V (o compensacién CC)
en una direccién de marcha positiva. Para las formas de onda arbitrarias, O grados es el primer punto de la forma de
onda. La fase de inicio no tiene efecto sobre el ruido.

- La fase de inicio también se usa en el modo de réfaga admitida. Cuando la sefial de la puerta se vuelve falsa, el
ciclo de la forma de onda de la corriente termina, y la salida permanece en el nivel de tensién de la fase de la rafaga
inicial.

Operaciones del panel frontal

Presione [Burst] > Start Phase ([Rafaga] » Fase de inicio). Utilice el teclado numérico o la perilla y las flechas para
establecer un valor deseado. Si utiliza el teclado, pulse Degrees (Grados) para terminar.
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TECHNOLOGIES

Frequency 1.000,000,000 kHz Degrees

Amplitude 100.0 mVpp

Offset +0.000V

Phase 0.0°

Comando SCPI

[SOURce[1]2]:]BURSt:PHASe {<angle>|MINimum|MAXimum}

Fuente del disparo de rafagas

En el modo de réfaga disparada:

- Elinstrumento emite una forma de onda del nimero de ciclos especificado (recuento de rafagas) cuando se recibe
un disparo. Una vez que se ha emitido el nimero de ciclos especificado, el instrumento se detiene y espera al
siguiente disparador.

- IMMediate (interno): el instrumento emite continuamente cuando se activa el modo réfaga. La velocidad a la que
se genera la rafaga estéd determinada por BURSt:INTernal:PERiodo.

- EXTernal: el instrumento acepta un disparador de hardware en el conector Ext Trig del panel frontal. El
instrumento emite una rafaga del niumero especificado de ciclos cada vez que Ext Trig recibe una transicién de nivel
con la polaridad apropiada (TRIGger[1|2]:SLOPe). Las sefiales de disparo externas se ignoran durante una rafaga.

- BUS (software): el instrumento inicia una réfaga cada vez que se recibe un disparo de bus (*TRG). La tecla [Trigger]
(Disparo) del panel frontal se ilumina cuando el instrumento esté esperando un disparo de bus.

- EXTernal 0 BUS: el recuento de réfagas y la fase de rdfaga permanecen en efecto, pero se ignora el periodo de
rafaga.

- TIMer: los eventos de disparo son espaciados por un temporizador, con el primer disparo tan pronto como ocurre
el INIT.

Operaciones del panel frontal

Pulse [Trigger] > Trigger Setup > Source ([Disparo] > Configuracion de disparo > Fuente).
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KEYSIGHT

TECHNOLOGIES
Trigger

e, — T
Frequency 1.000,000.000 kHz | d °“'° e
xterna
CH 1 Trigger Setup

Amplitude 100.0r Delay

Offset +0.000 Source Immediate

B 00° Delay 0s

Para especificar si el instrumento dispara en un borde ascendente o descendente de la sefial en el conector Ext Trig,
seleccione la fuente de disparo externa antes de elegir Trigger Setup (Configuracién de disparo).

Comando SCPI
TRIGger[1|2] :SOURce {IMMediate|EXTernal|TIMer |BUS}
TRIGger[1|2]:SLOPe {POSitive|NEGative}

Consulte Disparo para obtener méas informacion.

Si se cambia el ciclo de trabajo en una onda cuadrada disparada con el modo de disparo establecido en el Timer
(Temporizador), la réfaga actual terminard y se ejecutara una rdfaga més antes de que cambie el ciclo de trabajo de
la rafaga.

Sefial de salida de disparo

Consulte Sefial de salida de disparo para obtener mas detalles.
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Operaciones del panel frontal

1. Pulse [Burst] > Burst ON | OFF > Burst ON | OFF ([Réfaga] > Réfaga Activado | Desactivado > Rafaga Activado | Des-
activado).

SIN,50Q
N-Cycle Burst, Trig Imm

—
Frequency 1000.000000 Hz Start Phase 0.000000

Amplitude  0.700000 Vpp # of Cycles 1.000000
Offset 0.000000 V Burst Period 0.010000 s

—

Phase 0.000000
Start Phase

# of Cycles

Burst Period

2. Pulse [Trigger] > Trig Out Setup ([Disparo] > Configuracién de salida de disparo).
3. Luego, use esta tecla de funcién para elegir la direccién del borde deseado: Presione Trig Out Off | (Up) | (Down)
(Salida de disparo Desactivada | (Arriba) | (Abajo).).

KEYSIGHT
TECHNOLOGIES

SIN,500Q

N-Cycle Burst, Trig Imm Trigger

Frequency 1.000,000,000 kHz Stort Phase 90.0° T 2

Amplitude 100.0 mVpp # of Cycles 10 Trig Out
Burst Period 1 ms off 1L
Offset +0.000V e

Phase 0.0°

Comando SCPI

OUTPut:TRIGger:SLOPe {POSitive|NEGative}

OUTPut:TRIGger {ON|1|OFF |0}
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Disparos

En esta seccidn se describe el sistema de disparo del instrumento.

Resumen del disparo

Esta informacion de disparo se aplica solo al barrido y a la rafaga. Se pueden realizar disparos para barridos o
rafagas utilizando el disparo interno, el disparo externo, el disparo por temporizador o el disparo manual.

- Interno o "automético" (por defecto): el instrumento emite de forma continua cuando se selecciona el modo de
barrido o de réfaga.

- Externo: Utiliza el conector Ext Trig del panel frontal para controlar el barrido o la réafaga. El instrumento inicia un
barrido o genera una rafaga cada vez que el Ext Trig recibe un pulso. Puede seleccionar si el instrumento se dispara
en el borde ascendente o descendente.

- Manual: El disparo inicia un barrido o produce una réfaga cada vez que se pulsa [Trigger] (Disparo) en el panel
frontal.

- Cuando se barre una lista, el disparo mueve la forma de onda a la siguiente frecuencia de la lista.

- La tecla [Trigger] (Disparo) se desactiva cuando esté en el control remoto y cuando se selecciona una funcién
distinta de la rafaga o el barrido.

Fuentes del disparo

Esta informacion de disparo se aplica solo al barrido y a la réfaga. Se debe especificar la fuente de donde el
instrumento acepta disparos.

- Fuente de disparo de barrido y réfaga: Immediate (por defecto), External, Manual o Timer (Inmediato, Externo ,
Manual o Temporizador).

- Elinstrumento aceptara un disparo manual, un disparo de hardware desde el conector Ext Trig del panel frontal, o
emitird continuamente barridos o rafagas usando un disparo interno. También puede disparar rafagas basadas en un
temporizador. Al encender el dispositivo, se selecciona disparo inmediato.

- La configuracion de la fuente de disparo es volétil; ajustada a disparo interno (panel frontal) o inmediato (interfaz
remota) cuando el instrumento se apaga y se vuelve a encender o *RST.

Operaciones del panel frontal

Activar barrido o réfaga. Luego:

Presione [Trigger] > Source ([Disparo] > Fuente).
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Comando SCPI
TRIGger[1|2] :SOURce {IMMediate|EXTernal|TIMer |BUS}

El comando APPLy configura automéaticamente la fuente en Inmediato.

Disparo inmediato

Modo de disparo interno (por defecto): El instrumento produce continuamente barridos o rafagas (segun se
especifique por el tiempo de barrido o el periodo de réfaga).

Operaciones del panel frontal
Presione [Trigger] > Source Immediate. ([Disparo] > Fuente Inmediato).
Comando SCPI

TRIGger:SOURce IMMediate

Disparo manual

Modo de disparo manual (solo en el panel frontal): Se activa manualmente el instrumento pulsando [Trigger]
(Disparo). Elinstrumento inicia un barrido o una réfaga cada vez que se pulsa el botén [Trigger] (Disparo). El botén
se ilumina cuando estd en el menu de disparo y el instrumento esté esperando un disparo manual. El botén
parpadea cuando el instrumento estd esperando un disparador manual, pero no esta en el menu de disparo. La tecla
se desactiva cuando el instrumento estd controlada a distancia.

Operaciones del panel frontal

Pulse [Trigger] > Source Manual [Disparo] > Fuente Manual.
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Disparo externo

En el modo de disparo externo, el instrumento acepta un disparo de hardware en el conector Ext Trig del panel
frontal. Elinstrumento inicia un barrido o rafaga cada vez que el Ext Trig recibe un pulso TTL con el borde
especificado. El modo de disparo externo es como el modo de disparo manual, excepto que se aplica el disparo al
conector Ext Trig.

Consulte Sefial de entrada del disparo, a continuacion.
Operaciones del panel frontal

Pulse [Trigger] > Source External ([Disparo] > Fuente Externa).

Para especificar si el instrumento se dispara en un borde ascendente o descendente, pulse Trigger Setup
(Configuracién de disparo) y seleccione la direccién del borde pulsando Slope (Pendiente).

Comando SCPI

TRIGger:SOURce EXTernal

TRIGger[1|2]:SLOPe {POSitive|NEGative}

Disparo de software (Bus)

Disponible solo desde la interfaz remota, es similar al modo de disparo manual del panel frontal, pero se dispara el
instrumento con un comando de disparo de bus. El instrumento inicia un barrido o emite una rafaga cada vez que se
recibe un comando de disparo del bus. La tecla parpadea cuando se recibe un comando de disparo del bus.

Para seleccionar la fuente de disparo del bus, envia TRIGger:SOURce BUS.

Para disparar el instrumento desde la interfaz remota (USB, o LAN) cuando se selecciona la fuente Bus, envie TRIG o
*TRG (disparo). La tecla [Trigger] (Disparo) del panel frontal se ilumina cuando el instrumento est4 esperando un
disparo de bus.

Operaciones del panel frontal

Pulse [Trigger] > Source Manual [Disparo] > Fuente Manual.

Disparo del temporizador

El modo de activacion del temporizador activa un periodo fijo de separacion. Para seleccionar la fuente del
disparador del bus, envie TRIGger:SOURce TIMer.

Operaciones del panel frontal

Presione [Trigger] > Source Timer[Disparo] > Fuente Temporizador).

Sefial de entrada de disparo

Este conector del panel frontal se utiliza en los siguientes modos:
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- Modo de barrido disparado: Presione [Trigger]> Trigger Setup > Source External ([Disparo]> Configuracién de
disparo > Fuente Externo), o ejecute TRIG:SOUR EXT (el barrido debe estar activado). Cuando se recibe una
transicion de nivel de la polaridad correcta en el conector Ext Trig, el instrumento genera un solo barrido.

- Modo réfaga disparada: Presione [Trigger] >Trigger Setup > Source External ([Disparo] > Configuracion de
disparo > Fuente Externa), o ejecute TRIG:SOUR EXT (la rdfaga debe estar activada). El instrumento emite una forma
de onda con un numero especificado de ciclos (recuento de réfagas) cada vez que se recibe un disparo de la fuente
de disparo especificada.

- Modo de réfaga de admisién externa: Presione la tecla de funcion Gated (Admintido) o ejecute BURS:MODE GAT
con la rafaga activada. Cuando la sefial admitida externa es verdadera, el instrumento emite una forma de onda
continua. Cuando la sefial de la puerta externa se vuelve falsa, el ciclo de la forma de onda de la corriente se
completa y luego el instrumento se detiene mientras permanece en el nivel de tensién correspondiente a la fase de
rafaga inicial. Para el ruido, la salida se detiene tan pronto como la sefial admitida se vuelve falsa.

Sefial de salida de disparo

La sefial de salida del disparo esté hace referencia al chasis. Tenga cuidado de no tocar las dos sefiales simul-
taneamente mientras conecta o desconecta estos cables. Desconecte las conexiones de la salida del instrumento
antes de conectar o desconectar estos cables.

- La sefial de "salida de disparo" aparece en el conector Sync Out del panel frontal (utilizado tnicamente con
barrido y réfaga). Cuando se activa, un pulso con un borde ascendente (por defecto) o descendente se genera desde
este conector al principio del barrido o la réfaga.

SALIDA

Sinc de salida +33V
AT

o >TUsS |

OV

Borde ascendente mostrado.

- Fuente de disparo Interna (inmediata) o Temporizador: El instrumento emite una onda cuadrada con un ciclo de
trabajo del 50 % desde el conector Sync Out al principio del barrido o la réfaga. El periodo de forma de onda es igual
al tiempo de barrido o al periodo de réfaga especificados.

- Fuente de disparo Externo: El instrumento desactiva la sefial de "salida de disparo".

- Bus (software) o fuente de disparo manual: El instrumento emite un pulso (>1 us amplitud de pulso) desde el
conector Sync Out al principio de cada barrido o rafaga.

Operaciones del panel frontal

. Activar barrido o rafaga.
. A continuacién, pulse [Trigger] > Trig Out Setup ([Disparo] > Configuracién de salida de disparo).
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3. Luego, use esta tecla de funcién para elegir la direccién del borde deseado: Trig Out Off | (Up) | (Down) (Salida de
disparo Desactivada | (Arriba) | (Abajo).).

KEYSIGHT
TECHNOLOGIES

SIN,50Q

Linear Sweep, Trig Trigger

. — Ty Source
Frequency Sweeping... Start Freq  100.000,000 Hz CHITCH2

Amplitude 100.0 mVpp Stop Freq  1.000,000,000 kHz Trig Ot
Sweep Time 1.000 s off "1t

Hold Time 0.000s
Return Time 0.000 s

Offset +0.000V

Phase 0.0°

Comando SCPI

OUTPut:TRIGger:SLOPe {POSitive|NEGative}

OUTPut:TRIGger {ON|1|OFF |0}

Operaciones relacionadas con el sistema

Esta seccién abarca el almacenamiento del estado del instrumento, la recuperacién del apagado, las condiciones de
error, la prueba automatica y el control de la pantalla. Aunque no estan relacionadas con la generacion de formas de

onda, estas operaciones son importantes para el funcionamiento de los instrumentos.

Almacenamiento del estado del instrumento

- Hay dos maneras de almacenar y recuperar los estados de los instrumentos:

- Archivos de estado nombrados, usando el panel frontal 0o MMEMory:STORe:STATe y
MMEMory:LOAD:STATe

- Ubicaciones de la memoria de O a 4, usando *SAV y *RCL

- Ambos métodos de almacenamiento de estados recuerdan la funcién seleccionada (incluyendo formas de onda
arbitrarias), la frecuencia, la amplitud, la compensacion de CC, el ciclo de trabajo, la simetria y los pardmetros de
modulacion.

- Los estados almacenados no se ven afectados por el *RST; un estado almacenado permanece hasta que se
sobrescribe o se borra especificamente.
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Operaciones del panel frontal

Consulte Almacenar o recuperar el estado del instrumento.

Estado de encendido del instrumento

Puede configurar el instrumento para que se apague desde la posicidn O al encenderlo. El ajuste de fabrica es para
recuperar el estado de fabrica en el encendido.

Operaciones del panel frontal

Pulse [System] > Power On Setting > Power On Factory Default o Power On State O ([Sistema] > Configuracién de
encendido > Encendido Predeterminado de fébrica o Estado de encendido 0).

Comando SCPI

MEMory:STATe:RECall:AUTO {ON|1|OFF|0}

Condiciones de error

Se pueden almacenar hasta 20 errores de sintaxis de comando o de hardware pueden en la cola de errores.
Consulte "Mensajes de error SCPI" en la Gufa de programacion de la serie EDU332170 para obtener mas informacion.

Operaciones del panel frontal
Pulse [System] > Help > Error View ([Sistema] > Ayuda > Vista de errores).
Comando SCPI

SYSTem:ERRor?

Control de pitido

Elinstrumento normalmente emite un pitido cuando se genera un error desde el panel frontal o la interfaz remota.

Esta configuracién no es volatil, no se modificara al encender y apagar el instrumento ni si se restablecen los valores
de fabrica (*RST).

Operaciones del panel frontal

Pulse [System] > User Settings > Beeper ON | OFF ([Sistema] > Configuracion del usuario > Pitido Activado |
Desactivado).

Comando SCPI

SYSTem:BEEPer:STATe {ON|1|OFF|O0}

SYSTem:BEEPer

Clic de la tecla

Elinstrumento emite un clic cuando se presiona una tecla del panel frontal o una tecla suave.
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Esta configuracion no es volatil, no se maodificard al encender y apagar el instrumento ni si se restablecen los valores
de fabrica (*RST).

Operaciones del panel frontal

Pulse [System] > User Settings > Key Click ON | OFF ([Sistema] > Configuracion del usuario > Clic de tecla Activado |
Desactivado).

Comando SCPI

SYSTem:CLICk:STATe {ON|1|OFF |0}

Apague la pantalla

Por razones de seguridad, o para acelerar la velocidad a la que el instrumento ejecuta los comandos de la interfaz
remota, es posible que desee apagar la pantalla.

Operaciones del panel frontal

Pulse [System] > User Settings > Display ON | OFF.([Sistema] > Configuracién del usuario > Pantalla Activado |
Desactivado).

Presione cualquier tecla para volver a encender la pantalla.
Comando SCPI

DISPlay {ON|1|OFF|0}

Brillo de la pantalla

Puede configurar el brillo de la pantalla para que se oscurezca automaticamente (del 100 % al 10 %) después de 2
minutos de inactividad. Puede configurar esta funcién solo desde el panel frontal.

Esta configuracion no es volatil, no se modificard al encender y apagar el instrumento ni si se restablecen los valores
de fabrica (*RST).

Operaciones del panel frontal
Pulse [System] > User Settings > Auto Dimming ON | OFF ([Sistema] > Configuracién del usuario > Atenuacion

automatica Activado | Desactivado).

Fechay hora

Puede ajustar el reloj de fecha y hora del instrumento.

Operaciones del panel frontal

Pulse [System] > User Settings > Date / Time ([Sistema] > Configuracién del usuario > Fecha / Hora).
Comando SCPI

SYSTem:DATE <yyyy>, <mm>, <dd>
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SYSTem:TIME <hh>, <mm>, <ss>

Administrar archivos

Puede realizar tareas de administracion de archivos, incluyendo copiar, renombrar, eliminar y crear nuevas carpetas.
Operaciones del panel frontal

Presione [System] > Store/Recall > File Manager ([Sistema] > Almacenar/Recuperar > Administrador de archivos).

Puede copiar, renombrar o eliminar archivos o carpetas. Al eliminar una carpeta se eliminan todos los archivos de
esta, asi que asegurese de que desea eliminar todos los archivos que hay en ella.

La tecla de funcién méas importante es Switch Pane (Mando de control) que permite especificar la ubicacién de la
accion a realizar. Una vez que haya elegido la ubicacién de la accién a realizar, pulse Select (Seleccionar) para
seleccionar el archivo a gestionar. Una vez que esté completamente preparado para ejecutar la tarea, pulse
Rename, Copy o Delete (Renombrar, Copiar o Eliminar).

Comando SCPI

Consulte "MEMory" y "Subsistemas MMEMory" en la Guia de Programacidn de la Serie EDU33210.

Prueba automatica

Se produce una prueba automatica de encendido limitada cuando se enciende el instrumento para asegurar que el
instrumento estd operativo. También puedes hacer una prueba automatica mas completa. Para obtener mas
detalles, consulte "Procedimientos de prueba automatica" en la Guia de Servicio de la Serie EDU332170.

Operaciones del panel frontal
Pulse [System] > Instr. Setup > Self Test ([Sistema] > Configuracidn Instr. > Prueba automética).

Comando SCPI

*TST

Consulta de revision del firmware

Envie *IDN? para determinar qué revision de firmware estd instalada actualmente. La consulta devuelve una cadena
de la forma:

Keysight Technologies, [Nimero de modelo], [Nimero de serie de 10 caracteres], [NUmero de revisién del
firmware]

Ejemplo de ndmero de revision del firmware: K-01.00.04-01.00-01.00-01.00-01.00
Operaciones del panel frontal

Pulse [System] > Help > About ([Sistema] > Ayuda > Acerca de). Escanee el cédigo QR mostrado para ver la
documentacion relacionada con este instrumento.
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Comando SCPI

*IDN?

Consulta de la version de lenguaje SCPI

Elinstrumento cumple con las reglas y convenciones de la presente versién del SCPI (Comandos estandar para
instrumentos programables). Utilice SYSTEM:VERSion? para determinar la version de SCPI con la que cumple el
instrumento. La consulta devuelve una cadena en la forma "YYYY.V", que representa el afio y el nimero de version
de ese afio (por ejemplo, 1999.0).

Configuracion de ES »

Consulte Conexiones de la interfaz remota y Configuraciones de la interfaz remota para obtener mas detalles.

Operacion de doble canal

Esta seccién cubre la mayoria de los temas relacionados con la operacién de doble canal.

Ingreso a la operacion de doble canal

Se entra en la configuracion de doble canal pulsando el botén de salida de un canal y, a continuaciéon, Dual Channel
(Doble canal).

KEYSIGHT

TECHNOLOGIES

Freq Cpl
Frequency 1. cp 1 pyal Channel Operation ON"TOFF

Amplitude 1! Frequencies Independent Freq Cpl Settings

-
Offset + Offset CH2 - CH1 =  +0.000,000 Hz

Phase 0.

Amplitudes & Offsets Independent Qr:? K D‘g
Tracking off

Tracking
OFF

Combine
CH2 " OFF

Acoplamiento de frecuencia

El acoplamiento de frecuencias permite acoplar frecuencias o frecuencias de muestreo entre canales, ya sea
mediante una relacién constante o una compensacion entre ellas. Presione Freq Cpl ON | OFF (Acoplamiento de
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frecuencia Activado | Desactivado) para activar o desactivar el acoplamiento de frecuencias y pulse Freq Cpl
Settings (Ajustes de Acoplamiento de frecuencia) para configurar el acoplamiento de frecuencias.

La tecla de funcién Freq Cpl Settings (Ajustes de Acoplamiento de frecuencia) abre el ment que se muestra a
continuacion. La primera tecla de funcion le permite especificar si desea acoplar las frecuencias con una relaciéon o
una compensacion, y la segunda tecla de funcion le permite especificar la relacion o compensacion.

— | offser <
Frequency 1. oy q pyal Channel Operation Riatio

Amplitude 1! Frequencies Independent Freq Couple

Offset
Offset + Offset CH2 - CH1 = +0.000,000 Hz

Amplitudes & Offsets Independent

Tracking

Phase 0.

Acoplamiento de amplitud

El acoplamiento de amplitud, que se habilita con la tecla de funciéon Ampl Cpl ON | OFF (Acoplamiento de amplitud
Activado | Desactivado), acopla la tensién de compensacién y amplitud entre canales, de modo que el cambio de
amplitud o compensacién en un canal afecta a ambos canales.

Rastreo

Elrastreo, que se configura con la tecla de funcién Tracking (Rastreo), tiene tres modos: OFF, Identical e Inverted
(Apagado, idéntico e invertido).

- Cuando el rastreo estd en modo OFF (desactivado), los dos canales funcionan de forma independiente.
- Cuando el rastreo estd en modo Identical (Idéntico), ambos e comportan como un solo canal.

- Eltercer modo, Inverted (Invertido), hace que las salidas de los canales sean inversas entre sf, dando como
resultado un canal diferencial que utiliza ambas salidas.

Combinar

La funcién Combine (Combinar) combina dos salidas en un solo conector. Si elige CH2 en el ment Canal 1, se
combinan en el canal 1; si elige CH1 en el menu Canal 2, se combinan en el canal 2.

En laimagen de abajo, la forma de onda superior es una onda sinusoidal de 100 mVpp, 1 kHzenelcanal 1,y la
forma de onda inferior es una onda sinusoidal de 100 mVpp, 5 kHz en el canal 2.
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La imagen siguiente muestra las dos salidas combinadas en el canal 1. Obsérvese que el eje X se ha comprimido
(alejado) para mostrar més ciclos.

DI B ] 4 Bk S by @ INe

Informacidn operativa

Las sefiales que se combinan no tienen por qué ser del mismo tipo; por ejemplo, esta imagen muestra el mismo
canal de 5 kHz en el canal 2 combinado con una onda cuadrada de 100 mVpp en el canal 1.

TR T T | o L L R

Cuando se combinan las sefiales, los valores de compensacion de CC no se suman. En la salida combinada solo se
utiliza la compensacion de CC del canal de recepcion. La figura siguiente muestra una compensacion de CC de 50 a
mV afiadida al canal 1. La compensacion de 50 mV afiadida al canal 2 se ignora.
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También puede utilizar Combinar con rafagas. Por ejemplo, considere la siguiente imagen, que incluye una onda
sinusoidal de 1 kHz en el canal 1y rafagas de tres ciclos de una onda sinusoidal de 5 kHz en el canal 2.

E e | e § [ ] W Bl BRI Pw f @ IR

Cuando estas sefiales se combinan en el canal 1, el resultado es una simple suma de amplitud de las dos sefiales,
como se muestra a continuacion.

E e | e § [ ] W Bl RIS w f @ IR

También puede combinar las sefiales en el canal 2, como se muestra a continuacion.

L B ] L} 4 G IR Bw 1 W ISe
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o Caracteristicas y especificaciones

Para ver las caracteristicas y especificaciones de los Generadores de formas de onda arbitrarias Trueform de la serie
EDU33210, consulte la hoja de datos en: https://www.keysight.com/us/en/assets/3121-1004/data-shee-
ts/EDU33210-Series-20-MHz-Function-Arbitrary-Waveform-Generators.pdf.
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o Tutoriales de medicion

Formas de onda arbitrarias
Ruido cuasi-gaussiano

PRBS

Modulacién

Rafaga

Barrido de frecuencia
Atributos de las sefiales de CA
Imperfecciones de la sefial

En esta seccidn se describe la informacion tedrica de funcionamiento
para varios tipos de formas de onda y modos de funcionamiento del
instrumento. Los dos ultimos temas incluyen informacidn que puede
ayudar a mejorar la calidad de la sefial.
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Formas de onda arbitrarias

Las formas de onda arbitrarias pueden satisfacer necesidades no cubiertas por las formas de onda estandar del
instrumento. Por ejemplo, es posible que necesite un estimulo Unico, o puede que quiera simular las imperfecciones
de la sefial como sobreimpulso, zumbido, fallos o ruido. Las formas de onda arbitrarias pueden ser muy complejas,
lo que las hace adecuadas para simular sefiales en los sistemas de comunicaciones modernos.

Puede crear formas de onda arbitrarias desde un minimo de 8 puntos hasta 1.000.000 de puntos. Elinstrumento
almacena estos puntos de datos numéricos, conocidos como "muestras", en la memoria y luego los convierte en
tensiones a medida que se genera la forma de onda. La frecuencia a la que se leen los puntos es la "tasa de
muestreo", y la frecuencia de la forma de onda es igual a la tasa de muestreo dividida por el nimero de puntos de la
forma de onda. Por ejemplo, supongamos que una forma de onda tiene 40 puntos y la frecuencia de muestreo es de
10 MHz. La frecuencia serfa (10 MHz)/40 = 250 kHz y su periodo serfa 4 ps.

Elinstrumento puede abrir archivos .ARB directamente. Para cargar un archivo arb especifico (.arb) en la memoria
interna o USB, presione [Waveforms] > Arb > Arbs > Select Arb([Formas de onda]> Arb > Arbs > Seleccionar Arb).

También puede importar una columna de datos en formato .CSV. Para hacerlo, presione [Waveforms] > Arb > Arbs >
Import Data ([Formas de onda] > Arb > Arbs > Importar datos). Esto abre una interfaz de ment que lo gufa por el
proceso de importar un archivo.

Cada valor en el archivo .CSV se limita a 7 caracteres (incluidos el signo menos y el punto decimal). Por ejemplo: -
0.1234.

Sielarchivo .CSV tiene mas de 7 caracteres, el generador de funcidn no podra importar el archivo.

Filtros de forma de onda

Elinstrumento incluye dos filtros para suavizar las transiciones entre puntos a medida que se generan formas de
onda arbitrarias.

- Filtro normal: Una respuesta de frecuencia amplia y plana, pero su respuesta de paso exhibe sobreimpulso y
zumbido

- Filtro de paso: Una respuesta escalonada casi ideal, pero con mas reduccion en su respuesta de frecuencia que el
filtro normal.

- Off: La salida cambia abruptamente entre los puntos, con un tiempo de transicién de aproximadamente 10 ns.

La frecuencia de corte de cada filtro es una fraccion fija de la tasa de muestreo de la forma de onda. La respuesta del
filtro Normal es de -3 dB al 27 % de la frecuencia de muestreo y la del filtro Paso es de -3 dB al 13 % de la frecuencia
de muestreo. Por ejemplo, para una forma de onda arbitraria a 100 MSa/s, el ancho de banda de frecuencia de -3 dB
delfiltro Normal es de 27 MHz.

Apagar el filtro puede cambiar la tasa de muestreo a una tasa menor si la tasa de muestreo era superior a 2560 MSa/s
antes de que se apagara el filtro.

Ruido cuasi-gaussiano

La forma de onda del ruido esté optimizada para las propiedades estadisticas cuantitativas y cualitativas. No se
repite durante mas de 50 afios de funcionamiento continuo. A diferencia de una verdadera distribucién Gaussiana,
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hay cero probabilidad de obtener una tensién mas alla del ajuste Vpp del instrumento. El factor de cresta (tension
pico dividida por la tensién RMS) es aproximadamente 4.6.

Puede variar el ancho de banda del ruido desde 1 mHz hasta el ancho de banda méximo del instrumento. La energia
de la sefial de ruido se concentra en una banda desde la CC hasta el ancho de banda seleccionado, por lo que la
sefial tiene una mayor densidad espectral en la banda de interés cuando el ajuste del ancho de banda es menor. En
los trabajos de audio, por ejemplo, se podria establecer el ancho de banda en 30 kHz, para que la intensidad de la
sefial de la banda de audio sea 30 dB mayor que si el ancho de banda se estableciera en 30 MHz.

PRBS

Una Secuencia de Bits Seudo-Aleatoria (PRBS) tiene dos niveles (alto y bajo), y cambia entre ellos de una manera
que es dificil de predecir sin conocer el algoritmo de generacion de la secuencia. Una PRBS se genera por un
registro de desplazamiento de retroalimentacion lineal (LFSR), que se muestra a continuacion.

[

XOR

F

M 1 z 3 4 5 » B T 8 9 » PRBS

Un LFSR se especifica por el nimero de etapas que contiene y qué etapas ("derivaciones") alimentan las puertas
exclusivas o (XOR) de su red de retroalimentacién. La salida de la PRBS se toma de la Gltima etapa. Con las
derivaciones correctamente elegidas, un LFSR de etapa L produce una PRBS repetitiva de longitud 2L - 1. La
frecuencia de reloj del LFSR determina la "tasa de bits" de la PRBS.

Puede configurarLa 7,9, 11, 15, 20, 0 23, lo que resulta en secuencias de 127 a 8.388.607 bits de longitud.

El valor predeterminado de L es 7, lo que resulta en una secuencia de 127 bits de longitud.

Modulacion

Modulacién de amplitud (AM)

Elinstrumento implementa dos formas de AM:

- Transportadora completa de doble banda lateral (DSB-FC), que tiene una designacion de la UIT de A3E y se utiliza
en la radiodifusion en AM.

La ecuacion para el DSB-FC es
y(0)= [(12)+(%%)-d-m(D)]-A.-sin(wy 1)
donde

m(t) es la sefial moduladora

A es laamplitud de la transportadora

w, es la frecuencia transportadora de la transportadora

d es la "profundidad de modulacién®, o fraccion de la gama de amplitud que utiliza la modulacion
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Por ejemplo, un ajuste de profundidad del 80 % varfa la amplitud del 10 % al 90 % del ajuste de amplitud (90 % -
10 % =80 %) con una sefial moduladora interna o externa a escala completa (+5 V). Puede ajustar la profundidad
hasta el 120 %, siempre que no exceda la tensién maxima de salida del instrumento de (+5V en 50 Q, +10 V en alta
impedancia).

Eltrazo superior de abajo representa la sefial moduladora; el trazo inferior representa la transportadora modulada.

- Transportadora suprimida de doble banda lateral (DSSC). Muchos sistemas de comunicaciones modernos
emplean DSSC en cada una de las dos transportadoras que tienen la misma frecuencia pero una diferencia de fase
de 90 grados. Esto se llama modulacién de amplitud en cuadratura (QAM).

La ecuacion para DSSC es
y(t)=d-m(t)-sin(w, t)

En el DSB-SC, la sefial transportadora se invierte siempre que m(t) < 0. Para QAM, la segunda sefial transportadora
serfa cos(w, t), por lo que estarfa 90 grados desfasada de la primera transportadora.

Modulacién de frecuencia (FM)

La modulacién de frecuencia varfa la frecuencia de una sefial transportadora segun la sefial moduladora:
y(t)=Ag-sin[(wy+d-m(t) )-t]

donde m(t) es la sefial moduladora y d es la desviacién de frecuencia. La FM se llama banda estrecha si la desviacién
es inferior al T % del ancho de banda de la sefial moduladora, y la banda ancha en caso contrario. Puede aproximar
el ancho de banda de la sefial modulada con las siguientes ecuaciones.

BW ~ 2-(Ancho de banda de la sefial moduladora) para banda estrecha FM

BW ~ 2-(Desviaciéon+Ancho de banda de la sefial moduladora) para FM de banda ancha

Eltrazo superior de abajo representa la sefial moduladora; el trazo inferior representa la transportadora modulada.
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Modulacién de fase (PM)

La PM es similar a la FM, pero la fase de la forma de onda transportadora es variada, mas que la frecuencia:
y(t)=sin[w, t+d-m(t) ]

donde m(t) es la sefial moduladora y d es la desviacion de fase.

Modulacién de introduccién de cambios de frecuencia (FSK, Frequency-Shift Keying)

La FSK es similar a la FM, excepto que la frecuencia transportadora alterna entre dos valores preestablecidos, la
frecuencia transportadora y la frecuencia de salto. A veces las frecuencias de salto y transportadora se llaman
"Marca"y "Espacio", respectivamente. La velocidad a la que se produce la conmutacidn entre estos valores esta
determinada por un temporizador interno o la sefial del conector Ext Trig del panel frontal. Los cambios de
frecuencia son instantaneos y de fase continua.

La sefial moduladora interna es una onda cuadrada con un ciclo de trabajo del 50 %.

Eltrazo superior de abajo representa la sefial moduladora; el trazo inferior representa la transportadora modulada.
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Introduccidon de cambios de fase binaria (BPSK)

La BPSK es similar a la FSK, excepto que es la fase de la transportadora, mas que su frecuencia, la que cambia entre
dos valores. La velocidad a la que se produce la conmutacion entre estos valores esta determinada por un
temporizador interno o la sefial del conector Ext Trig del panel frontal. Los cambios de fase son instantaneos.

La sefial moduladora interna es una onda cuadrada con un ciclo de trabajo del 50 %.

Modulacién de amplitud de pulso (PWM)

PWM solo esté disponible para la forma de onda de pulso, y la amplitud de pulso varia segun la sefial de
modulacidn. La cantidad en que varfa la amplitud de pulso se denomina desviacion de amplitud, y puede
especificarse como un porcentaje del periodo de la forma de onda (es decir, el ciclo de trabajo) o en unidades de
tiempo. Por ejemplo, si se especifica un pulso con un 20 % de ciclo de trabajo y luego se activa PWM con un b % de
desviacion, el ciclo de trabajo varfa entre el 15 % y el 25 % bajo el control de la sefial moduladora.

Modulacién aditiva (Suma)

La funcién "Suma" afiade la sefial moduladora a la transportadora. Por ejemplo, puede afiadir cantidades
controladas de ruido de ancho de banda variable a una sefial o crear sefiales de dos tonos. El generador de
modulacion interna del instrumento puede producir la misma forma de onda continua que el generador principal,
por lo que la funcién Suma le permite crear muchas sefiales que antes habrian requerido dos instrumentos.

La funcidon Suma aumenta la amplitud de la sefial de salida por la amplitud de la sefial de modulacion. Esto podria
causar que el instrumento cambie a un rango de tensién de salida mas alto, resultando en una pérdida momenténea
de la sefial. Si esto es un problema en su aplicacion, active la funcién de Retencidn de rango. Si el aumento de
tension puede dafiar el dispositivo que se estd probando, aplique limites de tension.

Rafaga

Puede configurar el instrumento para que emita una forma de onda con un nimero determinado de ciclos, llamado
réfaga. Puedes usar la rafaga en uno de los dos modos: Réafaga N-Cycle (N ciclos) (también llamada "rédfaga
disparada") o réfaga Gated (Admitida).

Una rafaga de N ciclos consiste en un nimero especifico de ciclos de forma de onda (1 a 1,000,000), donde cada
rafaga siempre se inicia por un evento de disparo. También puede establecer el conteo de rafagas en "Infinito", lo
gue resulta en una forma de onda continua una vez que el instrumento se dispara.

En laimagen de abajo, el trazo superior es la salida de sincronizacidn, y el inferior es la salida principal.
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Forma de onda de rafaga de tres ciclos

En el caso de las rafagas, el origen del disparo puede ser una sefial externa, un temporizador interno, la tecla o un
comando de la interfaz remota. La entrada para las sefiales de disparo externo es el conector de Ext Trig del panel
frontal. Este conector se refiere a la tierra del chasis (no a la tierra flotante). Cuando no se utiliza como entrada, el
conector Ext Trig puede configurarse como salida para permitir que el instrumento dispare otros instrumentos al
mismo tiempo que se produce su disparo interno.

Una réfaga de N ciclos siempre comienza y termina en el mismo punto de la forma de onda, llamada fase de inicio.

En el modo rafaga GATed, la forma de onda de salida estd activada o desactivada, segun la sefial del conector de Ext
Trig del panel frontal. Seleccione la polaridad de esta sefial usando BURSt:GATE:POLarity. Cuando la sefial admitida
es verdadera, el instrumento emite una forma de onda continua. Cuando la sefial admitida se vuelve falsa, el ciclo de
la forma de onda actual se completa y el instrumento se detiene y permanece en el nivel de tensidn correspondiente
a lafase de la rafaga inicial de la forma de onda. En el caso de una forma de onda de ruido, la salida se detiene
inmediatamente cuando la sefial admitida se vuelve falsa.

Barrido de frecuencia

El barrido de frecuencias es similar al de la FM, pero no se utiliza ninguna forma de onda moduladora. En cambio, el
instrumento establece la frecuencia de salida basandose en una funcion lineal o logaritmica, o en una lista de hasta
128 frecuencias especificadas por el usuario. Un barrido lineal cambia la frecuencia de salida en un nimero
constante de Hz por segundo, y un barrido logaritmico cambia la frecuencia en un nimero constante de décadas
por segundo. Los barridos logaritmicos permiten cubrir amplios rangos de frecuencia en los que la resolucidn en las
frecuencias bajas podria perderse con un barrido lineal.

Los barridos de frecuencia se caracterizan por un tiempo de barrido (durante el cual la frecuencia cambia
suavemente de la frecuencia de inicio a la frecuencia de parada), un tiempo de retencién (durante el cual la
frecuencia permanece en la frecuencia de parada) y un tiempo de retorno (durante el cual la frecuencia regresa
suave y linealmente a la frecuencia de inicio). Los ajustes del disparo determinan cudndo comienza el siguiente
barrido.
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La sefial de CA mas comun es una onda sinusoidal. De hecho, cualquier sefial periédica puede representarse como
la suma de diferentes ondas sinusoidales. La magnitud de una onda sinusoidal suele especificarse por su valor pico,
pico a pico o media cuadratica raiz (RMS). Todas estas medidas asumen que la forma de onda tiene una tensién de

compensacion cero.

VRMS =0.707 vPeak
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El pico de tensién de una forma de onda es el valor maximo absoluto de todos sus puntos. La tensién pico a pico es
la diferencia entre el maximo y el minimo. La tensién RMS es igual a la desviacion estandar de todos los puntos de la
forma de onda; también representa la potencia media de un ciclo en la sefial, menos la potencia en cualquier
componente de CC de la sefial. El factor de cresta es la relacion entre el valor de pico de una sefial y su valor RMS'y
varfa segun la forma de onda. El cuadro que figura a continuacion muestra varias formas de onda comunes con sus
respectivos factores de cresta y valores RMS.
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Si se utiliza un voltimetro de lectura media para medir el "tensién de CC" de una forma de onda, la lectura puede no
coincidir con el ajuste de compensacion de CC. Esto se debe a que la forma de onda puede tener un valor medio no
nulo que se affadirfa a la compensacion de CC.

Ocasionalmente se pueden ver niveles de CA especificados en "decibeles relativos a 1 miliwatio" (dBm). Como dBm
representa un nivel de potencia, es necesario conocer la tension RMS de la sefial y la resistencia de carga para

hacer el célculo.

dBm = 10xlogqo (P /0.001) donde P = VRMS? / RL

Para una onda sinusoidal en una carga de 50 Q, la siguiente tabla relaciona los dBm con la tension.

dBm Tension RMS Tensidn de pico a pico.
+23.98 dBm 3.54Vrms 10.00 Vpp
+13.01 dBm 1.00 Vrms 2.828 Vpp
+10.00 dBm 707 mVrms 2.000 Vpp
+6.99 dBm 500 mVrms 1.414 Vpp
3.98 dBm 354 mVrms 1.000 Vpp
0.00 dBm 224 mVrms 632 mVpp
-6.99 dBm 100 mVrms 283 mVpp
-10.00 dBm 70.7 mVrms 200 mVpp
-16.02 dBm 35.4 mVrms 100 mVpp
-30.00 dBm 7.07 mVrms 20.0mVp
-36.02 dBm 3.54 mVrms 10.0 mVpp
-50.00 dBm 0.707 mVrms 2.00 mVpp
-56.02 dBm 0.354 mVrms 1.00 mVpp

Para cargas de 75 Q o cargas de 600 Q, utilice las siguientes conversiones:

dBm (75Q)=dBm (50 Q) - 1.76
dBm (600 Q) =dBm (50 Q) - 10.79
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Imperfecciones de la sefial

En el caso de las ondas sinusoidales, las imperfecciones comunes de la sefial son més faciles de describir y observar
en el dominio de la frecuencia, usando un analizador de espectro. Se considera distorsion cualguier componente de
la sefial de salida con una frecuencia diferente de la fundamental (o "transportadora"). Esas imperfecciones pueden
clasificarse como distorsién armonica, espuria no armonica o ruido de fase, y se especifican en decibelios relativos al
nivel de la transportadora, o "dBc".

Distorsion armodnica

Los componentes armonicos se producen en multiplos enteros de la frecuencia fundamental y suelen ser creados
por componentes no lineales en la trayectoria de la sefial. En amplitudes de sefial bajas, otra posible fuente de
distorsion armdnica es la sefial Sync (de sincronizacién), que es una onda cuadrada con muchos componentes
armonicos fuertes que pueden acoplarse a la sefial principal. Aungue Sync estd altamente aislado de las principales
salidas de sefial del instrumento, el acoplamiento puede ocurrir en el cableado externo. Para obtener los mejores
resultados, use cables coaxiales de alta calidad con doble o triple blindaje. Si no se requiere Sync, déjelo
desconectado o apagado.

Espurios no armonicos

Una fuente de componentes espurios no armanicos (llamados "espurios") es el convertidor de digital a analégico
(DAC) que convierte los valores de la forma de onda digital en tensién. La no linealidad en este DAC da lugar a
armdnicos que pueden ser mas altos que la frecuencia de Nyquist y por lo tanto se aliardn a una frecuencia mas
baja. Por ejemplo, el quinto armdnico de 30 MHz (150 MHz) podrfa crear un espurio a 100 MHz.

Otra fuente de estimulos no armdnicos es el acoplamiento de fuentes de sefiales no relacionadas entre sf (como los
relojes del controlador incorporado) en la sefial de salida. Estos espurios suelen tener una amplitud constante y son
mas problematicos en amplitudes de sefial inferiores a 100 mVpp. Para una pureza 6ptima de la sefial a bajas
amplitudes, mantenga el nivel de salida del instrumento relativamente alto y utilice un atenuador externo.

Ruido de fase

El ruido de fase resulta de pequefios cambios instantéaneos en la frecuencia de salida ("jitter"). En un analizador de
espectro, aparece como un aumento del suelo de ruido aparente cerca de la frecuencia de la sefial de salida. La
especificacion del ruido de fase representa las amplitudes del ruido en las bandas de 1 Hz situadas a 1 kHz, 10 kHz y
100 kHz de distancia de una onda sinusoidal de 30 MHz. Tenga en cuenta que los analizadores de espectro también
tienen ruido de fase, por lo que los niveles que lea pueden incluir ruido de fase del analizador.

Ruido de cuantificacion

La resolucion finita en la forma de onda DAC causa errores de cuantificacion de tensién. Suponiendo que los errores
estan distribuidos uniformemente en un rango de +0,5 bits menos significativos, el nivel de ruido equivalente para
las formas de onda estandar es de aproximadamente -95 dBc. A este nivel, dominan otras fuentes de ruido en el
instrumento. El ruido de cuantificacion puede ser preocupante, sin embargo, en formas de onda arbitrarias que no
utilizan todo el rango de cédigos DAC (-32767 a +32767). Escale las formas de onda arbitrarias para usar todo el
rango, si es posible.
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